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WebWorks ePublisher Documentation
WebWorks ePublisher Documentation provides many resources online and in the product to help you use the ePublisher
system to deliver integrated, single-sourced document sets.

Dockable Help

Provides context-sensitive information and step-by-step guidance for common tasks, as well as descriptions of each
field on each window. Dockable Help is the ePublisher documentation set in Reverb 2.0 format and provides a
comprehensive, integrated deliverable that includes all the information from WebWorks resources. Dockable Help
displays when ePublisher is opened, or you can click Documentation on the Help tab in the product interface.

http://www.webworks.com/Documentation/Reverb/
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Contacting Quadralay
Please contact us with your questions and comments. We look forward to hearing from you. If you need assistance
with an issue, please contact Technical Support. The Support Web site allows you to review the support policy and
create a case to track an issue.
 

Telephone: 877.893.2967 (only in the United States and Canada)
512.719.3399

Email: info@webworks.com

Support www.webworks.com/Support/

Web Site: www.webworks.com

mailto:info@webworks.com
http://www.webworks.com/Support/
http://www.webworks.com
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Conventions
WebWorks ePublisher documentation uses consistent conventions to help you identify items. The following table
summarizes these conventions.
 

Convention Use

Bold Window and menu items
Technical terms, when introduced

Italics Book titles
Variable names
Emphasized words

Fixed Font File and folder names
Commands and code examples
Text you must type
Text (output) displayed in the command-line interface

Blue Links

> Submenu selections, such as Target > Target Settings

Brackets, such as [value] Optional parameters of a command

Braces, such as {value} Required parameters of a command

Logical OR, such as
value1 | value2

Exclusive parameters. Choose one parameter.
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Introduction to the WebWorks
ePublisher Platform

Content development, publication, and maintenance are complex, time-consuming processes. Each day,
companies spend numerous hours writing, formatting, and publishing information needed by internal and external
users. At the same time, these users search among vast amounts of content to find the information they want and
need. Companies need to streamline content production processes while delivering the content to users when,
where, and how they need it.

Adding to this complexity, teams across the company use multiple content authoring tools, such as Adobe
FrameMaker, Microsoft Word, and XML editors, to create the content. These teams must be able to use the
authoring tools that best meet their needs. However, mastering these tools for content development is only
half the battle. Content developers also need tools to publish content consistently in multiple formats, such as
print, HTML, and PDF. This requirement is difficult to meet and often leads to increased production costs or an
inconsistent corporate image. In addition, corporate branding standards change over time, and implementing these
changes across all content adds to production and maintenance costs.

With all these variations in content creation, publication, and maintenance, delivering the right information to the
right people in the right format and at the right time is an endless and costly struggle that consumes enormous
time and resources across organizations.
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What Is ePublisher?
The WebWorks ePublisher Platform (ePublisher) is a powerful, comprehensive solution that delivers cost-
effective processes for efficiently publishing and maintaining online and print information. ePublisher gives you
the flexibility to deliver content from multiple types of source documents, such as Adobe FrameMaker, Microsoft
Word, and DITA, in virtually any output format you need without incurring training or software deployment
expenses. The open, standards-based architecture provides a powerful engine that does not lock your content in a
proprietary format that can become outdated as tools and standards change.

With the robust combination of input and output formats supported by ePublisher, you can develop the content
using your preferred content authoring tools, and then produce and maintain all your deliverables within a single
publishing environment. You can implement a consistent look and feel across all deliverables and quickly modify
and deploy that branding if and when needed. ePublisher integrates seamlessly with your content management or
version control systems, so you can automatically generate and deploy the deliverables you need and reduce the
time demands on your teams.
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Workflow
WebWorks ePublisher Platform components provide a workflow that ensures you can deliver your content, your
way, every time. A successful online content delivery workflow includes the following items:

Creation and automation of consistent, reusable online content designs

Packaging of online content designs for seamless, consistent reuse

Application of online content designs to new and existing projects to ensure consistent content delivery and
deployment

ePublisher supports this workflow by allowing ePublisher users to perform the following tasks:

Stationery designers use ePublisher Designer to create and manage online content designs, then package the
designs into Stationery for writers to use

Writers use ePublisher Express and Stationery to create and deploy consistent online content

ePublisher AutoMap can be configured to automatically generate and deploy online content

For more information about the WebWorks ePublisher Platform components that support this workflow, see
“WebWorks ePublisher Platform Components”. For more information about the ePublisher workflow, see
“Understanding the ePublisher Workflow”.
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WebWorks ePublisher Platform Components
With ePublisher, you can write your content in your preferred authoring tools, then use ePublisher components to
design and deliver your content. The ePublisher components allow you to design all the content output formats
you need, and then automate the publication process and integrate it with your company-wide processes, such as
product builds and Web site updates.

ePublisher includes the following components:

ePublisher Designer
The design tool for creating and designing Stationery. Stationery defines the appearance and functionality
of all the output formats you need. ePublisher provides several default formats that you can use as a basis
for your Stationery, and then you can customize that standard and save it as your Stationery for your
deliverables produced using the other ePublisher components.

ePublisher Express
The on-demand publishing tool that transforms your content based on your Stationery and converts your
source documents into the desired output formats. This component is installed on the desktop and integrates
with your existing authoring tools to support the features you require, such as related topics and expand/
collapse sections within your deliverable. With this component, you can quickly prepare your source
documents and generate your final deliverables.

ePublisher AutoMap
The automation tool that enables you to automate the content conversion process, batch processing, and
integration with content management or version control systems. This component lets you schedule
conversion projects to occur at times when you are not using your computer. For example, you can
schedule the conversion to occur overnight. Then, when you arrive the next morning, your transformed
content is ready for you. You can also automatically generate and deploy deliverables to meet your specific
needs, such as updating Web site content based on updated source documents.



Supported Input Formats | 9

Supported Input Formats
ePublisher provides a single-sourcing environment that works with the following input formats.

Adobe FrameMaker

Microsoft Word

DITA XML Files

WebWorks Markdown



10 | Supported Output Formats

Supported Output Formats
ePublisher lets you define your output formats, such as XHTML and WebWorks Help, so content developers
can focus on developing quality content without worrying about tedious conversion requirements for various
deliverables. You can manage your content as you want and produce deliverables in the following formats:

WebWorks Reverb 2.0

WebWorks Reverb

WebWorks Help 5.0

Dynamic HTML

Microsoft HTML Help

Eclipse Help

Sun JavaHelp 2.0

Oracle Help

PDF

PDF - XSL-FO

eBook - ePUB 2.0

XML+XSL
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How ePublisher Helps You
With ePublisher and its agile enterprise publishing capabilities, you have unparalleled design flexibility with the
ability to deliver your information, regardless of input format, in multiple output formats. This solution enables
both large and small organizations to implement the publishing environment that works best for them.
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Streamline and Automate the Content Publishing Process
In a traditional content authoring environment, a content author produces content designed for a single output
format. This environment typically has the following limitations:

Content is often duplicated across multiple content-producing teams.

Content is not maintained consistently across the multiple teams.

Production is expensive with multiple tools and technologies.

Using ePublisher, you can quickly publish content from your source documents. You can develop the content
using your preferred content authoring environment, such as Microsoft Word, Adobe FrameMaker, or DITA. You
do not have to spend time and resources learning how to format content for each and every output format in which
your content will be delivered. You can focus on the content, and then use your Stationery to quickly and easily
deliver information in the multiple formats that meet the requirements for your organization.

ePublisher reduces wasted time and expenses that occur when multiple groups in your organization unknowingly
produce the same information at the same time. This publishing environment allows your organization to produce
content one time. This content can then be shared in varying input formats across your organization.
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Produce High Quality Deliverables with Fewer Individual Dependencies
Instead of requiring team members to understand the entire process to produce content in multiple formats, team
members can focus on their areas of expertise. Content developers can create informative content to add value
to the products and services they document. You can also expand the skills of individual team members into
important new areas, which strengthens your team as a whole.

ePublisher lets you concentrate on producing high-quality content within the authoring environment that works
for you. You spend much less time on designing, implementing, and delivering multiple output formats. With
ePublisher, you quickly generate complete, ready-to-deploy publications.

ePublisher also allows you to preview, proof, and review your content before you publish and deploy it. The
comprehensive reports and on-demand reporting help you identify and correct any issues that may effect your
online content, such as invalid styles, missing links, and compliance with Web accessibility standards. In this way,
ePublisher ensures that the content you produce is of the highest quality and consistency.
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Reduce Support Costs and Increase Customer Satisfaction
When you consider the many steps content goes through to get from the content developer to its final destination,
publishing content can be a tedious, costly process. When an organization does not commit its attention and
resources to product information, the negative results impact many aspects of the business.

Customers want to find their solution by reading as little as possible. Consistent content helps customers skim
the content and find the information they need. The time content developers spend formatting content for various
output formats reduces the time they have to review and improve the content. Customers can become frustrated
when they spend time sorting through inconsistent and potentially inaccurate or incomplete information.

Frustrated customers quickly give up and contact customer support, often with a negative impression of the
company. Increased customer support calls, especially for basic concepts and product usage, can waste valuable
company resources.

ePublisher provides a workflow designed to make the publishing process as non-intrusive as possible. By
allowing you to choose your preferred authoring environment and having role-focused software components,
training time and production costs are reduced. The published content is consistent and delivers more value to
your customers.
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Quickly Update and Deliver Content More Often
If your style or online content requirements change in your organization, you need to make changes throughout
your content to implement these new requirements. Extended production times increase the difficulty and
complexity of these changes. ePublisher streamlines the production process to enable you to quickly implement
and deploy updated content. With these streamlined processes in place, you can deliver updated content more
often.

ePublisher allows you to define and deploy centralized Stationery that all projects use. When corporate standards
change, such as logos and branding, you can quickly update the Stationery to incorporate the new standards. Then,
content developers can import the updated Stationery into their projects and publish their updated deliverables
using the new standards without changing or redesigning their source documents.
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Reduce Content Management Life Cycle Costs
Due to the limitations of the traditional content model, many organizations want to move to a single-sourcing
environment. Single sourcing allows the same content to be used multiple times and delivered in different
formats. Organizations use single sourcing to eliminate duplicate content, reduce content translation and
maintenance costs, improve content consistency, and minimize errors. Single sourcing also allows organizations to
produce information in various formats using the same source.

Many single-sourcing solutions require all content authors to use the same authoring tool. ePublisher allows
you to develop the content using your preferred content authoring environments, such as Microsoft Word,
Adobe FrameMaker, or DITA. Each department can standardize on the authoring tool that is right for them, and
ePublisher ties all the input formats together with a single, unified, reliable publishing process. ePublisher allows
you to create integrated deliverables with source documents from multiple authoring tools.

With ePublisher, you can use your existing authoring tools and content management systems to meet organization-
wide publishing needs without incurring training or software deployment expenses. The open architecture, based
on industry-standard XSL, provides a flexible solution that you can customize to meet your needs without locking
you into a proprietary format that could result in expensive future migration costs.
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How Organizations Use ePublisher
Companies use ePublisher to meet many of their content development, delivery, and maintenance needs:

Update Web sites automatically with thousands of HTML pages every day

Merge content across functional boundaries and deliver consistent content on corporate intranets and
extranets

Deliver integrated, context-sensitive help systems with products

Single-source and deliver content in online and print formats

Deploy content for multiple platforms and devices

The following sections highlight several ways you can use ePublisher to deliver consistent, comprehensive
information.
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Automatically Update Content on Web Sites and Wikis
Corporate Web sites have evolved into far more than just flashy advertising with contact information for your
business. In addition to attention grabbing marketing about products and features, many company Web sites
feature tutorials, product demos, specific product requirements and details, and Web 2.0 resources such as Wikis
and community forums where customers can share information.

With ePublisher, you can consistently update the content on your Web site to maintain the latest information and
make sure it is available to your customers. You can schedule and automate content processing and deployment to
deliver up to date information each and every day.

ePublisher also allows you to easily maintain corporate intranets and publish source documents from multiple
organizations across your company. You can define a standard Stationery and templates for teams to use. You
can then define an ePublisher job and schedule it to search a drop-box folder on a regular basis and publish the
content from the source documents in that folder using your standard Stationery. This scenario ensures your
team members have the latest information they need and reduces the expenses associated with publishing and
maintaining this content on your intranet.
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Deliver Full-Featured, Context-Sensitive Help Systems
Products need to provide comprehensive help systems that meet the needs of many potential audiences. Content
design and delivery must ensure that users get the information they need when, where, and how they need it.
Some products need to deliver different content to different audiences. Other products are sold by multiple
companies and require distinct product branding.

ePublisher provides comprehensive support for many advanced features used in online content design and
delivery, including the following elements:

Customizable browse navigation and breadcrumbs

Customizable table of contents and mini-TOCs

Pop-ups and expandable/collapsible text sections

Related topics

Images, image maps, and multiple forms of multimedia

Context-sensitive help topics

Merged help systems (multi-volume help)

Variables and conditions

Accessibility features, such as alternate text and long descriptions

Field-level help
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Produce Single-Sourced Print and Online Optimized Content
Customers have different needs and expectations for product content. In many cases, producing information
in multiple formats for users involves extensive conversion and customization work to develop and deliver
the various formats. Content authors must shift their attention to manipulating and converting the content into
the many different user formats, often for both print and online, instead of focusing their time and efforts on
developing quality information for users.

With ePublisher, you can quickly and efficiently produce consistent, effective print and online content in multiple
formats. ePublisher provides XML/XSL processing and intelligent caching to process your source documents
faster than ever before.

ePublisher produces the formatting code for you, whether it is HTML, XML, RTF, Wiki Markup, or a completely
custom format. You do not need to know how to tag files for various output formats. With ePublisher, content
developers can produce a printable PDF manual and a comprehensive online help deliverable immediately after
finishing their content using the Stationery defined separately from their content.
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Features Available in Each Output Format
ePublisher supports many output formats and you can implement many powerful features in your online content.
Some features are available only in certain output formats. The following table summarizes which features are
available in each output format.
 

Feature Dynamic
HTML

XML
and
XSL

WebWorks
Help

WebWorks
Reverb

Microsoft
HTML
Help

Eclipse
Help

Sun
JavaHelp

Oracle
Help

PDF PDF
-
XSL-
FO

eBook
-
ePUB
2.0

Wiki
-
Atlassian
Confluence

Wiki
-
MediaWiki

Wiki
-
MoinMoin

Abbreviation alternate text +  + + +   +  +     

Acronym alternate text +  + + +   +  +     

Bidirectional language support + + + + + +    +     

Bullet customization +  + + +     +     

Categories            + + +

Citation alternate text +  + + +   +  +     

Context-sensitive help using topic
aliases (topic IDs)

  + + + + + +       

CSS customization +  + + + +  +    + +  

Expand/Collapse sections + + + + + +         

Favorites   +  + + + +       

File name definition and control + + + + + + + +  + + + + +

Help window customization    + +   +       

Image alternate text + + + + + + + +   + + + +

Image long description + + + + + + + +   + + + +

Image long description by reference +  + + + + + +   + + + +

Image map alternate text + + + + + + + +   +    

Image scaling by image
(GraphicScale)

+  + + + + + +  + +    

Image style by image (GraphicStyle) +  + + + + + +  + +    

Index + + + + + + + + + + + + + +

Inline comments            +  +

Meta tag keywords +  + +  + + +       

Mini (partial) table of contents +  + + + + + +  +  + + +

Multimedia links +  + + + +    +     
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Feature Dynamic
HTML

XML
and
XSL

WebWorks
Help

WebWorks
Reverb

Microsoft
HTML
Help

Eclipse
Help

Sun
JavaHelp

Oracle
Help

PDF PDF
-
XSL-
FO

eBook
-
ePUB
2.0

Wiki
-
Atlassian
Confluence

Wiki
-
MediaWiki

Wiki
-
MoinMoin

Page style customization + + + + + + + +  + + + + +

Popup windows   +  +  + +       

Related topics +  + + + + + +    + + +

Search   + + + + + +    + + +

See also links   +  +          

Splash page customization   + +           

Table alternate text (table summary) +  + + +   +       

Table of contents +  + + + + + + + +  + + +

Table of contents icon customization
per topic

  +  +  + +       

Toolbar customization   + + +          

What’s This help     +          
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Planning and Installing ePublisher

This section helps you plan your ePublisher installation and install ePublisher components. This section provides
information about ePublisher components and supported configurations and ePublisher requirements. This section
also explains how to download and install ePublisher components, use your contract identifier (Contract ID),
work with license keys, upgrade ePublisher, and troubleshoot installation and licensing issues.
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Licensing Considerations
Before you can generate output using ePublisher, you must have a valid Contract ID. ePublisher uses your
Contract ID to automatically handle the licensing of all ePublisher components and features. You Contract ID is
valid for your ePublisher use. Your contact ID may also be valid for other users, as long as the other users were
included in the contract associated with the contract ID at the time ePublisher was purchased or the other users
have been added to the same contract.

Currently ePublisher is licensed based on component and input format. ePublisher components include ePublisher
Express, ePublisher Designer, and ePublisher AutoMap. ePublisher input formats include Adobe FrameMaker,
Microsoft Word, and DITA-XML. Based on the input format of the files you use to author content, you may have
access to one or more input formats. For more information about each ePublisher component, see “WebWorks
ePublisher Platform Components”. For more information about Contract IDs, see “Working with Contract IDs”.
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Components and Supported Configurations
Stationery designers must install ePublisher Designer and ePublisher Express on their computers. Stationery
designers use ePublisher Designer to design Stationery and ePublisher Express to test Stationery.

Writers install ePublisher Express on their computers. Writers use ePublisher Express to generate output using
Stationery created by a Stationery designer.

If you want to use AutoMap to automate output generation and integrate your output generation with content
management or version control systems, install ePublisher AutoMap and ePublisher Express on the computer
where you want to use ePublisher AutoMap. ePublisher AutoMap requires ePublisher Express. You can install
ePublisher AutoMap on its own separate computer, or you can install ePublisher AutoMap on a Stationery
designer or writer computer where ePublisher Express is already installed.

The following figure shows a sample ePublisher configuration.
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Requirements
This section lists requirements for ePublisher components and input and output formats.
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ePublisher Express, ePublisher Designer, and ePublisher AutoMap
Requirements
The following table lists the minimum and recommended system requirements for ePublisher Express, ePublisher
Designer, and ePublisher AutoMap.

Note: Memory requirements can vary with the size of the job, including number of files to generate, size of each
file, number of images and tables, and more. Generally, performance increases with available memory. The
following values provide good performance for an average job.

 Minimum Recommended

Processor Intel i3 3.0 GHz Xeon Dual Core

Memory 1 GB RAM 2 GB RAM

Available Disk Space 1 GB available hard disk space 2 GB available hard disk space

Operating System Microsoft Windows 7 SP1 Microsoft Windows 10
ePublisher AutoMap is also supported
on Windows Server 2008, 2012
(including R2), 2016.

Additional Software Depending on input requirements
Microsoft .NET Framework 4.6.1
(included with the installer)
Microsoft Visual C++ 2005
Redistributable (included with the
installer)

Depending on input requirements
Microsoft .NET Framework 4.6.1
(included with the installer)
Microsoft Visual C++ 2005
Redistributable (included with the
installer)

Display 800 x 600 display screen resolution 1280 x 1024 display screen resolution (dual
monitors supported)
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Additional Input Format Requirements
The following table lists the minimum and recommended system requirements for Adobe FrameMaker, Microsoft
Word, DITA Open Toolkit and Github-flavored Markdown.

Input Format Minimum Recommended

Adobe FrameMaker FrameMaker 9 FrameMaker 2017

Microsoft Word Word 2010 Word 2016

DITA Open Toolkit Oracle JRE or JDK (Java), version 7 Oracle JRE or JDK (Java), version 8

WebWorks Markdown N/A N/A

For additional information, please refer to the following page for up-to-date input requirements: http://
wiki.webworks.com/Permalinks/InputRequirements

http://wiki.webworks.com/Permalinks/InputRequirements
http://wiki.webworks.com/Permalinks/InputRequirements
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Additional Output Format Requirements
You can use ePublisher to produce output in several different formats. This section provides output format
requirements for each output format ePublisher supports.
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Dynamic HTML
To view Dynamic HTML, users must have a browser that supports HTML 4.0 installed. HTML 4.0 was published
in late 1997, and the major browsers, such as Internet Explorer, Firefox, and Safari support HTML 4.0. For more
information about the HTML version a browser supports, see the documentation for the browser. If you choose to
implement online features that require JavaScript, such as popups, users may also need JavaScript enabled. Most
browsers have JavaScript enabled by default. For more information about enabling JavaScript in a browser, see
the documentation for the browser.
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eBook - ePUB 2.0
To generate output in this format, there are no external tools required. However, you will need a compatible
ePUB reader in order to view the generated output. For development purposes, it is common practice to use an
ePUB reader on your computer desktop, for example, you can use Adobe Digital Editions available at: http://
www.adobe.com/products/digitaleditions/Microsoft Windows.

http://www.adobe.com/products/digitaleditions/Microsoft Windows
http://www.adobe.com/products/digitaleditions/Microsoft Windows
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Eclipse Help
To generate Eclipse Help, you must have the Java2 Platform SDK version 1.2.2 or later installed. You can
download the Java2 Platform SDK for free from the Sun Microsystems Web site at http://java.sun.com/javase/
index.jsp.

If you are using ePublisher to generate Eclipse Help, ePublisher includes a viewer that you can use on the
computer where you installed ePublisher to view the Eclipse Help you generated using ePublisher.

To view Eclipse Help when you include Eclipse Help with an application, users must have the Eclipse integrated
development environment (IDE) installed. Typically, application developers configure their applications to
install the Eclipse IDE with the Eclipse Help content to ensure users can view the Eclipse Help while using the
application. To view Eclipse Help, users must also have Microsoft Internet Explorer 6.0 or later or a Mozilla-
based browser 1.7 or later installed.

http://java.sun.com/javase/index.jsp
http://java.sun.com/javase/index.jsp
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Microsoft HTML Help 1.x
To generate Microsoft HTML Help, you must have Microsoft HTML Help Workshop 1.x installed. If you do not
have Microsoft HTML Help Workshop installed, ePublisher will ask you if you want to install Microsoft HTML
Help Workshop during the ePublisher installation process. You can also download the Microsoft HTML Help
Workshop for free from the Microsoft Developer Network Web site at http://msdn.microsoft.com/en-us/library/
ms669985.aspx.

To view Microsoft HTML Help, users must have the Microsoft HTML Help viewer installed. The Microsoft
HTML Help viewer is installed with most Windows operating systems in use today. Users must also have Internet
Explorer 4.0 or later installed. Microsoft HTML Help does not require that users use Internet Explorer as their
default browser. Microsoft

Note: Due to the legacy nature of this help run time, if you are generating your help from a networked location,
you must map your help drive to a mapped letter such as z:\. UNC drives such as \\server.example.com
\directory will not work as output locations for this help format. For more information on this issue, please
refer to Microsoft’s Support website and search for your version of Windows.

http://msdn.microsoft.com/en-us/library/ms669985.aspx
http://msdn.microsoft.com/en-us/library/ms669985.aspx
http://support.microsoft.com/
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Oracle Help
To generate Oracle Help, you must have the Java2 Platform SDK version 1.2.2 or later installed on your
computer. You can download the Java2 Platform SDK for free from the Sun Microsystems Web site at http://
java.sun.com/javase/index.jsp. The Java 2 Platform is also known as the Java Platform, Standard Edition (Java
SE).

To view Oracle Help, users must have the Java Runtime Environment (JRE) installed on their computer. Typically
application developers configure their applications to install the JRE with the Oracle Help content to ensure users
can view the Oracle Help while using the application. Oracle Help components must be installed and viewed on
the local computer.

http://java.sun.com/javase/index.jsp
http://java.sun.com/javase/index.jsp
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PDF
Most modern browsers such as Chrome and Microsoft Edge have the ability to read PDF files by default, though
the user may also install Adobe Reader if a desktop application is needed. You can download Adobe Reader for
free from the Adobe Web Site at http://www.adobe.com/products/acrobat/readstep2_allversions.html.

Customers may encounter issues with font embedding and Windows 7. Please refer to the following resources to
address this issue:

http://wiki.webworks.com/Permalinks/Solutions/Output/PDF/ProblemsInWindows7
http://wiki.webworks.com/Permalinks/Solutions/Output/PDF/IssuesWithTrueTypeFonts

http://www.adobe.com/products/acrobat/readstep2_allversions.html
http://wiki.webworks.com/Permalinks/Solutions/Output/PDF/ProblemsInWindows7
http://wiki.webworks.com/Permalinks/Solutions/Output/PDF/IssuesWithTrueTypeFonts
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PDF -XSL-FO
To generate PDF - XSL-FO files, you must have the Java2 Platform SDK version 1.2.2 or later installed. You can
download the Java2 Platform SDK for free from the Sun Microsystems Web site at http://java.sun.com/javase/
index.jsp.

http://java.sun.com/javase/index.jsp
http://java.sun.com/javase/index.jsp
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Sun JavaHelp 2.0
To generate Sun JavaHelp 2.0, you must have the Java2 Platform SDK version 1.2.2 or later installed on your
computer. You can download the Java2 Platform SDK for free from the Sun Microsystems Web site at http://
java.sun.com/javase/index.jsp. The Java 2 Platform is also known as the Java Platform, Standard Edition (Java
SE).

To view Sun JavaHelp, users must have the Java Runtime Environment (JRE) installed on their computer.
Typically, application developers configure their applications to install the JRE with the Sun JavaHelp content to
ensure users can view the Sun JavaHelp while using the application. Sun JavaHelp components must be installed
and viewed on the local computer.

http://java.sun.com/javase/index.jsp
http://java.sun.com/javase/index.jsp
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WebWorks Help 5.0
To view WebWorks Help, users must have JavaScript enabled in the browser. If JavaScript is not enabled, then the
help system does not display in its entirety. For more information about determining whether JavaScript is enabled
in your browser, see your browser options. For more information about enabling JavaScript in Internet Explorer,
refer to “Enabling JavaScript”.

WebWorks Help has been tested on the following platforms:

Internet Explorer

Microsoft Edge

Mozilla Firefox

Netscape

Safari

Google Chrome

Opera

Please refer to the WebWorks wiki for an up-to-date list of supported browsers: http://wiki.webworks.com/
Permalinks/BrowserSupport

http://wiki.webworks.com/Permalinks/BrowserSupport
http://wiki.webworks.com/Permalinks/BrowserSupport
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WebWorks Reverb
WebWorks Reverb can now be viewed directly from your computer’s file system or from a running web server.
This means that you can use this format to deliver online help as part of a non-networked help system. However,
in order to provide Reverb’s social-media capabilities (i.e. commenting, likes) to your end-users you must deploy
the output to a system that is running a web server. Then your end-users must access the content via an http or
https url. If you do not have a web server, you can configure IIS on Windows or any other available web server
software. For more information on IIS, consult the following resource.

When you are using ePublisher to generate WebWorks Reverb, ePublisher includes a viewer that you can use
on the computer where you installed ePublisher to view the WebWorks Reverb output you generated using
ePublisher.

http://wiki.webworks.com/Permalinks/Solutions/Output/WebWorksReverb/ConfiguringIIS
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Configuring web server for Reverb

If deploying Reverb output to a public web server that has X-FRAME-OPTIONS configured, make sure that for
HTML pages this header is not configured as follows:

X-Frame-Options: DENY

Instead it should be configured as:

X-Frame-Options: SAMEORIGIN



42 | Reverb browser requirements

Reverb browser requirements

Reverb requires the following browser WebWorks Reverb has been tested on the following platforms:

Internet Explorer

Note: Reverb 2.0 requires version 11.

Microsoft Edge

Mozilla Firefox

Safari

Google Chrome

Please refer to the WebWorks wiki for an up-to-date list of supported browsers: http://wiki.webworks.com/
Permalinks/BrowserSupport

http://wiki.webworks.com/Permalinks/BrowserSupport
http://wiki.webworks.com/Permalinks/BrowserSupport
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Wiki - Confluence
To view Confluence Wiki output, you must deploy the output to a server computer where Confluence 2.10.2or
later is installed. You may find it helpful to set up a staging Confluence server computer if you generate
Confluence output. A staging Confluence computer allows you to view your generated Wiki output before
deploying your generated Wiki output to a production Confluence computer.

Before you deploy Confluence output, ensure the following APIs and plug-ins are installed on the Confluence
Wiki:

Confluence Remote API

This API is enabled by default when Confluence is installed. The Confluence Remote API works in
conjunction with the Confluence XML RPC API.

Confluence XML RPC API

This API should be enabled, and this API works in conjunction with the Confluence Remote API.

Adaptivist Content Formatting Macros plug-in

The Adaptivist Content Formatting Macros plug-in is available at http://confluence.atlassian.com/display/
CONFEXT/Content+Formatting+Macros. ePublisher uses this plug-in to control indents and any kind
of complex table formatting such as row and column spans. This plug-in also provides support for .css
classes.

Ensure that the Confluence Compatibility Macros are disabled. The Confluence Compatibility Macros
define tables. If the Confluence Compatibility Macros and the Adaptivist Content Formatting Macros are
enabled at the same time, table macro definition conflicts may result.

The Confluence WYSIWYG editor does not preserve escaped characters if those character escapes are
specified as HTML entities, such as &#46;.

Note: Escape characters indicate that a character sequence is not formatting instructions for the Wiki. For
example, on some Wikis, and asterisk (*) character followed by a space at the beginning of a line
indicates a bullet. When the Wiki reads this markup, it converts the asterisk character and the space
into a bullet. However, if you need to have an asterisk character followed by a space at the beginning
of a line on your Wiki page, and not a bullet, you can use an escape character, such as '\'to display
the content correctly.

When ePublisher generates output for Wikis, it automatically and appropriately escapes characters in
your source documents so your content displays correctly in the generated output. However, if you deploy
content with escape characters to a Confluence Wiki server and users then edit the content using the
Confluence WYSIWYG editor, the WYSIWYG editor removes any escape characters used on the page to
display content. To avoid this issue, disable the Confluence WYSIWYG editor on the Wiki server where
you deploy your Confluence Wiki output.

When you deploy content to a Confluence Wiki, pages are deployed based on the table of contents
hierarchy. You can see this hierarchy in the Confluence Browse view.

For more information about Confluence, including installing and configuring Confluence, see the Confluence web
site at www.atlassian.com/software/confluence. For more information about deploying Confluence Wiki output
using ePublisher, see “Deploying Output”.

http://confluence.atlassian.com/display/CONFEXT/Content+Formatting+Macros
http://confluence.atlassian.com/display/CONFEXT/Content+Formatting+Macros
http://http://www.atlassian.com/software/confluence/
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Wiki - MediaWiki
To view MediaWiki output, you must deploy the output to a computer where MediaWiki 1.11 or later is installed.
You may find it helpful to set up a staging MediaWiki server computer if you generate MediaWiki output. A
staging MediaWiki computer allows you to view your generated Wiki output before deploying your generated
Wiki output to a production MediaWiki computer.

Before you deploy MediaWiki output, review the following settings on the MediaWiki:

The user account you specify for ePublisher to use when deploying output to a MediaWiki requires Write
access to the Wiki and the ability to remotely push content to the Wiki.

ePublisher uses the MediaWiki Write API when deploying output to MediaWiki. Using the MediaWiki
Write API ensures that any surge protection limits configured on the Wiki do not block ePublisher from
deploying output to the Wiki. Ensure that the MediaWiki Write API is enabled before deploying output to
MediaWiki. The Write API is disabled by default on MediaWiki.

If you try to use ePublisher to deploy large page files, such as 2 MB or 3 MB page files, to your MediaWiki
server, MediaWiki will display the following error if you do not have enough PHP memory allocated in
MediaWiki:

Fatal error: Allowed memory size of nnnnnnn bytes exhausted (tried to allocate nnnnnnnn
bytes)

Ensure you have enough PHP memory allocated in MediaWiki if you plan to use ePublisher to
deploy large page files to your MediaWiki server. You can raise the PHP memory limit in the
php.ini and LocalSettings.php files. For more information, see http://www.mediawiki.org/wiki/
Manual:Errors_and_Symptoms.

For more information about MediaWiki, including installing and configuring MediaWiki, see the MediaWiki
Web site at www.mediawiki.org. For more information about deploying MediaWiki output using ePublisher, see
“Deploying Output”.

http://www.mediawiki.org/wiki/Manual:Errors_and_Symptoms
http://www.mediawiki.org/wiki/Manual:Errors_and_Symptoms
http://www.mediawiki.org
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Wiki - MoinMoin
To view MoinMoin Wiki output, you must deploy the output to a computer where MoinMoin 1.6.4 or later is
installed. You may find it helpful to set up a staging MoinMoin server computer if you generate MoinMoin
output. A staging MoinMoin computer allows you to view your generated Wiki output before deploying your
generated Wiki output to a production MoinMoin computer.

Before you deploy MoinMoin Wiki output, review the following settings on the MoinMoin Wiki:

The user account you specify for ePublisher to use when deploying output to a MoinMoin Wiki requires
Write access to the Wiki and the ability to remotely push content to the Wiki. Ensure the user account
ePublisher uses when deploying content to the Wiki has the appropriate Write permissions on the Wiki.

Ensure xmlrpc actions are enabled on the MoinMoin Wiki.

Note: MoinMoin does not support the XML-RPC protocol when run as a CGI application.

Based on the MIME type assigned to the files you include in your generated output, you may need to add
content types to the mimetypes_embed setting in the wikiconfig file on the MoinMoin Wiki. For example,
if you use Scalable Vector Graphics (.svg) files when generating MoinMoin Wiki output, ensure that you
add image/svg+xml to the mimetypes_embed setting.

You can configure surge protection limits for requests on a MoinMoin Wiki, including the type of Write
requests ePublisher can make when deploying output to the Wiki. Ensure you understand how surge
protection is configured on the MoinMoin Wiki before you use ePublisher to deploy content to a MoinMoin
Wiki.

Surge protection limits are typically configured to help protect the performance of the Wiki and to ensure
the Wiki is available and has appropriate content for its intended users. Surge protection settings protect the
Wiki from malicious users, including spammers, who may want to try and push spam or other unwanted
content onto Wikis. In MoinMoin, you configure surge protection limits in the wikiconfig file. Verify that
ePublisher can deploy content to a MoinMoin Wiki using the surge protection limits configured for the
MoinMoin Wiki.

For more information about MoinMoin, including installing and configuring MoinMoin, see the MoinMoin Web
site at http://moinmo.in/. For more information about deploying MoinMoin Wiki output using ePublisher, see
“Deploying Output”.

http://moinmo.in/


46 | Downloading ePublisher Installers

Downloading ePublisher Installers
ePublisher installers are available for download as .exe files on a secure area on the WebWorks Web site. You can
obtain ePublisher installers through one of the following methods:

If you are evaluating ePublisher, the WebWorks customer service team will send you an email that
contains a link to the location where you can download the ePublisher installer.

If you are a new ePublisher customer, the WebWorks customer service team will send you an email
that contains a link to the location where you can download the ePublisher installer when you purchase
ePublisher.

If you are an existing ePublisher customer with an active maintenance agreement, the WebWorks
customer service team will automatically send you an email that contains a link to the location where you
can download the ePublisher installer each time a new version of ePublisher releases. If you have a My
Cases login for the WebWorks technical support Web site, you can also obtain the ePublisher installer in the
My Cases area when you log in to the WebWorks technical support site.

If you are an existing ePublisher customer without an active maintenance agreement, contact the
WebWorks account management team for more information.

The link you receive to the download location for the ePublisher installer is typically active for only one to two
weeks. ePublisher installer download locations are changed often for security reasons. If you need the latest link
to an ePublisher download kit, you can request a link by submitting a support request on the WebWorks Web site
at http://www.webworks.com/Support/. WebWorks technical support will verify that you purchased an ePublisher
license for the requested component and then provide a link where you can download the requested installer.

To download an ePublisher installer

1. Click the download link in the email from WebWorks.

2. On the WebWorks download page, click the link for the ePublisher component you want to install.

3. Click Save.

4. Browse to a location on your local computer where you want to save the installer, and then click Save.

5. Click Close when the download completes.

6. Browse to the location on your local computer where you saved the .exe file for the ePublisher component.

7. Run the .exe file.

http://www.webworks.com/Support/
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Microsoft Windows Requirements
ePublisher components require the Microsoft Visual C++ 2005 SP1 MFC Security Update Redistributable
Package (x86), which is installed by default as of Windows 10.

Note: The ePublisher Express installer will handle the download and installation of this component if it is
not present on the user’s machine. If the user cannot connect to the internet while installing, then this
component will need to be downloaded and installed manually before proceeding with the ePublisher
Express installation. This component can be found for free at: https://download.microsoft.com/download/8/
B/4/8B42259F-5D70-43F4-AC2E-4B208FD8D66A/vcredist_x86.EXE.

To see if the Microsoft Visual C++ 2005 SP1 MFC Security Update Redistributable Package (x86) is already
installed on your computer: Open the Control Panel, and select Add or Remove Programs and check if the
Microsoft Visual C++ 2005 Redistributable is listed.

https://download.microsoft.com/download/8/B/4/8B42259F-5D70-43F4-AC2E-4B208FD8D66A/vcredist_x86.EXE
https://download.microsoft.com/download/8/B/4/8B42259F-5D70-43F4-AC2E-4B208FD8D66A/vcredist_x86.EXE
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Downloading and Installing the Microsoft .NET 4.6.1
Framework
ePublisher components require the Microsoft .NET 4.6.1 Framework.

Note: The ePublisher Express installer will handle the download and installation of this component if it is
not present on the user’s machine. If the user cannot connect to the internet while installing, then this
component will need to be downloaded and installed manually before proceeding with the ePublisher
Express installation. This component can be found for free at: http://go.microsoft.com/fwlink/?
LinkId=671743. In any case, after the installation of the Microsoft .NET 4.6.1, the user needs to restart the
computer before installing ePublisher Express.

To see if the Microsoft .NET 4.6.1 Framework is already installed on your computer: Open the Control Panel,
and select Add or Remove Programs and check if the Microsoft .NET Framework 4.6.1 is listed.

http://go.microsoft.com/fwlink/?LinkId=671743
http://go.microsoft.com/fwlink/?LinkId=671743
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Enabling JavaScript
To use ePublisher, you must enable JavaScript in Microsoft Internet Explorer.

To enable JavaScript in Internet Explorer

1. Open Microsoft Internet Explorer.

2. On the Tools menu, click Internet Options.

3. On the Security tab, click Custom Level.

4. Under Active Scripting, click Enable.
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Installing ePublisher
This section explains how to install ePublisher components. Read this section before you install ePublisher
components.
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Installation Order for ePublisher Components
Ensure you install ePublisher components in the correct order. Review the following installation options before
you install ePublisher components:

If you want to generate output using Stationery created by a Stationery designer, install only ePublisher
Express on the computer.

If you want to design Stationery and generate output, install ePublisher Express and ePublisher Designer
on the computer.

Note: ePublisher Designer requires ePublisher Express. Ensure you install ePublisher Express on the
computer before you install ePublisher Designer.

If you want to schedule and automate output generation, install ePublisher Express and ePublisher
AutoMap on the computer where you want to use ePublisher AutoMap.

ePublisher AutoMap requires ePublisher Express. Ensure you install ePublisher Express on the computer
before you install ePublisher AutoMap. You can install ePublisher AutoMap using one of the following
configurations:

On its own separate computer where ePublisher Express is already installed

On a Stationery design computer where ePublisher Express and ePublisher Designer are already
installed

On a writer computer where ePublisher Express is already installed
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Installing ePublisher Components
This section provides instructions for installing ePublisher components, including ePublisher Express, ePublisher
Designer, and ePublisher AutoMap.

Note: You must install ePublisher Express first. Then, you can install ePublisher Designer and ePublisher
AutoMap. Both ePublisher Designer and ePublisher AutoMap require ePublisher Express.

If you are upgrading from a previous version of ePublisher, review the upgrade instructions. For more
information, see “Upgrading from Previous Versions”.

To install ePublisher components

1. Log on as a user using an account that is a member of the Administrators group on the local computer.

2. Close all instances of Microsoft Office applications running on the local computer, including instances
of Microsoft Word and Microsoft Outlook. Close all instances of Adobe FrameMaker running on the
computer.

3. Run the WebWorks ePublisher <Product><Build_Number>.exe file for the ePublisher component you
want to install.

4. Review the welcome message, and then click Next.

5. Review the license agreement. If you agree to the terms of the agreement, click I Agree.

6. Select the application shortcuts you want to create, and then click Next.

7. Specify the location of the installation directory, and then click Next. The default installation directory is C:
\Program Files (x86)\WebWorks.

8. Click Next to confirm your selections and to begin installing the ePublisher component.

9. In the WebWorks Licensing Info window, complete the following steps:

a. Enter your Contract ID. If you previously installed ePublisher on the computer using a valid Contract
ID, ePublisher will automatically detect the Contract ID and display your Contract ID information.
For more information about contract IDs and obtaining a Contract ID, see “Working with Contract
IDs” “Obtaining Contract IDs”.

b. Enter your email address. If you have an email address that you use as your WebWorks support
login, enter that email address.

c. Enter the name of your computer.

d. Click Confirm.

10. If the installer displays the HTML Help Workshop 1.3 Setup window, you can install Microsoft HTML
Help Workshop 1.3 as part of your ePublisher installation. Install Microsoft HTML Help Workshop if you
plan to generate Microsoft HTML Help output.

If you want to install Microsoft HTML Help Workshop 1.3, click Yes, and then follow the
instructions to install Microsoft HTML Help Workshop.

If you do not want to install Microsoft HTML Help Workshop 1.3, click No.

11. Click Close when the installation completes. ePublisher also opens a new browser window and displays a
page on the www.webworks.com web site when the installation completes.
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12. Restart your computer to update and register all configuration files.
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Configuring AutoMap for Microsoft Word Inputs
When installing ePublisher AutoMap and if publishing Microsoft Word documents, it may be necessary to
configure the DCOM Login Identify for the Microsoft Word 97 - 2003 Document configuration. Depending on
how you or your team will be running ePublisher AutoMap the user account that Microsoft Word will be launched
as should be set accordingly.

To configure the DCOM account Identify of Microsoft Word

1. If working with a 32-bit version of Microsoft Word, from the Start menu, type: mmc comexp.msc /32

2. If working with a 64-bit version of Microsoft Word, from the Start menu, type: mmc comexp.msc

3. In the Component Services dialog, select Component Services > Computers > My Computer > DCOM
Config.

4. Underneath DCOM Config, right-click Microsoft Word 97 - 2003 Document and select Properties.
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5. In the Microsoft Word 97 - 2003 Document Properties dialog, select the Identity tab, then specify the
user account to use to run Microsoft Word, which may or may not be a specific user depending on how you
are planning to use ePublisher AutoMap.
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Understanding Installed Sample Projects and Stationery
ePublisher Express and ePublisher Designer install sample projects and Stationery. You can use these sample
projects and Stationery to see some examples of how you can use ePublisher to generate output. For more
information about using these sample projects and Stationery to generate output, see “Customizing Your
ePublisher Workspace”.
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Working with Contract IDs
ePublisher no longer requires you to manually enter license keys. ePublisher now uses Contract IDs to enable
product functionality, which simplifies the ePublisher licensing process.

A Contract ID is a unique identifier that identifies the number of users and type of functionality enabled for your
ePublisher installation. WebWorks generates an appropriate Contract ID for your ePublisher installation when you
purchase ePublisher or request an evaluation copy of ePublisher. A Contract ID enables functionality based on the
items and time frame specified in the purchase contract between your company and WebWorks.

If you have a valid contract ID for one version of the ePublisher product, when a new version of ePublisher
releases, you can continue to use your same Contract ID when you upgrade to the new version of the product. You
can also continue to use your same Contract ID if you have to uninstall and then re-install a version of ePublisher.

ePublisher licensing is flexible, and the WebWorks team can work with you ensure that you have the licensing
that is right for you. Contact WebWorks Sales at sales@webworks.com or WebWorks Customer Service at
customerservice@webworks.com to discuss any special licensing needs you may have.

mailto:sales@webworks.com
mailto:customerservice@webworks.com
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Viewing Licensing and Contract ID Information
You can view licensing information in the License Information window in ePublisher. ePublisher uses adapter
license keys, or activation codes, to enable ePublisher functionality. Adapter licensing information is specified
in your Contract ID. ePublisher uses an Internet connection to connect to the ePublisher licensing server and
periodically retrieve and update adapter activation codes as needed based on your Contract ID.

Note: If you need to install ePublisher in an environment without Internet connectivity, WebWorks can
provide Contract IDs that support this environment. For more information, see “Managing Licensing in
Environments without Internet Connectivity”.

ePublisher licenses, or activation codes, do not display in the ePublisher user interface, but you can view the
adapters for which you are licensed and your Contract ID number in the ePublisher user interface.

To view ePublisher licensing and Contract ID information

1. On the Help menu, click License Keys. ePublisher displays the input formats for which the component is
licensed in the License Information window.

2. If you want to view your Contract ID number, click Register.
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Obtaining Contract IDs
ePublisher now uses Contract IDs instead of license keys to enable ePublisher functionality.

If you are evaluating ePublisher, the WebWorks customer service team will send you an email that
contains a Contract ID you can use when you install an evaluation copy of ePublisher. If you have not
received an evaluation Contract ID or are having problems with your evaluation license, send an email to
customerservice@webworks.com.

If you are a new ePublisher customer, the WebWorks customer service team will send you an email that contains
your Contract ID when you purchase ePublisher. If you have not received a Contract ID or are having problems
with your licensing, send an email to customerservice@webworks.com.

If you are an existing ePublisher customer with an active maintenance agreement, the WebWorks customer
service team will automatically send you an email that contains a link to the location where you can download
the ePublisher installer. ePublisher will automatically detect and use your existing Contract ID each time you
install a new version of the ePublisher product. If you have not received a Contract ID or are having problems
with licensing, send an email to customerservice@webworks.com or submit a support request.

If you are an existing ePublisher customer without an active maintenance agreement, contact the WebWorks
account management team for more information about obtaining your Contract ID by sending an email to
sales@webworks.com.

For more information about Contract IDs, see “Working with Contract IDs” and “Entering Contract IDs”.

mailto:customerservice@webworks.com
mailto:customerservice@webworks.com
mailto:customerservice@webworks.com
mailto:sales@webworks.com
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Entering Contract IDs
ePublisher now uses Contract IDs instead of license keys to enable ePublisher functionality. You must enter your
Contract ID, email address, and computer name before you can use ePublisher components. The Contract ID
enables the ePublisher product components and ePublisher input formats for which you are licensed. For more
information about Contract IDs, see “Working with Contract IDs”.

To enter a Contract ID

1. On the Help menu, click License Keys. ePublisher displays the input formats for which the component is
licensed in the License Information window.

2. Click Register.

3. In the Contract field, enter your Contract ID.

4. In the Email field, enter your email address. If you have an email address that you use as your WebWorks
support login, enter that email address.

5. In the Computer field, enter the name of the computer where you are installing ePublisher.

6. Click Confirm.
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Managing Licensing in Environments without Internet Connectivity
ePublisher uses an Internet connection to connect to the ePublisher licensing server and retrieve or update adapter
activation codes as needed based on your Contract ID. If you need to install ePublisher in a restricted environment
where ePublisher computers do not have Internet access, contact WebWorks Sales at sales@webworks.com or
WebWorks Customer Service at customerservice@webworks.com to request a non-network Contract ID. The
ePublisher licensing model is flexible, and WebWorks can work with you to provide non-network Contract IDs or
other licensing solutions appropriate for your environment.

mailto:sales@webworks.com
mailto:customerservice@webworks.com
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Updating Licensing
ePublisher automatically contacts the ePublisher licensing server as needed to obtain updated activation codes.
ePublisher communicates with the ePublisher licensing server using an Internet connection. ePublisher obtains
updated activation codes as appropriate based on the licensing specified in your Contract ID.

Note: If your ePublisher is installed in an environment without Internet connectivity, WebWorks can provide
Contract IDs that support this environment. For more information, see “Managing Licensing in
Environments without Internet Connectivity”

Typically, you will not need to request updated activation codes, as ePublisher obtains updated codes for your
automatically. However, you can manually request updated activations codes in the ePublisher interface. For
example, you may want to manually request updated activation codes if you know that the computer where you
installed ePublisher will not have Internet access for a long period of time. When you request updated activations
codes in the ePublisher interface, ePublisher immediately establishes an Internet connection to the ePublisher
licensing server and automatically obtains updated activation codes for the ePublisher adapters for which you are
licensed.

To update ePublisher licensing

1. On the Help menu, click License Keys. ePublisher displays the input formats for which the component is
licensed in the License Information window.

2. Click Refresh keys. ePublisher retrieves updated activation codes from the ePublisher licensing server.
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Deactivating Licensing
You can deactivate ePublisher licensing in the ePublisher user interface. Deactivating licensing for the current
ePublisher installation allows you to install ePublisher on a different computer without affecting the number of
available seats allowed by your contract.

Note: The terms of the ePublisher end-user license agreement (EULA) allow you to install ePublisher Express
or ePublisher Designer on one office computer and on one home or travelling computer for each assigned
ePublisher user seat. ePublisher AutoMap licensing terms can vary based on whether ePublisher AutoMap
was purchased on a per writer or per server basis, or in conjunction with a Content Management System
(CMS).

To deactivate ePublisher licensing:

1. On the Help menu, click License Keys.

2. Click Unregister.
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Upgrading from Previous Versions
In most cases, upgrading from a previous version to a new version of ePublisher can be accomplished in just a few
steps. This section explains how to prepare for an upgrade, how to upgrade a typical ePublisher installation, and
how to upgrade an ePublisher implementation with advanced customizations.



Updang ePublisher installaon | 65

Updating ePublisher installation
If you are installing an ePublisher component that is of version 2018.1 or higher and your currently installed
component is version 2017.1 or higher, then your component will automatically be uninstalled for you when you
choose the option to update. Otherwise, before installing a new version of an ePublisher component, you must
uninstall any previous versions of the component. Uninstalling an ePublisher component removes the installation
folder and registry entries for the component from the computer.

To update/repair an ePublisher component with an ePublisher executable installer

1. Close all ePublisher user interfaces.

2. Close all instances of Microsoft Office applications running on the local computer, including instances
of Microsoft Word and Microsoft Outlook. Close all instances of Adobe FrameMaker running on the
computer.

3. Double click the executable installer.

4. Select whether you want to Update/Repair, and then click Next.

5. Follow the instructions in the consecutive pages.
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Preparing existing projects for ePublisher Upgrade
To ensure smooth migration of existing projects and stationeries perform the following steps:

Save your Stationery, Stationery design projects, and any projects you currently use to generate output
to a secure location. Stationery defines the appearance and functionality of all the output formats you
need. Stationery design projects are the ePublisher Designer projects used to create Stationery. For more
information about Stationery and Stationery design projects, see the ePublisher Design Guide.

If you implemented overrides when designing Stationery, ensure you save the files in the Formats folder,
any override files currently in use, and a copy of the original files from which the overrides were created to
the secure location. Examples of overrides include the following items:

Modifications to the Page.asp file

Custom .css files

Modifications to image files

Any advanced overrides such as modifications to .xsl or .fti files or files in the Formats folder.

When the Stationery designer creates and saves Stationery, ePublisher creates the following folders:

StationeryName\Formats\OutputFormat

StationeryName\Formats\OutputFormat.base

where StationeryName is the name the Stationery designer specified for the Stationery, and OutputFormat is the
type of output format the Stationery Designer specified for a target in the Stationery.

The StationeryName\Formats\OutputFormat folder contains any customizations or overrides the Stationery
designer specified when designing the Stationery. ePublisher Express synchronizes with the files in the
OutputFormat folder and uses the information about customizations and overrides contained in files in the
OutputFormat folder to generate output.

Note: The Stationery may have one or more OutputFormat folders, based on the settings the Stationery designer
specified.

The StationeryName\Formats\OutputFormat.base folder contains copies of all the files located in the
\Program Files\WebWorks\ePublisher\release_number\Formats\OutputFormat folder. These files define
the default output format and transforms and are installed by default when you install ePublisher.

Stationery designers can do a compare, or diff, between the files located in these folders to quickly see any
customizations or overrides specified for the Stationery. Stationery designers can use this information to help
them reapply customizations and overrides as needed when designing a newer version of the Stationery in
ePublisher Designer.
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Upgrading Typical ePublisher Implementations
After you save your existing Stationery design projects, Stationery, any projects you currently use to generate
output, and any copies of override files to a secure location, perform the following steps:

On the Stationery designer computer, uninstall all existing versions of ePublisher components, such as
ePublisher Express, ePublisher Designer, and ePublisher AutoMap. The Stationery design computer is the
computer the Stationery designer uses to create and update Stationery. ePublisher Express and ePublisher
Designer are installed on the Stationery design computer. Based on your configuration, ePublisher
AutoMap may also be installed on the Stationery design computer.

Install the new version of ePublisher Express and ePublisher Designer on the Stationery designer computer.
Also install the new version of ePublisher AutoMap if you run ePublisher AutoMap on the Stationery
designer computer.

Open your existing Stationery design projects using the new version of ePublisher Designer.

Generate output and verify that your output generates as expected. Make any adjustments as needed.

If you have implemented typical overrides in a Stationery design project, such as overrides to
Page.asp files, custom .css files, or image files, you can continue to use your overrides to these
files, and the new version of ePublisher will recognize and use these existing modifications when
generating output.

If you have implemented advanced overrides, such as overrides to .xsl or .fti files, or overrides
to files in the Formats folder, update these files in your new ePublisher installation to include
your advanced overrides. For more information, see “Upgrading Implementations with Advanced
Customizations”.

Note: When ePublisher Designer detects overrides, by default it will not update to the latest version
of the format. This means that no modifications will be necessary in order to continue
using your Stationery. However, in this default mode, you will not get any of the format
improvements built into the latest release. If you want these improvements, then you will have
to configure the Project Settings to use the latest version of ePublisher’s formats.

Create new Stationery for each Stationery design project.

Deploy the updated Stationery to an appropriate location.

On each writer computer, update ePublisher Express installation.

The next time writers generate output, they open their existing projects using the new version of ePublisher
Express. Writers can choose to synchronize their projects immediately to obtain the latest Stationery and
then generate output, or writers can continue using their existing Stationery until they are ready to move to
the latest version of the Stationery.
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Upgrading Implementations with Advanced Customizations
If you have implemented advanced overrides in the Stationery design, such as overrides to .xsl or.fti files, or
overrides to files in the Formats folder, ensure you save a copy of the following items to a secure location before
uninstalling a previous version of ePublisher and installing a new version:

Overrides currently used in the Stationery design project

A copy of the original files from which the overrides were created

If you want to continue to use your advanced customizations with the new version of ePublisher, first uninstall
your previous ePublisher version and then install a new ePublisher version. Then identify and include your
overrides in the new versions of the ePublisher files as appropriate by performing a three-way merge of the
following items:

A copy of the existing override file used in the Stationery design project, located in the
StationeryName\Formats\OutputFormat folder, where StationeryName is the name the Stationery
designer specified for the Stationery, and OutputFormat is the type of output format the Stationery
Designer specified for a target in the Stationery.

A copy of the original file from which the override was created, available in the StationeryName\Formats
\OutputFormat.base folder, where StationeryName is the name the Stationery designer specified for the
Stationery, and OutputFormat is the type of output format the Stationery Designer specified for a target in
the Stationery.

A copy of the new file from the new version of ePublisher

Performing a three-way merge allows you to identify the code you changed when you created the override,
and also allows you to quickly and easily create the override again in the new ePublisher files. You may find
tools such as Araxis Merge Pro, available at http://www.araxix.com/merge, or KDiff3, available at http://
kdiff3.sourceforge.net, helpful as you compare and merge override files.

After you perform your three-way merge and update the files you want to override in the new version of
ePublisher with the overrides you specified in the previous version, test your overrides by generating output
using the new version of ePublisher Designer and the Stationery design project to confirm your output generates
appropriately. After you verify the output generated correctly using your advanced customizations, you can create
new Stationery using the Stationery design project and then deploy the updated Stationery that includes your
advanced customizations to writers to use to generate output.

http://www.araxix.com/merge
http://kdiff3.sourceforge.net
http://kdiff3.sourceforge.net
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Upgrading Advanced Customizations of WebWorks Reverb Skin
The WebWorks Reverb output format is highly customizable and chances are you may have made advanced
customizations to this format. If you are upgrading from a prior release, then you will want to understand what
files are most likely to be customized and how this is affected when you change the Skin Target Setting.

If you have or plan to customize any of the WebWorks Reverb skins, then most likely you will have to modify one
or more of the following files.
 

Table 5: Commonly Customized Reverb Files

Filename The display area or items affected by this file

webworks.css Content panel styling only. Includes the styling of the MiniTOC, RelatedTopics, Social
Buttons.

skin.css Styling of TOC, Index, Toolbar, and Breadcrumbs. All icons used in the skin.png sprite
file are managed here. Styling of content that appears above the Toolbar, such as the
company information.

search.css Styling of the search results page.

skin.png (derived from
skin.Fireworks.png)

PNG file with alpha channel that stores all of the Reverb icons.

connect.asp Used to manage the button placement in the toolbar. Also manages the TOC/Index/
Search panel title for the Corporate skin.

connect.css Manages basic structure of the entry-point file generated from the connect.asp
template file.

When working with alternate skins, you need to be aware of which files are most likely affected as a result of
changing the skin type. If you have Advanced Customizations in any of these files, then you need to re-examine
the diffs of these files after you switch the skin type. Most likely you will see significant changes. Here are some
basic steps you can follow to make sure you translate those changes to the new skin properly.

Basic steps for setting an alternate skin type when Advanced customizations are present

1. Check your Advanced Customizations for files listed in “Commonly Customized Reverb Files”.

2. Make sure any of these commonly customized files are implemented as Target Overrides as opposed
to Format Overrides. Setting an alternate skin type will create an implicit target override that will have
priority over any format overrides of the same name.

3. Before changing the skin type you will need to record any existing file differences. On the Advanced menu
click Manage Target Customizations. Now use the procedure discussed in “Managing Format/Target
Overrides” to record these file differences. These file differences will be used later after the skin type has
been changed.

4. On the Target menu, click Target Settings.

5. In the WebWorks Reverb category, select the right column of the Skin entry to display the file picker
button.

6. Click the file picker button to bring up an Open file dialog which will display a list of skin plugin files.
Each skin plugin file is identifiable by a .weplugin extension.
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7. Browse to the plugin file that you wish to use and double-click it to set the skin to that value.

8. At this point, you need to consider either removing your existing customizations and then re-implementing
them using the information from your previously recorded file differences. Or managing the differences
directly by comparing the differences using the procedure discussed in “Managing Format/Target
Overrides”. Either method will work.
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Uninstalling ePublisher
Uninstalling an ePublisher component removes the installation folder and registry entries for the component from
the computer.

If ePublisher installed the WebWorks Transit menu for Microsoft Word on the computer, ePublisher removes
the WebWorks Transit menu and WebWorks Transit registry entries when you uninstall the last ePublisher
component on the computer.

To uninstall an ePublisher component with an ePublisher executable installer

1. Close all ePublisher user interfaces.

2. Close all instances of Microsoft Office applications running on the local computer, including instances
of Microsoft Word and Microsoft Outlook. Close all instances of Adobe FrameMaker running on the
computer.

3. Double click the executable installer.

4. Select the Uninstall option, and then click Next.

5. Follow the instructions in the consecutive pages.

To uninstall an ePublisher component using Windows Control Panel

1. Close all ePublisher user interfaces.

2. Close all instances of Microsoft Office applications running on the local computer, including instances
of Microsoft Word and Microsoft Outlook. Close all instances of Adobe FrameMaker running on the
computer.

3. Open Control Panel.

4. Open Add or Remove Programs.

5. Select the ePublisher component you want to uninstall.

6. Click Remove.

7. Click Yes to confirm you want to remove the ePublisher component from your computer. ePublisher
removes the selected ePublisher component.
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Troubleshooting Installation, License Keys, and
Uninstallation
This section helps you troubleshoot issues related to the following ePublisher issues:

Installing ePublisher. For more information, see “Problems Installing ePublisher”.

Obtaining, adding, and removing Contract IDs and working with licensing. For more information, see
“Problems with Contract IDs and Licensing”.

Uninstalling ePublisher. For more information, see “Problems Uninstalling ePublisher”.
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Problems Installing ePublisher
This section helps you troubleshoot issues related to installing ePublisher.
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Error: Microsoft .NET Framework 2.0 Not Installed
If you are installing an ePublisher component and you do not have the Microsoft .NET Framework installed,
ePublisher displays the following error message.

To resolve this issue

1. Click Yes. ePublisher redirects you to the Microsoft .NET Framework Web site.

2. Download and install the Microsoft .NET Framework Redistributable Package. You do not need to
download and install the Microsoft .NET Framework Software Development Kit.
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Error: Please Close all Running Sessions of Microsoft Word
If you have any Microsoft Office processes running when installing ePublisher, including instances of Microsoft
Word and Microsoft Outlook, ePublisher displays the following error message.

 

To resolve this issue

1. Close any running instances of Microsoft Word.

2. Close Microsoft Outlook.

3. Open Task Manager.

4. Click on the Processes tab.

5. Search for WINWORD.EXE. You can click on the Image Name column to sort the processes alphabetically.

6. If there is a WINWORD.EXE process running, complete the following steps:

a. Select WINWORD.EXE.

b. Click End Process to close all running Word processes. Task Manager displays the following
warning.

c. Click Yes.

d. Close Task Manager, and then proceed with your ePublisher installation.

7. If there are no WINWORD.EXE processes running, proceed with your ePublisher installation.
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Problems with Contract IDs and Licensing
This section helps you troubleshoot issues related to obtaining, adding, and removing Contract IDs. For more
information about Contract IDs, see “Working with Contract IDs”.
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No Contract ID Received
After you purchase ePublisher components, your WebWorks customer service team will e-mail your Contract ID
that enables licensing for the products your purchased. If you have not received a Contract ID, send an email to
sales@webworks.com. For more information about Contract IDs, see “Working with Contract IDs”.

mailto:sales@webworks.com
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Error: No Valid License Key Found
You must enter a Contract ID before you can generate output. If you have not entered your Contract ID
information, ePublisher displays an error stating that no valid license key was found to enable support for your
content authoring tool.

If you have entered a Contract ID but still receive this error, verify you entered your Contract ID information
correctly. For more information about Contract IDs, see “Working with Contract IDs”.
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Other Contract ID and Licensing Problems
If you have received your Contract ID and entered your Contract ID into ePublisher but you are having problems
with licensing, send an email to customerservice@webworks.com. For more information about Contract IDs, see
“Working with Contract IDs”.

Note: ePublisher licensing is flexible, and the WebWorks team can work with you ensure that you have the
licensing that is right for you.

mailto:customerservice@webworks.com
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Problems Uninstalling ePublisher
This section helps you troubleshoot issues related to uninstalling ePublisher.
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Error: You Must Remove the Previous Version of ePublisher
If you try to install a new version of an ePublisher component before uninstalling the previous version of an
ePublisher component, ePublisher displays an error message telling you need to remove the previous version of
the ePublisher component before you can install the new version of the component. ePublisher should no longer
display this error once you uninstall the previous version of the component.

If after you uninstall an ePublisher component, you still receive an error when you try to install a new version of
the component, confirm that the component is no longer listed in the Add or Remove Programs list in Control
Panel. If the component is no longer listed but you still receive the error, there may still be some registry keys
from the prevision installation on the computer that are preventing you from installing a new version of the
ePublisher component.

To resolve this issue

1. Log on to the WebWorks technical support site at http://www.webworks.com/Support/My_Cases/.

Note: You must have an active maintenance agreement in order to log on to the WebWorks technical
support site.

2. On the Find Solution tab, in the Search for field, type Problems installing or upgrading
ePublisher component, and then click Find Solution.

3. Open the Knowledge Base article.

4. Click the Remove WebWorks registry file link.

5. Download the .zip file.

6. Unzip the file and then run the .reg file.

7. Follow the instructions to remove any problematic keys. No other changes will be made to your computer.

http://www.webworks.com/Support/My_Cases/
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Problems Completely Uninstalling ePublisher
If you have a problem uninstalling an ePublisher component, first ensure that no registry keys from the previous
version of the component remain on your computer. For more information, see “Error: You Must Remove the
Previous Version of ePublisher”. If after removing all registry key entries from the previous version you still
are unable to completely uninstall ePublisher, download and install the Windows Installer Cleanup Utility. The
Windows Installer Cleanup Utility allows you to completely remove ePublisher Express from your system.

To completely remove ePublisher using the Windows Installer Cleanup Utility

1. Download and install the Windows Installer Cleanup Utility. The Windows Installer Cleanup Utility is
available on the Microsoft Web site at http://support.microsoft.com/?scid=kb;en-us;290301.

2. Open the Windows Installer Cleanup Utility.

3. Find and select the ePublisher component from the list of installed products.

4. Click Remove.

5. A window displays and alerts you that ePublisher component will be deleted from the Windows Installer
database. Click OK to remove the ePublisher component.

6. Browse to Program Files\WebWorks on your local computer.

7. Verify that the ePublisher component is no longer in the folder. If the folder still exists, delete it.

http://support.microsoft.com/?scid=kb;en-us;290301
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Other Errors Uninstalling ePublisher
If you have already tried to completely uninstall the ePublisher component using the Windows Installer
Cleanup Utility but you are still receiving errors, submit a support request on the WebWorks Web site at http://
www.webworks.com/Support/My_Cases/.

 

http://www.webworks.com/Support/My_Cases/
http://www.webworks.com/Support/My_Cases/
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Exploring ePublisher

This section helps you understand the ePublisher workflow, from the tasks that the Stationery designer performs,
such as preparing source document templates and creating Stationery, through the tasks that writers perform,
such as preparing their source documents for output generation, generating output, and validating their generated
output.

This section also provides an overview of each ePublisher user interface and, through the use of sample Exploring
ePublisher source documents, projects, and Stationery, helps you understand how you can quickly and easily
produce online content that meets required styles and standards
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Understanding the ePublisher Workflow
ePublisher allows your organization to quickly and easily produce online content that meets your organization’s
styles and standards. With ePublisher, you use the following workflow to quickly and easily generate online
content:

Stationery designers create new or modify existing source document templates and then use ePublisher
Designer to create Stationery for writers to use to generate output. For more information, see “Stationery
Designers and ePublisher Designer”.

Writers use ePublisher Express and the Stationery created by a Stationery designer to generate and validate
online content. For more information, see “Writers and ePublisher Express”.

ePublisher AutoMap can automatically generate and deploy online content using the Stationery created by
a Stationery designer and source documents created by writers. For more information, see “Automating
Output Generation with ePublisher AutoMap”.
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Stationery Designers and ePublisher Designer
If you are a Stationery designer, your first step when you work with ePublisher will be to identify which input
formats will be used to author source documents, which types of output need to be generated, and which
online features should be included in generated output. For more information, see “Supported Input Formats”,
“Supported Output Formats”, and “Features Available in Each Output Format”.

After you identify your input and output formats and the features you want to include in your online content, your
next step is to either create source document templates or prepare your existing source document templates for
output generation. Stationery designers use source document templates to configure settings and create Stationery
for writers to use when generating output. Writers use the source document templates to create content and
prepare source documents for output generation. If writers already use source document templates, Stationery
designers can simply prepare the existing source document templates for output generation. If writers are not
currently using source document templates, the Stationery designer creates a source document template for each
content authoring tool used by the authors in the organization. Writers then use the styles and standards defined in
the template to prepare their source files for output generation.

For example, if all writers use Adobe FrameMaker and Adobe FrameMaker templates when authoring content,
the Stationery designer can take the existing Adobe FrameMaker templates, modify the templates as needed
to support online content, and then use the existing templates to create Stationery. If writers use both Adobe
FrameMaker and Microsoft Word but are not yet consistently using templates, the Stationery designer creates a
new standard set of both Adobe FrameMaker and Microsoft Word templates for writers to use when authoring
content. For more information about preparing source document templates for output generation, see the
ePublisher Design Guide.

After the Stationery designer prepares source document templates for the content authoring tools writers use, the
Stationery designer uses ePublisher Designer to perform the following tasks:

Create a Stationery design project using the source document templates.

Configure settings and options in the Stationery design project that define the look, feel, and behavior for
each output target.

For example, the Stationery designer can specify if ePublisher should use the existing styles and formatting
in the source documents when generating output to ensure the source documents and online content share
the same look and feel. The Stationery designer can also specify that online content have a completely
different look and feel than the source documents based on online output design goals and business needs.

Create Stationery using the settings defined in the Stationery design project. The Stationery defines the
style and behavior of generated output, and writers use the settings in the Stationery when they generate
output from their source documents.

After the Stationery designer creates the Stationery, the Stationery designer places the ePublisher Stationery and
source document template files on a shared network folder for writers to use as they author their content, prepare
their source documents for output generation, and generate output.
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Writers and ePublisher Express
With ePublisher, writers use their preferred content authoring tool and the source document templates provided
by the Stationery designer to create content and prepare their source documents for output generation. Writers can
use Microsoft Word, structured or unstructured Adobe FrameMaker, and DITA-XML content authoring tools to
author content. Writers format, or tag, their source documents by applying styles and formats, and then ePublisher
uses this information to generate the appropriate output based on the settings the Stationery designer specified in
the Stationery. Writers do not need to worry about output design. Instead, writers can focus on creating the content
users need.

When writers are ready to generate online content, writers use ePublisher Express to perform the following tasks:

Create an ePublisher Express project based on Stationery created by a Stationery designer.

Add the source documents they want to use to generate output to the ePublisher Express project.

Generate output. The output that writers generate adheres to the styles and standards defined by the
Stationery designer in the Stationery. Writers can generate output on demand. ePublisher can also
automatically generate output based on a schedule if ePublisher AutoMap is implemented.

Deploy generated output. Writers can deploy their generation to a Web site or to a central location from
which a product build can obtain the files. ePublisher can automatically deploy output if ePublisher
AutoMap is implemented.

Check the generated output into a version control system or copy the generated output to a central archive
location.

Although writers typically use the Stationery provided by the Stationery designer without modification, writers
can use ePublisher Express to perform some customizations of output target settings if they have target setting
modification permissions. For example, writers can customize company information such as company name,
phone number, and Web site information in their generated output if they have target setting modification
permissions. If writers need to customize any target or project settings, they should first ensure they have
appropriate target setting modification permissions. After they make any target setting customizations, they
regenerate their output and verify their target setting customizations before deploying their final output. For more
information about target setting permissions and modifying target settings, see “Customizing Target Settings”.

Most writers prefer to use ePublisher Express to perform an initial output generation early in their project cycle.
This allows writers to quickly and easily verify that they are formatting their source documents correctly and
also confirm that their generated output has the appearance and features they want. After an initial verification
of the generated output early in the project cycle, writers continue to add content to their source documents, then
regenerate output on a periodic basis, such as once a week, as the project progresses.

If ePublisher AutoMap is implemented, ePublisher AutoMap can be configured to automatically generate output
for writers on a regular schedule. For example, ePublisher AutoMap can be configured to automatically generate
output for a project every night. When writers arrive at work the next day, writers can quickly and easily verify
that the latest content they added to their source documents is formatted correctly and displays appropriately in
their generated output. Periodic output generation using the latest version of source documents and Stationery
provides the following benefits:

Allows writers to quickly and easily confirm that they are formatting their source documents correctly
and feel confident that their generated output always conforms to the standards and styles defined in their
project Stationery by the Stationery designer

Reduces the amount of time writers spend doing a quality assurance review for their generated output at the
end of a project cycle
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Helps eliminate post-generation editing and processing, which save organizations time and money

Ensures that the end of the project cycle is smooth and hassle-free

ePublisher allows writers to quickly and easily produce high-quality output according to specifications each time
they generate output.
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Automating Output Generation with ePublisher AutoMap
If you implement ePublisher AutoMap, you can configure ePublisher AutoMap to automate your output
generation using Stationery created by a Stationery designer and source documents created by writers. For more
information about ePublisher AutoMap, see the ePublisher Design Guide.
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Exploring the ePublisher User Interfaces
The WebWorks ePublisher Platform provides the following user interfaces:

ePublisher Express user interface, which writers use when generating output

ePublisher Designer user interface, which Stationery designers use when creating and updating Stationery

ePublisher AutoMap user interface, used to automate output generation and integrate the output generation
process with source control systems and product build systems

This section provides an overview of each of these ePublisher user interfaces.
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Exploring the ePublisher Express User Interface
The ePublisher Express user interface includes the following windows:

Start page. For more information, see “Understanding the Start Page”.

Document Manager. For more information, see “Understanding Document Manager”.

Output Explorer. For more information, see “Understanding Output Explorer”.

Log Window. For more information, see “Understanding the Log Window”.

The following figure shows the ePublisher Express user interface.
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Exploring the ePublisher Designer User Interface
The ePublisher Designer user interface includes the following windows:

Start page. For more information, see “Understanding the Start Page”.

Document Manager. For more information, see “Understanding Document Manager”.

Output Explorer. For more information, see “Understanding Output Explorer”.

Log Window. For more information, see “Understanding the Log Window”.

Style Designer. For more information, see “Understanding Style Designer”.

Preview window. For more information, see “Understanding the Preview Window”.

The following figure shows the ePublisher Designer user interface.
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Understanding the Start Page
The Start page is available in both ePublisher Express and ePublisher Designer. The Start page lists the most
recently opened ePublisher projects. You click on a project name on the Start page to open the associated project
file. You can also specify the number of projects you want to display on the Start page. For more information
about specifying the number of projects you want to display on the Start page, see “Specifying General ePublisher
Preferences”.

The following figure shows the Start page.
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Understanding Document Manager
Document Manager is available in both ePublisher Express and ePublisher Designer. Document Manager allows
you to organize the source documents in your project. Within Document Manager, you can add, remove, and
rearrange the groups and source documents in your project. For more information about working with source
documents in Document Manager, see “Working with Source Documents”.

The following figure shows Document Manager.
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Including or Excluding Files
ePublisher allows you to include/exclude documents from processing on a target by target basis. This capability
is available to all ePublisher users, regardless of their source authoring format. Users working with Adobe
FrameMaker 9 and later book files will see that ePublisher scans default include/exclude values from their source
documents.

To include or exclude a document from processing, right-click on any file or book. The context menu will
appear with the Include/Exclude option. Clicking this item will reveal three choices: Include, Exclude and Use
Document Value. Clicking Exclude will create a red dotted line around the file that will indicated that this source
file will not be created in the output file. Clicking include will show as normal and if it is not changed in the FM
source, will be included. The Use Document Value will take whatever is set in FrameMaker and if already set to
Exclude in the source will show the dotted red lines around the source documents.

Note: Include/exclude settings are configured on a per Target. For example in this project’s WebWorks Help
target, ecology.book (along with all child files) is excluded:

In the same project’s WebWorks Reverb target, ecology.book book is included for processing while
Exploring ePublisher.book (and child files) is excluded.
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Understanding Output Explorer
Output Explorer is available in both ePublisher Express and ePublisher Designer. Output Explorer displays all of
the files generated by ePublisher.

The following figure shows Output Explorer.

 

The output files displayed in the Output Explorer depend on the item you select in Document Manger. Output
Explorer displays items as follows:

If you have a source document selected in Document Manager, ePublisher displays the source document
group in Output Explorer. The source document group displayed in Output Explorer contains the Files
group, which lists all of the generated topic files, the Images group, which lists all of the generated images
for your output, and the Reports group, which lists Styles, Links, Accessibility, Filenames, and Topics
reports.

If you have a top-level group selected in Document Manager, ePublisher displays the top-level group in
Output Explorer. The top-level group displayed in Output Explorer contains the Navigation group, which
lists the entry-point file for the generated output based on the active target selected in the project, and the
Reports group, which lists Styles, Links, Accessibility, Filenames, and Topics reports.

If you have a subgroup selected in Document Manager, ePublisher displays the subgroup in Output
Explorer. The subgroup contains the entry-point file for the generated output.

If you have more than one top-level group in Document Manager, in addition to displaying the top-level
group you select in Document Manager in Output Explorer, ePublisher also displays a Merge Output group
in Output Explorer. The Merge Output group displays the merged entry-point file created from each top-
level group entry point file. You can use the merged entry-point file ePublisher automatically creates when
you have more than one top-level group in Document Manager to created merged help systems.

For more information about merged help systems, see “Merging Help Systems (Multivolume Help)”.
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Understanding the Log Window
The Log Window is available in both ePublisher Express and ePublisher Designer. The Log Window displays the
log ePublisher creates when generating output. When ePublisher creates a log during output generation, you can
see the status of the output generation process and any errors generated. You can also quickly and easily see which
pipelines ePublisher processed, which settings ePublisher applied, and which files ePublisher parsed. For more
information about viewing or working with logs, see the “Working with Output Log Files”. The following figure
shows the Log Window.
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Understanding Style Designer
Style Designer is available in only ePublisher Designer. ePublisher intelligently discovers the styles in the source
documents and presents a list of these styles in Style Designer. Stationery designers then define how output
should be generated by specifying properties and options for each style. Stationery designers use Style Designer
to define how paragraphs, characters, tables, and images display in generated output, including the color or font
of a paragraph style, the style of a table border, the layout of a page, and the file format of converted images.
Stationery designers can also specify other aspects of generated output, such as page layout and when topic pages
are created.

ePublisher uses the styles in source documents along with the settings the Stationery designer defines in the
Stationery to generate output. Using styles in source documents and Stationery settings allows precise control
over the appearance and behavior of generated output.

The following figure shows Style Designer.
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Understanding the Preview Window
The Preview window is available in only ePublisher Designer. When designing Stationery, Stationery designers
can use the Preview window to quickly see how modifications made to styles and project settings affect the
appearance of generated output. You can generate a preview of output from a source file in ePublisher Designer
when you select a source document in Document Manager. However, some online content features, such as popup
windows, links, and conditions, are not displayed or active in the Preview window.

The following figure shows the Preview window.

For more information about using the preview window in ePublisher Designer when designing Stationery, see the
ePublisher Design Guide.
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Exploring the ePublisher AutoMap User Interface
The ePublisher AutoMap user interface allows you to create, edit, and schedule ePublisher AutoMap jobs. The
following figure shows the ePublisher AutoMap user interface.

For more information about using ePublisher AutoMap, see the ePublisher Design Guide.
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Customizing Your ePublisher Workspace
By default, the ePublisher user interface comes preset with certain toolbar icons and window settings. ePublisher
gives you extensive control over the appearance of the user interface by allowing you to customize the display of
windows and toolbars.

When you open ePublisher for the first time, Document Manager and Output Explorer are docked and the Log
Window is undocked. When a window is undocked, it displays as a tab in the sidebar, and it will auto-hide unless
you hover over the tab in the sidebar. When you hover over an undocked window, the window displays.

You can customize the display of windows in the user interface to suit your needs. In ePublisher, you can move
Document Manager, Output Explorer, and the Log Window to different locations within the user interface or make
them into floating windows. When you dock a window, it becomes stationary within the user interface and is
always visible.

You can rearrange docked windows by moving the window to a new location within the user interface. For
example, you can move the Output Explorer into a new window pane next to the Start page. However, the Start
page cannot be moved. The Start page serves as the central point from which all the windows are arranged. To
move a docked window within the user interface, click on the title bar of the window and then drag the window to
a new location. To undock a window, click on the pin icon in the upper right corner of the window.

In addition to rearranging docked windows, you can add, remove, customize, or create buttons on tool bars. You
can also create your own custom toolbars. By customizing your toolbars and buttons, you can create a workspace
that fits your preferences and work style.

Whenever you make changes to the user interface by moving windows, changing window dock settings, or
customizing toolbars, the changes take effect for each subsequent project you create or open. For example, if you
dock Document Manager, Output Explorer, and the Log Window and add customized buttons to the toolbar, these
settings will become the default settings for each project you open.
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Specifying General ePublisher Preferences
You use the General tab of the Preferences window to specify ePublisher preferences, such as the number of
recent projects to display on the Start page, whether to automatically scan source documents when you add them
to Document Manager, and where to store user-created formats. You can also reset the user interface toolbar and
window dock positions.

To specify general ePublisher preferences

1. On the Edit menu, click Preferences.

2. Specify preferences for each setting. For more information about settings and options, click Help.

 



104 |

4



Preparing Adobe FrameMaker Source Documents | 105

Preparing Adobe FrameMaker
Source Documents

If you want to implement online content features in your generated output, you need to prepare your Adobe
FrameMaker source documents for output generation. This section explains how to prepare your Adobe
FrameMaker source documents. This section assumes that you use Adobe FrameMaker templates prepared by
a Stationery designer. Using Adobe FrameMaker templates ensures that content in your source documents is
formatted consistently and can be used effectively by ePublisher to generate output. For more information about
preparing Adobe FrameMaker templates, see the ePublisher Design Guide.
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Checklist: Preparing FrameMaker Source Documents
Use the following checklist to help you prepare your Adobe FrameMaker source documents.

Task For more information, see...

1. Review the online features you can
implement and verify which online
features your Stationery supports.

“Implementing Online Features in
FrameMaker”

2. Obtain your latest templates and
apply the templates to your source
documents.

“Obtaining and Applying the Latest Adobe
FrameMaker Template”

3. Review any tables in your source
documents and prepare your tables for
output generation as needed.

“Working with Tables in FrameMaker”

4. Review any images in your source
documents and prepare your images
for output generation as needed.

“Working with Images in FrameMaker”

5. If you want to include an index,
prepare your source files for index
generation.

“Creating Index Entries in FrameMaker”

6. If you want to use variables, insert
variables in your source documents.

“Using Variables in FrameMaker”

7. If you want to use conditions, apply
conditions to content in your source
documents.

“Using Conditions in FrameMaker”

8. If you want to specify file names for
output files, insert Filename markers
in your source documents.

“Specifying Output File Names in
FrameMaker”

9. If you want to create context-
sensitive help, insert TopicAlias
markers in your source documents.

“Creating Context-Sensitive Help in
FrameMaker”

10. If you want to create popup
windows, insert hyperlinks and then
insert Popup markers or apply Popup
paragraph formats to content in your
source documents.

“Creating Popup Windows in FrameMaker”

11. If you want to create expand/
collapse sections, apply the Expand/
Collapse paragraph formats and insert
DropDownEnd markers in your source
documents.

“Creating Expand/Collapse Sections (Drop-
Down Hotspots) in FrameMaker”

12. If you want to create related topics,
apply the Related Topics paragraph
format to content in your source
documents.

“Creating Related Topics in FrameMaker”

13. If you want to specify categories
or labels for Wiki pages, insert

“Specifying Wiki Categories or Labels in
FrameMaker”
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Task For more information, see...

WikiCategory markers in your source
documents.

14. If you want to create See Also links,
insert SeeAlso markers in your source
documents.

“Creating See Also Links in FrameMaker”

15. If you want to create meta tag
keywords for pages, insert Keywords
markers in your source documents.

“Creating Meta Tag Keywords in
FrameMaker”

16. If you want to use multiple page
designs, insert PageStyle markers in
your source documents.

“Assigning Custom Page Styles in
FrameMaker”

17. If you want to create What’s This
Help, also known as field-level help,
insert WhatIsThisID markers in your
source documents.

“Creating What’s This (Field-Level) Help in
FrameMaker”

18. If you want to open certain topics in
a custom window, insert WindowType
markers in your source documents.

“Opening Topics in Custom Windows in
FrameMaker”

19. If you want to customize the table of
contents icons for specific topics,
insert TOCIcon markers in your source
documents.

“Customizing Table of Contents Icons in
FrameMaker”

20. If you want to specify context plug-
ins for Eclipse help systems, insert
Context Plugin markers in your source
documents.

“Specifying Context Plug-ins in
FrameMaker”

21. If you want to create accessible
online content, insert the
appropriate markers and apply the
appropriate paragraph formats and
character formats to images, tables,
abbreviations, acronyms, and citations
in your source documents.

“Creating Accessible Online Content in
FrameMaker”
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Implementing Online Features in FrameMaker
Implement online features in your output by preparing your Adobe FrameMaker source documents with custom
marker types, paragraph formats, and character formats defined by the Stationery designer for your Stationery.
These markers and styles define the presentation and behavior or your online content. For example, markers can
define the name of the file generated for a topic. Formats can define how content displays online.
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Understanding Custom Marker Types in FrameMaker
ePublisher projects use the custom marker types to implement online features when generating output. Before you
begin using custom marker types, talk to the Stationery designer and verify which online features your Stationery
supports. Your Stationery only recognizes the custom marker types defined by the Stationery designer in your
Stationery. If you try to implement online features using custom marker types not supported in your Stationery,
ePublisher does not recognize these items when generating output. ePublisher correctly converts all standard
Adobe FrameMaker marker types. In addition, ePublisher also supports several custom marker types you can use
to implement online features in your generated output.

When the Stationery designer creates the Stationery, the Stationery designer can use the default name for a custom
marker type or the Stationery designer can use a different name for the customer marker type. The following
table lists the default names of custom marker types used to implement online features. Always verify with the
Stationery designer the names of the custom marker types you should use when implementing online features
before you use these items in your source documents.

Marker Type Description

AbbreviationTitle marker type Specifies abbreviation alternate text for browsers to display for abbreviations such
as SS# when a user hovers over the abbreviation in output. Screen readers also
can read the abbreviation alternate text. Used in combination with the Abbreviation
character format. For more information, see “Assigning Alternate Text to Abbreviations in
FrameMaker”

AcronymTitle marker type Specifies acronym alternate text for browsers to display for acronyms such as HTML
when a user hovers over the acronym in output. Screen readers can also read the
acronym alternate text. Used in combination with the Acronym character format. For
more information, see “Assigning Alternate Text to Acronyms in FrameMaker”.

Citation marker type Specifies the source of a quote using a fully qualified Uniform Resource Identifier (URI)
when a user hovers over the quote in output. Screen readers can also read the URI for
the quote. Used in combination with the Citation character format. For more information,
see “Providing Citations for Quotes in FrameMaker”.

Context Plugin marker type Specifies context plug-ins for Eclipse help systems. Other Eclipse plug-ins can use the
context plug-in IDs to call the Eclipse help system. For more information, see “Specifying
Context Plug-ins in FrameMaker”.

DropDownEnd marker type Marks the end of an expand/collapse section. Used in conjunction with an Expand/
Collapse paragraph format. For more information, see “Creating Expand/Collapse
Sections (Drop-Down Hotspots) in FrameMaker”.

Filename marker type Specifies the name of an output file for a page or an image. For more information, see
“Specifying Output File Names in FrameMaker”.

GraphicScale marker type Specifies a percentage to use to resize an image, such as 50 or 75 percent, in
generated output. For more information, see “Assigning Image Scales in FrameMaker”.

GraphicStyle marker type Specifies the name of a image style defined in a project to apply to an image. This
marker type is an internal marker type that is not displayed in Stationery Designer. You
cannot create a marker type with a different name and assign it this functionality. For
more information, see “Assigning Image Styles in FrameMaker”.

Hypertext marker type Specifies a link using the newlink and gotolink commands in Adobe FrameMaker.
This marker type is a default Adobe FrameMaker marker type ePublisher automatically
maps.
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Marker Type Description

ImageAltText marker type Specifies alternate text for an image.This text is added to the alt attribute of the img
tag in the output. Screen readers use this text when you create accessible content. For
more information, see “Assigning Alternate Text to Images in FrameMaker”.

ImageAreaAltText marker type Specifies alternate text for clickable regions in an image map. This text is added to the
alt attribute of the img tag in the output. Screen readers use this text when you create
accessible content. For more information, see “Assigning Alternate Text to Image Maps
in FrameMaker”.

ImageLongDescByRef marker type Specifies the path to the file that contains the long description for an image. This text is
added to the longdesc attribute of the img tag in the output. Screen readers read this
description when you create accessible content. For more information, see “Using Text
in External Files to Assign Long Descriptions to Images in FrameMaker”.

ImageLongDescNotReq marker type Specifies that a long description is not required for an image, which bypasses this
accessibility check for the image when you create accessible content. For more
information, see “Excluding Images from Accessibility Report Checks in FrameMaker”.

ImageLongDescText marker type Specifies the long description for an image. This text is added to the longdesc attribute
of the img tag in the output. Screen readers read this description when you create
accessible content. For more information, see “Assigning Long Descriptions to Images in
FrameMaker”.

Keywords marker type Specifies the keywords to include in the meta tag for the topic. The meta tag improves
searchability on the Web. For more information, see “Creating Meta Tag Keywords in
FrameMaker”.

PageStyle marker type Specifies the name of a page style defined in the project to apply to a topic. This marker
type is an internal marker type that is not displayed in Stationery Designer. You cannot
create a marker type with a different name and assign it this functionality. For more
information, see “Assigning Custom Page Styles in FrameMaker”.

PassThrough Specifies that ePublisher place the contents of the marker directly into the generated
output without processing the content in any way. For example, you could use a
PassThrough marker if you wanted to embed HTML code within your generated output.

Popup marker type Specifies the start of the content to include in a popup window. The content is displayed
in a popup window when you hover over the link. When you click the link in some output
formats, the topic where the popup text is stored, such as the glossary, is displayed. For
more information, see “Using Markers to Create Popup Windows in FrameMaker”.

PopupEnd marker type Marks the end of the content to include in a popup window. For more information, see
“Using Markers to Create Popup Windows in FrameMaker”.

PopupOnly marker type Specifies the start of the content to include in only a popup window. Browsers display the
content in a popup window when you hover over or click the link. For more information,
see “Using Markers to Create Popup Windows in FrameMaker”.

RubiComposite marker type No longer supported.

SeeAlsoKeyword marker type Specifies an internal identifier for a topic. SeeAlsoLink markers in other topics can list
this identifier to create a link to this topic. Used in conjunction with a See Also paragraph
format or character format. For more information, see “Creating See Also Links in
FrameMaker”.

SeeAlsoLink marker type Identifies an internal identifier from another topic to include in the list of See Also links in
this topic. Used in conjunction with a See Also paragraph format or character format. For
more information, see “Creating See Also Links in FrameMaker”.

SeeAlsoLinkDisplayType marker typeSpecifies whether to display the target topics on a popup menu or in a window. By
default, the links are displayed in the Topics Found window. To display a popup menu,
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Marker Type Description

set the value to menu. This marker type is supported only in HTML Help. For more
information, see “Creating See Also Links in FrameMaker”.

SeeAlsoLinkWindowType marker
type

Specifies the name of the window defined in the .hhp file, such as TriPane or Main, that
the topic opens in when the user clicks the link. This marker type is supported only in
HTML Help. For more information, see “Creating See Also Links in FrameMaker”.

TableStyle marker type Specifies the name of a table style defined in the project to apply to a table in versions of
Microsoft Word that did not support table styles. This marker type is an internal marker
type that is not displayed in Stationery Designer. This marker type is supported only for
Microsoft Word documents. You cannot create a marker type with a different name and
assign it this functionality. For more information, see “Applying Table Styles in Word”

TableSummary marker type Specifies an alternate text summary for a table, which is used when you create
accessible content. This text is added to the summary attribute of the table tag in the
output. Screen readers read this description when you create accessible content. For
more information, see “Assigning Alternate Text (Summaries) to Tables in FrameMaker”.

TableSummaryNotReq marker type Specifies that a summary is not required for a table, which bypasses this accessibility
check for that table. For more information, see “Excluding Tables from Accessibility
Report Checks in FrameMaker”.

TOCIconHTMLHelp marker type Identifies the image to use as the table of contents icon for a topic in the HTML Help
output format. For more information, see “Customizing Table of Contents Icons in
FrameMaker”.

TOCIconJavaHelp marker type Identifies the image to use as the table of contents icon for a topic in the Sun JavaHelp
output format. For more information, see “Customizing Table of Contents Icons in
FrameMaker”.

TOCIconOracleHelp marker type Identifies the image to use as the table of contents icon for a topic in the Oracle Help
output format. For more information, see “Customizing Table of Contents Icons in
FrameMaker”.

TOCIconWWHelp marker type Identifies the image to use as the table of contents icon for a topic in the WebWorks
Help output format. For more information, see “Customizing Table of Contents Icons in
FrameMaker”.

TopicAlias marker type Specifies an internal identifier for a topic that can be used to create a context-sensitive
link to that topic. For more information, see “Creating Context-Sensitive Help in
FrameMaker”.

TopicDescription marker type Specifies a topic description for a context-sensitive help topic in Eclipse help systems.
For more information, see “Specifying Context-Sensitive Help Links in FrameMaker”.

WhatIsThisID marker type Identifies a What’s This help internal identifier for creating context-sensitive What’s This
field-level help for Microsoft HTML Help. For more information, see “Creating What’s
This (Field-Level) Help in FrameMaker”.

WikiCategory marker type Specifies the Wiki category or label you want to assign to a topic when generating
Wiki output. For more information, see “Specifying Wiki Categories or Labels in
FrameMaker”.

WindowType marker type Specifies the name of the window defined in the Help project that the topic should be
displayed in. In Microsoft HTML Help, the window names are defined in the .hhp file.
This marker type is supported in Microsoft HTML Help and Oracle Help. For more
information, see “Opening Topics in Custom Windows in FrameMaker”.
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Understanding Paragraph and Character Formats in FrameMaker
ePublisher projects use the paragraph formats and character formats defined by the Stationery designer to
implement online features when generating output. Before you begin using paragraph formats and character
formats to implement online features, talk to the Stationery designer and verify which online features your
Stationery supports. Your Stationery only recognizes the paragraph formats and character formats defined by
the Stationery designer in your Stationery. If you try to implement online features using paragraph formats and
character formats not supported in your Stationery, ePublisher does not recognize these items when generating
output.

When the Stationery designer creates the Stationery, the Stationery designer specifies the names of paragraph
format and character formats used to implement an online feature. Consult with the Stationery designer to obtain
the names of the paragraph formats and character formats defined by the Stationery designer to support each
online feature you want to implement.

The following table lists the default names of paragraph formats and character formats used to implement online
features. Always verify with the Stationery designer the names of the paragraph formats and character formats
you should use when implementing online features before you use these items in your source documents.

Format Description

AbbreviationTitle character format Specifies abbreviation alternate text for browsers to display for abbreviations such
as SS# when a user hovers over the abbreviation in output. Screen readers also can
read the abbreviation alternate text. Used in combination with the AbbreviationTitle
marker type. For more information, see “Assigning Alternate Text to Abbreviations in
FrameMaker”.

AcronymTitle character format Specifies acronym alternate text for browsers to display for acronyms such as HTML
when a user hovers over the acronym in output. Screen readers can also read the
acronym alternate text. Used in combination with the AcronymTitle marker type. For
more information, see “Assigning Alternate Text to Acronyms in FrameMaker”.

Citation character format Specifies the source of a quote using a fully qualified Uniform Resource Identifier (URI)
when a user hovers over the quote in output. Screen readers can also read the URI for
the quote. Used in combination with the Citation marker type. For more information, see
“Providing Citations for Quotes in FrameMaker”.

Expand/Collapse paragraph format Specifies the content you want to include in an expand/collapse section. Used in
conjunction with a DropDownEnd marker type. For more information, see “Creating
Expand/Collapse Sections (Drop-Down Hotspots) in FrameMaker”.

Popup paragraph format Specifies the popup content to display in both a popup window and in a standard help
topic. Applied to the first paragraph of popup content. For more information, see “Using
Paragraph Formats to Create Popup Windows in FrameMaker”.

Popup Append paragraph format Specifies the popup content to display in a popup window and in a standard help topic.
Applied to additional popup paragraphs when you have more than one paragraph of
popup content. For more information, see “Using Paragraph Formats to Create Popup
Windows in FrameMaker”.

Popup Only paragraph format Specifies the popup content to display in only a popup window. Applied to the first
paragraph of popup content. For more information, see “Using Paragraph Formats to
Create Popup Windows in FrameMaker”.

Popup Only Append paragraph
format

Specifies the popup content to display in only a popup window. Applied to additional
popup paragraphs when you have more than one paragraph of popup content. For more
information, see “Using Paragraph Formats to Create Popup Windows in FrameMaker”.
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Format Description

Related Topic paragraph format Specifies related topics links. For more information, see “Creating Related Topics in
FrameMaker”.

See Also character format Specifies the text you want to include in a See Also button. For more information, see
“Creating See Also Links in FrameMaker”.

See Also paragraph format Specifies the text you want to include in a See Also inline text link. For more information,
see “Creating See Also Links in FrameMaker”.
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Obtaining and Applying the Latest Adobe FrameMaker Template
An efficient, effective, and consistent ePublisher online content generation process relies upon the use of
templates. Templates define marker types and paragraph, character, and table formats. Templates may also contain
standard conditions, variables, and cross-reference definitions that you can use when creating and working with
source documents used to generate online content. Templates help control the look and feel of source documents
and generated output across multiple writers, multiple projects, and multiple types of generated output.

The ePublisher content generation process assumes that you use marker types and paragraph, character and table
formats defined in an Adobe FrameMaker template prepared by a Stationery designer as you create content
and format your source documents. Using Adobe FrameMaker templates and the marker types and paragraph,
character, and table formats and other layout formats and characteristics defined in templates ensures that you
format content in your source documents consistently and also ensures ePublisher can use your source documents
effectively to generate output.

If your source documents do not use templates or do not use the same marker types, formats, and standards
defined in your Stationery by the Stationery designer, your generated output may not conforms to the styles and
standards defined by the Stationery designer for output. You may also not be able to implement some online
features if you do not use the correct templates or the correct marker types and formats defined in the templates.

As a part of preparing your Adobe FrameMaker source documents for output generation, ensure your source
documents use the correct Adobe FrameMaker templates from the Stationery designer and you have applied all
paragraph, character, and table formats specified in the template correctly. For more information about obtaining
and applying the correct Adobe FrameMaker templates for your project, see the ePublisher Design Guide.
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Importing Custom Marker Types in FrameMaker
Typically the Stationery designer defines custom marker types supported in your ePublisher Stationery in an
Adobe FrameMaker template. You then import the custom marker types defined in an Adobe FrameMaker
template into your Adobe FrameMaker source documents by importing document properties from the Adobe
FrameMaker template. This procedure explains how to import custom marker types from an Adobe FrameMaker
template. For more information about creating custom marker types, see “Creating Custom Marker Types in
FrameMaker”.

The following procedure provides an example of how to import custom marker types into Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for importing custom marker types in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To import custom marker types from an Adobe FrameMaker template into your source
documents

1. In your Adobe FrameMaker source document, on the File menu, click Import > Formats.

2. In the Import from Document field, select the Adobe FrameMaker template that contains the custom
marker types you want to import from the list.

3. In the Import and Update field, select only the Document Properties check box.

4. Click Import.

5. Click OK to confirm the operation.
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Creating Custom Marker Types in FrameMaker
Typically you should not need to create a custom marker type in an Adobe FrameMaker source document. If
you want to use a custom marker type to implement an online feature, use the custom marker type provided in
the Adobe FrameMaker template you use for your source documents. If you do not see a custom marker type
you want to use to implement an online feature in the Adobe FrameMaker template, verify with the Stationery
designer that your Stationery supports the custom marker type before you insert and use the custom marker in a
source document.

Occasionally your Stationery may support a custom marker type that is not defined in the Adobe FrameMaker
template you use with your source documents. In this situation, first confirm with the Stationery designer that
your Stationery supports the custom marker type. After confirming your project supports the custom marker type,
you can create the custom marker type in your Adobe FrameMaker source document.

The following procedure provides an example of how to create custom marker types in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for creating custom marker types in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To create a custom marker type in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, on the Special menu, click Marker.

2. In the Marker Type field, select Edit from the drop-down list.

3. Type CustomMarkerTypeName to create a custom marker type, where CustomMarkerTypeName is the name
of the custom marker type you want to create.

Note: The custom marker type name you type must match the name of the custom marker type supported
in your ePublisher Stationery. If you specify a name for the custom marker type that is different than
the name of the custom marker type supported in your ePublisher Stationery, ePublisher will not be
able to recognize and use the custom marker type when generating output.

4. Click Add.

5. Click OK to confirm the operation.

6. Click Done. Adobe FrameMaker displays the custom marker type you created in the Marker window in the
Marker Type field.
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Creating a Passthrough Marker in FrameMaker
A passthrough marker is a marker that allows you to insert content that you do not want ePublisher to process
when you generate output. For example, if you have embedded multimedia files in your source documents, such
as Audio Video Interleave files (.avi) or Adobe Software Flash files (.swf), you can insert a passthrough marker
with a value that is set to the HTML code that you do not want ePublisher to process.

The following example shows .avi code to which you could insert using a passthrough marker.

<embed src="sample.avi" width="400"

height="300" pluginspage="">

</embed>

To create a passthrough marker in an Adobe FrameMaker source document

1. In Adobe FrameMaker, on the Special menu, click Marker.

2. In the Marker Type field, select Passthrough from the drop-down list.

3. If the Passthrough marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

4. In the Marker Text field, type the html code that you would like to not be processed by ePublisher such as
the Flash embed code indicated in the previous topic.

5. Click New Marker.

6. Save your source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher created the appropriate result for your embedded html code. For more
information, see “Viewing Output in Output Explorer”.
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Creating Cross-References and Links in FrameMaker
When you generate output, ePublisher automatically converts all cross-references in your Adobe FrameMaker
source documents to links. Typically Stationery designers specify in Stationery how cross-references should
display in generated output. For example, Stationery designers typically specify that cross-references that contain
page numbers in source documents display without page numbers in generated output, as page numbers are out
of context in online output. If you have target setting permissions, you can also customize the cross-reference
formats you want to use when you generate output. For more information about customizing cross-reference
settings, see “Customizing Cross-Reference Settings in Projects”.

Including cross-references in Adobe FrameMaker source documents is typically the easiest way to produce links
in online content. However, in some cases you may not be able to achieve the effect you want by creating links
using cross-references. In these cases, you can insert native Adobe FrameMaker Hypertext markers that use the
gotolink and message URL hypertext commands in your Adobe FrameMaker source documents and use the
Hypertext markers to create the links you want.

To create a link using a cross-reference or Hypertext markers in an Adobe FrameMaker source
document

1. If you want to create a link using a cross-reference, complete the following steps:

a. In your Adobe FrameMaker source document, select the text for which you want to create a link.

b. On the Special menu, click Cross-Reference.

c. In the Document field, select the document that contains the content to which you want to link.

d. In the Paragraph Tags field, select the paragraph tag used for the content to which you want to link.

e. In the Paragraphs field, select the paragraph to which you want to link.

f. In the Format field, select the appropriate format for the link. For example, if you are creating a link
to a glossary term, select a glossary term cross-reference format.

g. Click Replace.

2. If you want to create a link using hypertext markers, complete the following steps:

a. In your Adobe FrameMaker source document, insert your cursor in front of the link target text.

b. On the Special menu, click Marker.

c. In the Marker Type field, select Hypertext from the list.

d. In the Marker Text field, type newlink linkname or newlink filename:linkname, where
linkname is the name of the named destination for the link, and filename is the name of the file
that contains the link, if the link is in a different Adobe FrameMaker source document. To make
maintenance easy, create short link names that use alphanumeric, lowercase characters.

e. Click New Marker.

f. Insert your cursor in front of the word or phrase for which you want to create a link.

a. On the Special menu, click Marker.

b. In the Marker Type field, select Hypertext from the list.
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c. In the Marker Text field, type gotolink linkname or gotolink filename:linkname, where
linkname is the name of the named destination you created for the link, and filename is the name of
the file that contains the link, if the link is in a different Adobe FrameMaker source document.

d. Click New Marker.

e. Select the word or phrase for which you want to create a link. The selected area must contain the
both text and the hypertext marker you created.

f. Apply a link character format to the word or phrase. Applying a link character format to the word or
phrase makes the link appear active, or clickable, in the generated output. If you do not know which
character format to use for links, consult the Stationery designer.

3. If you want to create a link to a PDF file, complete the following steps:

a. In the FrameMaker menu, go to Special > Hypertext

b. From the Command dropdown menu, chose Message Client

c. In the Syntax text box, type message openfile relative_path where relative_path is the
relative directory where you have your PDF located and then you add example.pdf to this path

4. Save your Adobe FrameMaker source document.
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Working with Tables in FrameMaker
This section explains how to prepare tables in source documents for output generation. Obtain your latest
templates and apply the latest table formats from the template to tables in your source documents. If your tables
do not have header rows, create a header row for each table. If your tables do not have footer rows, create a footer
row for each table.
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Applying Table Formats in FrameMaker
Table formats define the appearance of your tables, and ePublisher uses table formats to define the appearance
of tables in generated output. When you work with tables in your Adobe FrameMaker source documents, ensure
you apply the correct table formats to your tables. The Stationery designer defines the table formats you can use
in your Adobe FrameMaker source documents in the Adobe FrameMaker templates you associate with your
Adobe FrameMaker source documents. If you want to specify a different table format for sets of tables in your
generated output, first ensure the different table format you want to apply is available in your Adobe FrameMaker
source document. Then apply the different table format to tables in your Adobe FrameMaker source documents as
appropriate.

For example, you may have a small set of tables that contain information about a specific component in a product.
If you decide you want to modify the appearance of these tables in your generated output by specifying that the
tables associated with this component display with a yellow background in your generated output, apply a table
format available in your Adobe FrameMaker source document that the Stationery designer created to meet this
requirement. When you generate output, the Stationery designed by the Stationery designer specifies that any
tables created with a table format configured to display tables with a yellow background display in your output
with a yellow background.
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Creating Table Header Rows in FrameMaker
Most tables in Adobe FrameMaker source documents include header rows, because by default Adobe
FrameMaker allows you to quickly and easily specify the number of header rows in a table when you create a
table. However, if your tables do not have header rows, consider adding table header rows to tables in your Adobe
FrameMaker source documents. Using table header rows allows you to more tightly control the appearance of
tables when you generate output. For example, if you use header rows, you can specify one appearance for header
rows in your generated output, and a difference appearance for body rows in your generated output.

The following procedure provides an example of how to create table header rows in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for creating table header rows in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To create a table header row in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the table for which you want to create a table header
row.

2. Insert your cursor in the top row of the table.

3. On the Table menu, click Add Rows or Columns.

4. Click Add 1 Row.

5. Select To Heading from the list.

6. Click Add. Adobe FrameMaker inserts a header row into the table.

7. Type the text for the header row into the table.

8. Delete any existing rows in the text that contain the text you typed into the new table header row as needed.
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Creating Table Footer Rows in FrameMaker
Most tables in Adobe FrameMaker source documents include footer rows, because by default Adobe FrameMaker
allows you to quickly and easily specify the number of footer rows in a table when you create a table. However,
if your tables do not have footer rows, consider creating footer rows in your source documents in order to quickly
and easily specify the appearance that you want for your table footer rows in your generated output. For example,
if you use footer rows in conjunction with header rows, you can specify one appearance for footer rows in your
generated output, and then different appearances for header rows and table body rows in your generated output.

The following procedure provides an example of how to create table footer rows in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for creating table footer rows in Adobe FrameMaker
may be different in other versions of Adobe FrameMaker.

To create a table with a footer row in Adobe FrameMaker

1. In your Adobe FrameMaker source document, locate the table for which you want to create a table footer
row.

2. Insert your cursor in the bottom row of the table.

3. On the Table menu, click Add Rows or Columns.

4. Click Add 1 Row.

5. Select To Footing from the list.

6. Click Add. Adobe FrameMaker inserts a footer row into the table.



124 | Working with Images in FrameMaker

Working with Images in FrameMaker
Many writers include images when producing documents using Adobe FrameMaker. Most writers typically insert
images into Adobe FrameMaker source documents in one of the following ways:

Copying images directly into in Adobe FrameMaker source documents, also known as embedding images

Importing images by reference, which creates a link to the source image in the Adobe FrameMaker source
documents

If you copy an image into an Adobe FrameMaker source document, Adobe FrameMaker copies, or embeds, the
image in the Adobe FrameMaker source document, and the image becomes a part of the document.

If you import an image by reference in Adobe FrameMaker source documents, Adobe FrameMaker creates a link
to the image and displays the image in the Adobe FrameMaker source document. The link becomes a part of the
document, but the actual image file is not inserted into the document, although the actual image files is displayed
in the document. If you update the image file referenced by the link, Adobe FrameMaker displays the updated
image referenced by the link automatically.

There are benefits and drawbacks to copying images directly into Adobe FrameMaker source documents and
importing images by reference.

For example, if you copy images into Adobe FrameMaker source documents, you do not have worry about
breaking the reference, or link, between the Adobe FrameMaker source documents and the image files. If you
import the image by reference into Adobe FrameMaker source documents, you must ensure that you keep
the same file structure for the image files in order to not break the references, or links, between the Adobe
FrameMaker source document and the image file.

However, importing images by reference in Adobe FrameMaker source documents, rather than copying images
into the source documents, provides the following benefits:

You can update image files without recopying the image into your Adobe FrameMaker source documents.

If you have one image used in multiple places, you can update the image in one place, rather than recopying
the image into multiple places.

You can manage your documentation files and image files separately, which makes organizing images
easier.

Source documents with images imported by reference in Adobe FrameMaker are smaller than source
documents with copied images.

When you work with Adobe FrameMaker source documents that you will use to generate output, ensure you
follow the guidelines specified by the Stationery designer for the following items:

Method used to insert images

Correct DPI to use for inserted images

Correct image file format to use for inserted images

For more information about image considerations, see the ePublisher Design Guide.
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Inserting Images in FrameMaker
Before you insert images into Adobe FrameMaker source documents you plan to use to generate output, review
image considerations. For more information, see “Working with Images in FrameMaker”.

When you insert images into Adobe FrameMaker source documents, insert the image into an anchored frame. The
anchored frame allows you to specify the image alignment and position. For more information about anchored
frame options, see the Adobe FrameMaker documentation.

The following procedure provides an example of how to use an anchored frame to insert an image by reference in
an unstructured Adobe FrameMaker source document using Adobe FrameMaker 7.2. Steps for inserting an image
by reference in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To insert an image in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, insert your cursor on a blank line below the paragraph where
you want to insert your image.

Note: Inserting an image on a blank line allows you to customize the paragraph tag applied to the line.
Many Adobe FrameMaker templates have a special paragraph tag for you to use when you insert
graphics. This paragraph tag specifies the space above and below the paragraph and the alignment of
the inserted image.

2. Apply the appropriate paragraph format for images to the blank anchored frame line. For more information
about the correct paragraph format to use for image anchored frame lines, consult with the Stationery
designer.

3. On the Special menu, click Anchored Frame.

4. Specify the position, alignment, and size of the anchored frame, and then click New Frame. Adobe
FrameMaker inserts an empty anchored frame into the source document.

For more information about anchored frame options, see the Adobe FrameMaker documentation.

5. On the File menu, click Import > File.

6. Click OK to continue.

7. Browse to the location of the file you want to import and select the file.

8. Click Import by Reference, and then click Import.

9. Specify the size of the graphic.

Note: Most writers do not select the Fit in Selected Rectangle option. This option resizes the image to fit
inside the selected anchor or graphic frame. When you select this option, Adobe FrameMaker sets
the DPI to unknown, and the imported image is usually distorted.

If you want to use the DPI from the graphic, do not change the setting in the Custom dpi field. The
number in the Custom dpi field is the DPI of the imported graphic.

If you want to change the size of the graphic, click the button for the dpi setting you want to
specify.

Note: If you do not use the same DPI setting as the source image, the image in your output may be
distorted.

10. Click Set. Adobe FrameMaker imports the image into the source document.
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11. If you have white space between the graphic and the anchored frame, you can shrink-wrap the frame by
completing the following steps:

Shrinking-wrapping an anchored frame removes the white space between the graphic and the anchored
frame and changes the anchoring position of the frame to At Insertion Point and displays the frame 0
points above the baseline of the text. If the anchored frame is on the same line as the text, the 0 point
baseline can cause the image to cover the text of the preceding lines. For this reason, many writers prefer
to insert images on a separate line below the text. The image may also be distorted if you don’t shrink wrap
the image.

a. Click the anchored frame or the image in the anchored frame.

b. Press ESC+M+P. Adobe FrameMaker shrinks or expands the anchored frame to fit the contents of the
anchored frame and positions the anchored frame according to the paragraph pagination settings.

After you insert an image, you can assign alternate text or a long description to the image. For more information,
see “Assigning Alternate Text to Images and Image Maps in FrameMaker” and “Assigning Long Descriptions to
Images in FrameMaker”.
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Creating Image Links in FrameMaker
You can create image links that allow users who click the image to link to content in another location. For
example, if you include your company logo in a source document, you can define a link for the logo so that when
users click the logo, they link to your company home page.

The following procedure provides an example of how to create an image link in Adobe FrameMaker source
documents using Adobe FrameMaker 7.2. Steps for creating an image link in Adobe FrameMaker may be
different in other versions of Adobe FrameMaker.

To create an image link in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, insert the image for which you want to create an image link.
For more information, see “Inserting Images in FrameMaker”.

2. If you want to link to content in a different location in your source document, create a named destination
for the link by completing the following steps:

Note: You do not need to perform these steps if you want to link to content on a Web site.

a. Locate the link target in your source document.

b. On the Special menu, click Marker.

c. In the Marker Type field, click Hypertext.

d. In the Marker Text field, newlink linkname or newlink filename:linkname, where linkname is
the name of the named destination for the link, and filename is the name of the file that contains the
link, if the link is in a different Adobe FrameMaker source document.

Note: To make maintenance easy, create short link names that use alphanumeric, lowercase
characters.

e. Click New Marker.

3. In the anchored frame that contains the image for which you want to create a link, draw a text frame that
covers the entire clickable region by completing the following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Text Frame icon.

c. Drag the cursor across the image to draw a text frame over the image.

d. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

e. Click outside of the image, and then insert your cursor in the text frame.

4. In the text frame, insert a Hypertext marker that specifies the destination of the link by completing the
following steps:

a. On the Special menu, click Marker.

b. In the Marker Type field, select Hypertext from the list.

c. If you want link to content in a different location in your source document, use the named
destination link you created in step 2. In the Marker Text field, type gotolink linkname or
gotolink filename:linkname, where linkname is the name of a link target you created previously,
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and filename is the name of the file that contains the link, if the link is in a different Adobe
FrameMaker source document.

d. If you want to link to a page on a Web site, in the Marker Field, type message URL web address,
where web address is the URL of the web page you want to open when users click the image.

Note: For more information about using the gotolink and message URL commands, see the Adobe
FrameMaker documentation.

e. Click New Marker.

5. Save your Adobe FrameMaker source document.

6. Generate output for your project. For more information, see “Generating Output”.

7. In Output Explorer, verify ePublisher created the image link using the link information you specified on
the page by clicking on the image. For more information about viewing output files in Output Explorer, see
“Viewing Output in Output Explorer”.
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Creating Clickable Regions for Image Maps in FrameMaker
An image map can be a single image separated with clickable regions or a composite image made up of multiple
images grouped together, yet still separated with clickable regions. For example, you could create an image of
the countries of Europe and then define an image map for the image that allows users to link to a topic about each
country when they click on an area of the image. User can click France to see information about France, Italy to
see information about Italy, and so on.

When you define an image map, you can also define alternate text for each clickable region. For example,
you might define alternate text for the Italy region as “Click here for more information about Italy.” For more
information about assigning alternate text to image maps, see “Assigning Alternate Text to Images and Image
Maps in FrameMaker”.
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Creating Image Maps for Single Images in FrameMaker
You create image maps for single images in Adobe FrameMaker source documents using text frames and
hyperlinks. In Adobe FrameMaker, a hyperlink consists of a link and a link target, or named destination. A named
destination is a unique identifier for a location in the document.

You can also create an image map for a composite image in an Adobe FrameMaker source document. For more
information about creating composite images, see “Creating Image Maps for Composite Images in FrameMaker”.

The following procedure provides an example of how to create an image map for a single image in Adobe
FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for creating an image map for a
single image in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To create an image map for a single image in an Adobe FrameMaker source document:

1. In your Adobe FrameMaker source document, insert the image you want to use for you image map into an
anchored frame. For more information, see “Inserting Images in FrameMaker”.

2. If you want to link to content in a different location in your source document, create a named destination
for the link for each area of the image map by completing the following steps:

Note: You do not need to perform these steps if you want to link to content on a Web site.

a. Locate the link target in your source document.

b. On the Special menu, click Marker.

c. In the Marker Type field, click Hypertext.

d. In the Marker Text field, newlink linkname or newlink filename:linkname, where linkname is
the name of the named destination for the link, and filename is the name of the file that contains the
link, if the link is in a different Adobe FrameMaker source document.

Note: To make maintenance easy, create short link names that use alphanumeric, lowercase
characters.

e. Click New Marker.

3. In the anchored frame that contains the image for which you want to create an image map, draw a text
frame that covers each region of the image where you want users to be able to click by completing the
following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Text Frame icon.

c. Drag the cursor over the portion of the image for which you want to create a clickable area.

d. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

4. In the text frame, insert a Hypertext marker that specifies the destination for the clickable region by
completing the following steps:

a. Insert your cursor into the text frame.

b. On the Special menu, click New Marker.

c. If you want to link to content in a different location in your source document, use a named
destination link you created in step 2. In the Marker Text field, type gotolink linkname or
gotolink filename:linkname, where linkname is the name of a link target you created previously,
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and filename is the name of the file that contains the link, if the link is in a different Adobe
FrameMaker source document.

d. If you want to link to a page on a Web site, in the Marker Text field, type message URL web
address, where web address is the URL of the web page you want to open when users click the
image.

Note: For more information about using the these commands, see the Adobe FrameMaker
documentation.

e. Click New Marker.

5. Save your Adobe FrameMaker source document.

6. Generate output for your project. For more information, see “Generating Output”.

7. In Output Explorer, verify ePublisher created the image map using the link information you specified by
clicking on the page that contains the image map and then clicking on each area of the image where you
created a link. For more information about viewing output files in Output Explorer, see “Viewing Output in
Output Explorer”.
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Creating Image Maps for Composite Images in FrameMaker
You can create composite images by inserting the composite images into an anchored frame and then inserting
text frames that contain the link you want users to go to when they click an area of a composite image.

The following procedure provides an example of how to use Hotspots in Adobe FrameMaker to create image
maps for composite images in source documents.

To create an image map for a composite image using Hotspots in an Adobe FrameMaker source
document:

1. In your Adobe FrameMaker source document, insert each image you want to use for your image map into
an anchored frame. For more information, see “Inserting Images in FrameMaker”.

2. If you want to link to content in a different location in your source document, create a named destination
for the link for each area of the image map by completing the following steps:

Note: You do not need to perform these steps if you want to link to content on a Web site.

a. Locate the link target in your source document.

b. On the Special menu, click Marker.

c. In the Marker Type field, click Hypertext.

d. In the Marker Text field, newlink linkname or newlink filename:linkname, where linkname is
the name of the named destination for the link, and filename is the name of the file that contains the
link, if the link is in a different Adobe FrameMaker source document.

Note: To make maintenance easy, create short link names that use alphanumeric, lowercase
characters.

e. Click New Marker.

3. In the anchored frame that contains the image for which you want to create an image map, draw a text
frame that covers each region of the image where you want users to be able to click by completing the
following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Text Frame icon.

c. Drag the cursor over the portion of the image for which you want to create a clickable area.

d. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

4. For each text frame, set the Hotspot properties that specifies the destination for the clickable region and
optionally set its tooltip text by completing the following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Select Object icon.

c. Click on the text frame so that you can set its hotspot properties.

d. With the text frame selected, right-click and select Hotspot Properties... from the menu.
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e. If you want to link to content in a different location in your source document, under Destination
select the Document radio button. Then select either Current or the name of your target source
document. Then click the marker with the named destination you created previously in step 2.

f. If you want to link to a page on a Web site, under Destination select the URL radio button. Then
type the complete web address (including protocol such as http://) in the adjacent text box of the web
page you want to open when users click the image.

g. If you want tooltip text to be available in the output, under the Tooltip Text label, enter the text you
want to appear as the tooltip.

h. Click the Save button on the Hotspot dialog.

5. Save your Adobe FrameMaker source document.

6. Generate output for your project. For more information, see “Generating Output”.

7. In Output Explorer, verify ePublisher created the image map using the link information you specified by
clicking on the page that contains the image map and then clicking on each area of the image where you
created a link. For more information about viewing output files in Output Explorer, see “Viewing Output in
Output Explorer”.

If your version of Adobe FrameMaker does not provide for Hotspot properties, you can still create image maps
for composite images by following this alternate example of how to create image maps for composite images in
Adobe FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for creating image maps
for composite images in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To create an image map for a composite image in an Adobe FrameMaker source document using
hypertext markers:

1. In your Adobe FrameMaker source document, insert each image you want to use for your image map into
an anchored frame. For more information, see “Inserting Images in FrameMaker”.

2. If you want to link to content in a different location in your source document, create a named destination
for the link for each area of the image map by completing the following steps:

Note: You do not need to perform these steps if you want to link to content on a Web site.

a. Locate the link target in your source document.

b. On the Special menu, click Marker.

c. In the Marker Type field, click Hypertext.

d. In the Marker Text field, newlink linkname or newlink filename:linkname, where linkname is
the name of the named destination for the link, and filename is the name of the file that contains the
link, if the link is in a different Adobe FrameMaker source document.

Note: To make maintenance easy, create short link names that use alphanumeric, lowercase
characters.

e. Click New Marker.

3. In the anchored frame that contains the image for which you want to create an image map, draw a text
frame that covers each region of the image where you want users to be able to click by completing the
following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Text Frame icon.
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c. Drag the cursor over the portion of the image for which you want to create a clickable area.

d. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

4. In each text frame, insert a Hypertext marker that specifies the destination for the clickable region by
completing the following steps:

a. Insert your cursor into the text frame.

b. On the Special menu, click Marker.

c. If you want to link to content in a different location in your source document, use the named
destination link you created in step 2. In the Marker Text field, type gotolink linkname or
gotolink filename:linkname, where linkname is the name of a link target you created previously,
and filename is the name of the file that contains the link, if the link is in a different Adobe
FrameMaker source document.

d. If you want to link to a page on a Web site, in the Marker Text field, type message URL web
address, where web address is the URL of the web page you want to open when users click the
image.

Note: For more information about using the these commands, see the Adobe FrameMaker
documentation.

e. Click New Marker.

5. Save your Adobe FrameMaker source document.

6. Generate output for your project. For more information, see “Generating Output”.

7. In Output Explorer, verify ePublisher created the image map using the link information you specified by
clicking on the page that contains the image map and then clicking on each area of the image where you
created a link. For more information about viewing output files in Output Explorer, see “Viewing Output in
Output Explorer”.
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Assigning Image Scales in FrameMaker
When ePublisher converts images inserted into your source documents, it can scale images to make them display
larger or smaller in your generated output. By default, ePublisher uses the scaling factor applied to images as
specified by the image format you apply to each image. For example, if you apply an image format to images and
the Stationery designer defined the image format to scale images to 80% of their original size, all images that have
this image format applied to them will be scaled to 80% in the generated output.

Typically, using the standard scaling factor specified in the image format is sufficient. Occasionally, however you
may want to override the scaling factor for an individual image. For example, while most .gif images scale to
80%, you may have one large image that you want scaled to 60% in your generated output. You can manually
override the standard scaling factor specified in your Stationery for a specific image by using the GraphicScale
marker.

To assign a scale to a specific image, your Stationery and template must have the GraphicScale marker type
configured. Your output format must also support scaling by image. For more information about output formats
that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify image scaling for an image in Adobe
FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying image scaling for
an image in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To specify an image scale for an image in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the anchored frame for the image for which you want
to specify image scaling.

2. Right-click on the image anchor. Make sure this is the entire anchor, not just the graphic itself

3. Click on Object Properties and then click Object Attributes. Identify the GraphicScale according to the
box below. Assign the desired style name in the attribute value box.
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4. Click Add, then Set, and then Set. Adobe FrameMaker may prompt you to approve the change as the
operation cannot be undone

5. Save your Adobe FrameMaker source document.

6. Scan this document in ePublisher so that the GraphicScale marker will show up under “Marker Styles”.
This will configure the correct marker behavior for processing.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher created the image using the image scale you specified in the
GraphicScale marker by clicking on the page that contains the image for which you specified image
scaling. For more information about viewing output files in Output Explorer, see “Viewing Output in
Output Explorer”.



Assigning Image Styles in FrameMaker | 137

Assigning Image Styles in FrameMaker
Typically you do not need to specify an image style for images when you generate output. By default, each image
generated by ePublisher is associated with the default image style defined in the Stationery. However, if you want
to change the image style of one image or a small set of images, you can specify the image style you want to use
for an image in your source document using the GraphicStyle marker type.

For example, if you want to specify a yellow border around a set of screen shot images that illustrate a particular
piece of product functionality, you can specify that each of the screen shots images in the set have a yellow border
around them through the use of the GraphicStyle marker type.

To assign a style to a specific image, your Stationery and FrameMaker template must have the GraphicStyle
marker type configured. Your output format must also support specifying image styles. For more information
about output formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify image styles for images in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying image styles for images in
Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To specify an image style for an image in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the anchored frame for the image for which you want
to specify an image style.

2. Right-click on the image anchor. Make sure this is the entire anchor, not just the graphic itself

3. Click on Object Properties and then click Object Attributes. Identify the GraphicStyle according to the
box below. Assign the desired style name in the attribute value box.
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4. Click Add, then Set, and then Set. Adobe FrameMaker may prompt you to approve the change as the
operation cannot be undone

5. Save your Adobe FrameMaker source document.

6. Scan this document in ePublisher so that the GraphicStyle marker will show up under “Graphic Styles”

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher created the image using the image style you specified by clicking on
the page that contains the image for which you specified an image style and verifying ePublisher applied
the image style you specified in the generated output. For more information about viewing output files in
Output Explorer, see “Viewing Output in Output Explorer”.
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Creating Index Entries in FrameMaker
An index lists the terms and topics discussed in a document and the page or pages on which they appear. An
online index provides the user with a point-and-click resource for quickly navigating online content.

ePublisher uses the same native index entry features used in source documents to create a printed index to create
an online index. If you include index entries in your source documents, ePublisher detects the index entries and
uses the index entries to create an online index in your generated output.

Adobe FrameMaker inserts index entries as Index markers. To create index entries in an Adobe FrameMaker
source document, insert Index markers into your Adobe FrameMaker source document. ePublisher then uses the
Index markers to create an online index when you generate output.

Before you insert index entries, verify with the Stationery designer that your Stationery is configured to support
online index generation. By default, ePublisher enables online index generate for output, but this functionality can
be disabled in your Stationery by the Stationery designer. Also confirm that your output format supports online
index creation. For more information about output formats that support this feature, see “Features Available in
Each Output Format”.

Talk with the Stationery designer and other writers about the standard location and method you should use when
you insert Index markers into your Adobe FrameMaker source documents. For example, some writers prefer to
insert index entries into topic headings, while other writers prefer to insert index entries on the first line of the
paragraph that contains the indexed term or terms. Some writers prefer to create one Index marker for each term,
while other writers prefer to create one Index marker and then type all index terms associated with a paragraph
into one Index marker.

The following procedure provides an example of how to inset index entries in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for inserting index entries in Adobe FrameMaker
may be different in other versions of Adobe FrameMaker.

To insert an index entry in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, insert your cursor in the location where you want to create
an index entry.

2. On the Special menu, click Marker.

3. In the Marker Type field, select Index from the drop-down list.

4. In the Marker Text field, type the text you want to specify for the index entry.

Note: Following are some common ways writers can create index entries in Adobe FrameMaker. For more
information about creating index entries, see the Adobe FrameMaker Help.

If you want to specify multiple index entries in the marker, separate each index entry with a
semicolon (;) character.

For example, type index; table of contents; headings; footers

If you want to create a subentry, separate the primary and secondary entry with a colon (:).

For example, type index:creating; index:generating;

If you want to create See references, insert the entry but use the <$nopage> command to suppress
the page number.
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For example, type document, See source document <$nopage>

If you want to create see references with the word See italicized, use a character tag inside the Index
marker and the <Default Para Font> tag to turn off the character tagging.

For example, type document, <Emphasis>See <Default Para Font>source documents<
$nopage>

If you want to create See also references, use alternate text that specifies how Adobe FrameMaker
sorts the see also reference.

For example, type document, <Emphasis>See also<Default Para Font>source documents<
$nopage>[document:aa]

The text in brackets at the end of the entry controls where Adobe FrameMaker displays the text
in the entry. In this example, the aa text ensures Adobe FrameMaker displays the entry as the first
subentry under document.

5. Click New Marker.

6. After you insert you index entries, save your Adobe FrameMaker source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher created the index correctly by clicking on the page or tab that displays
the index and then clicking on the index entries. For more information about viewing output files in Output
Explorer, see “Viewing Output in Output Explorer”.



Using Variables in FrameMaker | 141

Using Variables in FrameMaker
A variable serves as a placeholder for information that may change frequently. Using variables in source
documents allows you to quickly and easily control the content in your generated output. When you change the
value of a variable in an ePublisher project, it changes the value in only your generated output. The variable value
does not change in your source document.

Once you insert variables into your source documents, whenever the value of a item defined by a variable needs to
change, you can make the change in a single location, rather than searching and replacing for all instances of the
item. For example, you can use variables in the following ways:

If you have publication dates or release dates in your source documents that you need to update
periodically, you can set up the date as a variable.

If you work with products that have names or versions that frequently change, you can set up variables for
product names and versions.

If you need to produce documentation sets for a product with multiple brands, you can use variables to help
you produce documentation for each different brand using the same set of source files.
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Importing or Creating Variables in FrameMaker
When you work with Adobe FrameMaker source documents, typically you import variables into your Adobe
FrameMaker source documents from an Adobe FrameMaker template. The Adobe FrameMaker template contains
variables defined by the Stationery designer.

Typically you should not need to create variables in your Adobe FrameMaker source files if you use an Adobe
FrameMaker template created by a Stationery designer. However, in some cases you may need to create a variable
in an Adobe FrameMaker source document if you do not have an Adobe FrameMaker template that includes a
variable you need for your project.

The following procedure provides an example of how to import or create variables in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for importing or creating variables in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To import variables or create a variable in an Adobe FrameMaker source document

1. Open your Adobe FrameMaker source file.

2. If you want to import variables into your Adobe FrameMaker source file from an Adobe FrameMaker
template, complete the following steps:

a. Open the Adobe FrameMaker template that contains the variables you want to import.

b. On the File menu, click Import > Formats.

c. In the Import from Document field, select the Adobe FrameMaker template that contains the
variables you want to import from the list.

d. In the Import and Update field, select only the Variable Definitions check box.

e. Click Import.

f. Click OK to confirm the operation.

3. If you want to create a variable in your Adobe FrameMaker source file, complete the following steps:

a. On the Special menu, click Variables.

b. Click Create Variable.

c. In the Name field, type a name for the variable. Variable names are case sensitive. For example,
VariableName and variablename are different variables.

d. Insert your cursor in the Definition field.

e. In the Character Formats field, select a character format for the variable and then type a value for
the variable. For more information about specifying character formats for variables, see the Adobe
FrameMaker Help.

f. Click Add. Adobe FrameMaker adds the variable to the list of variables. The variable is the value
that Adobe FrameMaker displays in your Adobe FrameMaker source document.

g. Click Done.

4. Save your Adobe FrameMaker source file.
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Inserting Variables into FrameMaker
You can insert a variable into a source document after you import the variables into your source document. If
you want to use a variable that is not defined in an Adobe FrameMaker template, you must create the variable in
your source document before you can insert it. For more information about importing or creating variables, see
“Importing or Creating Variables in FrameMaker”.

The following procedure provides an example of how to insert variables in Adobe FrameMaker source documents
using unstructured Adobe FrameMaker 7.2. Steps for inserting variables in Adobe FrameMaker may be different
in other versions of Adobe FrameMaker.

To insert a variable into an Adobe FrameMaker source document

1. Open the Adobe FrameMaker source document into which you want to insert a variable.

2. Place your cursor in the location where you want to insert the variable.

3. On the Special menu, click Variable.

4. In the Variable field, select the variable you want to insert from the list, and then click Insert. Adobe
FrameMaker inserts the variable.
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Changing Variable Values in FrameMaker
You can change the value assigned to a variable in an Adobe FrameMaker source document.

The following procedure provides an example of how to change variable values in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for changing variable values in Adobe FrameMaker
may be different in other versions of Adobe FrameMaker.

To change a variable value in an Adobe FrameMaker source document

1. Open the Adobe FrameMaker source document that contains the variable with a value you want to change.

2. On the Special menu, click Variable.

3. In the Variable field, select the variable with the value you want to change.

4. Click Edit Definition.

5. In the Definition field, edit the variable value.

6. Click Done. Adobe FrameMaker updates the variable value in each place in your source document where
you inserted the variable.

7. Click Done again to close the window.
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Deleting Variables in FrameMaker
Delete a variable in an Adobe FrameMaker source document when you no longer want to use the variable. Before
you delete a variable, ensure you search for the variable and delete or replace all references to the variable. If your
source document still contains a reference to a variable after you delete it, Adobe FrameMaker prompts you to
convert references to the variable in your source document to editable text.

The following procedure provides an example of how to delete variables in Adobe FrameMaker source documents
using unstructured Adobe FrameMaker 7.2. Steps for deleting variables in Adobe FrameMaker may be different
in other versions of Adobe FrameMaker.

To delete a variable in an Adobe FrameMaker source document

1. Open the Adobe FrameMaker source document that contains the variable you want to edit.

2. Search for and replace all references to the variable you want to delete in the source document by
completing the following steps:

a. On the Edit menu, click Find/Change.

b. In the Find field, select Variable of Name from the list.

c. In the field next to the Find field, type the name of the variable you want to delete.

d. Click Find.

e. Delete each variable you find or replace the variable with a different variable as appropriate.

3. On the Special menu, click Variable.

4. In the Variable field, select the variable you want to delete.

5. Click Edit Definition.

6. In the User Variables field, ensure the variable you want to delete is selected, and then click Delete.

7. Click Done.

8. Click OK to confirm the operation.
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Using Conditions in FrameMaker
Conditions allow you to show or hide information in your source documents and in your online output. You apply
conditions to the content in your source documents, and then you set the visibility for those conditions either in
your source documents or in your ePublisher project.

For example, your source documents might contain some content that should be displayed in only the printed
version and other content that should be displayed in only the online version. You can use the same set of source
documents for both printed and online versions through the use of conditions. You can create one condition
called PrintOnly specifically for printed content, and then you can create another condition called OnlineOnly
specifically for online content. After you create the PrintOnly and OnlineOnly conditions, you can apply them to
the appropriate content in your source documents.

After you apply conditions in your source documents, ePublisher can use the conditions defined in your source
document to control the visibility of content when it generates output. You can also change the visibility specified
for any condition in your ePublisher project. Changing the visibility specified for any condition in your ePublisher
project does not change the visibility specified for the condition in your source documents.
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Creating Conditions in FrameMaker
When you work with Adobe FrameMaker source documents, typically you import conditions into your Adobe
FrameMaker source documents from an Adobe FrameMaker template. The Adobe FrameMaker template contains
conditions defined by the Stationery designer.

Typically you should not need to create conditions in your Adobe FrameMaker source files if you use an Adobe
FrameMaker template created by a Stationery designer. However, in some cases you may need to create a
condition in your Adobe FrameMaker source documents if you do not have an Adobe FrameMaker template that
includes a condition you need for a project. If you need to create a condition that is not available in your Adobe
FrameMaker template, use native Adobe FrameMaker functionality to create the condition.

The following procedure provides an example of how to create conditions in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for creating conditions in Adobe FrameMaker may
be different in other versions of Adobe FrameMaker.

To create a condition in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, on the Special menu, click Conditional Text.

2. Click Edit Condition Tag.

3. In the Tag field, type a name for the condition.

For example, if you want to create a condition for content that you want to display in only online content,
type OnlineOnly. If you want to create a condition for content that you want to display in only printed
content, type PrintOnly.

4. If you want to specify a style for the condition, in the Style field, select the style you want to use for the
condition from the drop-down list. Specifying a style for the condition allows you to more easily see the
content tagged with the condition in your Adobe FrameMaker source documents. If you do not want to use
a style for the condition, select As Is.

5. If you want to specify a color for the condition, in the Color field, select a color for the condition from
the drop-down list. Specifying a color for the condition allows you to more easily see the content tagged
with the condition in your Adobe FrameMaker source documents. If you do not want to use a color for the
condition, select As Is.

6. Click the Set to create the condition.
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Applying Conditions in FrameMaker
After you have imported conditions from your Adobe FrameMaker template or created conditions in your
Adobe FrameMaker source document, you can apply conditions to content in your Adobe FrameMaker source
documents. For more information about creating conditions in Adobe FrameMaker source documents, see
“Creating Conditions in FrameMaker”.

The following procedure provides an example of how to apply conditions in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for applying conditions in Adobe FrameMaker may
be different in other versions of Adobe FrameMaker.

To apply a condition to content in an Adobe FrameMaker source document

1. In your Adobe Framemaker source document, select the content to which you want to apply the condition.

2. On the Special menu, click Conditional Text.

3. In the Not In list, select the condition you want to apply to the content.

4. Click the left arrow to move the condition from the Not In list to the In list.

5. Click Apply button to apply the condition.
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Removing Conditions in FrameMaker
If you no longer want to apply a condition to content in an Adobe FrameMaker source document, you can remove
the applied condition from the content.

The following procedure provides an example of how to remove conditions from content in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for removing conditions from content in
Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To remove a condition from content in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, select the content with the condition you want to remove.

2. On the Special menu, click Conditional Text.

3. Click Unconditional.

4. Click Apply.
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Modifying Conditions in FrameMaker
You can edit the name of a condition and change the color or style assigned to a condition in an Adobe
FrameMaker source document.

The following procedure provides an example of modify conditions in Adobe FrameMaker source documents
using unstructured Adobe FrameMaker 7.2. Steps for modifying conditions in Adobe FrameMaker may be
different in other versions of Adobe FrameMaker.

To modify a condition in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, on the Special menu, click Conditional Text.

2. Select the condition you want to modify.

3. Click Edit Condition Tag.

4. If you want to modify the name of the condition, in the Tag field, type the new name for the condition.

5. If you want to modify the style specified for the condition, in the Style field, select the style you want to
apply to the condition from the drop-down list. If you do not want to use a style, select As Is.

6. If you want to modify the color specified for the condition, in the Color field, select a color for the
condition from the drop-down list. If you do not want to use a color, select As Is

7. Click Set to modify the condition.
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Showing and Hiding Conditions in FrameMaker
You can show and hide conditions you applied in your Adobe FrameMaker source document. You can also show
all of the conditions you applied in your Adobe FrameMaker source document. Showing all of the conditions
applied allows you to see where all of the conditional content is in your Adobe FrameMaker source document.

The following procedure provides an example of how to show and hide conditions in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for showing and hiding conditions in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To show and hide conditions in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, on the Special menu, click Conditional Text.

2. Click Show/Hide.

3. If you want to show all conditions, click Show All. Showing all conditions is helpful when you are
working with a document and you want to be sure you can see all of the content in the document.

4. If you want to show a specific condition, select it, and then click the left arrow to move it to the Show list
on the left.

5. If you want to hide a specific condition, select it, and then click the right arrow to move it to the Hide list
on the right.

6. Click Set.
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Using Passthrough Conditions in FrameMaker
A passthrough condition is a condition you apply to content that you do not want ePublisher to process when you
generate output. For example, if you have embedded multimedia files in your source documents, such as Audio
Video Interleave files (.avi) or Adobe Software Flash files (.swf), you can apply a passthrough condition to the
code so that ePublisher does not process the code.

The following example shows .avi code to which you can apply a passthrough condition.

<embed src="sample.avi" width="400"

height="300" pluginspage=";>

</embed>

The following example shows .swf code to which you can apply a passthrough condition.

<embed src="sample.swf" width="400"

height="300" pluginspage="

http://www.macromedia.com/shockwave/download/index.cgi?
P1_Prod_Version=ShockwaveFlash";>

</embed>

If you have code in your Adobe FrameMaker source documents that you do not want ePublisher to process, create
a passthrough condition and then apply the passthrough condition to the code.

Typically you use a passthrough condition defined in an Adobe FrameMaker template by a Stationery designer.
You import this condition into your Adobe FrameMaker source document from an Adobe FrameMaker template.
After you import the passthrough condition into your source document from the template, you apply the
passthrough condition to the content as appropriate.

Typically you should not need to create a passthrough condition in your Adobe FrameMaker source file if you
use an Adobe FrameMaker template created by a Stationery designer. However, in some cases you may need
to create a passthrough condition in your Adobe FrameMaker source document if you do not have an Adobe
FrameMaker template that includes a passthrough condition you need for a project. If you need to create a
passthrough condition that is not available in your Adobe FrameMaker template, use native Adobe FrameMaker
functionality to create the condition. For more information about creating a condition and applying a condition,
see “Creating Conditions in FrameMaker” and “Removing Conditions in FrameMaker”.

You can also use Passthrough markers and the Passthrough paragraph styles and character styles options to insert
content directly into your output without being transformed and coded for your output.
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Deleting Conditions in FrameMaker
Delete a condition in an Adobe FrameMaker source document when you no longer want to apply the condition to
content in the source document.

The following procedure provides an example of how to delete conditions in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for deleting conditions in Adobe FrameMaker may
be different in other versions of Adobe FrameMaker.

To delete a condition in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, on the Special menu, click Conditional Text.

2. Select the condition you want to delete.

3. Click Edit Condition Tag.

4. Click Delete.
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Conditional Output Using Expressions in FrameMaker
Adobe FrameMaker 8.0 introduced ways to use Boolean Expressions (using the terms AND, OR, or Not) in
condional text, for exmaple WebHelp AND PDF. To do this, you first create the conditions, and then use the Build
Expression button to create this.

The following procedure provides an example of how to use Expressions in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 9. Steps for deleting conditions in Adobe FrameMaker may be
different in other versions of Adobe FrameMaker.

To build an Expression in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, on the Special menu, click Conditional Text -> Show/Hide
Conditional Text

2. Click button Build Expression

3. Click desired condition and the arrow button to add it to the Expression

4. Separate the conditions by clicking the buttons for “AND” “OR” or “NOT”

5. When finished select Set so that this Expression will be able to be selected in the Expression dropdown
located in the Show/Hide Conditional Text window

6. Go to Special -> Conditional Text -> Show/Hide Conditional Text and select the Show as per Expression
radio button

7. Select the desired text you want to apply the expression and hit Apply

8. Save your source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. In Output Explorer, verify ePublisher created an output file using the file name you specified. For more
information, see “Viewing Output in Output Explorer”.
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Specifying Output File Names in FrameMaker
By default, ePublisher automatically assigns file names to your generated output files for topics (pages) and for
embedded image (graphic) output files.

Note: If you insert your images by reference in Adobe FrameMaker, ePublisher preserves the original file names.
For more information, see “Working with Images in FrameMaker”.

You can customize this naming convention using one of the following methods:

Inserting Filename markers into your source documents

Specifying the topic (page) and image (graphic) naming patterns for ePublisher to use in the target settings
for your output

This section explains how you can specify output file names in your FrameMaker source documents using
Filename markers. For more information about using target settings to specify output file names using page and
image naming patterns, see “Specifying Page, Image, and Table File Naming Patterns”.

To specify a file name for a page or image output file using Filename markers, your Stationery and FrameMaker
template must have the Filename marker type configured. Your output format must also support this feature. For
more information about output formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify page and embedded image output file names
in Adobe FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying page
and embedded image output file names in Adobe FrameMaker may be different in other versions of Adobe
FrameMaker.

To specify page and embedded image output file names in an Adobe FrameMaker source
document

1. If you want to insert a Filename marker for a page output file, complete the following steps:

a. In your Adobe FrameMaker source document, locate the page for the topic to which you want
to assign a specific filename. For more information about creating pages using page breaks, see
“Specifying Page Breaks Settings”.

b. Insert your cursor at the beginning of the first paragraph on the page.

2. If you want to insert a Filename marker for an embedded image output file, complete the following steps:

a. In your Adobe FrameMaker source document, locate the embedded image for which you want to
assign the output graphic file.

b. On the Graphics menu, click Tools to display the graphic tools palette.

c. Click the Text Frame icon.

d. Drag the cursor across the image to draw a text frame over the image.

e. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

f. Click outside of the image, and then insert your cursor in the text frame.

3. In Adobe FrameMaker, on the Special menu, click Marker.

4. In the Marker Type field, select Filename from the drop-down list.
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5. If the Filename marker type is not on the list, check with the Stationery designer to obtain the name of
the marker type the Stationery designer created to support this functionality and then use the marker type
specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

6. In the Marker Text field, type the file name you want to assign to the output file. Do not include the output
file extension when you type the Filename marker text.

7. Click New Marker.

8. Save your source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. In Output Explorer, verify ePublisher created an output file using the file name you specified. For more
information, see “Viewing Output in Output Explorer”.
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Creating Context-Sensitive Help in FrameMaker
This section explains how you can use ePublisher to create links to context-sensitive help content in Adobe
FrameMaker source documents.
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Understanding Context-Sensitive Help in FrameMaker
Context-sensitive help links provide content based on the context of what the user is doing. In many cases, this
help content is based on the window that is open and active. For example, the Help button on a window in a
software product can open a specific Help topic that provides important information about the window:

What the window allows you to do

Brief concepts needed to understand the window

Guidance for how to use the window

Descriptions about each field on the window, valid values, and related fields

Links to related topics, such as concepts and tasks related to the window

The Help topic can also be embedded in the window itself, such as an HTML pane that displays the content of
the Help topic. Providing this content when and where the user needs it, without requiring the user to search
through the help, keeps the user productive and focused. This type of help also makes the product more intuitive
by providing answers when and where needed.

There are several methods for creating context-sensitive Help. In addition, output formats use different
mechanisms to support context-sensitive Help. You can reference a topic in the following ways:

File name
Use a Filename marker to assign a file name to a topic. Each topic can have no more than one Filename
marker by default. However, you can create a custom mapping mechanism using file names. Then, you can
open the specific topic with that file name. However, if your file naming changes, you need to change the
link to the topic. This file naming approach delivers context-sensitive help capabilities in output formats
that do not provide a mapping mechanism.

Internal identifier (topic alias)
Use a TopicAlias marker to define an internal identifier for each topic. The benefit of using an internal
identifier is that it allows file names to change without impacting the links from the product. The writer
inserts this marker in a topic and specifies a unique value for that topic. Then, the mapping mechanism
of your output format determines how that internal identifier is supported. Some output formats, such as
HTML Help, use a mapping file that defines these topic aliases.

To simplify the coding of your source documents, the Stationery designer can also configure your Stationery to
define both the file name and the topic alias for each topic file.

Before you begin to insert Filename markers or TopicAlias markers into your source documents, consult with
your Stationery designer. Confirm that your Stationery supports context-sensitive help links, and discuss with
your Stationery designer the type of marker you should use to define context-sensitive help link in your source
documents.

For more information about configuring Filename and TopicAlias markers for use in context-sensitive help, see
the ePublisher Design Guide.

If you generate Eclipse Help output, you also can choose the topic description you want to display for each
context-sensitive link. When you use a TopicAlias marker to create context-sensitive links, Eclipse creates a
contexts.xml file that lists all of the context IDs for the Eclipse Help system you created using TopicAlias
markers. In the contexts.xml file, Eclipse also provides a description of the context-sensitive link. By default,
the description Eclipse provides for the context-sensitive link is the text of the first paragraph of the topic.
However, if you want to specify a different description for the context-sensitive link, you can do this by using
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the TopicDescription marker. For more information about using the TopicDescription marker, see “Specifying
Context-Sensitive Help Links in FrameMaker”.
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Planning for Context-Sensitive Help in FrameMaker
Creating context-sensitive help requires you to collaborate with application developers. Because topic IDs and
map numbers must be embedded in both the software application and in your source documents, you and the
application developers must agree in advance on the values to use.

Before you create context-sensitive help topics, first confirm with your application developers that the application
supports context-sensitive help. Then work with your application developers to decide how to choose the topic ID
for each context-sensitive help topic:

You choose the topic IDs
You can choose a set of topic IDs and embed them in your source documents using TopicAlias markers.
When you generate output, ePublisher can generate a mapping file using those topic IDs and assign
a unique number to each topic ID. You can provide the generated mapping file to your application
developers, who can embed the topic IDs in the application code. You can then manually maintain
this mapping file, or you can allow ePublisher to generate a new file each time you generate the help.
Remember to give the updated help system and mapping file to your application developers each time.

Your developers choose the topic IDs
Your application developers can choose a set of topic IDs and embed them in the application code. Then,
you can get a copy of the mapping file from your application developers, specify this mapping file in your
project settings, and embed the topic IDs in your source documents using TopicAlias markers. In this case,
ePublisher does not generate the mapping file.

Before you begin to implement context-sensitive help, meet with your application developers to select one of
these methods for assigning the topic IDs to use for context-sensitive help links. Once you choose a set of topic
IDs, embed them in your source documents using TopicAlias markers and do not change them.
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Specifying Context-Sensitive Help Links in FrameMaker
You can use TopicAlias markers that contain topic IDs, or Filename markers that specify file names, to create
context-sensitive help. If your output format supports the use of mapping files and topic IDs, typically you use
TopicAlias markers to create context-sensitive help. If your output format does not support the use of mapping
files and topic IDs, typically you use Filename markers to create context-sensitive help.

If you are generating Eclipse Help, you can also choose to specify a topic description for each context-sensitive
help link your created using a TopicAlias marker by using a TopicDescription marker in conjunction with the
TopicAlias marker. For more information about how TopicAlias markers and TopicDescription markers can work
together when generating Eclipse Help, see “Understanding Context-Sensitive Help in FrameMaker”.

To specify a context-sensitive help link, your Stationery and template must have a TopicAlias or Filename
marker type configured. If you are generating Eclipse Help and you want to be able to specify topic descriptions
for your context-sensitive help links, your Stationery and template must also have a TopicDescription marker
type configured. Consult with the Stationery designer to determine which marker type you should use to create
context-sensitive help links and topic descriptions in your source documents. Your output format must also
support this feature. For more information about output formats that support this feature, see “Features Available
in Each Output Format”.

The following procedure provides an example of how to create context-sensitive help links and topic descriptions
in Adobe FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for creating context-
sensitive help links in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To create a context-sensitive help link in an Adobe FrameMaker source document

1. Open the Adobe FrameMaker source document that contains the context-sensitive topic you want to link to
when users click a help button or help icon from within an application.

2. Insert your cursor at the beginning of the topic or paragraph in which you want to link.

3. On the Special menu, click Marker.

4. In the Marker Type field, select the marker type the Stationery designer configured your Stationery to
support from the drop-down list. For example, select TopicAlias or Filename.

5. If the TopicAlias or Filename marker type is not on the list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

6. In the Marker Text field, type the topic ID or file name you want to use for the context-sensitive help link.
Specify topic IDs or file names that met the following guidelines:

Must be unique

Must begin with an alphabetical character

May contain alphanumeric characters

May not contain special characters or spaces, with the exception of underscores ( _ )

7. Click New Marker.

8. If you are generating Eclipse Help and you want to specify topic descriptions for each context-sensitive
help link you are creating, complete the following steps:
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a. Insert your cursor in the topic after the TopicAlias marker you inserted for the Eclipse context-
sensitive help topic.

b. On the Special menu, click Marker.

c. In the Marker Type field, select TopicDescription marker type from the drop-down list.

a. If the TopicDescription marker type is not on the list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use
the marker type specified by the Stationery designer. For more information, refer to “Implementing
Online Features in FrameMaker”.

b. In the Marker Text field, type the topic description you want to use.

c. Click New Marker.

9. Save your source Adobe FrameMaker source document.

10. Generate output for your project. For more information, see “Generating Output”.

11. In Output Explorer, complete the following steps:

a. Verify that ePublisher inserted the topic ID into the map file when it generated output.

b. If you generated Eclipse Help and specified topic descriptions for your context-sensitive help
topics, verify that the contents.xml file for your Eclipse Help system contains the topic descriptions
you specified for context-sensitive help topics.

c. Test the generated output using the application and verify that the application links to the appropriate
context-sensitive help topic. This testing ensures the context-sensitive help link you created displays
correctly within the application.
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Creating Popup Windows in FrameMaker
A popup window is a window that is smaller than standard windows and typically does not contain some of the
standard window features such as tool bars or status bars. Popup windows display when users hover over or click
on a link. The popup window closes automatically as soon as the users click somewhere else.

A typical use of popup windows is to display glossary terms. For example, in printed documentation, terms and
definitions are typically grouped in a separate glossary document. However, in online content, you can display
glossary definitions in popup windows. With glossary popup windows, users can choose whether or not they want
to view the definition of a term.

You create popup windows by creating a link between the word or phrase in a topic and the content you want to
display in the popup window. After you create the link, you then insert Popup markers or apply Popup paragraph
styles to define the content you want to display in the popup window.

If the Stationery designer configured the Stationery to support popup windows using markers, you use the
following Popup markers to create popup windows:

Popup
Specifies the start of the content to include in a popup window. The content displays in a popup window
when users hover over or click on the link. In some output formats users can also view the content in a
standard help topic window in addition to viewing the content in a popup window. For example, if you
insert a Popup marker in front of a glossary definition, the glossary definition displays in both a popup
window and in a glossary topic that contains the definition.

PopupEnd
Specifies the end of the content to display in the popup window.

PopupOnly
Specifies that the popup content displays only through a popup window. For example, if you insert a
PopupOnly marker in front of a glossary definition, the glossary definition displays only in a popup
window.

If the Stationery designer configured the Stationery to support popup windows using paragraph formats, you use
the following paragraph formats to create popup windows:

Popup and Popup Append paragraph behaviors
Specifies that content displays both in popup windows and in standard help topics. You apply the Popup
paragraph format to the first paragraph of content you want displayed in the popup window. If you have
more than one paragraph of content you want to display, you apply the Popup Append format to the
additional paragraphs.

For example, if you apply a glossary term and glossary definitions format for a glossary using the Popup
and Popup Append format, the terms and definitions in your output display in both a popup window and in
a glossary topic that contains the definitions.

Popup Only and Popup Only Append paragraph behaviors
Specifies that content displays only in popup windows. You apply the Popup Only paragraph format to the
first paragraph of content you want displayed in the popup window. If you have more than one paragraph of
content you want to display, you apply the Popup Only Append format to the additional paragraphs.
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For example, if you apply a glossary term and glossary definition format for a glossary using the Popup
Only and Popup Only Append paragraph format, the terms and definitions in your output display in only
popup windows. The content is not displayed in an additional glossary topic that contains the definitions.
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Checklist: Creating Popup Windows in FrameMaker
If you want to include popup windows in your generated output, prepare your Adobe FrameMaker source
documents using the following checklist.

Task For more information, see...

1. Create a link between a link between
a word or phrase and the content you
want to display in a popup window.

“Creating Popup Window Links in
FrameMaker”

2. If you want to implement popup
windows using Popup markers,
insert Popup markers into the
appropriate locations in your Adobe
FrameMaker source documents.

“Using Markers to Create Popup Windows
in FrameMaker”

3. If you want to implement popup
windows using paragraph formats,
apply the appropriate Popup paragraph
format to content in your Adobe
FrameMaker source documents.

“Using Paragraph Formats to Create Popup
Windows in FrameMaker”
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Creating Popup Window Links in FrameMaker
Your first step in creating a popup window is to create a link between a word or phrase in a topic and the popup
content you want to display when users hover over or click the link. Use native Adobe FrameMaker functionality
to create a link between the word or phrase in a topic and the content you want to display in a popup window. You
can create a link in Adobe FrameMaker by using a cross-reference or by using hypertext markers.

Before you create popup window links, verify that your output format supports this feature. For more information
about output formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to create a popup window link in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for creating links in Adobe FrameMaker may
be different in other versions of Adobe FrameMaker.

To create a link between a word or phrase and popup content in an Adobe FrameMaker source
document

1. In you Adobe FrameMaker source document, locate the text you want to create a link to and display in the
popup window.

2. If you want to create a link that includes the link target text, create the link using a cross-reference by
completing the following steps:

a. Select the text for which you want to create a link.

b. On the Special menu, click Cross-Reference.

c. In the Document field, select the document that contains the content to which you want to link.

d. In the Paragraph Tags field, select the paragraph tag used for the content to which you want to link.

e. In the Paragraphs field, select the paragraph to which you want to link.

f. In the Format field, select the appropriate format for the link. For example, if you are creating a link
to a glossary term, select a glossary term cross-reference format.

g. Click Replace.

3. If you want to create a link that does not include the link target text, create the link using a hypertext
marker by completing the following steps:

a. Insert your cursor in front of the link target text.

b. On the Special menu, click Marker.

c. In the Marker Type field, click Hypertext.

d. In the Marker Text field, newlink linkname or newlink filename:linkname, where linkname
is the name of the named destination for the link, and filename is the name of the file that contains
the link, if the link is in a different Adobe FrameMaker source document. To make maintenance easy,
create short link names that use alphanumeric, lowercase characters.

e. Click New Marker.

f. Insert your cursor in front of the word or phrase for which you want to create a link.

a. On the Special menu, click Marker.

b. In the Marker Type field, select Hypertext from the list.
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c. In the Marker Text field, type gotolink linkname or gotolink filename:linkname, where
linkname is the name of the named destination you created for the link, and filename is the name of
the file that contains the link, if the link is in a different Adobe FrameMaker source document.

d. Click New Marker.

e. Select the word or phrase for which you want to create a link. The selected area must contain the
both text and the hypertext marker you created.

f. Apply a link character format to the word or phrase. If you do not know which character format to
use for links, consult the Stationery designer.

4. Save your Adobe FrameMaker source document.

After you create a link between a word or phrase in a topic and the popup content you want to display in the
popup window, define the content you want to display in the popup window using one of the following methods:

Create popup windows using Popup markers. For more information, see “Using Markers to Create Popup
Windows in FrameMaker”.

Create popup windows using Popup paragraph formats. For more information, see “Using Paragraph
Formats to Create Popup Windows in FrameMaker”.
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Using Markers to Create Popup Windows in FrameMaker
You can insert Popup markers into your Adobe FrameMaker source documents to create popup windows. To use
Popup markers to create popup windows, your Stationery and FrameMaker template must have the following
items configured:

Popup marker type

PopupEnd marker type

PopupOnly marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to insert Popup markers in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for inserting Popup markers in Adobe FrameMaker
may be different in other versions of Adobe FrameMaker.

Note: Popup content is created from whole paragraphs. You cannot include a subset of a paragraph in a
popup.

To use popup markers to create popup windows in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, create a link between a word or phrase in the topic and the
content you want to display in the popup window. For more information, see “Creating Popup Window
Links in FrameMaker”.

2. Insert your cursor in front of the text you want to display in the popup window.

3. On the Special menu, click Marker.

4. If you want the popup content to display in both a popup window and in a standard help topic, in the
Marker Type field select Popup from the drop-down list.

5. If you want the popup content to display only in a popup window, in the Marker Type field select
PopupOnly from the drop-down list.

6. If the Popup or PopupOnly marker type is not on the list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

7. In the Marker Text field, do not enter any text. You do not need to enter any text in this field when you
insert a Popup or PopupOnly marker.

8. Click New Marker.

9. Specify where you want the popup content to end by completing the following steps:

a. Insert your cursor at the end of the content you want to display in the popup window.

b. On the Special menu, click Marker.

c. In the Marker Type field, select PopupEnd from the drop-down list.

d. If the PopupEnd marker type is not on the list, check with the Stationery designer to obtain the
name of the marker type the Stationery designer created to support this functionality and then use
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the marker type specified by the Stationery designer. For more information, refer to “Implementing
Online Features in FrameMaker”.

e. In the Marker Text field, do not enter any text. You do not need to enter any text in this field when
you insert a PopupEnd marker.

f. Click New Marker.

10. Save your Adobe FrameMaker source document.

11. Generate output for your project. For more information, see “Generating Output”.

12. In Output Explorer, go to the page where you created the popup window and verify that ePublisher created
the popup window and that the popup window displays the content you specified. For more information,
see “Viewing Output in Output Explorer”.
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Using Paragraph Formats to Create Popup Windows in FrameMaker
You can use Popup paragraph formats in your Adobe FrameMaker source documents to create popup windows.
To use Popup paragraph formats to create popup windows, your Stationery and FrameMaker template must have
the following items configured:

Popup and Popup Append paragraph formats if you want your content to display both in popup windows
and in standard help topics.

Popup Only and Popup Only Append paragraph formats if you want your content to display only in popup
windows.

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to use Popup paragraph formats to create popup windows
in Adobe FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for using Popup
paragraph formats to create popup windows in Adobe FrameMaker may be different in other versions of Adobe
FrameMaker.

To create popup windows using Popup paragraph formats in an Adobe FrameMaker source
document

1. In your Adobe FrameMaker source document, create a link between a word or phrase in the topic and the
content you want to display in the popup window. For more information, see “Creating Popup Window
Links in FrameMaker”.

2. Apply the appropriate Popup paragraph format to the popup content you want to display in the popup
window.

3. Save your Adobe FrameMaker source document.

4. Generate output for your project. For more information, see “Generating Output”.

5. In Output Explorer, go to the page where you created the popup window and verify that ePublisher created
the popup window and that the popup window displays the content you specified. For more information,
see “Viewing Output in Output Explorer”.
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Creating Expand/Collapse Sections (Drop-Down Hotspots) in
FrameMaker
You can create sections of content that expand and collapse when you click a link or hot spot. This structure
allows you to create items, such as tasks with numbered procedures, bulleted lists, or definitions, that are easy to
scan. Users can then expand individual items to display additional information.

Hot spots for expand/collapse sections initially display in one of the following states:

The content is initially collapsed and will expand beneath the hotspot when the user clicks the hotspot.
Clicking the hotspot a second time causes the expanded content to return to its original collapsed state.

The content is initially expanded and will collapse or disappear from beneath the hotspot when the user
clicks the hotspot.

You use an Expand/Collapse paragraph or table format to start expand/collapse sections and a DropDownEnd
marker to specify where the content in the expand/collapse section ends. The Stationery defines whether the
sections should initially be expanded (shown) or collapsed (hidden) and the image used to show the state of the
section.

To create expand/collapse sections, your Stationery and FrameMaker template must have the following items
configured:

An Expand/Collapse paragraph or table format

A DropDownEnd marker

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to create expand/collapse sections in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for creating expand/collapse sections in
Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To create an expand/collapse section in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, identify a topic that contains text for which you want to
create an expand/collapse section.

2. Apply an Expand/Collapse paragraph format to the text you want users to click to expand or collapse
content.

For example, in the following sample procedure, you could apply the Expand/Collapse paragraph format to
the To open a project text.

To open a project

a. On the File menu, click Open.

b. Browse to the location of the project on your local computer.

c. Select the project, and then click Open.

3. Insert your cursor at the end of the content you want to display in the expand/collapse section.
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For example, in the following sample procedure, you would insert your cursor after the period in the last
sentence of the procedure, Select the project, and then click Open.

To open a project

a. On the File menu, click Open.

b. Browse to the location of the project on your local computer.

c. Select the project, and then click Open.

4. On the Special menu, click Marker.

5. In the Marker Type field, select DropDownEnd from the drop-down list.

6. If the DropDownEnd marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

7. In the Marker Text field, do not enter any text. You do not need to enter any text in this field when you
insert a DropDownEnd marker.

8. Click New Marker.

9. Save your Adobe FrameMaker source document.

10. Generate output for your project. For more information, see “Generating Output”.

11. In Output Explorer, go to the page where you created the expand/collapse section and verify that ePublisher
created the expand/collapse section and that the expand/collapse section displays the content you specified.
For more information, see “Viewing Output in Output Explorer”.
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Creating Related Topics in FrameMaker
Related topics provide a list of other topics that may be of interest to the user viewing the current topic. For
example, you could have a section called Creating Web Pages in your help. You may also have many other topics,
such as HTML Tags and Cascading Style Sheets, that related to creating Web pages. Identifying these related
topics for users can help them find the information they need and identify additional topics to consider. However,
providing these types of links as cross-references within the content itself may not be the most efficient way to
present the information. By utilizing related topics links, you combine the capabilities of cross-references with the
efficiency of a related topics button.

Related topics and See Also links provide similar capabilities, but there are several important differences:

Related topics can link to headings in a Help system that do not start a new page.

Relate topics links are static and defined in the source documents as links. You must have all the source
documents to create the link and generate the output.

If a related topics list contains a broken link in the source document, that link is broken in the generated
output. In a See Also link list, the broken link is not included in the output.

The Stationery designer can configure related topics to display in the following ways:

Included as a list in the topic itself.

Displayed in a popup window when the user clicks a button, as show in the following figure.
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Note: If a related topic link is broken in the source document, in most cases that link is broken in the generated
output. WebWorks Help and WebWorks Reverb provide an additional feature by removing broken links
from related topics lists that are displayed in a popup window when a user clicks the Related Topics button.

 

To create related topics links, your Stationery and FrameMaker template must have a Related Topics paragraph
style configured. Your output format must also support this feature. For more information about output formats
that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to create related topics links in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for creating related topics links in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To create a related topics list in an Adobe FrameMaker source document

1. Identify the topic in which you would like to insert a related topics list.

2. Identify the different topics you want to link to from this topic.

Note: Generally, you should only create one related topics list for each section of your source document
that corresponds to a help topic. For example, if the Stationery designer specified in your Stationery
that there will be a page break at each Heading 1 section, then you should only create one related
topics list for each Heading 1 section within your source document.

3. Create a cross-reference to each topic you want to include in the related topics list by completing the
following steps:

a. Insert your cursor in the location in your Adobe FrameMaker source document where you want to
insert the link to the related topic.

b. On the Special menu, click Cross-Reference.

c. In the Document field, select the source document that contains the topic to which you want to link.

d. In the Source Type field, click Paragraphs.

e. In the Paragraph Tags field click the paragraph tag used by the topic to which you want to link.

f. In the Paragraphs field, select the topic to which you want to link.

g. In the Format field, select the format you want to use for the cross-reference.

h. Click Insert.

4. Apply the Related Topic paragraph format to the cross-references in your related topics list.

5. If you want to display the list of related topics in only your generated output, apply an OnlineOnly
condition to the list of related topics. For more information about applying conditions, refer to “Applying
Conditions in FrameMaker”.

6. Save your Adobe FrameMaker source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, go to the page where you created the related topics list and verify that ePublisher
created the related topics and that the related topics list displays the topics you specified. For more
information, see “Viewing Output in Output Explorer”.
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Specifying Wiki Categories or Labels in FrameMaker
On Wikis, categories, which are referred to as labels in some Wiki formats, are used to organize Wiki content.
Categories help group together pages that have similar subjects.

Note: MoinMoin and Media Wiki use the term category to describe page grouping functionality. Confluence uses
the term label to describe page grouping functionality.

Pages are assigned to category groups through the use of category or label tags. When you assign a category or
label tag to a Wiki page, the category to which the Wiki page belongs displays in a box at the bottom of the page.

Category and label tags on Wiki pages allow categorized pages to automatically be added to a list on a category
page on the Wiki. The category page lists all of the Wiki pages tagged for a certain category. For example, if
you tag each page on a Wiki that contains licensing information with a Licensing category tag, then a licensing
category page on the Wiki can display a list of all of the pages tagged as containing licensing information.

The following procedure provides an example of how to specify categories for Wiki pages in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying categories in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To specify a Wiki category or label for a topic in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, find the first paragraph on the page for the page for which
you want to specify a category or label.

2. Insert your cursor into the paragraph.

3. On the Special menu, click Marker.

4. In the Marker Type field, select WikiCategory from the drop-down list.

5. If the WikiCategory marker type is not on the drop-down list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

6. In the Marker Text field, type the category or list of categories you want to specify for the page. If you
want to specify more than one category for a page, separate each category with a comma (,).

For example, if you want to specify one category for the page, type category1. If you want to specify
multiple categories for the page, type category1, category2, category3, where category is the
category you want to specify for the page.

Note: Each Wiki target handles white space in it own way. For example, MoinMoin removes white space in
category names, so if you specify Licensing Considerations as a category in a WikiCategory marker,
in MoinMoin output the category will display as LicensingConsiderations.

7. Click New Marker.

8. Save your Adobe FrameMaker source document.

9. Generate output for your Wiki target. For more information, see “Generating Output”.

10. Deploy the Wiki output files to a Wiki server. For more information, see “Deploying Output to Output
Destinations”.
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Note: You must deploy generated Wiki content to a Wiki server before you can view the Wiki content.

11. Verify that your Wiki pages display the categories or labels you specified at the bottom of the pages.
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Creating See Also Links in FrameMaker
See Also links, also known as ALinks, or associative links, are links that may be of interest to the user viewing the
current topic. These links use internal identifiers to specify the links and the link list is built dynamically based on
the topics available when the user clicks to display the links. See Also links are important to use with larger help
sets and merged help sets.

Related topics and See Also links provide similar capabilities, but there are several important differences:

See Also links must link to formats that start a new topic, such as a heading.

See Also links are dynamic and the lists of links are built at display time instead of during help generation.

Since see Also link lists are dynamically built, they do not include links to topics that are not available
when the user displays the links. If a related topics list contains a broken link in the source document, that
link is broken in the generated output for most output formats.

See Also links are useful if you plan to merge help systems. For example, if you have a multiple help systems that
you merge into one main help system at run time and if your topics in the merged help systems contain See Also
keywords that are also used in the main help system, links to those topics are included in the See Also lists in the
main project.

You can create See Also links as buttons or as inline text links in Microsoft HTML Help and WebWorks Help.
The following example shows how the two different types of See Also links display in a Microsoft HTML Help
system.

Create See Also links by applying the See Also paragraph format or character format to text in your Adobe
FrameMaker source documents and inserting markers into your Adobe FrameMaker source documents. To create
See Also links, your Stationery and template must have the following items configured:

See Also paragraph format if you want to create See Also links with buttons

See Also paragraph format if you want to create see Also links as inline text links

SeeAlsoKeyword marker type

SeeAlsoLink marker type
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SeeAlsoLinkDisplay marker type if you generate Microsoft HTML Help and you want to display the target
topics in a popup menu

SeeAlsoLinkWindowType marker type if you generate Microsoft HTML Help and you want to display the
target topics in a custom window

The following procedure provides an example of how to create See Also links in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for creating See Also links in Adobe FrameMaker
may be different in other versions of Adobe FrameMaker.

To create a See Also link in an Adobe FrameMaker source document

1. Identify each topic to which you want to link from a See Also link, and then complete the following steps
for each topic:

a. Insert your cursor into the topic to which you want to link.

b. On the Special menu, click Marker.

c. In the Marker Type field, select SeeAlsoKeyword from the drop-down list.

2. If the SeeAlsoKeyword marker type is not on the list, check with the Stationery designer to obtain the
name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

3. In the Marker Text field, type a text string that is a unique identifier for the topic.

For example, if you have a unique topic called About WebWorks Help, type AboutWebWorks help in the
Marker Text field.

4. Click New Marker.

5. Identify the topic where you want to insert a list of See Also links.

6. Enter the text you want to display for the See Also button or for the See Also inline text link on a separate
line in the source document where you want the See Also button or inline text link to display.

For example, if you want to create a button with the text See Also on the button, type See Also. If you
want to create inline text with the text Additional Information for the link, type Additional Information.

7. If you want to create a See Also button for your See Also links, apply the See Also paragraph format to
the text you want to display in the See Also button.

8. If you want to create a See Also inline text link for your See Also links, apply the See Also character
format to the text you want to display for the See Also inline text link.

9. Apply an OnlineOnly condition to the See Also text. Applying an OnlineOnly condition to the See Also
button or See Also inline text displays the See Also link in your generated output, but does not display the
See Also button or link in your printed content.

10. Insert your cursor inside the text you specified for the See Also button or See Also inline text link.

11. On the Special menu, click Marker.

12. In the Marker Type field, select SeeAlsoLink from the drop-down list.

13. If the SeeAlsoLink marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
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type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

14. In the Marker Text field, type the text string that is a unique identifier for the topic to which you want
to link. This text string is the text string you typed when you created the SeeAlsoKeyword marker for the
topic.

For example, if you have a unique topic called About WebWorks Help, type AboutWebWorks help in the
Marker Text field.

15. Click New Marker.

16. Continue to insert SeeAlsoLink markers for each topic you want display when users click the See Also
button or inline text link.

17. If you generate Microsoft HTML Help output and you want to display the target topics in a popup menu,
complete the following steps:

a. Insert your cursor inside the text you specified for the See Also button or inline text link.

b. In the Marker Type field, select SeeAlsoLinkDisplayType from the drop-down list.

Note: This marker type is supported only in Microsoft HTML Help.

c. If the SeeAlsoLinkDisplayType marker type is not on the list, check with the Stationery designer
to obtain the name of the marker type the Stationery designer created to support this functionality
and then use the marker type specified by the Stationery designer. For more information, refer to
“Implementing Online Features in FrameMaker”.

d. In the Marker Text field, type menu. By default, Microsoft HTML Help displays See Also links in
the Topics Found window. To display See Also links in a popup menu, specify menu for the marker
value.

e. Click New Marker.

18. If you generate Microsoft HTML Help output and you want to display the target topics in a custom
window, complete the following steps:

a. Insert your cursor inside the text you specified for the See Also button or inline text link.

b. In the Marker Type field select SeeAlsoLinkWindowType from the drop-down list.

Note: This marker type is supported only in Microsoft HTML Help.

c. If the SeeAlsoWindowType marker type is not on the list, check with the Stationery designer to
obtain the name of the marker type the Stationery designer created to support this functionality
and then use the marker type specified by the Stationery designer. For more information, refer to
“Implementing Online Features in FrameMaker”

d. In the Marker Text field, type menu. By default, Microsoft HTML Help displays See Also links in
the Topics Found window. To display See Also links in a popup menu, specify menu for the marker
value.

e. Click New Marker.

19. Save your Adobe FrameMaker source document.

20. Generate output for your project. For more information, see “Generating Output”.
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21. In Output Explorer, go to the page where you created the See Also links and verify that ePublisher created
the See Also button or See Also inline text and that the See Also button or inline text displays the links you
specified. For more information, see “Viewing Output in Output Explorer”.
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Creating Meta Tag Keywords in FrameMaker
Meta tags are lines of code placed between the <head> and </head> tags in HTML pages. Meta tags give web
search engines information about the content of the web page and how search engines should treat the web page.
Users viewing web pages do not see the meta tags, but meta tags can be used to influence the way web pages on a
web site appear in web search engine results. Users also see the text you specify for meta tags right following the
title of your page when your page comes up in search results.

In help systems, search ranking works like ranking in an Internet search engine. If you generate help system
output, you can use meta tag keywords to specify terms for pages for help topics where you want to improve
searchability. For example, assume that in your help system you have a topic called See Also links. However, you
know that See Also links are also sometimes referred to as ALinks, and you think that some users of your help
system may search for information about See Also links by typing ALinks into the Search field for your help
system. In this example, you can insert ALinks as a meta tag keyword for each page that discusses See Also links,
so users who search your system for information about ALinks can find the information they are looking for in
your See Also link topics.

To assign meta tag keywords, your Stationery and template must have the Keywords marker type configured.
Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to create meta tag keywords in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for creating meta tag keywords in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To create meta tag keywords for a page in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, find the first paragraph in the page for the page for which
you want to create a meta tag keyword.

2. Insert your cursor into the paragraph.

3. On the Special menu, click Marker.

4. In the Marker Type field, select Keywords from the drop-down list.

5. If the Keywords marker type is not on the drop-down list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

6. In the Marker Text field, type the comma-delimited list of keywords that you want search engines to use.

For example, type keyword1, keyword2, keyword3, where keyword is the keyword you want search engines
to use.

7. Click New Marker.

8. Save your Adobe FrameMaker source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. In Output Explorer, verify that ePublisher inserted your meta tag keywords correctly by completing the
following steps:
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a. On the View menu, click Output Explorer.

b. In the TargetName\ProjectName folder, open the page to which you assigned meta tag keywords in
Notepad, where TargetName is the name of your target and ProjectName is the name of your project.

c. Verify that the text you specified for your meta tag displays in the meta name attribute between
in the <head> and </head> tags section of your web page. For example, if you typed keyword1,
keyword2, keyword3, for your meta tag keywords, your meta tags in for the page should be similar to
the following entry:

<meta name="keywords" content="keyword1, keyword2, keyword3" />
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Assigning Custom Page Styles in FrameMaker
By default, each page generated by ePublisher is associated with the default page style defined in the Stationery
used by your ePublisher project. This means that typically you do not need to specify a page style for pages when
you generate output. However, if you want to change the page style of one page or a smaller set of pages, you
can specify the page style you want to use for a page in your Adobe FrameMaker source document using the
PageStyle marker.

For example, you may want to use one page style in your help system for all concept and procedure topic pages,
and another page style for all context-sensitive window description topic pages in your help system. In this
example, you can use the default page style for all of your concept and procedure topic pages, and then you can
use a second custom page style defined in your Stationery for all context-sensitive window description topic pages
in your help system.

To assign custom page styles, your Stationery and template must have the following items configured:

Custom page styles defined for your Stationery by the Stationery designer

PageStyle marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

For more information about creating page styles, see the ePublisher Design Guide.

The following procedure provides an example of specifying custom page styles for pages in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying custom page styles for pages
in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To specify a custom page style for a page in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the page for the topic to which you want to assign a
page style.

2. Insert your cursor in the location on the page where you want to insert the PageStyle marker.

3. On the Special menu, click Marker.

4. In the Marker Type field, select PageStyle from the drop-down list.

5. If the PageStyle marker type is not on the list, check with the Stationery designer to obtain the name of
the marker type the Stationery designer created to support this functionality and then use the marker type
specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

6. In the Marker Text field, type the name of the custom page style the Stationery designer configured for
your Stationery.

For example, if the Stationery designer configured an page style called BluePage in your Stationery, type
BluePage.

7. Click New Marker.

8. Save your Adobe FrameMaker source document.

9. Generate output for your project. For more information, see “Generating Output”.
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10. In Output Explorer, verify ePublisher created the page using the page style you specified by clicking on
the page and verifying ePublisher applied the page style you specified in the generated output. For more
information about viewing output files in Output Explorer, see “Viewing Output in Output Explorer”.
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Creating What’s This (Field-Level) Help in FrameMaker
If you generate Microsoft HTML Help output, you can implement What’s This help for product dialog boxes and
windows. What’s This help is also known as field-level help. Only Microsoft HTML Help supports field-level
help. In addition, not all products are designed to support field-level help for product dialog boxes and windows.
Before you begin implementing field-level help, consult your product team to determine if field-level help part of
the product design. If field-level help is part of the product design, you will also need to obtain the appropriate ID
from your product team for each field-level help topic you need.

Users can view the field-level help you create using one of following methods:

Users click on the question mark icon in the upper right corner of the dialog box or window.

When users click on the question mark icon, their cursor changes to a question mark. Users can then move
the question mark cursor over the fields on the dialog box or window, and Windows displays the field-level
help you created in a popup window when they hover over a specific field.

Users right-click a field on a dialog box or window and then select the What’s This? option from the single
option menu Windows displays.

After users select this option, Windows displays the field-level help you specify in in a popup window.

Users close the popup window that provides the field-level help by pressing the Esc key on the keyboard. When
users press the Esc key, their cursor returns to the regular cursor shape for the user.

To create What’s This help, your Stationery and template must have the following items configured:

What Is This help paragraph style

WhatIsThisHelpID

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to create What’s This help in Adobe FrameMaker source
documents using unstructured Adobe FrameMaker 7.2. Steps for creating What’s This help in Adobe FrameMaker
may be different in other versions of Adobe FrameMaker.

To create What’s This help in an Adobe FrameMaker source document

1. Identify a topic that contains field-level help.

2. Apply the What Is This paragraph format to the text that contains the field-level help.

3. Insert your cursor into the field-level help text.

4. On the Special menu, click Marker.

5. In the Marker Type field, select WhatIsThisID from the drop-down list.

6. If the WhatIsThisID marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.
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7. In the Marker Text field, type the appropriate ID for the field-level description. Obtain appropriate IDs for
each field-level description from your product team.

8. Click New Marker.

9. Save your Adobe FrameMaker source document.

10. Generate output for your project. For more information, see “Generating Output”.

11. In Output Explorer, verify ePublisher created the What’s This help you specified by completing the
following steps:

a. On the View menu, click Output Directory.

b. Open the ProjectName folder, where ProjectName is the name of your project.

c. Open the whatisthis.txt file and verify that the field-level help you created is associated with the
correct ID you received from your product development team.

d. Open the whatisthis.h file and verify that each new string you added is listed in the file.
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Opening Topics in Custom Windows in FrameMaker
You can open topics in custom windows in Microsoft HTML Help and Oracle Help. By default, Microsoft HTML
Help displays content in the standard Microsoft HTML Help tri-pane window. The Stationery designer can
modify the size, position, and other characteristics of the tri-pane window in your Microsoft HTML Help project.
The Stationery designer can also define custom windows for you to use in a Microsoft HTML Help project. If the
Stationery designer defines custom windows in a Microsoft HTML Help project, you can specify which topics
you want to display in the custom window using the WindowType marker.

By default, Oracle Help displays content in the standard Oracle Help viewer. The Stationery designer can modify
the size, position, and other characteristics of Oracle Help windows. The Stationery designer can also define
custom windows for you to use in an Oracle Help project. If the Stationery designer defines custom windows
in an Oracle Help project, you can specify which topics you want to display in the custom window using the
WindowType marker.

For example, if you want your context-sensitive help topics to display in a different type of window than other
content, after you create a context-sensitive help topic you can use the WindowType marker to specify that you
want the context-sensitive help topics to display in a custom window. After you assign a custom window to a
topic using the WindowType marker, the help system displays the topic in your generated output in the custom
window whenever users access the topic from the table of contents, index, a standard hyperlink, a related topics
list, or a See Also link.

To open topics in custom windows, your Stationery and template must have the following items configured:

Custom window styles defined for your Stationery by the Stationery designer

PageStyle marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify topics open in custom Microsoft HTML Help or
Oracle Help windows in Adobe FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps
for specifying topics open in custom Microsoft HTML Help or Oracle Help windows in Adobe FrameMaker may
be different in other versions of Adobe FrameMaker.

To specify topics open in a custom window in an Adobe FrameMaker source document

1. Obtain the names of custom windows configured in the Stationery you use for your ePublisher project from
the Stationery designer.

2. In your Adobe FrameMaker source document, locate the topic that you want to open in a custom window.

3. Insert your cursor into the topic.

4. On the Special menu, click Marker.

5. In the Marker Type field, select WindowType from the drop-down list.

6. If the WindowType marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.
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7. In the Marker Text field, type the name of the custom window configured by the Stationery designer that
you want to specify for the topic.

8. Click New Marker.

9. Save your Adobe FrameMaker source document.

10. Generate output for your project. For more information, see “Generating Output”.

11. In Output Explorer, verify the topic displays in the custom window you specified for the topic. For more
information about viewing output files in Output Explorer, see “Viewing Output in Output Explorer”.
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Customizing Table of Contents Icons in FrameMaker
By default, the Contents tab in a Microsoft HTML Help, Oracle Help, and WebWorks Help uses book and page
icons to identify entries. By default, the Contents tab in Sun JavaHelp uses folder and page icons to identify
entries. You can also customize the table of contents icons.

For example, if you want to make new topics stand out by using a unique icon specific to new books, pages, or
folders, you can insert a marker into a topic and specify the icon you want to display for the book, page, or folder
in your help system table of contents.

To customize a table of contents icon, your Stationery and template must have the following items configured:

TOCIconHTMLHelp for Microsoft HTML Help

TOCIconOracleHelp for Oracle Help

TOCIconJavaHelp for Sun JavaHelp

TOCIconWWHelp for WebWorks Help

You can customize the appearance of table of contents icons for topics in Microsoft HTML Help, Sun JavaHelp,
Oracle Help, and WebWorks help.

The following procedure provides an example of how to customize table of contents icons for topics in Adobe
FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for customizing table of
contents icons for topics in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To specify a custom table of contents icon in an Adobe FrameMaker source document

1. If you want to specify a custom table of contents icon for Microsoft HTML Help, identify the number of
the image you want to use for the table of contents image for the topic in the .hhp file for your Microsoft
HTML Help project by completing the following steps:

a. On the View menu, click Output Directory.

b. Open the ProjectName folder, where ProjectName is the name of your project.

c. Open the ProjectName.hhp file where ProjectName is the name of your project.

d. On the Contents tab, select a table of contents entry, and then click the Pencil icon.

e. On the Advanced tab, in the Image index field, use the up and down arrows to identify the table of
contents image you want to use for the topic.

f. Note the number of the image you want to use for the table of contents image for the topic.

For example, if you want to use a question mark icon with a red star for the table of contents icon for
new topics, note that the number for this icon is 10.

g. Close HTML Help Workshop.

2. If you want to specify a custom table of contents icon for Oracle Help or Sun JavaHelp, create the
graphic file for the custom table of contents icon in .gif format. The default graphics used as Sun
JavaHelp or Oracle Help table of contents icons are 17 x 17 pixels. The custom graphics you create for Sun
JavaHelp or Oracle Help table of contents icons should also be 17 x 17 pixels. You can assign any name to
the graphic files.
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3. If you want to specify a custom table of content icon for WebWorks help, create graphics files containing
the collapsed and expanded versions of the icons you want to use, then save the graphic files in .gif
format. The default graphics used as WebWorks Help table of contents icons are 17 x 17 pixels. The custom
graphics you create for WebWorks Help table of contents icons should also be 17 x 17 pixels. You can
assign any name to the graphic files.

4. Copy the graphic files you want to use as icons in the table of contents into the following folder:

Note: If the folder does not exist, first create the folder using the specified folder structure and then copy
the graphic files you want to use as icons into the folder. You do not need to perform this step when
specifying custom table of contents icons for Microsoft HTML Help.

If you are generating Oracle Help, copy the graphic files you want to use into the following folder:

ProjectName\Formats\Oracle Help\Files\images folder, where ProjectName is the name of
your project.

If you are generating Sun JavaHelp 1.1.3, copy the graphic files you want to use into the following
folder:

ProjectName\Formats\Sun Java Help 1.1.3\Files\images folder, where ProjectName is the
name of your project.

If you are generating Sun JavaHelp 2.0, copy the graphic files you want to use into the following
folder:

ProjectName\Formats\Sun Java Help 2.0\Files\images folder, where ProjectName is the
name of your project.

If you are generating WebWorks Help, in your ProjectName\Files folder, where ProjectName is
the name of your project, create a wwhelp\images subfolder and copy the graphic files you want to
use into this folder. Your project file structure should be similar to the following structure:

ProjectName\Files\wwhelp\images, where ProjectName is the name of your project.

5. In your Adobe FrameMaker source document, locate the topic where you want to use the custom table of
contents icon.

6. Insert your cursor into the heading for the topic.

7. On the Special menu, click Marker.

8. In the Marker Type field, select the appropriate TOCIcon marker type from the drop-down list.

9. If the appropriate TOCIcon marker type is not on the list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

10. In the Marker Text field, type the following text:

If you are generating Microsoft HTML Help, type the number of the icon that you want to use for
the table of contents image.

For example, if you want to use a question mark icon with a red star for the table of contents icon for
new topics, type 10.

If you are generating Oracle Help or Sun JavaHelp, type the following text:

images/TOCIcon.gif

where TOCIcon.gif is the name of the table of contents icon you want to display for the topic.
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If you are generating WebWorks Help, type the following text:

c=”collapsed.gif” e=”expanded.gif”

where collapsed.gif is the name of the icon you want to use when the table of contents entry is
collapsed, and expanded.gif is the name of the icon you want to use when the table of contents
entry is expanded. If the table of contents entry is for a page instead of a book, the entry will never
be expanded, so you can omit the e=”expanded.gif” portion of the entry for pages.

For example, you might create a special icon to highlight books that are new for a particular
release of your WebWorks Help system. If you named these icons newbookopen.gif and
newbookclosed.gif, you would type the following text into the Value field:

c=”newbookclosed.gif” e=”newbookopen.gif”

11. Click New Marker.

12. Save your Adobe FrameMaker source document.

13. Generate output for your project. For more information, see “Generating Output”.

14. In Output Explorer, verify ePublisher created the table of contents using the table of contents icon you
specified for the topic. For more information about viewing output files in Output Explorer, see “Viewing
Output in Output Explorer”.
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Specifying Context Plug-ins in FrameMaker
You can specify Eclipse Help context plug-ins by using Context Plugin markers in your source documents.
ePublisher places the context plug-ins you specify in your source documents in the plugin.xml file generated for
each source document group you have in Document Manager. You can then have developers use the context plug-
ins defined in plugin.xml files to call your Eclipse Help system as appropriate from Eclipse plug-ins.

For example, assume you have the following three top-level groups in Document Manager for your Eclipse Help
system target:

Component A group - contains the source documents for ComponentA Feature1 and ComponentA Feature2

Component B group - contains the source documents for ComponentB Feature1 and ComponentB Feature
2

Component C group - contains the source documents for ComponentC Feature1 and ComponentC Feature
2

You insert the following Context Plugin markers into the source documents for each group:

ComponentAFeature1 and ComponentAFeature2 Context Plugin markers in source documents contained in
the ComponentA group

ComponentBFeature1 and ComponentBFeature2 Context Plugin markers in source documents contained in
the ComponentB group

ComponentCFeature1 and ComponentCFeature2 Context Plugin markers in source documents contained in
the ComponentC group

When you generate your Eclipse Help system, ePublisher creates the following folder structure in the
ProjectName\Output\TargetName folder, where ProjectName is the name of your ePublisher project, and
TargetName is the name of your target:

ComponentA folder, which contains a plugin.xml file with the following entries:

plugin="ComponentAFeature1ContextPlugin"

plugin="ComponentAFeature2ContextPlugin"

ComponentB folder, which contains a plugin.xml file with the following entries:

plugin="ComponentBFeature1ContextPlugin"

plugin="ComponentBFeature2ContextPlugin"

ComponentC folder, which contains a plugin.xml file with the following entries:

plugin="ComponentCFeature1ContextPlugin"

plugin="ComponentCFeature2ContextPlugin"

You can then provide the context plug-in IDs in your plugin.xml files to the appropriate Eclipse developers to
use. The Eclipse developers use the context plug-ins defined in plugin.xml files to call your Eclipse Help system
as appropriate from Eclipse plug-ins.

To specify a context plug-in in an Adobe FrameMaker source document

1. Identify a topic in a source document where you want to insert the context plug-in.

2. On the Special menu, click Marker.
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3. In the Marker Type field, select Context Plugin from the drop-down list.

4. If the Context Plugin marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

5. In the Marker Text field, type the appropriate ID for the context plug-in.

Note: If you are responsible for defining the ID, ensure you supply the context plug-in ID to your
developers to use as appropriate for their Eclipse plug-ins. If your developers define the ID, use the
context plug-in ID you obtained from your developers.

6. Click New Marker.

7. Save your Adobe FrameMaker source document.

8. Generate output for your project. For more information, see “Generating Output”.

9. In Output Explorer, verify ePublisher generated a plugin.xml file that contains the context plug-in IDs you
specified by completing the following steps:

a. On the View menu, click Output Directory.

b. Open the ProjectName folder, where ProjectName is the name of your project.

c. Open the group folder for a group that contains the source documents where you specified your
context plug-in ID.

d. Open the plugin.xml file in Notepad and verify that the context plug-in IDs you specified in your
source documents are listed in the plugin.xml file. Your context plug-in IDs should be listed in the
Contexts area of the file. Following is an example of the how the context plug-in IDs you specified
in your source documents should be displayed in the plugin.xml file:

<!-- Contexts -->

<!-- -->

<extension point="org.eclipse.help.contexts">

<contexts file="contexts.xml" plugin="ComponentAFeature1ContextPlugin" />

</extension>

<extension point="org.eclipse.help.contexts">

<contexts file="contexts.xml" plugin="ComponentAFeature2ContextPlugin" />

</extension>
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Creating Accessible Online Content in FrameMaker
Accessible content is content that can be easily accessed by users with certain disabilities. This section explains
how you can prepare your Adobe FrameMaker source documents to ensure your content is accessible to users
using assistive technologies.



Understanding Accessible Content in FrameMaker | 195

Understanding Accessible Content in FrameMaker
Images and tables are helpful ways to convey information to end users. However, users with disabilities often
cannot access the important information provided by images and table layouts in online content. You should
document images and other non-text items such as table layouts so that users using assistive technologies to
access online content can access the information these items provide.

Content that must easily be accessed by people with disabilities must conform to certain guidelines published
by both the W3C and the United States government in order to produce accessible online output, also known as
Section 508 compliant output. These guidelines are intended to help writers produce accessible content.

You can use ePublisher to help you produce online content that conforms to the W3C Web Content Accessibility
Guidelines 1.0 (WCAG), Section 508 of the U.S. Rehabilitation Act of 1998, and the Americans with Disabilities
Act (ADA). If you are required to generate accessible content, typically you provide the following items in your
online content:

Alternate text and descriptions for all images and image maps. For more information, see “Assigning
Alternate Text to Images and Image Maps in FrameMaker”.

Long descriptions for all images. For more information, see “Assigning Long Descriptions to Images in
FrameMaker”.

Summaries for all tables. For more information, see “Assigning Alternate Text (Summaries) to Tables in
FrameMaker”.

You may also choose to provide the following items in your online content:

Alternate text for abbreviations. For more information, see “Assigning Alternate Text to Abbreviations in
FrameMaker”.

Alternate text for acronyms. For more information, see “Assigning Alternate Text to Acronyms in
FrameMaker”.

Citations for quotes. For more information, see “Providing Citations for Quotes in FrameMaker”

You must prepare source documents and configure your ePublisher project in order to create accessible content.
You prepare your source documents by inserting markers into your source documents and by applying character
formats and paragraph formats. You configure accessibility settings in your ePublisher project. ePublisher uses the
information in your source documents and your ePublisher project to generate accessible online output.

For more information about producing accessible content and to check your content further for compliance, see
the following Web sites:

For the complete W3C note on the WCAG, visit http://www.w3c.org/TR/WCAG10-CORE-TECHS.

For information about the related Web Accessibility Initiative, visit http://www.w3.org/WAI.

For information about Section 508 of the U.S. Rehabilitation Act of 1998, visit http://www.w3.org/WAI/
Policy/#508.

http://www.w3c.org/TR/WCAG10-CORE-TECH
http://www.w3.org/WAI
http://www.w3.org/WAI/Policy/#508
http://www.w3.org/WAI/Policy/#508
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Understanding Accessible Content Navigation in FrameMaker
Users can navigate through the accessible content using keys on the keyboard. The following output formats
support navigation keys:

Dynamic HTML

Microsoft HTML Help

Oracle Help

WebWorks Help

Note: For the Dynamic HTML, navigation key behavior may vary based on the browser the user uses. For
example, in Netscape and Mozilla, users must hold down the Alt key while pressing the navigation keys. In
Internet Explorer, users must first hold down the Alt key while pressing the navigation key, and then press
Enter.

The following table lists the how each output format supports navigation keys.

Navigation Key Function Format

1 Display the TOC Dynamic HTML
WebWorks Help 5.0

2 Display the Index Dynamic HTML
WebWorks Help 5.0

3 Display the Search tab WebWorks Help 5.0

4 Go to the previous page Dynamic HTML
Microsoft HTML Help
Oracle Help
WebWorks Help 5.0

If you are using Microsoft HTML Help,
Alt+4 works only if the topic pane has the
focus. If the topic pane does not have the
focus, you must press Alt+0 and then Alt
+4.
If you are using Oracle Help, you must
press Enter after pressing Alt+4.

5 Go to the next page Dynamic HTML
Microsoft HTML Help 1.x
Oracle Help
WebWorks Help 5.0

If you are using Microsoft HTML Help,
the Alt+5 key works only if the topic pane
has the focus. If the topic pane does not
have the focus, you must press Al+ 0 and
then Alt +5.
If you are using Oracle Help, you must
press Enter after pressing Alt+5.

6 Shift the focus to the related topics list
displayed at the bottom of the current page

WebWorks Help 5.0
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Navigation Key Function Format

After you press the 6 key, you can press
Tab to cycle through the entries in the
related topics list.

7 Display a blank feedback e-mail (equivalent
to clicking the e-mail button in the toolbar
frame)

WebWorks Help 5.0

8 Print the current page (equivalent to clicking
the Print button in the toolbar frame)

WebWorks Help 5.0

9 Bookmark the current page (equivalent to
clicking the Bookmark button in the toolbar
frame)

WebWorks Help 5.0

10 Shift the focus to the topic frame (equivalent
to clicking within the topic frame)

WebWorks Help 5.0
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Validating Accessible Content in FrameMaker
After you configure your source documents and configure the appropriate settings, ePublisher uses Accessibility
conformance reports to perform the following checks to verify that the generated output conforms to accessibility
standards:

Alternate text for all images

Alternate text for all clickable regions in all image maps

Long descriptions for all images

Summaries for all tables

ePublisher does not verify that you have provided alternate text for abbreviations or acronyms or verify that
you have included citations for quotes. For more information about understanding and using the Accessibility
conformance reports ePublisher provides, see “Configuring Reports”, and “Generating Reports”.
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Assigning Alternate Text to Images and Image Maps in FrameMaker
This section provides information about how to create accessible images and image maps in your generated output
by assigning alternate text to images.
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Understanding Image and Image Map Alternate Text in FrameMaker
One of the largest accessibility challenges with online content today is the lack of alternative text for images and
image maps. Sight-impaired users often use screen readers or refreshable Braille devices to read online content.
However, when these assistive technologies come across images or image maps without alternative text, also
known as alternate text, they are unable to provide users with information about the image or image map and its
meaning.

The Web Content Accessibility Guidelines require that alternate text be provided for all images and image maps
in online content. The alternate text is an image label that describes the image or each area of the image map.
Online content should display alternate text for images and image maps when users perform the following actions:

The user hovers the mouse pointer over an image or section of an image map.

The user browser has been configured to disable display of images and image maps.

The user browser is a text-only browser such as Lynx.

The user uses assistive technology such as a screen reader.

The alternate text you assign to an image or sections of an image map should be as accurate and as succinct as
possible and provide users with a brief description of the image and how the image relates to the page they are
viewing. Make sure that your alternate text conveys all of the important information related to the image or image
map section, but do not burden users with excessively long alternative text. Screen readers or refreshable Braille
devices always read the alternative text, so if your page has several images or complex image maps with long
descriptions, it can take a long time for the assistive devices to read image-heavy pages with long descriptions.
If you need to provide a description of the image or image map section that is more than a few words or a few
short sentences, you should provide a brief alternate text description of the image or image map section and then
assign a longer description the image using either the longdesc attribute or a description. Once you specify a
long description using the longdesc attribute, you can also optionally display a D link next to the image. For
more information about assigning long descriptions to images, see “Assigning Long Descriptions to Images in
FrameMaker”.
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Assigning Alternate Text to Images in FrameMaker
To assign alternate text to an image, your Stationery and template must have the ImageAltText marker type
configured. Your output format must also support this feature. For more information about output formats that
support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to assign alternate text to images in the most current version
of FrameMaker. The Object Attribute method can be used with newer versions of FrameMaker.

To assign alternate text to an image in an Adobe FrameMaker source document using object
attributes

1. In your Adobe FrameMaker source document, locate the anchored frame for the image to which you want
to assign alternate text.

2. In the anchored frame that contains the image to which you want to assign alternate text, and complete the
following:

a. Select the anchored frame that contains the image to which you want to assign an alternate name.

b. On the Graphics menu, click Object Properties.

c. Click Object Attributes.

d. In the New or Changed Attribute area, in the Name field, type ImageAltText.

e. In the Definition field, type the alternate text you want to assign to the image. Your text cannot
exceed 255 characters.

f. Click Add.

g. Click Set.

h. Click Set again to close the window.

To assign alternate text to an image in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the anchored frame for the image to which you want
to assign alternate text.

2. In the anchored frame that contains the image to which you want to assign alternate text, insert a text frame
by completing the following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Text Frame icon.

c. Drag the cursor over the portion of the image where you want to insert the text frame that will
contain the ImageAltText marker.

d. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

e. Click outside the image, and then insert your cursor in the text frame.

3. On the Special menu, click Marker.

4. In the Marker Type field, select ImageAltText from the drop-down list.
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5. If the ImageAltText marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

6. In the Marker Text field, type the alternate text you want to assign to the image.

7. Click New Marker.

8. Save your Adobe FrameMaker source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. Verify ePublisher assigned the alternate text you specified to the image when it generated output by
completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the image to which you assigned alternate text in
Notepad, where TargetName is the name of your target.

c. Verify that the alternate text you specified is included in the alt tag for the image.
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Assigning Alternate Text to Image Maps in FrameMaker
To assign alternate text to an image, your Stationery and template must have the ImageAreaAltText marker type
configured. Your output format must also support this feature. For more information about output formats that
support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to assign alternate text to an image map in Adobe
FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for assigning alternate text to
an image map in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To assign alternate text for an image map in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the anchored frame for the image map to which you
want to assign alternate text.

2. In the anchored frame that contains the image map to which you want to assign alternate text, complete the
following steps for each area of an image map:

a. Insert your cursor into the text frame that defines a clickable region on the image map.

b. On the Special menu, click Marker.

c. In the Marker Type field, select ImageAreaAltText from the drop-down list.

d. If the ImageAreaAltText marker type is not on the list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use
the marker type specified by the Stationery designer. For more information, refer to “Implementing
Online Features in FrameMaker”.

e. In the Marker Text field, type the alternate text you want to assign to the image map area.

f. Click New Marker.

3. Save your Adobe FrameMaker source document.

4. Generate output for your project. For more information, see “Generating Output”.

5. Verify ePublisher assigned the alternate text you specified to each area of the image map when it generated
output by completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the image map to which you assigned alternate text
in Notepad, where TargetName is the name of your target.

c. Verify that the alternate text you specified is included in the alt tag for each area of the image map.
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Assigning Long Descriptions to Images in FrameMaker
This section explains how to create accessible images in your generated output by assigning long descriptions to
images.
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Understanding Image Long Descriptions in FrameMaker
The Web Content Accessibility Guidelines and Section 508 guidelines require you to include long descriptions
for each image in an HTML document. You can use the longdesc attribute and a long descriptions stored in an
external .txt file to assign a long description to an image. When you use this approach, the long descriptions are
referenced in the HTML <img> tag in the longdesc attribute as shown in the following example:

<img src=“mission.gif” height=“240” width=“386” alt=“The Mission”
longdesc=“mission.txt” />

The longdesc attribute in the <img> tag provides a link to a separate page where a long description is available.
The link is invisible to sighted users, but when a conformant screen reader application reads the longdesc
attribute, it loads the file referenced in the longdesc attribute and reads it. In the previous example, the screen
reader would load and read the mission.txt file.

ePublisher provides the following options for assigning long descriptions to images:

You can use the ImageLongDescText marker to assign a long description to an image. With this method,
you assign a long description to an image using a description you include in a marker you insert into your
source document. For more information, see “Assigning Long Descriptions to Images in FrameMaker”.

You can use the ImageLongDescByRef marker to assign a long description to an image by referencing a
long description saved in an external text (.txt) file. With this method, you specify the path to the external
text file in a marker. For more information, see “Using Text in External Files to Assign Long Descriptions
to Images in FrameMaker”.

If you assign long descriptions to some, but not all of you images, you can use the ImageLongDescNotReq
marker. Use this marker when you use accessibility reports to verify that all images have long description but you
have certain images in your source document that do not require a long description. For more information, see
“Excluding Images from Accessibility Report Checks in FrameMaker”.

Although using the longdesc attribute is recommended in the Web Content Accessibility Guidelines and in 508
guidelines, older screen readers and many current browsers do not support this attribute and few online content
developers use this attribute. As a result, the longdesc attributed benefits a only a small number of users. Only
users who use modern screen readers can access the longdesc attribute easily. Older screen readers did not
support this attribute. In addition, even users who use the latest version of screen reader may be unfamiliar with
the longdesc attribute and may not know how to access long descriptions using their screen reader because the
longdesc attribute is used so infrequently in online content.

If you use the ImageLongDescText marker to assign long descriptions to images, as an interim solution ePublisher
allows you to display a D link immediately after the image. The D link is an upper case letter D link that directs
users to another page that contains the text you specified in the ImageLongDescText marker. Although a D link is
not required for accessible Web pages, it can be used in addition to the longdesc attribute. The D link technique
works in all browsers, but it is less elegant than using the londesc attribute. Some users may be confused when
they see a D link on the page, while other users will ignore the D link.

If you want to use D links in addition to the longdesc attribute when you generate output, your Stationery must
have the D link option enabled. If you have permissions to modify target settings in ePublisher Express, you can
enable the D link option setting in an ePublisher Express project. For more information about enabling the D link
option in an ePublisher project, see “Specifying Accessibility Settings”. For more information about permissions
required to modify target settings using ePublisher Express, see “Customizing Target Settings”.
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Specifying Long Descriptions for Images in FrameMaker
To assign a long description to an image, your Stationery and template must have the ImageLongDescText marker
type configured. Your output format must also support this feature. For more information about output formats
that support this feature, see “Features Available in Each Output Format”.

When you use the ImageLongDescText marker to assign long descriptions to images, ePublisher generates an
external text file that contains the long description you specify. When a conformant screen reader application
reads the generated page, it loads the .txt file referenced in the longdesc attribute on the page and reads the file.

You can use the ImageLongDescText marker to assign long descriptions to images if your image descriptions
do not exceed 255 characters. If your image long descriptions are longer than 255 characters, you must use an
external .txt file and the ImageLongDescByRef marker to assign long descriptions to images, because Adobe
FrameMaker limits the length of marker text to 255 characters. For more information, see “Using Text in External
Files to Assign Long Descriptions to Images in FrameMaker”.

In addition, Adobe FrameMaker ignores carriage returns in marker text when generating MIF files. As result, if
you use ImageLongDescText markers, each long description will be generated as a single paragraph.

The steps you use to assign long descriptions to images varies based on the version of Adobe FrameMaker you
use. If you use Adobe FrameMaker 6.0, you use the ImageLongDescText marker. If you use Adobe FrameMaker
7.0 or later, you can use either the ImageLongDescText marker or an object attribute you create for the anchored
frame to assign a long description to an image. For more information about long descriptions and D links, see
“Specifying Long Descriptions for Images in FrameMaker”.

To assign a long description to an image using marker text in an Adobe FrameMaker source
document

1. In your Adobe FrameMaker source document, locate the anchored frame for the image to which you want
to assign a long description.

2. If you are using Adobe FrameMaker 6.0, complete the following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Text Frame icon.

c. Drag the cursor over the portion of the image where you want to insert the text frame that will
contain the ImageLongDescText marker.

d. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

e. Click outside the image, and then insert your cursor in the text frame.

f. On the Special menu, click Marker.

g. In the Marker Type field, select ImageLongDescText from the drop-down list.

h. If the ImageLongDescText marker type is not on the list, check with the Stationery designer to
obtain the name of the marker type the Stationery designer created to support this functionality
and then use the marker type specified by the Stationery designer. For more information, refer to
“Implementing Online Features in FrameMaker”.

i. In the Marker Text field, type the long description you want to assign to the image. Your description
cannot exceed 255 characters.

j. Click New Marker.
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3. If you are using Adobe FrameMaker 7.0, complete the following steps:

a. Select the anchored frame that contains the image to which you want to assign a long description
using an external file.

b. On the Graphics menu, click Object Properties.

c. Click Object Attributes.

d. In the New or Changed Attribute area, in the Name field, type ImageLongDescText.

e. In the Definition field, type the long description you want to assign to the image. Your description
cannot exceed 255 characters.

f. Click Add.

g. Click Set.

h. Click Set again to close the window.

4. Save your Adobe FrameMaker source document.

5. Generate output for your project. For more information, see “Generating Output”.

6. Verify ePublisher assigned the long description to the image by completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName\images folder, verify that ePublisher created a .txt file that contains the long
description you specified in the ImageLongDescText marker, where TargetName is the name of your
target.

For example, if you specified a long description for ImageName.png, verify that ePublisher created
an ImageName.txt file in the images folder, where ImageName is the name of the image to which you
assigned a long description.

c. In the TargetName\ProjectName folder, open the page that contains the image to which you
assigned the long description in Notepad and verify that the longdesc attribute references the
ImageName.txt file ePublisher created for the image, where TargetName is the name of your target,
ProjectName is the name of your project, and ImageName is the name of the image to which you
assigned a long description.

d. If you used the ImageLongDescText marker and the Stationery designer configured your
Stationery to support D links, open the page in a browser, verify that the D link displays in the
browser, and then click the D link and verify that a page opens that displays the long description that
you specified in the ImageLongDescText marker.
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Using Text in External Files to Assign Long Descriptions to Images in FrameMaker
Assign long descriptions to images using external files when you have image descriptions that exceed 255
characters or if you want to use image descriptions in external text files to assign long descriptions to images.

To assign a long description to an image, your Stationery and template must have the ImageLongDescText marker
type configured. Your output format must also support this feature. For more information about output formats
that support this feature, see “Features Available in Each Output Format”.

The steps you use to assign long descriptions to image varies based on the version of Adobe FrameMaker you use.
If you use Adobe FrameMaker 6.0, you use the ImageLongDescByRef marker. If you use Adobe FrameMaker 7.0
or later, you use an object attribute you create for the anchored frame to assign a long description to an image.

To assign a long description to an image using an external file in an Adobe FrameMaker source
document

1. Create a .txt file that contains each image long description.

2. Place each image long description text file in a folder in the ProjectName\Formats\TargetName\Files
folder for your project, where ProjectName is the name of your ePublisher project and TargetName is the
name of your target.

For example, place the each image long description in the following location:

ProjectName\Formats\TargetName\Files\longdescriptions\imagelongdescription.txt

where ProjectName is the name of your ePublisher project, TargetName is the name of your target,
longdescriptions is the name of the folder where you placed the image long description, and
imagelongdescription is the name of the .txt file that contains the image long description.

3. In your Adobe FrameMaker source document, locate the anchored frame for the image to which you want
to assign a long description.

4. If you are using Adobe FrameMaker 6.0, complete the following steps:

a. On the Graphics menu, click Tools to display the graphic tools palette.

b. Click the Text Frame icon.

c. Drag the cursor over the portion of the image where you want to insert the text frame that will
contain the ImageLongDescByRef marker.

d. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

e. Click outside the image, and then insert your cursor in the text frame.

f. On the Special menu, click Marker.

g. In the Marker Type field, select ImageLongDescByRef from the drop-down list.

h. If the ImageLongDescByRef marker type is not on the list, check with the Stationery designer
to obtain the name of the marker type the Stationery designer created to support this functionality
and then use the marker type specified by the Stationery designer. For more information, refer to
“Implementing Online Features in FrameMaker”.

i. In the Marker Text field, type the path to the .txt file that contains the long description you want to
assign to the image.

For example, type:
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./longdescriptions/imagelongdescription.txt

where longdescriptions is the name of the folder where you placed the image long description,
and imagelongdescription is the name of the .txt file that contains the image long description.

j. Click New Marker.

5. If you are using Adobe FrameMaker 7.0 or later, complete the following steps:

a. Select the anchored frame that contains the image to which you want to assign a long description
using an external file.

b. On the Graphics menu, click Object Properties.

c. Click Object Attributes.

d. In the New or Changed Attribute area, in the Name field, type ImageLongDescByRef.

e. In the Definition field, type the path to the .txt file that contains the long description you want to
assign to the image.

For example, type:

./longdescriptions/imagelongdescription.txt

where longdescriptions is the name of the folder where you placed the image long description,
and imagelongdescription is the name of the .txt file that contains the image long description.

f. Click Add.

g. Click Set.

h. Click Set again to close the window.

6. Save your Adobe FrameMaker source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher assigned the long description to the image using the long description
in the external file when it generated output by completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName\ProjectName folder, open the page that contains the image to which you
assigned the long description using an external file in Notepad and verify that the longdesc attribute
references the external text file that contains the long description for the image, where TargetName is
the name of your target, and ProjectName is the name of your project.
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Excluding Images from Accessibility Report Checks in FrameMaker
In some instances, alternate text is sufficient for an image, and assigning a long description to an image in
addition to alternate text would be redundant. However, you may have configured Accessibility reports to check
for images without long descriptions and notify you when an image does not have a long description.

In this scenario, while you want an Accessibility report to notify you when you have an image without a long
description, you do not want to be notified when you deliberately did not assign a long description to an image
because assigning a both a long description and alternative text would be redundant. To address this issue, you
can use the ImageLongDescNotReq marker to exclude an image that deliberately does not have a long description
from validation when you generate Accessibility reports. For more information about Accessibility reports and
configuring and generating Accessibility reports, see “Understanding Accessibility Reports”, “Configuring
Reports”, and “Generating Reports”.

To exclude images without long descriptions from Accessibility reports, your Stationery and template must have
the ImageLongDescNotReq marker type configured. Your output format must also support this feature. For more
information about output formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to exclude images without long descriptions from
Accessibility report checks in Adobe FrameMaker source documents using unstructured Adobe FrameMaker 7.2.
Steps for excluding images without long descriptions from Accessibility report checks in Adobe FrameMaker
may be different in other versions of Adobe FrameMaker.

To exclude an image without a long description from Accessibility report checks in an Adobe
FrameMaker source document

1. In your Adobe FrameMaker source document, locate the anchored frame for the image without a long
description that you want to exclude from an Accessibility report check.

2. On the Graphics menu, click Tools to display the graphic tools palette.

3. Click the Text Frame icon.

4. Drag the cursor over the portion of the image where you want to insert the text frame that will contain the
ImageLongDescNotReq marker.

5. In the Create New Text Frame window, in the Number field, type 1, and then click Set.

6. Click outside the image, and then insert your cursor in the text frame.

7. On the Special menu, click Marker.

8. In the Marker Type field, select ImageLongDescNotReq from the drop-down list.

9. If the ImageLongDescNotReq marker type is not on the list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

10. In the Marker Text field, do not enter any text. You do not need to enter any text in this field when you
insert a ImageLongDescNotReq marker.

11. Save your Adobe FrameMaker source document.

12. Generate output for your project. For more information, see “Generating Output”.
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13. Generate an Accessibility report and confirm that ePublisher did not generate an Image is missing a
long description message for the image. For more information about generating Accessibility reports
and Accessibility report messages, see “Generating Reports” and “Accessibility Report Messages”.
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Assigning Alternate Text (Summaries) to Tables in FrameMaker
Tables, just like images, are a way to visually display information. Although tables typically contain text, the
purpose of the table is often not evident from text alone. The organization and display of the table may contain
information that is not evident to assistive technologies. However, through the use of table summaries, assistive
technologies can convey useful information to users about tables. The Web Content Accessibility Guidelines
recommend that you provide summary text for each table in an HTML document. Table alternate text, or table
summaries, provide users with information about what type of information the table contains.

You can create accessible tables by typing the table summary into a TableSummary marker. When ePublisher
generates content, ePublisher puts the table summary you specify into the table in the summary attribute.

To assign alternate text to tables, your Stationery and template must have the TableSummary marker type
configured. Your output format must also support this feature. For more information about output formats that
support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to assign alternate text to tables in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for assigning alternate text to tables in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To assign table summaries in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the table to which you want to assign a table
summary.

2. Insert your cursor in front of the table.

3. On the Special menu, click Marker.

4. In the Marker Type field, select TableSummary from the drop-down list.

5. If the TableSummary marker type is not on the list, check with the Stationery designer to obtain the name
of the marker type the Stationery designer created to support this functionality and then use the marker
type specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

6. In the Marker Text field, type the table summary you want to assign to the table.

7. Click New Marker.

8. Save your Adobe FrameMaker source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. Verify ePublisher assigned the table summary you specified to the table when it generated output by
completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the table to which you assigned a table summary in
Notepad, where TargetName is the name of your target.

c. Verify that the table summary you specified is included in the summary attribute for the table.
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Excluding Tables from Accessibility Report Checks in FrameMaker
Tables used specifically for layout may not need a table summary. For example, if you use a table for layout, you
probably would not assign a table summary to the table. However, you may have configured Accessibility reports
to check for tables without table summaries and notify you when a table does not have a table summary.

In this scenario, while you want an Accessibility report to notify you when you have a table without a table
summary, you do not want to be notified when you deliberately did not assign a table summary to a table because
a table summary is not required. To address this issue, you can use the TableSummaryNotReq marker to exclude
a table that deliberately does not have a table summary from validation when you generate Accessibility reports.
For more information about Accessibility reports and configuring and generating Accessibility reports, see
“Understanding Accessibility Reports”, “Configuring Reports”, and “Generating Reports”.

To exclude tables from Accessibility report checks, your Stationery and FrameMaker template must have the
TableSummaryNotReq marker type configured. Your output format must also support this feature. For more
information about output formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to exclude tables without table summaries from
Accessibility report checks in Adobe FrameMaker source documents using unstructured Adobe FrameMaker 7.2.
Steps for excluding tables without table summaries from Accessibility report checks in Adobe FrameMaker may
be different in other versions of Adobe FrameMaker.

To exclude a table without a table summary from Accessibility report checks in an Adobe
FrameMaker source document

1. In your Adobe FrameMaker source document, locate the table without a table summary that you want to
exclude from an Accessibility report check.

2. Insert your cursor in front of the table.

3. On the Special menu, click Marker.

4. In the Marker Type field, select TableSummaryNotReq from the drop-down list.

5. If the TableSummaryNotReq marker type is not on the list, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

6. In the Marker Text field, do not enter any text. You do not need to enter any text in this field when you
insert a TableSummaryNotReq marker.

7. Click New Marker.

8. Save your Adobe FrameMaker source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. Generate the Accessibility report and confirm that ePublisher did not generate an Table is missing a
table summary message for the table. For more information about generating Accessibility reports and
Accessibility report messages, see “Generating Reports” and “Accessibility Report Messages”.
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Assigning Alternate Text to Abbreviations in FrameMaker
Abbreviations are often used in written communication. Using an Abbreviation character format and an
AbbreviationTitle marker, you can specify alternate text for abbreviations. For example, if your source
document includes an abbreviation such as SS#, you can specify Social Security Number as alternate text for the
abbreviation. When you use an AbbreviationTitle marker and Abbreviation character format to specify alternate
text for an abbreviation, ePublisher adds the abbreviation alternate text you specify to the title attribute of the
abbr tag in the output.

Following is an example of the HTML code produced when you specify Social Security Number as alternate text
for SS#.

<th>First name</th>

<th><abbr title="Social Security Number">SS#</abbr></th>

 

To assign alternate text to abbreviations, your Stationery and template must have the following items configured:

Abbreviation character format

AbbreviationTitle marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify alternate text for abbreviations in Adobe
FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying alternate text for
abbreviations in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To specify alternate text for an abbreviation in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the abbreviation for which you want to specify
alternate text.

2. Apply the Abbreviation character format to the abbreviation text.

3. Insert your cursor anywhere inside the abbreviation.

4. On the Special menu, click Marker.

5. In the Marker Type field, select AbbreviationTitle from the drop-down list.

6. If the AbbreviationTitle marker type is not on the list, check with the Stationery designer to obtain the
name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in FrameMaker”.

7. In the Marker Text field, type the abbreviation alternate text.

8. Click New Marker.

9. Save your Adobe FrameMaker source document.

10. Generate output for your project. For more information, see “Generating Output”.
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11. Verify ePublisher assigned the abbreviation alternate text you specified when it generated output by
completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the abbreviation to which you assigned alternate
text in Notepad, where TargetName is the name of your target.

c. Verify that the alternate text you specified for the abbreviation is included in the abbr tag in the
title attribute.
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Assigning Alternate Text to Acronyms in FrameMaker
Acronyms are often used in written communication. Using an Acronym character format and an AcronymTitle
marker, you can specify alternate text for acronyms. For example, if your document includes an acronym like
NATO you can specify North Atlantic Treaty Organization as alternate text for the acronym. When you use an
AcronymTitle marker and an Acronym character format to specify alternate text for an acronym, ePublisher adds
the acronym alternate text you specify to the title attribute of the acronym tag in the output.

Following is an example of the HTML code produced when you specify North Atlantic Treaty Organization as
alternate text for NATO.

<p><acronym title=”North Atlantic Treaty Organization”>NATO</acronym> is a military
alliance.<p>

 

To assign alternate text to acronyms, your Stationery and template must have the following items configured:

Acronym character format

AcronymTitle marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify alternate text for acronyms in Adobe
FrameMaker source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying alternate text for
acronyms in Adobe FrameMaker may be different in other versions of Adobe FrameMaker.

To specify alternate text for an acronym in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the acronym for which you want to specify alternate
text.

2. Apply the Acronym character format to the acronym text.

3. Insert your cursor anywhere inside the acronym.

4. On the Special menu, click Marker.

5. In the Marker Type field, select Acronym from the drop-down list.

6. If the Acronym marker type is not on the list, check with the Stationery designer to obtain the name of
the marker type the Stationery designer created to support this functionality and then use the marker type
specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

7. In the Marker Text field, type the acronym alternate text.

8. Click New Marker.

9. Save your Adobe FrameMaker source document.

10. Generate output for your project. For more information, see “Generating Output”.

11. Verify ePublisher assigned the acronym alternate text you specified when it generated output by completing
the following steps:
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a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the acronym to which you assigned alternate text in
Notepad, where TargetName is the name of your target.

c. Verify that the alternate text you specified for the acronym is included in the acronym tag in the
title attribute.
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Providing Citations for Quotes in FrameMaker
A citation is a reference or footnote to a book, article, or other material that specifies the source from which a
quotation was borrowed. A citation contains all the information necessary to identify and locate the work. Using a
Citation character format and the Citation marker, you can specify citations for quotes that enable users to go to a
Web site that contains additional information about the quote.

Following is an example of the HTML code produced when you specify a citation for a quote.

<blockquote cite="http://shakespeare.mit.edu/lll/full.html"> <p>Remuneration! O! that's the
Latin word for three farthings.

--- William Shakespeare (Love's Labor Lost).</p> </blockquote>

 

To provide citations for quotes, your Stationery and template must have the following items configured:

Citation character format

Citation marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify citations for quotes in Adobe FrameMaker
source documents using unstructured Adobe FrameMaker 7.2. Steps for specifying citations for quotes in Adobe
FrameMaker may be different in other versions of Adobe FrameMaker.

To specify citations for quotes in an Adobe FrameMaker source document

1. In your Adobe FrameMaker source document, locate the quotation for which you want to specify a citation.

2. If the quotation is a phrase within a paragraph, complete the following steps:

a. Apply the Citation character format to the quotation phrase.

b. Insert your cursor anywhere inside the quotation phrase.

c. On the Special menu, click Marker.

3. If the quotation is a full paragraph, complete the following steps:

a. Insert your cursor into the paragraph.

b. On the Special menu, click Marker.

4. In the Marker Type field, select Citation from the drop-down list.

5. If the Citation marker type is not on the list, check with the Stationery designer to obtain the name of
the marker type the Stationery designer created to support this functionality and then use the marker type
specified by the Stationery designer. For more information, refer to “Implementing Online Features in
FrameMaker”.

6. In the Marker Text field, type the URL for the citation.

7. Click New Marker.

8. Save your Adobe FrameMaker source document.
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9. Generate output for your project. For more information, see “Generating Output”.

10. Verify ePublisher created the citation you specified when it generated output by completing the following
steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the quotation for which you specified a quotation in
Notepad, where TargetName is the name of your target.

c. Verify that the citation you specified for the quotation is included in the cite attribute.
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Troubleshooting FrameMaker issues
Occasionally there might be issues with the source documents you are using. Below is a list linking to the wiki
solutions website that will help you troubleshoot each one:

Issue For more information, see...

If you are trying to use smart quotes Character Mapping in mapentrysets.xml

If you are trying to turn off auto-
hyphenation

Turning off Auto-hyphenation

If you are using autonumbering in
anchored frames

Autonumbered Paragraphs

If you receive a “Cannot Duplicate
Document” upon generation

Cannot Duplicate Document

If you receive a “Cannot Initialize
API” message opening FrameMaker

Cannot Initialize API

If you are working with Change Bars Change Bars

If you receive the “Error
Communicating with FrameMaker”
message upon generating

Error Communicating with FrameMaker

If you are not seeing your filename
Markers in ePublisher

Filename markers are not working

If you are seeing unwanted files in
the temp directory upon generating

Files being created in Temp directory

If you are trying to use an image as a
bullet

Using an image and text together as a paragraph bullet

If you are trying to import an XLS file
into FrameMaker

Problems with Imported Excel files

If you are trying to link to an external
PDF

Creating links outside of project structure

If you are using multiple TOC files in
FrameMaker

FrameMaker books with multiple TOC, Index, or Front-matter files

If your title page material is not
ordered properly

Title page material not ordered properly

If you are having unexpected
paragraph ordering with multiple text
flows

FrameMaker paragraphs in different text flows have unexpected order in HTML

If you are wanting to turn unbulleted
text to bulleted text in the output

How do I turn regular FrameMaker text into bulleted text in my output?

If you are working with structured
content in text-boxes

Structured Elements in Text Boxes

http://wiki.webworks.com/Permalinks/Solutions/Overrides/CharacterMapping
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/Auto-Hyphenation
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/AutonumberedParagraphs
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/CannotDuplicateDocument/
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/CannotIntializeAPI
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/ChangeBars
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/ErrorCommunicating
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/FilenameMakerNotWorking
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/FrmFilesInTempDirectory
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/ImagesAndTextAsBulle
http://wiki.webworks.com/Permalinks/Solutions/Input/FrameMaker/MultipleTOCFiles
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Issue For more information, see...

If you notice that some paragraphs in
your output are formatting differently
than others bearing the same style
name

Unexpected changes in font size or other formatting for certain paragraphs

If you notice a few lines of code
that are very small at the end of the
HTML page from the FM document,

Unexpected Code from FrameMaker plugin
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Preparing Microsoft Word Source
Documents

If you want to implement online content features in your generated output, you need to prepare your Microsoft
Word source documents for output generation. This section explains how to prepare your Microsoft Word source
documents. This section assumes that you use Microsoft Word templates prepared by a Stationery designer.
Using Microsoft Word templates ensures that content in your source documents is formatted consistently and
can be used effectively by ePublisher to generate output. For more information about preparing Microsoft Word
templates, see the ePublisher Design Guide.



224 | Checklist: Preparing Word Source Documents

Checklist: Preparing Word Source Documents
Use the following checklist to help you prepare your Microsoft Word source documents.

Task For more information, see...

1. Review the online features you can
implement and verify which online
features your Stationery supports.

“Implementing Online Features in Word”

2. Obtain your latest templates and
apply the templates to your source
documents.

“Obtaining and Applying the Latest
Microsoft Word Template”

3. Install the WebWorks Transit Menu for
Microsoft Word.

“Working with the WebWorks Transit Menu
for Word”

4. Review any tables in your source
documents and prepare your tables for
output generation as needed.

“Working with Tables in Word”

5. Review any images in your source
documents and prepare your images
for output generation.

“Working with Images in Word”

6. If you want to include an index,
prepare your source files for index
generation.

“Creating Index Entries in Word”

7. If you want to use variables, insert
variables in your source documents.

“Using Variables in Word”

8. If you want to use conditions, apply
conditions to content in your source
documents.

“Using Conditions in Word”

9. If you want to specify file names for
output files, insert Filename markers
in your source documents.

“Specifying Output File Names in Word”

10. If you want to create context-
sensitive help, insert TopicAlias
markers in your source documents.

“Creating Context-Sensitive Help in Word”

11. If you want to create popup
windows, insert hyperlinks and then
insert Popup markers or apply Popup
paragraph styles to content in your
source documents.

“Creating Popup Windows in Word”

12. If you want to create expand/
collapse sections, apply the Expand/
Collapse paragraph style and insert
DropDownEnd markers in your source
documents.

“Creating Expand/Collapse Sections (Drop-
Down Hotspots) in Word”

13. If you want to create related topics,
apply the Related Topics paragraph
style to content in your source
documents.

“Creating Related Topics in Word”
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Task For more information, see...

14. If you want to specify categories
or labels for Wiki pages, insert
WikiCategory markers in your source
documents.

“Specifying Wiki Categories or Labels in
Word”

15. If you want to create See Also links,
insert SeeAlso markers in your source
documents.

“Creating See Also Links in Word”

16. If you want to create meta tag
keywords for pages, insert Keywords
markers in your source documents.

“Creating Meta Tag Keywords in Word”

17. If you want to use multiple page
designs, insert PageStyle markers in
your source documents.

“Assigning Custom Page Styles in Word”

18. If you want to create What’s This
Help, also known as field-level help,
insert WhatIsThisID markers in your
source documents.

“Creating What’s This (Field-Level) Help in
Word”

19. If you want to open certain
topics in a custom window, insert
WindowType markers in your source
documents.

“Opening Topics in Custom Windows in
Word”

20. If you want to customize the table of
contents icons for specific topics,
insert TOCIcon markers in your source
documents.

“Customizing Table of Contents Icons in
Word”

21. If you want to specify context plug-
ins for Eclipse help systems, insert
Context Plugin markers in your source
documents.

“Specifying Context Plug-ins in Word”

22. If you want to create accessible
online content, insert the
appropriate markers and apply the
appropriate paragraph formats and
character formats to images, tables,
abbreviations, acronyms, and citations
in your source documents.

“Creating Accessible Online Content in
Word”
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Implementing Online Features in Word
Implement online features in your output by preparing your Microsoft Word source documents with custom
marker types, paragraph styles, and character styles defined by the Stationery designer for your Stationery. These
markers and styles define the presentation and behavior or your online content. For example, markers can define
the name of the file generated for a topic. Formats can define how content displays online.
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Understanding Custom Marker Types in Word
ePublisher projects use the custom marker types to implement online features when generating output. Custom
markers are created using custom marker types available in the WebWorks Transit menu for Microsoft Word.
ePublisher inserts markers based on marker types as field codes in your Microsoft Word source documents.

Before you begin using custom marker types to implement online features, talk to the Stationery designer and
verify which online features your Stationery supports. Your Stationery only recognizes the custom marker types
defined by the Stationery designer in your Stationery. If you try to implement online features using custom marker
types not supported in your Stationery, ePublisher does not recognize these items when generating output.

When the Stationery designer creates the Stationery, the Stationery designer can use the default name for a custom
marker type or the Stationery designer can use a different name for the customer marker type. The following
table lists the default names of custom marker types used to implement online features. Always verify with the
Stationery designer the names of the custom marker types you should use when implementing online features
before you use these items in your source documents. If you need to create a custom marker type to implement
an online feature, verify with the Stationery designer that your Stationery supports the custom marker type
before you create the custom marker type and insert and use the custom marker in a source document. For more
information about creating custom marker types, see “Creating Custom Marker Types Using the WebWorks
Transit Menu in Word”.

Marker Type Description

AbbreviationTitle marker type Specifies abbreviation alternate text for browsers to display for abbreviations such as
SS# when a user hovers over the abbreviation in output. Screen readers also can read
the abbreviation alternate text. Used in combination with the Abbreviation character
style. For more information, see “Assigning Alternate Text to Abbreviations in Word”

AcronymTitle marker type Specifies acronym alternate text for browsers to display for acronyms such as HTML
when a user hovers over the acronym in output. Screen readers can also read the
acronym alternate text. Used in combination with the Acronym character style. For more
information, see “Assigning Alternate Text to Acronyms in Word”.

Citation marker type Specifies the source of a quote using a fully qualified Uniform Resource Identifier (URI)
when a user hovers over the quote in output. Screen readers can also read the URI for
the quote. Used in combination with the Citation character style. For more information,
see “Providing Citations for Quotes in Word”.

Context Plugin marker type Specifies context plug-ins for Eclipse help systems. Other Eclipse plug-ins can use the
context plug-in IDs to call the Eclipse help system. For more information, see “Specifying
Context Plug-ins in Word”.

DropDownEnd marker type Marks the end of an expand/collapse section. Used in conjunction with an Expand/
Collapse paragraph style. For more information, see “Creating Expand/Collapse
Sections (Drop-Down Hotspots) in Word”.

Filename marker type Specifies the name of an output file for a page or an image. For more information, see
“Specifying Output File Names in Word”.

GraphicScale marker type Specifies a percentage to use to resize an image, such as 50 or 75 percent, in
generated output. For more information, see “Assigning Image Scales in Word”.

GraphicStyle marker type Specifies the name of a image style defined in a project to apply to an image. This
marker type is an internal marker type that is not displayed in Stationery Designer. You
cannot create a marker type with a different name and assign it this functionality. For
more information, see “Assigning Image Styles in Word”.
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Marker Type Description

ImageAltText marker type Specifies alternate text for an image.This text is added to the alt attribute of the img
tag in the output. Screen readers use this text when you create accessible content. For
more information, see “Assigning Alternate Text to Images in Word”.

ImageAreaAltText marker type Specifies alternate text for clickable regions in an image map. This text is added to the
alt attribute of the img tag in the output. Screen readers use this text when you create
accessible content. For more information, see “Assigning Alternate Text to Image Maps
in Word”.

ImageLongDescByRef marker type Specifies the path to the file that contains the long description for an image. This text is
added to the longdesc attribute of the img tag in the output. Screen readers read this
description when you create accessible content. For more information, see “Assigning
Long Descriptions to Images in Word”.

ImageLongDescNotReq marker type Specifies that a long description is not required for an image, which bypasses this
accessibility check for the image when you create accessible content. For more
information, see “Excluding Images from Accessibility Report Checks in Word”.

ImageLongDescText marker type Specifies the long description for an image. This text is added to the longdesc attribute
of the img tag in the output. Screen readers read this description when you create
accessible content. For more information, see “Specifying Long Descriptions for Images
in Word”.

Keywords marker type Specifies the keywords to include in the meta tag for the topic. The meta tag improves
searchability on the Web. For more information, see “Creating Meta Tag Keywords in
Word”.

PageStyle marker type Specifies the name of a page style defined in the project to apply to a topic. This marker
type is an internal marker type that is not displayed in Stationery Designer. You cannot
create a marker type with a different name and assign it this functionality. For more
information, see “Assigning Custom Page Styles in Word”.

PassThrough Specifies that ePublisher place the contents of the marker directly into the generated
output without processing the content in any way. For example, you could use a
PassThrough marker if you wanted to embed HTML code within your generated output.

Popup marker type Specifies the start of the content to include in a popup window. The content is displayed
in a popup window when you hover over the link. When you click the link in some output
formats, the topic where the popup text is stored, such as the glossary, is displayed. For
more information, see “Using Markers to Create Popup Windows in Word”.

PopupEnd marker type Marks the end of the content to include in a popup window. For more information, see
“Using Markers to Create Popup Windows in Word”.

PopupOnly marker type Specifies the start of the content to include in only a popup window. Browsers display the
content in a popup window when you hover over or click the link. For more information,
see “Using Markers to Create Popup Windows in Word”.

RubiComposite marker type No longer supported.

SeeAlsoKeyword marker type Specifies an internal identifier for a topic. SeeAlsoLink markers in other topics can list
this identifier to create a link to this topic. Used in conjunction with a See Also paragraph
style or character style. For more information, see “Creating See Also Links in Word”.

SeeAlsoLink marker type Identifies an internal identifier from another topic to include in the list of See Also links
in this topic. Used in conjunction with a See Also paragraph style or character style. For
more information, see “Creating See Also Links in Word”.

SeeAlsoLinkDisplayType marker typeSpecifies whether to display the target topics on a popup menu or in a window. By
default, the links are displayed in the Topics Found window. To display a popup menu,
set the value to menu. This marker type is supported only in HTML Help. For more
information, see “Creating See Also Links in Word”.
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Marker Type Description

SeeAlsoLinkWindowType marker
type

Specifies the name of the window defined in the .hhp file, such as TriPane or Main, that
the topic opens in when the user clicks the link. This marker type is supported only in
HTML Help. For more information, see “Creating See Also Links in Word”.

TableStyle marker type Specifies the name of a table style to apply to a table. This marker type is an internal
marker type that is not displayed in the Style Designer as a marker. You cannot create a
marker type with a different name and assign it this functionality. For more information,
see “Applying Table Styles in Word”

TableSummary marker type Specifies an alternate text summary for a table, which is used when you create
accessible content. This text is added to the summary attribute of the table tag in the
output. Screen readers read this description when you create accessible content. For
more information, see “Assigning Alternate Text (Summaries) to Tables in Word”.

TableSummaryNotReq marker type Specifies that a summary is not required for a table, which bypasses this accessibility
check for that table. For more information, see “Excluding Tables from Accessibility
Report Checks in Word”.

TOCIconHTMLHelp marker type Identifies the image to use as the table of contents icon for a topic in the HTML Help
output format. For more information, see “Customizing Table of Contents Icons in Word”.

TOCIconJavaHelp marker type Identifies the image to use as the table of contents icon for a topic in the Sun JavaHelp
output format. For more information, see “Customizing Table of Contents Icons in Word”.

TOCIconOracleHelp marker type Identifies the image to use as the table of contents icon for a topic in the Oracle Help
output format. For more information, see “Customizing Table of Contents Icons in Word”.

TOCIconWWHelp marker type Identifies the image to use as the table of contents icon for a topic in the WebWorks Help
output format. For more information, see “Customizing Table of Contents Icons in Word”.

TopicAlias marker type Specifies an internal identifier for a topic that can be used to create a context-sensitive
link to that topic. For more information, see “Specifying Context-Sensitive Help Links in
Word”.

Topic Description marker type Specifies a topic description for a context-sensitive help topic in Eclipse help systems.
For more information, see “Creating Context-Sensitive Help in Word”.

WhatIsThisID marker type Identifies a What’s This help internal identifier for creating context-sensitive What’s This
field-level help for Microsoft HTML Help. For more information, see “Creating What’s
This (Field-Level) Help in Word”.

WikiCategory marker type Specifies the category or label you want to assign to a topic when generating Wiki
output. For more information, see “Specifying Wiki Categories or Labels in Word”.

WindowType marker type Specifies the name of the window defined in the Help project that the topic should be
displayed in. In Microsoft HTML Help, the window names are defined in the .hhp file.
This marker type is supported in Microsoft HTML Help and Oracle Help. For more
information, see “Opening Topics in Custom Windows in Word”.
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Understanding Paragraph and Character Formats in Word
ePublisher projects use the paragraph styles and character styles defined by the Stationery designer to implement
online features when generating output. Before you begin using paragraph styles and character styles to
implement online features, talk to the Stationery designer and verify which online features your Stationery
supports. Your Stationery only recognizes the paragraph styles and character styles defined by the Stationery
designer in your Stationery. If you try to implement online features using paragraph styles and character styles not
supported in your Stationery, ePublisher does not recognize these items when generating output.

When the Stationery designer creates the Stationery, the Stationery designer specifies the names of paragraph
styles and character styles used to implement an online feature. Consult with the Stationery designer to obtain
the names of the paragraph styles and character styles defined by the Stationery designer to support each online
feature you want to implement.

The following table lists the default names of paragraph styles and character styles used to implement online
features. Always verify with the Stationery designer the names of the styles formats and character styles you
should use when implementing online features before you use these items in your source documents.

style Description

AbbreviationTitle character style Specifies abbreviation alternate text for browsers to display for abbreviations such as
SS# when a user hovers over the abbreviation in output. Screen readers also can read
the abbreviation alternate text. Used in combination with the AbbreviationTitle marker
type. For more information, see “Assigning Alternate Text to Abbreviations in Word”.

AcronymTitle character style Specifies acronym alternate text for browsers to display for acronyms such as HTML
when a user hovers over the acronym in output. Screen readers can also read the
acronym alternate text. Used in combination with the AcronymTitle marker type. For
more information, see “Assigning Alternate Text to Acronyms in Word”.

Citation character style Specifies the source of a quote using a fully qualified Uniform Resource Identifier (URI)
when a user hovers over the quote in output. Screen readers can also read the URI for
the quote. Used in combination with the Citation marker type. For more information, see
“Providing Citations for Quotes in Word”.

Expand/Collapse paragraph style Specifies the content you want to include in an expand/collapse section. Used in
conjunction with a DropDownEnd marker type. For more information, see “Creating
Expand/Collapse Sections (Drop-Down Hotspots) in Word”.

Popup paragraph style Specifies the popup content to display in both a popup window and in a standard
help topic. Applied to the first paragraph of popup content. For more information, see
“Creating Expand/Collapse Sections (Drop-Down Hotspots) in Word”.

Popup Append paragraph style Specifies the popup content to display in a popup window and in a standard help topic.
Applied to additional popup paragraphs when you have more than one paragraph of
popup content. For more information, see “Creating Expand/Collapse Sections (Drop-
Down Hotspots) in Word”.

Popup Only paragraph style Specifies the popup content to display in only a popup window. Applied to the first
paragraph of popup content. For more information, see “Creating Expand/Collapse
Sections (Drop-Down Hotspots) in Word”.

Popup Only Append paragraph style Specifies the popup content to display in only a popup window. Applied to additional
popup paragraphs when you have more than one paragraph of popup content. For more
information, see “Creating Expand/Collapse Sections (Drop-Down Hotspots) in Word”.

Related Topic paragraph style Specifies related topics links. For more information, see “Creating Related Topics in
Word”.
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style Description

See Also character style Specifies the text you want to include in a See Also button. For more information, see
“Creating See Also Links in Word”.

See Also paragraph style Specifies the text you want to include in a See Also inline text link. For more information,
see “Creating See Also Links in Word”.
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Obtaining and Applying the Latest Microsoft Word Template
An efficient, effective, and consistent ePublisher online content generation process relies upon the use of
templates. Templates define paragraph, character, and table styles and standards. Templates may also contain
standard variables and cross-reference definitions that you can use when creating and working with source
documents used to generate online content. Templates help control the look and feel of source documents and
generated output across multiple writers, multiple projects, and multiple types of generated output.

The ePublisher content generation process assumes that you use marker types and paragraph, character, and table
styles defined in a Microsoft Word template prepared by a Stationery designer as you create content and format
your source documents. Using Microsoft Word templates and the marker types and paragraph, character, and table
styles and other layout styles and characteristics defined in templates ensures that you format content in your
source documents consistently and also ensures ePublisher can use your source documents effectively to generate
output.

If your source documents do not use templates or do not use the same marker types, styles and standards defined
in your Stationery by the Stationery designer, your generated output may not conforms to the styles and standards
defined by the Stationery designer for output. You may also not be able to implement some online features if you
do not use the correct templates or the correct marker types and styles defined in the templates.

As a part of preparing your Microsoft Word source documents for output generation, ensure your source
documents use the correct Microsoft Word templates from the Stationery designer and you have applied all
paragraph, character, and table styles specified in the template correctly. For more information about obtaining
and applying the correct Microsoft Word templates for your project, see the ePublisher Design Guide.
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Working with the WebWorks Transit Menu for Word
This section explains how to work with the WebWorks Transit menu for Microsoft Word. For more information
about using the WebWorks Transit menu to prepare Microsoft Word documents for output generation, see
“Checklist: Preparing Word Source Documents”.
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Understanding the WebWorks Transit Menu for Word
The WebWorks Transit menu for Microsoft Word allows you to insert the following items into your Microsoft
Word source documents:

Markers, including filename markers and TopicAlias markers. For more information about markers in
Microsoft Word, see “Understanding Custom Marker Types in Word”.

Conditions. For more information about conditions in Microsoft Word, see “Using Conditions in Word”.

Note: Writers authoring content in non-Word formats do not use the WebWorks Transit menu for Microsoft Word.
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Installing the WebWorks Transit Menu for Word
If you have Microsoft Word installed on you computer, running the ePublisher Express installer will automatically
install the WebWorks Transit plug-in.

If you did not have installed Microsoft Word before installing ePublisher Express, you can do a repair installation
after installing Word.

Make sure every time you run the ePublisher Express installer, to close and save your Word documents.
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Running Transit Menu in Secure Environments
Thankfully, Microsoft eventually got serious about security. Office 2003 added a macro security level feature. By
default, only macros signed with a trusted certificate could run. And guess what!!! Now Quadralay Corporation
has a trusted certificate for macro documents.

Modern versions of Microsoft Office are even more restrictive. Office 2013 is set to disable all macros by default,
providing a notification that the macro wasn’t allowed to run. That’s why after you install ePublisher Express you
still need to say Microsoft Word that you do trust in us.

If you need to know a little bit more on how macros work and what are them, you can go to https://
www.howtogeek.com/171993/macros-explained-why-microsoft-office-files-can-be-dangerous/.

To run the WebWorks Transit menu for Microsoft Word in a Secure Environment

1. Open a Microsoft Word document, or even a Blank document.

2. On the Word menu, click File and then Options.

3. In the window that pops out in the left side menu click on Trust Center, and on the right side select Trust
Center Settings. You should see a window similar to the following figure.

4. After selecting Trust Center Settings you’ll see a new window, click on the left side on Macro Settings
and on the right panel check Disable all macros except digitally signed macros and Trust access to the
VBA project object model. You should see a window similar to the following figure.

https://www.howtogeek.com/171993/macros-explained-why-microsoft-office-files-can-be-dangerous/
https://www.howtogeek.com/171993/macros-explained-why-microsoft-office-files-can-be-dangerous/
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5. Then you can click OK to close all your opened windows and go again to the Word menu, click File and
then Info. I you get the Security Warning then click on the Enable Content button and then Advanced
Options. On the right side you’ll see a window similar to the next one before clicking Advanced Options.
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6. On the Microsoft Office Security Options check Trust all documents from this publisher. As you can
see in the following figure: The digital signature is valid, but the signature is from a publisher whom
you have not yet chosen to trust.
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7. Finally you can double check going through Step 2 and 3 above, and then click on the left side Trusted
Publishers and you’ll see Quadralay Corporation there, as the next figure shows.
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Initializing the WebWorks Transit Menu for Microsoft Word
After you install the WebWorks Transit menu for Microsoft Word, you must initialize the WebWorks Transit menu
before you can use it. For more information about installing the WebWorks Transit Menu for Microsoft Word, see
“Installing the WebWorks Transit Menu for Word”.

To initialize the WebWorks Transit menu for Microsoft Word

1. Open Microsoft Word.

2. Verify that Microsoft Word displays the WebWorks menu on the Microsoft Word menu bar. Your
Microsoft Word menu should be similar to the following figure.

3. If you do not have the WebWorks Transit menu for Microsoft Word installed, install it. For more
information, see “Installing the WebWorks Transit Menu for Word”.

4. If this is the first time you are using the WebWorks Transit menu for Microsoft Word, on the WebWorks
menu, click Initialize Menu. WebWorks initializes the WebWorks Transit menu for Microsoft Word and
displays the WebWorks Transit menu in the Microsoft Word window. Your Microsoft Word Window should
be similar to the following figure.
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Displaying and Hiding the WebWorks Transit Menu in Word
You can choose to display or hide the WebWorks Transit menu in Microsoft Word.

For example, you may want to display the WebWorks Transit menu when you are working in Microsoft Word
documents that you will use to generate output. However, you may want to hide the WebWorks Transit menu
when you are working in Microsoft Word source documentation that you will not use to generate output.

To display or hide the WebWorks Transit menu for Microsoft Word

1. Open Microsoft Word.

2. On the WebWorks menu, click Preferences.

3. If you want to display the WebWorks Transit menu for Microsoft Word in Microsoft Word, select the
Enable Toolbar check box.

4. If you do not want to display the WebWorks Transit menu for Microsoft Word in Microsoft Word, clear
the Enable Toolbar check box.

5. Click OK.
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Creating Custom Marker Types Using the WebWorks Transit Menu in Word
Typically your Stationery designer will provide the list of markers, which are a type of private or custom
Microsoft Word field codes, that you can use in Microsoft Word source documents to create online features. In
most cases, you should not need to create a custom marker type for use in Microsoft Word source documents.
However, if you need to create a custom marker type to implement an online feature, verify with the Stationery
designer that your Stationery supports the custom marker type before you create the custom marker and insert and
use the custom marker in a source document.

Occasionally your Stationery may also support a custom marker type that is not defined in the WebWorks Transit
menu for Microsoft Word. In this situation, first confirm with the Stationery designer that your Stationery
supports the custom marker type. After confirming your project supports the custom marker type, you can create
the custom marker type using the WebWorks Transit menu for Word.

To create a custom marker type using the WebWorks Transit menu for Word

1. In your Microsoft Word source document, on the WebWorks menu, click Markers.

2. Click the plus (+) icon.

3. In the Type field, type CustomMarkerTypeName to create a custom marker type, where
CustomMarkerTypeName is the name of the custom marker type you want to create.

Note: The custom marker type name you type must match the name of the custom marker type supported
in your ePublisher Stationery. If you specify a name for the custom marker type that is different than
the name of the custom marker type supported in your ePublisher Stationery, ePublisher will not be
able to recognize and use the custom marker type when generating output.

4. Click OK.

5. Click OK again to close the window.

The WebWorks Transit menu for Word saves the custom marker you specified in the marker list and inserts the
marker in your Microsoft Word source document.
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Creating a Passthrough Marker in Word
A passthrough marker is a marker that allows you to insert content that you do not want ePublisher to process
when you generate output. For example, if you have embedded multimedia files in your source documents, such
as Audio Video Interleave files (.avi) or Adobe Software Flash files (.swf), you can insert a passthrough marker
with a value that is set to the HTML code that you do not want ePublisher to process.

The following example shows .avi code to which you could insert using a passthrough marker.

<embed src="sample.avi" width="400"

height="300" pluginspage=";>

</embed>

To create a passthrough marker in a Microsoft Word source document

1. In your Microsoft Word source document, locate the paragraph in which you want to insert the passthrough
marker.

2. Insert your cursor in the location on the page where you want to insert the Passthrough marker.

3. On the WebWorks menu, click Markers.

4. In the Marker field, select Passhtrough from the list of markers.

5. In the Value field, type the html code that you would like to not be processed by ePublisher such as the
Flash embed code indicated in the previous topic.r

6. Click OK. ePublisher inserts the Passthrough marker into your source document.

7. Save your Microsoft Word source document.

8. Generate output for your project. For more information, see “Generating Output”.

9. In Output Explorer, verify ePublisher created the appropriate result for your embedded html code. For more
information about viewing output files in Output Explorer, see “Viewing Output in Output Explorer”.
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Working with Tables in Word
This section explains how to prepare tables in source documents for output generation. Obtain your latest
templates and apply the latest table formats from the template to tables in your source documents. If your tables
do not have header rows, create a header row for each table.



Applying Table Styles in Word | 245

Applying Table Styles in Word
Table styles define the appearance of your tables, and ePublisher uses table styles to define the appearance of
tables in generated output. When you work with tables in your Microsoft Word source documents, ensure you
apply the correct table styles to your tables. The Stationery designer defines the table styles you can use in your
Microsoft Word source documents in the Microsoft Word templates you associate with your Microsoft Word
source documents. If you want to specify a different table styles for sets of tables in your generated output, first
ensure the different table styles you want to apply are available in your Microsoft Word source document. Then
apply the different table styles to tables in your Microsoft Word source documents as appropriate.

For example, you may have a small set of tables that contain information about a specific component in a product.
If you decide you want to modify the appearance of these tables in your generated output by specifying that
the tables associated with this component display with a yellow background in your generated output, apply a
table style available in your Microsoft Word source document that the Stationery designer created to meet this
requirement. When you generate output, the Stationery designed by the Stationery designer specifies that any
tables created with a table style configured to display tables with a yellow background display in your output with
a yellow background.

If you are working in Microsoft Word 2000 or earlier, Microsoft did not provide support for named tabled styles
in these versions of Word. You can use TableStyle markers to manually assign table style names to tables. To use
the TableStyle marker, insert the TableStyle marker using the WebWorks Transit menu for Word into a cell in the
table header row, then save your document, generate output, and verify in Output Explorer that ePublisher applied
the table style you specified correctly.

If you are working in Microsoft Word XP (2002) or later, you may use TableStyle markers to assign table styles
if you prefer that approach to using Microsoft’s available table style assignment controls.

Note: TableStyle markers take precedence over table style names derived from Word assigned table styles.

Because of the ambiguity between the different table styles present in the Microsoft Word ribbon for the versions
of 2007 and beyond, a recommended approach would be to use the TableStyle marker in lieu of assigning table
styles,

To set a TableStyle marker in a Microsoft Word source document (instructions for Word 2007 or
higher)

1. In your Microsoft Word source document, locate the table for which you want to assign a tablestyle marker

2. Insert cursor any where inside the table cells.

3. Click the Add-Ins tab to access the WebWorks Transit menu

4. Select the Markers option from the menu

5. In the Configure Markers dialog box, select the TableStyle marker from the list

6. In the text box for Value:, enter in desired name of the TableStyle

7. Click OK

For more information about generating output and using Output Explorer to view output files, see “Generating
and Regenerating Output” and “Viewing Output in Output Explorer”.
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Creating Table Header Rows in Word
Header rows are rows that contain information that help identify the content of a particular column. If the table
spans several pages of a print layout, the header row will usually repeat itself at the beginning of each new page.

When you create a table in Microsoft Word, by default Microsoft Word does not create a header row. However,
if you create header rows in your Microsoft Word source documents, you can quickly and easily specify the
appearance that you want for table header rows in your generated output.

Note: You cannot create table footer rows in Microsoft Word source documents. Microsoft Word does not support
the creation of table footer rows.

The following procedure provides an example of how to create table header rows in Microsoft Word source
documents using Microsoft Word 2003. Steps for creating table header rows in Microsoft Word may be different
in other versions of Microsoft Word.

To create a table header row in a Microsoft Word source document

1. In your Microsoft Word source document, locate the table for which you want to create a table header row.

2. Select the row or rows of an existing table you want to use to create the header row.

3. On the Table menu, click Table Properties.

4. On the Row tab, in the Options area, verify that the Repeat as header row at the top of each page check
box is selected.

5. If the check box is not selected, select the check box to create a header row for the table.

6. Click OK.
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Working with Images in Word
Many writers include images when producing documents using Microsoft Word. Most writers typically insert
images into Microsoft Word source documents in one of the following ways:

Inserting images in Microsoft Word source documents, also known as embedding images

Inserting links to image files in the Microsoft Word source documents

If you insert an image into a Microsoft Word source document, Microsoft Word inserts, or embeds, the image in
the Microsoft Word source document, and the image becomes a part of the document. Embedded images move
with the text of the paragraph in the document. Embedded images in Microsoft Word are also sometimes called
inline shapes.

If you insert a link to an image is Microsoft Word source documents, Microsoft Word inserts a link to the image
and displays the image in the Microsoft Word source document. The link becomes a part of the document, but the
actual image file is not inserted into the document, although the actual image files is displayed in the document.
If you update the image file referenced by the link, Microsoft Word displays the updated image referenced by the
link automatically. Linked images in Microsoft Word are also sometimes called shapes.

There are benefits and drawbacks to inserting images directly into Microsoft Word source documents and
inserting links to images used in Microsoft Word source documents.

For example, if you insert images in Microsoft Word source documents, you do not have worry about breaking
links between the Microsoft Word source documents and the image files. If you link to images in Microsoft Word
source documents, you must ensure that you keep the same file structure for the image files in order to not break
links between the Microsoft Word source document and the image file.

However, linking images in Microsoft Word source files, rather than inserting or embedding images, provides
some of the following benefits:

You can update image files without reinserting the image file into your Microsoft Word source documents.

If you have one image used in multiple places, you can update the image in one place, rather than
reinserting the image into multiple places.

You can manage your documentation files and image files separately, which makes organizing images
easier.

Source documents with linked images are smaller in size than source documents with inserted, or
embedded, images.

When you work with Microsoft Word source documents that you will use to generate output, ensure you follow
the guidelines specified by the Stationery designer for the following items:

Method used to insert images

Correct DPI to use for inserted images

Correct image file format to use for inserted images

For more information about image considerations, see the ePublisher Design Guide.
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Inserting Images in Word
Before you insert images into Microsoft Word source documents you plan to use to generate output, review image
considerations. For more information, see “Working with Images in Word”.

The following procedure provides an example of how to insert an image in Microsoft Word source documents
using Microsoft Word 2003. Steps for inserting an image in Microsoft Word may be different in other versions of
Microsoft Word.

After you insert your images, validate your images. For more information, see “Validating Images in Word”.

To insert an image in a Microsoft Word source document

1. In your Microsoft Word source document, on the Insert menu, click Picture  > From File.

2. Browse to the location of the image file you want to insert in your Microsoft Word source document, and
then select the image file.

3. If you want to embed the image in your Microsoft Word source document, click the Insert button.
Microsoft Word inserts the image in your source document and displays the image.

4. If you want to insert a link to the image file in your Microsoft Word source document, click the drop-
down button on the Insert button and then click Link to File. Microsoft Word inserts a link to the image in
your source document and displays the image in your source document.

After you insert an image, you can assign alternate text or a long description to the image. For more information,
see “Assigning Alternate Text to Images and Image Maps in Word” and “Assigning Long Descriptions to Images
in Word”.
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Validating Images in Word
If you inserted images in your Microsoft Word source documents, you can validate the images you inserted using
the WebWorks Transit menu for Microsoft Word before you generate output. For more information about inserting
images into Microsoft Word source documents, see “Inserting Images in Word”.

In the WebWorks Transit menu for Microsoft Word, embedded images are referred to as inline shapes, and
images referenced by links in Microsoft Word source documents are referred to as shapes.When you validate
embedded images or images referenced by links in Microsoft Word source documents, if ePublisher detects an
issue with the image in your source document, ePublisher displays an error and highlights the image with the issue
in your Microsoft Word source document.

To validate images in a Microsoft Word source document:

1. Open the Microsoft Word source document that contains the images you want to validate.

2. If you want to validate embedded images, complete the following steps:

a. On the WebWorks menu, click Tools  > Validate Inline Shapes.

b. ePublisher displays a message that tells you how many embedded images are in the source
document. Click OK to continue with the validation.

c. If ePublisher did not detect any issues with the embedded images, ePublisher displays a status
message that tells you all embedded images were validated successfully.

d. If ePublisher detects an issue with an embedded image, ePublisher displays an error message.
Complete one of the following steps:

If you want to fix the image with the issue, click No to stop the validation scan. Go to the
highlighted inline shape with the issue, fix the inline shape by re-adding the inline shape to
your Microsoft Word source document, and then run the inline shape validation scan again.

If you want to continue the scan without fixing the image with the issue, click Yes to
continue with the validation scan.

3. If you want to validate images referenced by links, complete the following steps:

a. On the WebWorks menu, click Tools  > Validate Shapes.

b. ePublisher displays a message that tells you how many images referenced by links are in the source
document. Click OK to continue with the validation.

c. If ePublisher did not detect any issues with the images referenced by links, ePublisher displays a
status message that tells you all images were validated successfully.

d. If ePublisher detects an issue with an image referenced by a link, ePublisher displays an error
message. Complete one of the following steps:

If you want to fix the image with the issue, click No to stop the validation scan. Go to the
highlighted shape with the issue, fix the shape by re-adding the link to the shape in your
Microsoft Word source document, and then run the inline shape validation scan again.

If you want to continue the scan without fixing the image with the issue, click Yes to
continue with the validation scan.
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Creating Image Links in Word

You can create image links that allow users who click the image to link to content in another location. For
example, if you include your company logo in a source document, you can define a link for the logo so that when
users click the logo, they link to your company home page.

The following procedure provides an example of how to create an image link in Microsoft Word source
documents using Microsoft Word 2003. Steps for creating an image link in Microsoft Word may be different in
other versions of Microsoft Word.

To create an image link in a Microsoft Word source document

1. In your Microsoft Word source document, insert the image for which you want to create an image link. For
more information, see “Inserting Images in Word”.

2. Select the image for which you want to create an image link.

3. On the Insert menu, click Hyperlink.

Note: If Microsoft Word does not display Hyperlink on the Insert menu, you cannot use this procedure to
create a hyperlinked image. However, you can create a hyperlinked text box to create a hyperlinked
image. For more information, see “Creating Clickable Regions for Image Maps in Word”.

4. In the Insert Hyperlink window, select the object you want to link to and specify the appropriate options.
For example, you can link to an existing file or web page, a location in a document, or an email address.

5. Click OK.

6. Save your Microsoft Word source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher created the image link using the link information you specified on
the page by clicking on the image. For more information about viewing output files in Output Explorer, see
“Viewing Output in Output Explorer”.
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Creating Clickable Regions for Image Maps in Word
An image map can be a single image separated with clickable regions or a composite image made up of multiple
images grouped together, yet still separated with clickable regions. For example, you could create an image of
the countries of Europe and then define an image map for the image that allows users to link to a topic about each
country when they click on an area of the image. User can click France to see information about France, Italy to
see information about Italy, and so on.

When you define an image map, you can also define alternate text for each clickable region. For example,
you might define alternate text for the Italy region as “Click here for more information about Italy.” For more
information about assigning alternate text to image maps, see “Assigning Alternate Text to Images and Image
Maps in Word”.
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Creating Image Maps for Single Images in Word
You create an image map for a single image by inserting the image into a drawing canvas and then creating
text boxes with hyperlinks that link to a location with additional content. You can also create image maps for
composite images. For more information about creating image maps for composite images, see “Creating Image
Maps for Composite Images in Word”.

The following procedure provides an example of how to create an image map for a single image in Microsoft
Word source documents using Microsoft Word 2003. Steps for creating an image map for a single image in
Microsoft Word may be different in other versions of Microsoft Word.

To create an image map for a single image in a Microsoft Word source document:

1. Insert your cursor on the line where you want to insert the single image you want to use for your image
map.

2. On the Insert menu, click Text Box. Microsoft Word inserts a drawing canvas. You will insert your image
and the text boxes that contain hyperlinks for each clickable area you want to specify for the image into this
drawing canvas.

3. Click in the drawing canvas to insert a text box in the drawing canvas.

4. On the Insert menu, click Picture > From File.

5. Browse to the location of the image you want to use for your image map, select the image, and then click
Insert, Link to File, or Insert and Link based on the image insertion method you use for your projects.
Microsoft Word inserts the image into the drawing canvas.

6. Add a text box that covers each region in the image that you want to be able to click by completing the
following steps:

a. Select the drawing canvas.

b. On the Insert menu, click Text Box.

c. Click on the drawing canvas, and then drag and drop the text box over an area of the image you want
to make clickable.

d. Right-click the text box, and then click Format Text box.

e. On the Colors and Lines tab, in the Fill area, in the Color field, select No Fill from the list.

f. In the Line area, in the Color field, select No Line from the list.

g. Click OK.

7. Specify a hyperlink for each text box by completing the following steps:

a. Right-click the text box, and then click Hyperlink from the right-click menu.

b. Specify the location to which you want to link, and then click OK. For example, you can link to a
Web site or you can link to a location in the source document.

8. Press and hold the SHIFT key, and then click the image and the text box you created for each hyperlinked
area you want to use to create the clickable image map for the area.

9. When you have the image and all of the hyperlinked text boxes you created for the image map selected,
continue to press and hold the SHIFT key, then right-click the selection and then click Grouping > Group
on the context menu.
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10. Save your Microsoft Word source document.

11. Generate output for your project. For more information, see “Generating Output”.

12. In Output Explorer, verify ePublisher created the image map using the link information you specified by
clicking on the page that contains the image map and then clicking on each area of the image where you
created a link. For more information about viewing output files in Output Explorer, see “Viewing Output in
Output Explorer”.
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Creating Image Maps for Composite Images in Word
You can create composite images by inserting the composite images into a drawing canvas and then grouping the
composite images with hyperlinked text boxes.

The following procedure provides an example of how to create image maps for composite images in Microsoft
Word source documents using Microsoft Word 2003. Steps for creating image maps for composite images in
Microsoft Word may be different in other versions of Microsoft Word.

To create an image map for a composite image in a Microsoft Word source document

1. Insert your cursor on the line where you want to insert the composite image you want to use for your image
map.

2. On the Insert menu, click Picture > New Drawing. Microsoft Word inserts a drawing canvas. You will
insert the images that make up your composite image and the text boxes that contain hyperlinks for each
clickable area you want to specify for the image into this drawing canvas.

3. Select the drawing canvas, and then on the Insert menu, click Picture > From File.

4. Browse to the location of each image that makes up your composite image, select the image, and then click
Insert, Link to File, or Insert and Link based on the image insertion method you use for your projects.
Microsoft Word inserts the image into the drawing canvas.

5. Position each image that makes up your composite image in the drawing canvas by dragging and dropping
the image into its correct position.

6. Add a text box that covers each region in the image that you want to be able to click by completing the
following steps:

a. Select the drawing canvas.

b. On the Insert menu, click Text Box.

c. Click on the drawing canvas, and then drag and drop the text box over an area of the image you want
to make clickable.

d. Right-click the text box, and then click Format Text box.

e. On the Colors and Lines tab, in the Fill area, in the Color field, select No Fill from the list.

f. In the Line area, in the Color field, select No Line from the list.

g. Click OK.

7. Specify a hyperlink for each text box by completing the following steps:

a. Right-click the text box, and then click Hyperlink from the right-click menu.

b. Specify the location that you want to link to, and then click OK. For example, you can link to a Web
site or you can link to a location in the source document.

8. Press and hold the SHIFT key, and then click each image that makes up your composite image and the text
box you created for each hyperlinked area you want to use to create the clickable image map for the area.

9. When you have the image and all of the hyperlinked text boxes you created for the image map selected,
continue to press and hold the SHIFT key, then right-click the selection and then click Grouping > Group
on the context menu.



Creang Image Maps for Composite Images in Word | 255

Note: After grouping the image and the text boxes, do not use the Hyperlink command on the right-click
menu to assign a hyperlink to the entire group. If you do, the hyperlink you assign for the group will
override the hyperlinks you assigned to the individual text boxes in the group.

10. Save your Microsoft Word source document.

11. Generate output for your project. For more information, see “Generating Output”.

12. In Output Explorer, verify ePublisher created the image map using the link information you specified by
clicking on the page that contains the image map and then clicking on each area of the image where you
created a link. For more information about viewing output files in Output Explorer, see “Viewing Output in
Output Explorer”.



256 | Assigning Image Scales in Word

Assigning Image Scales in Word
When ePublisher converts images inserted into your source documents, it can scale images to make them display
larger or smaller in your generated output. By default, ePublisher uses the scaling factor applied to images as
specified by the image style you apply to each image. For example, if you apply an image style to images and the
Stationery designer defined the image style to scale images to 80% of their original size, all images that have this
image style applied to them will be scaled to 80% in the generated output.

Typically, using the standard scaling factor specified in the image style is sufficient. Occasionally, however you
may want to override the scaling factor for an individual image. For example, while most .gif images scale to
80%, you may have one large image that you want scaled to 60% in your generated output. You can manually
override the standard scaling factor specified in your Stationery for a specific image by using the GraphicScale
marker.

To assign a scale to a specific image, your Stationery and template must have the GraphicScale marker type
configured. Your output format must also support scaling by image. For more information about output formats
that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify image scaling for an image Microsoft Word
source documents using Microsoft Word 2003. Steps for specifying image scaling for an image in Microsoft Word
may be different in other versions of Microsoft Word.

To specify an image scale for an image in a Microsoft Word source document

1. In your Microsoft Word source document, locate the image for which you want to specify image scaling.

2. Right-click the image, and then click Format Picture or Format Object.

3. Change the layout setting of the image to Top and Bottom by completing the following steps:

Note: By default when you insert images into Microsoft Word, Microsoft Word inserts the image using the
Inline with text layout setting. In order to specify the image scale for image output files, you must
group the image and the text box that contains the GraphicScale marker. However, you cannot group
images using the In line with text layout setting in Microsoft Word. To work around this known
Microsoft Word issue, if you have an image that uses an In line with text layout setting, use the Top
and Bottom layout setting for the image while you insert the GraphicScale marker, and then reapply
the In line with text layout setting after you group the image and the GraphicScale marker.

a. On the Layout tab, click Advanced.

b. On the Text Wrapping tab, click Top and Bottom.

c. Click OK, and then click OK again to close the window.

4. Select your image.

5. On the Insert menu, click Text Box, and then click to the right of your image. Microsoft Word inserts a text
box.

6. Insert your cursor into the text box, and then complete the following steps:

a. On the WebWorks menu, click Markers.

b. In the Markers field, select GraphicScale from the list of markers.

c. In the Value field, type a scaling value for the image.



Assigning Image Scales in Word | 257

For example, if you want the image in your Microsoft Word source document reduced by 50% when
you generate output, type 50.

Click OK. ePublisher inserts the GraphicScale marker into the text box.

d. Select the text box.

e. Right-click the selected text box, and then click Format Text Box.

f. On the Colors and Lines tab, in the Fill area, in the Color field, select No Fill.

g. In the Line area, in the Color field, select No Line.

h. Click OK.

7. Drag and drop the text box onto the image.

8. Select the text box and the image.

9. Right-click the selected text box and image, and then click Grouping  > Group.

Note: When you select Group, the location of the image in your Microsoft Word source document may
change in relation to the text in your source document. For example, the image may move up or
down in your Microsoft Word source document. This is known Microsoft Word behavior. You may
need to scroll up or down in your source document to the new location of the image to find the
image.

10. If your image previously used the In line with text layout setting for the image, reassign this style to your
image by completing the following steps:

a. Right-click only the image, and then click Format Object.

Note: You must ensure you right-click only the image, and not on the text box or the grouped text
box and image. If you right-click on the text box or the grouped text box and image, Microsoft
Word does not display the Format Object menu option on the context menu.

b. On the Layout tab, click In line with text.

c. Click OK, and then click OK again to close the window.

11. Save your Microsoft Word source document.

12. Generate output for your project. For more information, see “Generating Output”.

13. In Output Explorer, verify ePublisher created the image using the image scale you specified in the
GraphicScale marker by clicking on the page that contains the image for which you specified image
scaling. For more information about viewing output files in Output Explorer, see “Viewing Output in
Output Explorer”.
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Assigning Image Styles in Word
Typically you do not need to specify an image style for images when you generate output. By default, each
image generated by ePublisher is associated with the default image style defined in the Stationery used by your
Stationery. However, if you want to change the image style of one image or a small set of images, you can specify
the image style you want to use for an image in your source document using the GraphicStyle marker type.

For example, if you want to specify a yellow border around a set of screen shot images that illustrate a particular
piece of product functionality, you can specify that each of the screen shots images in the set have a yellow border
around them through the use of the GraphicStyle marker type.

To assign a style to a specific image, your Stationery and template must have the GraphicStyle marker type
configured. Your output format must also support specifying image styles. For more information about output
formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify image styles for images in Microsoft Word
source documents using Microsoft Word 2003. Steps for specifying image styles for images in Microsoft Word
may be different in other versions of Microsoft Word.

To specify an image style for an image in a Microsoft Word source document

1. In your Microsoft Word source document, locate the image for which you want to specify an image style.

2. Select the image, and then select the WebWorks menu to insert a GraphicStyle marker next to the image.
To insert the marker follow these steps.

a. On the WebWorks menu, click Markers.

b. In the Markers field, select GraphicStyle from the list of markers.

c. In the Value field, type the name of the image style the Stationery designer configured for the
Stationery used by your ePublisher project.

For example, if the Stationery designer configured an image style called GreenBorder in your
Stationery, type GreenBorder.

Click OK. ePublisher inserts the GraphicStyle marker into the text box.

3. Save your Microsoft Word source document.

4. Generate output for your project. For more information, see “Generating Output”.

5. In Output Explorer, verify ePublisher created the image using the image style you specified by clicking on
the page that contains the image for which you specified an image style and verifying ePublisher applied
the image style you specified in the generated output. For more information about viewing output files in
Output Explorer, see “Viewing Output in Output Explorer”.
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Creating Index Entries in Word
An index lists the terms and topics discussed in a document and the page or pages on which they appear. An
online index provides the user with a point-and-click resource for quickly navigating online content.

ePublisher uses the same native index entry features used in source documents to create a printed index to create
an online index. If you include index entries in your source documents, ePublisher detects the index entries and
uses the index entries to create an online index in your generated output.

Microsoft Word inserts index entries as an XE (Index Entry) field in a field code. To create index entries in a
Microsoft Word source document, insert index entries into your Microsoft Word source document. ePublisher then
uses the index entries to create an online index when you generate output.

Before you insert index entries, verify with the Stationery designer that your Stationery is configured to support
online index generation. By default, ePublisher enables online index generate for output, but this functionality can
be disabled in your Stationery by the Stationery designer. Also confirm that your output format supports online
index creation. For more information about output formats that support this feature, see “Features Available in
Each Output Format”.

The following procedure provides an example of how to insert index entries in Microsoft Word source documents
using Microsoft Word 2003. Steps for inserting index entries in Microsoft Word may be different in other versions
of Microsoft Word.

To insert an index entry in a Microsoft Word source document

1. In your Microsoft Word source document, select the word you want to include in your index.

2. Press ALT+SHIFT+X. Microsoft Word displays the selected text in the Main entry field on the Mark Index
Entry window.

3. Specify the appropriate options for the index entry, and then click Mark. For more information about the
options for the index entry, see the Microsoft Word Help.

Microsoft Word inserts each index entry as an XE (Index Entry) field in a field code. Field codes use
hidden text format. If you don’t see the XE field after you insert your index entry, click the Paragraph
symbol on the Standard toolbar.

4. After you insert your index entries, update all of your inserted index entries by completing the following
steps:

a. On the Edit menu, click Select All.

b. Press F9. Microsoft Word updates all of the field codes in the Microsoft Word source document,
including the XE (Index Entry) field codes.

5. Hide the XE (Index Entries) in your source document by clicking the Paragraph symbol on the Standard
toolbar to hide the index field codes and hidden text.

6. Save your Microsoft Word source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher created the index correctly by clicking on the page or tab that displays
the index and then clicking on the index entries. For more information about viewing output files in Output
Explorer, see “Viewing Output in Output Explorer”
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Using Variables in Word
A variable serves as a placeholder for information that may change frequently. Using variables in source
documents allows you to quickly and easily control the content in your generated output. When you change the
value of a variable in an ePublisher project, it changes the value in only your generated output. The variable value
does not change in your source document.

Once you insert variables into your source documents, whenever the value of a item defined by a variable needs to
change, you can make the change in a single location, rather than searching and replacing for all instances of the
item. For example, you can use variables in the following ways:

If you have publication dates or release dates in your source documents that you need to update
periodically, you can set up the date as a variable.

If you work with products that have names or versions that frequently change, you can set up variables for
product names and versions.

If you need to produce documentation sets for a product with multiple brands, you can use variables to help
you produce documentation for each different brand using the same set of source files.
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Creating Variables in Word
Microsoft Word implements variables as DocProperty field codes. When you work with Microsoft Word source
documents, typically you use variables defined in a Microsoft Word template by a Stationery designer. The
variables in these templates will also include the built-in document properties such as Author or Subject. You
import these variables into your Microsoft Word source documents when you apply the template to your source
documents. After you import the variables, you insert the variables as appropriate.

Typically you should not need to create variables in your Microsoft Word source files if you use a Microsoft
Word template created by a Stationery designer. However, in some cases you may need to create a variable in a
Microsoft Word source document if you do not have a Microsoft Word template that includes a variable you need
for your project.

The following procedure provides an example of how to create variables in Microsoft Word source documents
using Microsoft Word 2007 and Word 2010.

Note: Newer versions of Word may or may not use this exact procedure, however this may provide enough
information to get working with variables in Word.

To create a variable in Word 2007 or Word 2010

1. Go to File, and click Info

2. Click the Properties tab in the right-hand side of the window and click the Advanced Properties option
from the dropdown

3. Click the Custom tab

4. Type in the Name of your variable in Name, for example BookName

5. For the Value, type in the information you want the variable to represent, for example User Guide

6. Click Add to add the variable to the list
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Inserting Variables into Word
You can insert a variable into a source document after you apply a Microsoft Word template that contains the
variables to your source document. If you want to use a variable that is not defined in a Microsoft Word template,
you must create the variable in your source document before you can insert it. For more information about
creating a variable, see “Creating Variables in Word”.

The following procedure provides an example of how to insert variables in Microsoft Word source documents
using Microsoft Word 2007 or 2010.

Note: Newer versions of Word may or may not use this exact procedure, however this may provide enough
information to get working with variables in Word.

To insert a variable (DocProperty field) into a Microsoft Word document

1. Open the Microsoft Word source document in which you want to insert a variable.

2. Place your cursor in the location where you want to insert the variable.

3. Go to the Insert ribbon and click on the Quick Parts dropdown and then select Field...

4. In the Field names selection box, select DocProperty

5. In the adjacent selection box labeled Property, select the appropriate variable name to insert in your
document
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Changing Variable Values in Word
You can change the value assigned to a variable in a Microsoft Word source document.

Note: After you change a variable value in your source document, update the variable value for the variable from
the previous value to the new value by selecting all the content in your Microsoft Word source document
and then pressing the F9 key.

The following procedure provides an example of how to change a variables in Microsoft Word source documents
using Microsoft Word 2007 or 2010.

Note: Newer versions of Word may or may not use this exact procedure, however this may provide enough
information to get working with variables in Word.

To change a variable value in a Microsoft Word source document

1. Open the Microsoft Word source document that contains the variable with a value you want to change.

2. On the File menu, click Info.

3. Click the Properties tab in the right-hand side of the window and click the Advanced Properties option
from the dropdown

4. Click the Custom tab and from the Name list box, select the variable you wish to change

5. In the Value field, type a new value for the variable. The value you type is the value that Microsoft Word
displays in your Microsoft Word document.

6. Click OK

7. On the Edit menu, click Select All.

8. Press the F9 key. Microsoft Word updates the variable value in each place in your source document where
you inserted the variable.

9. Click Done again to close the window.



264 | Deleng Variables in Word

Deleting Variables in Word
Delete a variable in a Microsoft Word source document when you no longer want to use the variable. Before you
delete a variable, ensure you search for the variable and delete or replace all references to the variable. If your
source document still contains a reference to a variable after you delete it, Microsoft Word displays errors in
places where a reference to a deleted variable still exists.

The following procedure provides an example of how to delete variables in Microsoft Word source documents
using Microsoft Word 2007 or 2010.

To delete a variable in a Microsoft Word source document

1. Open the Microsoft Word source document that contains the variable you want to delete.

2. Press Alt+F9 to display all field codes in the source document.

3. Search for and replace all references to the variable you want to delete.

4. On the File menu, click Info

5. Click Properties and select Advanced Properties

6. On the Custom tab, in the Properties field, select the name of the variable you want to delete in the Name
column.

7. Click Delete.

8. Click OK.

9. On the Edit menu, click Select All.

10. Press the F9 key. Microsoft Word updates the fields in your Microsoft Word source document. If there are
any fields that reference the deleted variable in your source document, Microsoft Word displays an error
message in the field.

11. Search for the word Error in your Microsoft Word source document to verify no references to the deleted
variable remain in your source document.

12. Save your Microsoft Word source document.



Using Condions in Word | 265

Using Conditions in Word
Conditions allow you to show or hide information in your source documents and in your online output. You apply
conditions to the content in your source documents, and then you set the visibility for those conditions either in
your source documents or in your ePublisher project.

For example, your source documents might contain some content that should be displayed in only the printed
version and other content that should be displayed in only the online version. You can use the same set of source
documents for both printed and online versions through the use of conditions. You can create one condition
called PrintOnly specifically for printed content, and then you can create another condition called OnlineOnly
specifically for online content. After you create the PrintOnly and OnlineOnly conditions, you can apply them to
the appropriate content in your source documents.

Use the WebWorks Transit menu plug-in for Microsoft Word to work with conditions in your Microsoft Word
source documents. ePublisher installs the WebWorks Transit menu plug-in for Microsoft Word by default when
you install ePublisher Express. You also have the option to install the WebWorks Transit menu plug-in for
Microsoft Word when you install ePublisher Designer or ePublisher AutoMap. For more information about
installing the WebWorks Transit menu plug-in for Microsoft Word, see “Installing ePublisher Components”.

After you apply conditions in your source documents, ePublisher can use the conditions defined in your source
document to control the visibility of content when it generates output. You can also change the visibility specified
for any condition in your ePublisher project. Changing the visibility specified for any condition in your ePublisher
project does not change the visibility specified for the condition in your source documents.
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Creating Conditions in Word
The WebWorks Transit menu for Microsoft Word allows you to quickly and easily create conditions you can
then use to control content in your source documents. Obtain a list of supported conditions from the Stationery
designer, and then create each supported condition in each of your Microsoft Word source documents using the
WebWorks Transit menu for Microsoft Word.

The following procedure provides an example of how to create conditions in Microsoft Word source documents
using Microsoft Word 2003. Steps for creating conditions in Microsoft Word may be different in other versions of
Microsoft Word.

To create a condition in a Microsoft Word source document

1. Open Microsoft Word.

2. Ensure that the WebWorks Transit Menu for Microsoft Word is installed on your computer and initialized.
For more information, see “Working with the WebWorks Transit Menu for Word”.

3. In your Microsoft Word source document, on the WebWorks menu, click Conditions.

4. Click the Add icon.

5. In the Type field, type a name for the condition.

For example, if you want to create a condition for content that you want to display in only online content,
type OnlineOnly. If you want to create a condition for content that you want to display in only printed
content, type PrintOnly.

6. If you want the content the condition is applied to hidden in Microsoft Word, select the Hidden check
box.

7. If you want to highlight the content the condition is applied to in Microsoft Word, in the Highlight field,
select a color from the drop-down list. Highlighting the content the condition is applied to allows you to
more easily see the conditionalized content in your Microsoft Word source documents.

8. Click OK.

9. Click OK again.
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Applying Conditions in Word
After you have created conditions in your Microsoft Word source documents, you can apply conditions to content.
For more information about creating conditions in Microsoft Word source documents, see “Creating Conditions in
Word”.

The following procedure provides an example of how to apply conditions in Microsoft Word source documents
using Microsoft Word 2003. Steps for applying conditions in Microsoft Word may be different in other versions of
Microsoft Word.

To apply a condition to content in a Microsoft Word source document

1. In your Microsoft Word source document, select the content to which you want to apply the condition.

2. On the WebWorks menu, click Conditions.

3. Select a condition.

4. Click Apply Condition.

5. Click OK.
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Validating Conditions in Word
An unbalanced condition is a condition that does not have either an opening or closing tag. You may accidently
create an unbalanced condition if you delete an opening or closing tag.

The following is an example of a balanced condition:

{PRIVATE WWMTS PrintOnly} Timing Devices {PRIVATE WWMTE PrintOnly}

The following is an example of an unbalanced condition:

{PRIVATE WWMTS PrintOnly} Timing Devices

If you have any unbalanced conditions in your Microsoft Word source documents, ePublisher cannot apply the
condition when it generates output.

If you use conditions in your Microsoft Word source documents, validate your conditions and verify that your
conditions are balanced before you generate output. When you validate conditions, if you have unbalanced
conditions in your Microsoft Word source document ePublisher displays the following error.

If ePublisher displays the error, you can go either go to the location of the error, fix the unbalanced condition in
your source document, and then continue the validation, or you can cancel the validation.

To validate conditions in a Microsoft Word source document

1. In your Microsoft Word source document, on the WebWorks menu, click Tools  > Validate Conditions.
ePublisher scans the Microsoft Word source document for unbalanced conditions.

2. If the validation scan detects an unbalanced condition, click Navigate to error to go to the unbalanced
condition and correct the error.

3. If you want the validation scan to continue without correcting the unbalanced condition, click Continue
scan.

4. If you want to cancel the validation scan, click Cancel scan.
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Removing Conditions in Word
If you no longer want to apply a condition to content in a Microsoft Word source document, you can remove the
applied condition from the content.

The following procedure provides an example of how to remove conditions from content in Microsoft Word
source documents using Microsoft Word 2003. Steps for removing conditions from content in Microsoft Word
may be different in other versions of Microsoft Word.

To remove a condition from content in a Microsoft Word source document

1. In your Microsoft Word source document, select the content with the condition you want to remove.

2. On the WebWorks menu, click Conditions.

3. Click the Delete icon.

4. If you want to remove the condition from the content but keep the content in your Microsoft Word source
document, click OK.

5. If you want to remove both the condition from the content and delete the content from your Microsoft
Word source document, select the Delete applied content check box, and then click OK.

6. Click OK again.
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Modifying Conditions in Word
You can edit the name of the condition, specify whether you want the content to which you applied the condition
hidden or displayed in Microsoft Word, and change the color assigned to a condition.

The following procedure provides an example of how to modify conditions in Microsoft Word source documents
using Microsoft Word 2003. Steps for modifying conditions in Microsoft Word may be different in other versions
of Microsoft Word.

To modify a condition in a Microsoft Word source document

1. In your Microsoft Word source document, on the WebWorks menu, click Conditions.

2. Select the condition you want to modify.

3. Click the Edit icon.

4. If you want to change the name of the condition, in the Type field, type a new name for the condition.

5. If you want the content the condition is applied to hidden in Microsoft Word, select the Hidden check
box.

6. If you want the content the condition is applied to displayed in Microsoft Word, clear the Hidden check
box.

7. If you want to change the color used to highlight the content to which the condition is applied, in the
Highlight field, select a color from the drop-down list. Specifying a color for the condition allows you to
more easily see the content the condition is applied to in your Microsoft Word source document.

8. Click OK.

9. Click OK again.
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Highlighting All Conditions in Word
You can use WebWorks Transit menu functionality to highlight conditions you applied in your Microsoft Word
source document. Highlighting all of the conditions you applied in your Microsoft Word source document allows
you to see where all of the conditional content is in your Microsoft Word source document.

The following procedure provides an example of how to highlight all conditions in Microsoft Word source
documents using Microsoft Word 2003. Steps for highlighting all conditions in Microsoft Word may be different
in other versions of Microsoft Word.

To highlight all conditions in a Microsoft Word source document

1. In your Microsoft Word source document, on the WebWorks menu, click Preferences.

2. Select the Show highlighting check box.

3. Click OK.
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Displaying Conditionalized Content with Conflicting Settings in Word
You can apply more than one condition to content in your Microsoft Word source documents. If you apply more
than one condition to content in your Microsoft Word source document and the conditions that you applied to
the content have different show and hide settings, you can specify how you want conditionalized content with
conflicting show and hide settings displayed in your Microsoft Word source documents.

For example, you may have content with three conditions applied to it. Two of the conditions applied may be set
to show, or display, in the Microsoft Word source document, while one of the conditions may be set to hide, or not
display, in the Microsoft Word source document.

If you have multiple conditions applied to content in your source documents with conflicting show and hide
settings, you can choose if you want to display the content with conflicting conditions in a Microsoft Word source
document or hide the content.

The following procedure provides an example of how to display conditionalized content with conflicting
show and hide settings in Microsoft Word source documents using Microsoft Word 2003. Steps for displaying
conditionalized content with confecting show and hide settings in Microsoft Word may be different in other
versions of Microsoft Word.

To display conditionalized content with conflicting show and hide settings in a Microsoft Word
source document

1. In your Microsoft Word source document, on the WebWorks menu, click Preferences.

2. If you want to show content that has conditions applied with conflicting show and hide settings, select
the Give priority to show conditions check box. This check box is selected by default.

3. If you want to hide content that has conditions applied with conflicting show and hide settings, clear the
Give priority to show conditions check box.

4. Click OK.
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Using Passthrough Conditions in Word
A passthrough condition is a condition you apply to content that you do not want ePublisher to process when you
generate output. For example, if you have embedded multimedia files in your source documents, such as Audio
Video Interleave files (.avi) or Adobe Software Flash files (.swf), you can apply a passthrough condition to the
code so that ePublisher does not process the code.

The following example shows .avi code to which you can apply a passthrough condition.

<embed src="sample.avi" width="400"

height="300" pluginspage=";>

</embed>

The following example shows .swf code to which you can apply a passthrough condition.

<embed src="sample.swf" width="400"

height="300" pluginspage="

http://www.macromedia.com/shockwave/download/index.cgi?
P1_Prod_Version=ShockwaveFlash";>

</embed>

If you have code in your Microsoft Word source documents that you do not want ePublisher to process, create a
passthrough condition and then apply the passthrough condition to the code. For more information, see “Creating
Conditions in Word” and “Applying Conditions in Word”.

You can also use Passthrough markers and the Passthrough paragraph styles and character styles options to insert
content directly into your output without being transformed and coded for your output.
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Deleting Conditions in Word
Delete a condition in a Microsoft Word source document when you no longer want to apply the condition to
content in the source document.

The following procedure provides an example of how to delete conditions in Microsoft Word source documents
using Microsoft Word 2003. Steps for deleting conditions in Microsoft Word may be different in other versions of
Microsoft Word.

To delete a condition in a Microsoft Word source document

1. In your Microsoft Word source document, on the WebWorks menu, click Conditions.

2. Select the condition you want to delete.

3. Click the Delete condition icon.

4. If you want to delete the condition from the list of available conditions and remove the condition from
any content to which it was applied in the source document, click OK. ePublisher removes the condition
from the list of conditions and removes the condition from any content in the source document to which
you applied the condition.

5. If you want to delete the condition from the list of available conditions and also delete any content
to which the condition was applied, select the Delete applied content check box, and then click OK.
ePublisher removes the condition from the list of conditions and deletes any content to which the condition
was applied in the source document.
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Specifying Output File Names in Word
By default, ePublisher automatically assigns file names to your generated output files for topics (pages) and for
embedded images (graphics).

Note: If you insert your images using the Link to File or Insert and Link option in the Insert Picture window
in Microsoft Word, ePublisher preserves the original file names. For more information, see “Working with
Images in Word”.

You can customize this naming convention using one of the following methods:

Inserting Filename markers into your source documents

Specifying the topic (page) and image (graphic) naming patterns for ePublisher to use in the target settings
for your output

This section explains how you can specify page and image output file names in your Word source documents
using Filename markers. For more information about using target settings to specify output file names using page
and image naming patterns, see “Specifying Page, Image, and Table File Naming Patterns”.
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Specifying Page Output File Names in Word
Specify specific names for page output files when you generate output using Filename markers. Insert Filename
markers into your source document for each page you want to specify a file name for when you generate content.

Note: You can also use page naming patterns to specify names for page output files and embedded image output
files. For more information, see “Specifying Page, Image, and Table File Naming Patterns”.

To specify a file name for a page output file, your Stationery and template must have the Filename marker type
configured. Your output format must also support this feature. For more information about output formats that
support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify page output file names in Microsoft Word source
documents using Microsoft Word 2003. Steps for specifying page output file names in Microsoft Word may be
different in other versions of Microsoft Word.

To specify page output file names in a Microsoft Word source document

1. In your Microsoft Word source document, locate the page for the topic to which you want to assign a
specific file name. For more information about creating pages using page breaks, see “Specifying Page
Breaks Settings”.

2. Insert your cursor at the beginning of the first heading on the page.

3. On the WebWorks menu, click Insert Filename Marker.

4. In the Filename field, complete the following steps:

a. Type the file name you want to specify for the output page file. Do not include the output file
extension when you type the file name text.

b. Click OK. ePublisher inserts the Filename marker into your Microsoft Word source document.

5. Save your Microsoft Word source document.

6. Generate output for your project. For more information, see “Generating Output”.

7. In Output Explorer, verify ePublisher created an output file using the file name you specified. For more
information, see “Viewing Output in Output Explorer”.
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Specifying Image Output File Names in Word
Specify specific names for image output files when you generate output if you embed, or insert images directly
into the source document instead of inserting and linking or linking images.

Many writers do not need use Filename markers to specify image output file names because many writers prefer
to insert images in Microsoft Word source documents as references, or links, using the Link to File or Insert and
Link option in the Insert Picture window in Microsoft Word. When writers use one of these methods to insert
images, ePublisher automatically uses the name of the image file referenced by the link as the name of the image
output file when generating image output files from Microsoft Word source documents.

However, some writers prefer to insert images directly into Microsoft Word source documents using the Insert
option in Microsoft Word. If you use the Insert option, Microsoft Word inserts the image directly into the
Microsoft Word source document. When you use the Insert option to insert images directly into Microsoft Word
source documents, by default, ePublisher assigns image output file names for the inserted images using an image
naming pattern. For more information about image naming patterns, see “Specifying Page, Image, and Table File
Naming Patterns”.

However, if you use the Insert option to insert images directly into Microsoft Word source documents, you can
also use Filename markers to specify image output file names. Insert Filename markers into your source document
for each image you want to specify a file name for when you generate content. To specify a file name for an image
output file, your Stationery must have the Filename marker type configured. Your output format must also support
this feature. For more information about output formats that support this feature, see “Features Available in Each
Output Format”.

When you specify image output file names, you create a text box, insert a Filename marker in the text box, and
then group the image and the text box that contains the Filename marker. The following procedure provides
an example of how to specify image output file names in Microsoft Word source documents using Microsoft
Word 2003. Steps for specifying image output file names in Microsoft Word may be different in other versions of
Microsoft Word.

To specify image output file names for inserted images in a Microsoft Word source document

1. In your Microsoft Word source document, locate the inserted image for which you want to assign an output
image file name.

Note: Only perform this procedure if you have inserted the image directory into the file using the Insert
option when you inserted the image into your Microsoft Word source document. Do not perform this
procedure if you have inserted the image using the Link to File or Insert and Link options when
you inserted the image into your Microsoft Word source document.

2. Right-click the image, and then select Format Picture or Format Object.

3. Change the layout setting of the image to Top and Bottom by completing the following steps:

Note: By default when you insert images into Microsoft Word, Microsoft Word inserts the image using the
Inline with text layout setting. In order to specify an image output file name for an inserted image,
you must group the image and the text box that contains the Filename marker. However, you cannot
group images using the In line with text layout setting in Microsoft Word. To work around this
known Microsoft Word issue, if you have an image that uses an In line with text layout setting, use
the Top and Bottom layout setting for the image while you insert the Filename marker, and then
reapply the Inline with text layout setting after you group the image and the Filename marker.

a. On the Layout tab, click Advanced.
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b. On the Text Wrapping tab, click Top and Bottom.

c. Click OK, and then click OK again to close the window.

4. Select the image.

5. On the Insert menu, click Text Box, and then click to the right of your image. Microsoft Word inserts a text
box.

6. Insert your cursor into the text box, and then complete the following steps:

a. On the WebWorks menu, click Insert Filename Marker.

b. In the Filename field, type the file name you want to specify for the output image file, and then click
OK. ePublisher inserts a Filename marker into the text box.

c. Select the text box.

d. Right-click the selected text box, and then click Format Text Box.

e. On the Colors and Lines tab, the Fill area, in the Color field, select No Fill.

f. In the Line area, in the Color field, select No Line.

g. Click OK.

7. Drag and drop the text box onto the image.

8. Select the text box and the image.

9. Right-click the selected text box and image, and then click Grouping  > Group.

Note: When you select Group, the location of the image in your Microsoft Word source document may
change in relation to the text in your source document. For example, the image may move up or
down in your Microsoft Word source document. This is known Microsoft Word behavior. You may
need to scroll up or down in your source document to the new location of the image to find the
image.

10. If your image previously used the In line with text layout setting for the image, reassign this style to the
image by completing the following steps:

a. Right-click only the image, and then click Format Object.

Note: You must ensure you right-click only the image, and not on the text box or the grouped text
box and image. If you right-click on the text box or the grouped text box and image, Microsoft
Word does not display the Format Object menu option on the context menu.

b. On the Layout tab, click In line with text.

c. Click OK, and then click OK again to close the window.

11. Save your Microsoft Word source document.

12. Generate output for your project. For more information, see “Generating Output”.

13. In Output Explorer, verify ePublisher created an image output file using the file name you specified in the
Filename marker. For more information, see “Viewing Output in Output Explorer”.



Creang Context-Sensive Help in Word | 279

Creating Context-Sensitive Help in Word
This section explains how you can use ePublisher to create links to context-sensitive help content in Microsoft
Word source documents
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Understanding Context-Sensitive Help in Word
Context-sensitive help links provide content based on the context of what the user is doing. In many cases, this
help content is based on the window that is open and active. For example, the Help button on a window in a
software product can open a specific Help topic that provides important information about the window:

What the window allows you to do

Brief concepts needed to understand the window

Guidance for how to use the window

Descriptions about each field on the window, valid values, and related fields

Links to related topics, such as concepts and tasks related to the window

The Help topic can also be embedded in the window itself, such as an HTML pane that displays the content of
the Help topic. Providing this content when and where the user needs it, without requiring the user to search
through the help, keeps the user productive and focused. This type of help also makes the product more intuitive
by providing answers when and where needed.

There are several methods for creating context-sensitive Help. In addition, output formats use different
mechanisms to support context-sensitive Help. You can reference a topic in the following ways:

File name
Use a Filename marker to assign a file name to a topic. Each topic can have no more than one Filename
marker by default. However, you can create a custom mapping mechanism using file names. Then, you can
open the specific topic with that file name. However, if your file naming changes, you need to change the
link to the topic. This file naming approach delivers context-sensitive help capabilities in output formats
that do not provide a mapping mechanism.

Internal identifier (topic alias)
Use a TopicAlias marker to define an internal identifier for each topic. The benefit of using an internal
identifier is that it allows file names to change without impacting the links from the product. The writer
inserts this marker in a topic and specifies a unique value for that topic. Then, the mapping mechanism
of your output format determines how that internal identifier is supported. Some output formats, such as
HTML Help, use a mapping file that defines these topic aliases.

To simplify the coding of your source documents, the Stationery designer can also configure your Stationery to
define both the file name and the topic alias for each topic file.

Before you begin to insert Filename markers or TopicAlias markers into your source documents, consult with
your Stationery designer. Confirm that your Stationery supports context-sensitive help links, and discuss with
your Stationery designer the type of marker you should use to define context-sensitive help link in your source
documents.

For more information about configuring Filename and TopicAlias markers for use in context-sensitive help, see
the ePublisher Design Guide.

If you generate Eclipse Help output, you also can choose the topic description you want to display for each
context-sensitive link. When you use a TopicAlias marker to create context-sensitive links, Eclipse creates a
contexts.xml file that lists all of the context IDs for the Eclipse Help system you created using TopicAlias
markers. In the contexts.xml file, Eclipse also provides a description of the context-sensitive link. By default,
the description Eclipse provides for the context-sensitive link is the text of the first paragraph of the topic.
However, if you want to specify a different description for the context-sensitive link, you can do this by using
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the TopicDescription marker. For more information about using the TopicDescription marker, see “Specifying
Context-Sensitive Help Links in Word”.
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Planning for Context-Sensitive Help in Word
Creating context-sensitive help requires you to collaborate with application developers. Because topic IDs and
map numbers must be embedded in both the software application and in your source documents, you and the
application developers must agree in advance on the values to use.

Before you create context-sensitive help topics, first confirm with your application developers that the application
supports context-sensitive help. Then work with your application developers to decide how to choose the topic ID
for each context-sensitive help topic:

You choose the topic IDs
You can choose a set of topic IDs and embed them in your source documents using TopicAlias markers.
When you generate output, ePublisher can generate a mapping file using those topic IDs and assign
a unique number to each topic ID. You can provide the generated mapping file to your application
developers, who can embed the topic IDs in the application code. You can then manually maintain
this mapping file, or you can allow ePublisher to generate a new file each time you generate the help.
Remember to give the updated help system and mapping file to your application developers each time.

Your developers choose the topic IDs
Your application developers can choose a set of topic IDs and embed them in the application code. Then,
you can get a copy of the mapping file from your application developers, specify this mapping file in your
project settings, and embed the topic IDs in your source documents using TopicAlias markers. In this case,
ePublisher does not generate the mapping file.

Before you begin to implement context-sensitive help, meet with your application developers to select one of
these methods for assigning the topic IDs to use for context-sensitive help links. Once you choose a set of topic
IDs, embed them in your source documents using TopicAlias markers and do not change them.

Note: Because of the way Microsoft Word uses markers with the Transit menu, in order for ePublsher to best
pickup a marker such as a TopicAlias, please place this marker after the heading and not before.



Specifying Context-Sensive Help Links in Word | 283

Specifying Context-Sensitive Help Links in Word
You can use TopicAlias markers that contain topic IDs, or Filename markers that specify file names, to create
context-sensitive help. If your output format supports the use of mapping files and topic IDs, typically you use
TopicAlias markers to create context-sensitive help. If your output format does not support the use of mapping
files and topic IDs, typically you use Filename markers to create context-sensitive help.

If you are generating Eclipse Help, you can also choose to specify a topic description for each context-sensitive
help link your created using a TopicAlias marker by using a TopicDescription marker in conjunction with the
TopicAlias marker. For more information about how TopicAlias markers and TopicDescription markers can work
together when generating Eclipse Help, see “Understanding Context-Sensitive Help in Word”.

To specify a context-sensitive help link, your Stationery and template must have a TopicAlias or Filename
marker type configured. If you are generating Eclipse Help and you want to be able to specify topic descriptions
for your context-sensitive help links, you Stationery and template must also have a TopicDescription marker
type configured. Consult with the Stationery designer to determine which marker type you should use to create
context-sensitive help links and topic descriptions in your source documents. Your output format must also
support this feature. For more information about output formats that support this feature, see “Features Available
in Each Output Format”.

The following procedure provides an example of how to create context-sensitive help links and topic descriptions
in Microsoft Word source documents using Microsoft Word 2003. Steps for creating context-sensitive help links
in Microsoft Word may be different in other versions of Microsoft Word.

To create a context-sensitive help link in a Microsoft Word source document

1. Open the Microsoft Word source document that contains the context-sensitive topic you want to link to
when users click a help button or help icon from within an application.

2. Insert your cursor at the end of the heading paragraph (or body paragraph if no heading) to which you want
to link.

3. On the WebWorks menu, click Markers.

4. Select the marker type the Stationery designer configured your Stationery to support from the drop-down
list. For example, select TopicAlias or Filename.

5. In the Value field, type the topic ID you want to specify for the topic.

6. Click OK.

7. If you are generating Eclipse Help and you want to specify topic descriptions for each context-sensitive
help link you are creating, complete the following steps:

a. Insert your cursor in the topic after the TopicAlias marker you inserted for the Eclipse context-
sensitive help topic.

b. On the WebWorks menu, click Markers.

c. Select the TopicDescription marker type from the list.

d. If the TopicDescription marker type is not on the list, check with the Stationery designer to
obtain the name of the marker type the Stationery designer created to support this functionality,
and then use the marker type specified by the Stationery designer. For more information, refer to
“Implementing Online Features in Word”.

e. In the Value field, type the topic description you want to use.
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f. Click OK.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. In Output Explorer, complete the following steps:

a. Verify that ePublisher inserted the topic ID into the map file when it generated output.

b. If you generated Eclipse Help and specified topic descriptions for your context-sensitive help
topics, verify that the contents.xml file for your Eclipse Help system contains the topic descriptions
you specified for context-sensitive help topics.

c. Test the generated output using the application and verify that the application links to the appropriate
context-sensitive help topic. This testing ensures the context-sensitive help link you created displays
correctly within the application.
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Creating Popup Windows in Word
A popup window is a window that is smaller than standard windows and typically does not contain some of the
standard window features such as tool bars or status bars. Popup windows display when users hover over or click
on a link. The popup window closes automatically as soon as the users click somewhere else.

A typical use of popup windows is to display glossary terms. For example, in printed documentation, terms and
definitions are typically grouped in a separate glossary document. However, in online content, you can display
glossary definitions in popup windows. With glossary popup windows, users can choose whether or not they want
to view the definition of a term.

You create popup windows by creating a link between the word or phrase in a topic and the content you want to
display in the popup window. After you create the link, you then insert Popup markers or apply Popup paragraph
styles to define the content you want to display in the popup window.

If the Stationery designer configured the Stationery to support popup windows using markers, you use the
following Popup markers to create popup windows:

Popup
Specifies the start of the content to include in a popup window. The content displays in a popup window
when users hover over or click on the link. In some output formats users can also view the content in a
standard help topic window in addition to viewing the content in a popup window. For example, if you
insert a Popup marker in front of a glossary definition, the glossary definition displays in both a popup
window and in a glossary topic that contains the definition.

PopupEnd
Specifies the end of the content to display in the popup window.

PopupOnly
Specifies that the popup content displays only through a popup window. For example, if you insert a
PopupOnly marker in front of a glossary definition, the glossary definition displays only in a popup
window.

If the Stationery designer configured the Stationery to support popup windows using paragraph styles, you use the
following paragraph styles to create popup windows:

Popup and Popup Append paragraph styles
Specifies that content displays both in popup windows and in standard help topics. You apply the Popup
paragraph style to the first paragraph of content you want displayed in the popup window. If you have more
than one paragraph of content you want to display, you apply the Popup Append style to the additional
paragraphs.

For example, if you apply a glossary term and glossary definitions style for a glossary using the Popup and
Popup Append styles, the terms and definitions in your output display in both a popup window and in a
glossary topic that contains the definitions.

Popup Only and Popup Only Append paragraph styles
Specifies that content displays only in popup windows. You apply the Popup Only paragraph style to the
first paragraph of content you want displayed in the popup window. If you have more than one paragraph of
content you want to display, you apply the Popup Only Append style to the additional paragraphs.
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For example, if you apply a glossary term and glossary definition style for a glossary using the Popup Only
and Popup Only Append paragraph styles, the terms and definitions in your output display in only popup
windows. The content is not displayed in an additional glossary topic that contains the definitions.



Checklist: Creang Popup Windows in Word | 287

Checklist: Creating Popup Windows in Word
If you want to include popup windows in your generated output, prepare your Microsoft Word source documents
using the following checklist.

Task For more information, see...

Create a link between a link between a
word or phrase and the content you want to
display in a popup window.

“Creating Popup Window Links in Word”

If you want to implement popup windows
using Popup markers, insert Popup
markers into the appropriate locations in
your Microsoft Word source documents.

“Using Markers to Create Popup Windows
in Word”

If you want to implement popup
windows using paragraph styles, apply
the appropriate paragraph style to the
appropriate content in your Microsoft Word
source documents.

“Using Paragraph Styles to Create Popup
Windows in Word”
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Creating Popup Window Links in Word
Your first step in creating a popup window is to create a link between a word or phrase in a topic and the popup
content you want to display when users hover over or click the link. Use native Microsoft Word functionality to
create a link between the word or phrase in a topic and the content you want to display in a popup window. You
can create a link in Microsoft Word with a bookmark and a cross-reference or hyperlink.

Before you create popup window links, verify that your output format supports this feature. For more information
about output formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to create a a popup window link in Microsoft Word source
documents using Microsoft Word 2003. Steps for creating popup window links in Microsoft Word may be
different in other versions of Microsoft Word.

To create a link between a word or phrase and popup content in a Microsoft Word source
document

1. In your Microsoft Word source document, locate the text you want to create a link to and display in the
popup window.

2. If you want to create a link that includes the link target text, create the link using a bookmark and a cross-
reference by completing the following steps:

a. Select the text to which you want to link.

b. On the Insert menu, click Bookmark.

c. In the Bookmark name field, type a name for the bookmark in CamelCase. The bookmark name
cannot include spaces.

For example, if you are creating a bookmark for the definition of WebWorks Help in your source
document, type WebWorksHelpDefinition.

d. Click Add. Microsoft Word inserts a hidden bookmark.

e. In your Microsoft Word source document, locate the word or phrase for which you want to create a
link.

f. Using your cursor, select the text you for which you want to create a link.

For example, if you want to specify WebWorks Help as a link, select WebWorks Help.

g. On the Insert menu, click Reference  > Cross-reference.

h. In the Reference type field, select Bookmark.

i. In the Insert reference to field, select Bookmark text.

j. Select the Insert as hyperlink check box.

k. In the For which bookmark field, click the name of the bookmark for the text you want to display
in the popup.

For example, if you created a bookmark named WebWorksHelpDefinition for text that provides a
definition for WebWorks Help, click WebWorksHelpDefinition.

l. Click Insert, and then click Close.
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3. If you want to create a link that does not include the link target text, create the link using a bookmark and
a hyperlink by completing the following steps:

a. Insert your cursor in front of the text to which you want to link.

b. On the Insert menu, click Bookmark.

c. In the Bookmark name field, type a name for the bookmark in CamelCase. The bookmark name
cannot include spaces.

For example, if you are creating a bookmark for the definition of WebWorks Help in your source
document, type WebWorksHelpDefinition.

d. Click Add. Microsoft Word inserts a hidden bookmark.

e. In your Microsoft Word source document, locate the word or phrase for which you want to create a
link.

f. Using your cursor, select the text you for which you want to create a link.

For example, if you want to specify WebWorks Help as a link, select WebWorks Help.

g. On the Insert menu, click Hyperlink.

h. In the Link to area, click Place in This Document.

i. In the Select a place in this document field, under Bookmarks, click the name of the bookmark for
the text you want to display in the popup.

For example, if you created a bookmark named WebWorksHelpDefinition for text that provides a
definition for WebWorks Help, click WebWorksHelpDefinition.

j. Click OK.

4. Verify that the link goes to the appropriate location in the source document by pressing and holding down
the CTRL key and then clicking the link.

5. Save your Microsoft Word source document.

After you create a link between a word or phrase in a topic and the popup content you want to display in the
popup window, define the content you want to display in the popup window using one of the following methods:

Create popup windows using Popup markers. For more information, see “Using Markers to Create Popup
Windows in Word”.

Create popup windows using Popup paragraph styles. For more information, see “Using Paragraph Styles
to Create Popup Windows in Word”.
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Using Markers to Create Popup Windows in Word
You can insert Popup markers into your Microsoft Word source documents to create popup windows. To use
Popup markers to create popup windows, your Stationery must have the following items configured:

Popup marker type

PopupEnd marker type

PopupOnly marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to insert Popup markers in Microsoft Word source
documents using Microsoft Word 2003. Steps for inserting Popup markers in Microsoft Word may be different in
other versions of Microsoft Word.

Note: Popup content is created from whole paragraphs. You cannot include a subset of a paragraph in a
popup.

To use popup markers to create popup windows in a Microsoft Word source document

1. In your Microsoft Word source document, create a link between a word or phrase in the topic and the
content you want to display in the popup window. For more information, see “Creating Popup Window
Links in Word”.

2. Insert your cursor in front of the text you want to display in the popup window.

3. On the WebWorks menu, click Markers.

4. If you want the popup content to display in both a popup window and in a standard help topic, complete
the following steps:

a. Select Popup from the list of markers in the Marker field.

b. Leave the Value field blank.

c. Click OK to insert the marker.

5. If you want the popup content to display only in a popup window, complete the following steps:

a. Select PopupOnly from the list of markers in the Marker field.

b. Leave the Value field blank.

c. Click OK to insert the marker.

6. Specify where you want the popup content to end by completing the following steps:

a. Insert your cursor at the end of the content you want to display in the popup window.

b. On the WebWorks menu, click Markers.

c. Select PopupEnd from the list of markers in the Marker field.

d. Leave the Value field blank.

e. Click OK to insert the marker.
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7. Save your Microsoft Word source document.

8. Generate output for your project. For more information, see “Generating Output”.

9. In Output Explorer, go to the page where you created the popup window and verify that ePublisher created
the popup window that the popup window displays the content you specified. For more information, see
“Viewing Output in Output Explorer”.
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Using Paragraph Styles to Create Popup Windows in Word
You can use Popup paragraph styles in your Microsoft Word source documents to create popup windows. To use
Popup paragraph styles to create popup windows, your Stationery and Microsoft Word template must have the
following items configured:

Popup and Popup Append paragraph style behaviors if you want your content to display both in popup
windows and in standard help topics.

Popup Only and Popup Only Append paragraph style behaviors if you want your content to display only in
popup windows.

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to use Popup paragraph styles to create popup windows in
Microsoft Word source documents using Microsoft Word 2003. Steps for using Popup paragraph styles to create
popup windows in Microsoft Word may be different in other versions of Microsoft Word.

To create popup windows using Popup paragraph styles in a Microsoft Word source document

1. In your Microsoft Word source document, create a link between a word or phrase in the topic and the
content you want to display in the popup window and ensure that the link resolves in the document. For
more information, see “Creating Popup Window Links in Word”.

2. Save your Microsoft Word source document.

3. In the ePublisher Style Designer, configure the destination paragraph styles with the appropriate popup
behavior via the Options panel.

4. Generate output for your project. For more information, see “Generating Output”.

5. In Output Explorer, go to the page where you created the popup window and verify that ePublisher created
the popup window and that the popup window displays the content you specified. For more information,
see “Viewing Output in Output Explorer”.
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Creating Expand/Collapse Sections (Drop-Down Hotspots) in
Word
You can create sections of content that expand and collapse when you click a link or hot spot. This structure
allows you to create items, such as tasks with numbered procedures, bulleted lists, or definitions, that are easy to
scan. Users can then expand individual items to display additional information.

Hot spots for expand/collapse sections initially display in one of the following states:

The content is initially collapsed and will expand beneath the hotspot when the user clicks the hotspot.
Clicking the hotspot a second time causes the expanded content to return to its original collapsed state.

The content is initially expanded and will collapse or disappear from beneath the hotspot when the user
clicks the hotspot.

You create expand/collapse sections in Microsoft Word source documents by using the following items:

An Expand/Collapse paragraph style

A DropDownEnd marker

You use an Expand/Collapse paragraph style to start expand/collapse sections and a DropDownEnd marker to
specify where the content in the expand/collapse section ends. The Stationery defines whether the sections should
initially be expanded (shown) or collapsed (hidden) and the image used to show the state of the section.

To create expand/collapse sections, your Stationery and template must have the following items configured:

An Expand/Collapse paragraph style

A DropDownEnd marker

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to create expand/collapse sections in Microsoft Word
source documents using Microsoft Word 2003. Steps for creating expand/collapse sections in Microsoft Word
may be different in other versions of Microsoft Word.

To create an expand/collapse section in a Microsoft Word source document

1. In your Microsoft Word source document, identify a topic that contains text for which you want to create an
expand/collapse section.

2. Apply an Expand/Collapse paragraph style to the text you want users to click to expand or collapse content.

For example, in the following sample procedure, you would apply the Expand/Collapse paragraph style to
the To open a project text.

To open a project

a. On the File menu, click Open.

b. Browse to the location of the project on your local computer.

c. Select the project, and then click Open.
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3. Insert your cursor at the end of the content you want to display in the expand/collapse section.

For example, in the following sample procedure, you would insert your cursor after the period in the last
sentence of the procedure, Select the project, and then click Open.

To open a project

a. On the File menu, click Open.

b. Browse to the location of the project on your local computer.

c. Select the project, and then click Open.

4. On the WebWorks menu, click Markers.

5. In the Markers field, select the DropDownEnd marker.

6. Leave the Value field blank.

7. Click OK. ePublisher inserts a DropDownEnd marker at your insertion point. This marker identifies where
the contents of your expand/collapse section will end.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. In Output Explorer, go to the page where you created the expand/collapse section and verify that ePublisher
created the expand/collapse section and that the expand/collapse section displays the content you specified.
For more information, see “Viewing Output in Output Explorer”.
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Creating Related Topics in Word
Related topics provide a list of other topics that may be of interest to the user viewing the current topic. For
example, you could have a section called Creating Web Pages in your help. You may also have many other topics,
such as HTML Tags and Cascading Style Sheets, that related to creating Web pages. Identifying these related
topics for users can help them find the information they need and identify additional topics to consider. However,
providing these types of links as cross-references within the content itself may not be the most efficient way to
present the information. By utilizing related topics links, you combine the capabilities of cross-references with the
efficiency of a related topics button.

Related topics and See Also links provide similar capabilities, but there are several important differences:

Related topics can link to headings in a Help system that do not start a new page.

Relate topics links are static and defined in the source documents as links. You must have all the source
documents to create the link and generate the output.

If a related topics list contains a broken link in the source document, that link is broken in the generated
output. In a See Also link list, the broken link is not included in the output.

The Stationery designer can configure related topics to display in the following ways:

Included as a list in the topic itself.

Displayed in a popup window when the user clicks a button, as show in the following figure.
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Note: If a related topic link is broken in the source document, in most cases that link is broken in the generated
output. WebWorks Help and WebWorks Reverb provide an additional feature by removing broken links
from related topics lists that are displayed in a popup window when a user clicks the Related Topics button.

To create related topics links, your Stationery and template must have a Related Topics paragraph style
configured. Your output format must also support this feature. For more information about output formats that
support this feature, see “Features Available in Each Output Format”.
 

The following procedure provides an example of how to create related topics links in Microsoft Word source
documents using Microsoft Word 2003. Steps for creating related topics links in Microsoft Word may be different
in other versions of Microsoft Word.

To create a related topics list in a Microsoft Word source document

1. Identify the topic in which you would like to insert a related topics list.

2. Identify the different topics you want to link to from this topic.

Note: Generally, you should only create one related topics list for each section of your source document
that corresponds to a help topic. For example, if the Stationery designer specified in your Stationery
that there will be a page break at each Heading 1 section, then you should only create one related
topics list for each Heading 1 section within your source document.

3. Create a cross-reference to each topic you want to include in the related topics list by completing the
following steps:

a. Insert your cursor in the location in your Microsoft Word source document where you want to insert
the link to the related topic.

b. On the Insert menu, click Reference  > Cross-reference.

c. In the Reference type field, select Heading.

d. In the Insert reference to field, click Heading text.

e. Select the insert as hyperlink checkbooks.

f. In the For which heading field, select the heading to which you want to cross reference.

g. Click Insert.

h. Click Close.

4. Apply the Related Topic paragraph style to the cross-references in your related topics list.

5. If you want to display the list of related topics in only your generated output, apply an OnlineOnly
condition to the list of related topics. For more information about applying conditions, refer to “Applying
Conditions in Word”.

6. Save your Microsoft Word source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, go to the page where you created the related topics list and verify that ePublisher
created the related topics and that the related topics list displays the topics you specified. For more
information, see “Viewing Output in Output Explorer”.
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Creating Links to PDF in Word
You have the ability to link to different information in an external document such as a PDF with a hyperlink to the
content.

To create an external hyperlink to a PDF document

1. In the Word menu, go to Insert > Hyperlink.

2. Select Existing File or Web Page for the Link to label located on the left.

3. In the Text to display text box, enter the text you would like for the hyperlink

4. Navigate to the file location on the system to link against for the PDF.

5. Save the Word document.
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Specifying Wiki Categories or Labels in Word
On Wikis, categories, which are referred to as labels in some Wiki formats, are used to organize Wiki content.
Categories help group together pages that have similar subjects.

Note: MoinMoin and Media Wiki use the term category to describe page grouping functionality. Confluence uses
the term label to describe page grouping functionality.

Pages are assigned to category groups through the use of category or label tags. When you assign a category or
label tag to a Wiki page, the category to which the Wiki page belongs displays in a box at the bottom of the page.

Category and label tags on Wiki pages allow categorized pages to automatically be added to a list on a category
page on the Wiki. The category page lists all of the Wiki pages tagged for a certain category. For example, if
you tag each page on a Wiki that contains licensing information with a Licensing category tag, then a licensing
category page on the Wiki can display a list of all of the pages tagged as containing licensing information.

The following procedure provides an example of how to specify categories for Wiki pages in Microsoft Word
source documents using Microsoft Word 2003. Steps for specifying categories may be different in other versions
of Microsoft Word.

To specify a Wiki category or label for a topic in a Microsoft Word source document

1. In your Microsoft Word source document, find the first paragraph on the page for the page for which you
want to specify a category or label.

2. On the WebWorks menu, click Markers.

3. In the Marker field, select WikiCategory from the list of markers.

4. If the WikiCategory marker type is not on the list of markers, check with the Stationery designer to obtain
the name of the marker type the Stationery designer created to support this functionality and then use the
marker type specified by the Stationery designer. For more information, refer to “Implementing Online
Features in Word”.

5. In the Value field, type the category or list of categories you want to specify for the page. If you want to
specify more than one category for a page, separate each category with a comma (,).

For example, if you want to specify one category for the page, type category1. If you want to specify
multiple categories for the page, type category1, category2, category3, where category is the
category you want to specify for the page.

Note: Each Wiki target handles white space in it own way. For example, MoinMoin removes white space in
category names, so if you specify Licensing Considerations as a category in a WikiCategory marker,
in MoinMoin output the category will display as LicensingConsiderations.

6. Click OK.

7. Save your Microsoft Word source document.

8. Generate output for your Wiki target. For more information, see “Generating Output”.

9. Deploy the Wiki output files to a Wiki server. For more information, see “Deploying Output to Output
Destinations”.

Note: You must deploy generated Wiki content to a Wiki server before you can view the Wiki content.
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10. Verify that your Wiki pages display the categories or labels you specified at the bottom of the pages.
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Creating See Also Links in Word
See Also links, also known as ALinks, or associative links, are links that may be of interest to the user viewing the
current topic. These links use internal identifiers to specify the links and the link list is built dynamically based on
the topics available when the user clicks to display the links. See Also links are important to use with larger help
sets and merged help sets.

Related topics and See Also links provide similar capabilities, but there are several important differences:

See Also links must link to styles that start a new topic, such as a heading.

See Also links are dynamic and the lists of links are built at display time instead of during help generation.

Since see Also link lists are dynamically built, they do not include links to topics that are not available
when the user displays the links. If a related topics list contains a broken link in the source document, that
link is broken in the generated output for most output formats.

See Also links are useful if you plan to merge help systems. For example, if you have a multiple help systems that
you merge into one main help system at run time and if your topics in the merged help systems contain See Also
keywords that are also used in the main help system, links to those topics are included in the See Also lists in the
main project.

You can create See Also links as buttons or as inline text links in Microsoft HTML Help and WebWorks Help.
The following example shows how the two different types of See Also links display in a Microsoft HTML Help
system.

Create See Also links by applying the See Also paragraph style or character style to text in your Microsoft Word
source documents and inserting markers into your Microsoft Word source documents.

Create See Also links by applying the See Also paragraph style or character style to text in your Microsoft Word
source documents and inserting markers into your Microsoft Word source documents. To create See Also links,
your Stationery and template must have the following items configured:

See Also paragraph style if you want to create See Also links with buttons

See Also paragraph style if you want to create see Also links as inline text links

SeeAlsoKeyword marker type

SeeAlsoLink marker type
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SeeAlsoLinkDisplay marker type if you generate Microsoft HTML Help and you want to display the target
topics in a popup menu

SeeAlsoLinkWindowType marker type if you generate Microsoft HTML Help and you want to display the target
topics in a custom window

The following procedure provides an example of how to create See Also links in Microsoft Word source
documents using Microsoft Word 2003. Steps for creating See Also links in Microsoft Word may be different in
other versions of Microsoft Word.

To create a See Also link in a Microsoft Word source document

1. Identify each topic to which you want to link from a See Also link, and then complete the following steps
for each topic:

a. Insert your cursor into the topic to which you want to link.

b. On the WebWorks menu, click Markers.

c. In the Marker field, select the SeeAlsoKeyword marker.

d. In the Value field, type a text string that is a unique identifier as the See Also keyword for the topic.
See Also keywords are case sensitive and cannot contain punctuation or spaces.

For example, if you have a unique topic called About WebWorks Help, type AboutWebWorks help in
the Value field.

e. Click OK. ePublisher inserts a SeeAlsoKeyword marker at your insertion point. This marker
identifies the topic for See Also links.

2. Identify the topic where you want to insert a list of See Also links.

3. Enter the text you want to display for the See Also button or for the See Also inline text link on a separate
line in the source document where you want the See Also button or inline text link to display.

For example, if you want to create a button with the text See Also on the button, type See Also. If you
want to create inline text with the text Additional Information for the link, type Additional Information.

4. If you want to create a See Also button for your See Also links, apply the See Also paragraph style to the
text you want to display in the See Also button.

5. If you want to create a See Also inline text link for your See Also links, apply the See Also character style
to the text you want to display in the See Also inline text link.

6. Apply an OnlineOnly condition to the See Also text. Applying an OnlineOnly condition to the See Also
button or See Also inline text displays the See Also link in your generated output, but does not display the
See Also button or link in your printed content.

7. Insert your cursor inside the text you specified for the See Also button or See Also inline text link.

8. For each topic to which you want to link from a See Also link, complete the following steps:

a. On the WebWorks menu, click Markers.

b. In the Marker field, select the SeeAlsoLink marker.

c. In the Value field, type the text string that is a unique identifier for the topic to which you want to
link. This text string is the text string you typed when you created the SeeAlsoKeyword marker for
the topic.
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For example, if you created a SeeAlsoKeyword marker with the text string AboutWebWorksHelp,
type AboutWebWorksHelp in the Value field for the SeeAlsoLink marker.

d. Click OK. ePublisher inserts a SeeAlsoLink marker at your insertion point. This marker identifies
the topics users can link to when they click the See Also button.

9. If you generate Microsoft HTML Help output and you want to display the target topics in a popup menu,
complete the following steps:

a. Insert your cursor inside the text you specified for the See Also button or inline text link.

a. On the WebWorks menu, click Markers.

b. In the Marker field, select the SeeAlsoLinkDisplayType marker.

Note: This marker type is supported only in Microsoft HTML Help.

c. In the Value field, type menu. By default, Microsoft HTML Help displays See Also links in the
Topics Found window. To display See Also links in a popup menu, specify menu for the marker
value.

d. Click OK. ePublisher inserts a SeeAlsoDisplayType marker at your insertion point.

10. If you generate Microsoft HTML Help output and you want to display the target topics in a custom
window, complete the following steps:

a. Insert your cursor inside the text you specified for the See Also button or See Also inline text link.

b. On the WebWorks menu, click Markers.

c. In the Marker field, select the SeeAlsoLinkWindowType marker.

Note: This marker type is supported only in Microsoft HTML Help.

d. In the Value field, type the name of a custom window defined for Microsoft HTML Help by the
Stationery designer.

For example, if the Stationery designer defined a custom window called ContextHelp to use
to when displaying context-sensitive help topics, type ContextHelp in the Value field for the
SeeAlsoLinkWindowType marker.

e. Click OK. ePublisher inserts a SeeAlsoDisplayType marker at your insertion point.

11. Save your Microsoft Word source document.

12. Generate output for your project. For more information, see “Generating Output”.

13. In Output Explorer, go to the page where you created the See Also links and verify that ePublisher created
the See Also button or See Also inline text and that the See Also button or inline text displays the links you
specified. For more information, see “Viewing Output in Output Explorer”.
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Creating Meta Tag Keywords in Word
Meta tags are lines of code placed between the <head> and </head> tags in HTML pages. Meta tags give web
search engines information about the content of the web page and how search engines should treat the web page.
Users viewing web pages do not see the meta tags, but meta tags can be used to influence the way web pages on a
web site appear in web search engine results. Users also see the text you specify for meta tags right following the
title of your page when your page comes up in search results.

In help systems, search ranking works like ranking in an Internet search engine. If you generate help system
output, you can use meta tag keywords to specify terms for pages for help topics where you want to improve
searchability. For example, assume that in your help system you have a topic called See Also links. However, you
know that See Also links are also sometimes referred to as ALinks, and you think that some users of your help
system may search for information about See Also links by typing ALinks into the Search field for your help
system. In this example, you can insert ALinks as a meta tag keyword for each page that discusses See Also links,
so users who search your system for information about ALinks can find the information they are looking for in
your See Also link topics.

To assign meta tag keywords, your Stationery and template must have the Keywords marker type configured.
Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.
 

The following procedure provides an example of how to create meta tag keywords in Microsoft Word source
documents using Microsoft Word 2003. Steps for creating meta tag keywords in Microsoft Word may be different
in other versions of Microsoft Word.

To create meta tag keywords for a page in a Microsoft Word source document

1. In your Microsoft Word source document, find the first paragraph in the page for the page for which you
want to create a meta tag keyword.

2. On the WebWorks menu, click Markers.

3. In the Marker field, select Keywords from the list of markers.

4. In the Value field, type the comma-delimited list of keywords that you want web search engines to use
when crawling Web sites and to display immediately following the title of your page when your page
comes up in search results.

For example, type keyword1, keyword2, keyword3, where keyword is the keyword you want web search
engines to use when crawling your Web site.

5. Click OK.

6. Save your Microsoft Word source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify that ePublisher inserted your meta tag keywords correctly by completing the
following steps:

a. On the View menu, click Output Explorer.

b. In the TargetName\ProjectName folder, open the page to which you assigned meta tag keywords in
Notepad, where TargetName is the name of your target and ProjectName is the name of your project.
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c. Verify that the text you specified for your meta tag displays in the meta name attribute between
in the <head> and </head> tags section of your web page. For example, if you typed keyword1,
keyword2, keyword3, for your meta tag keywords, your meta tags in for the page should be similar to
the following entry:

<meta name="keywords" content="keyword1, keyword2, keyword3" />
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Assigning Custom Page Styles in Word
By default, each page generated by ePublisher is associated with the default page style defined in the Stationery
used by your ePublisher project. This means that typically you do not need to specify a page style for pages when
you generate output. However, if you want to change the page style of one page or a smaller set of pages, you can
specify the page style you want to use for a page in your Microsoft Word source document using the PageStyle
marker.

For example, you may want to use one page style in your help system for all concept and procedure topic pages,
and another page style for all context-sensitive window description topic pages in your help system. In this
example, you can use the default page style for all of your concept and procedure topic pages, and then you can
use a second custom page style defined in your Stationery for all context-sensitive window description topic pages
in your help system.

Before you begin, obtain the names of the custom page styles you can use with your Stationery from the
Stationery designer. Then insert a PageStyle marker with the page style name into the topic you want to display
using a custom page style. After you assign a custom page style to a topic using the PageStyle marker, the
generated output displays the topic using the specified page style.

To assign custom page styles, your Stationery and template must have the following items configured:

Custom page styles defined for your Stationery by the Stationery designer

PageStyle marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

For more information about creating page styles, see the ePublisher Design Guide.

The following procedure provides an example of specifying page styles for pages in Microsoft Word source
documents using Microsoft Word 2003. Steps for specifying page styles for pages in Microsoft Word may be
different in other versions of Microsoft Word.

To specify a custom page style for a page in a Microsoft Word source document

1. In your Microsoft Word source document, locate the page for the topic to which you want to assign a page
style.

2. Insert your cursor in the location on the page where you want to insert the PageStyle marker.

3. On the WebWorks menu, click Markers.

4. In the Marker field, select PageStyle from the list of markers.

5. In the Value field, type the name of the page style you want to associate with the page.

For example, if you Stationery designer configured a page style for your Stationery called
YellowBackground, type YellowBackground.

6. Click OK. ePublisher inserts the PageStyle marker into your source document.

7. Save your Microsoft Word source document.

8. Generate output for your project. For more information, see “Generating Output”.
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9. In Output Explorer, verify ePublisher created the page using the page style you specified by clicking on
the page and verifying ePublisher applied the page style you specified in the generated output. For more
information about viewing output files in Output Explorer, see “Viewing Output in Output Explorer”.
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Creating What’s This (Field-Level) Help in Word
If you generate Microsoft HTML Help output, you can implement What’s This help for product dialog boxes and
windows. What’s This Help is also known as field-level help. Only Microsoft HTML Help supports field-level
help. In addition, not all products are designed to support field-level help for product dialog boxes and windows.
Before you begin implementing field-level help, consult your product team to determine if field-level help part of
the product design. If field-level help is part of the product design, you will also need to obtain the appropriate ID
from your product team for each field-level help topic you need.

Users can view the field-level help you create using one of following methods:

Users click on the question mark icon in the upper right corner of the dialog box or window.

When users click on the question mark icon, their cursor changes to a question mark. Users can then move
the question mark cursor over the fields on the dialog box or window, and Windows displays the field-level
help you created in a popup window when they hover over a specific field.

Users right-click a field on a dialog box or window and then select the What’s This? option from the single
option menu Windows displays.

After users select this option, Windows displays the field-level help you specify in in a popup window.

Users close the popup window that provides the field-level help by pressing the Esc key on the keyboard. When
users press the Esc key, their cursor returns to the regular cursor shape for the user.

To create What’s This help, your Stationery and template must have the following items configured:

What Is This help paragraph style

WhatIsThisHelpIDThe following procedure provides an example of how to create What’s This help in Microsoft
Word source documents using Microsoft Word 2003. Steps for creating What’s This help in Microsoft Word may
be different in other versions of Microsoft Word.

To create What’s This help in a Microsoft Word source documents

1. Identify a topic that contains field-level help.

2. Apply the What Is This paragraph style to the text that contains the field-level help.

3. Insert your cursor into the field-level help text.

4. On the WebWorks menu, click Markers.

5. In the Marker field, select WhatIsThisID from the list of markers.

6. In the Value field, type the appropriate ID for the field-level description. Obtain appropriate IDs for each
field-level description from your product team.

7. Click OK.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. In Output Explorer, verify ePublisher created the What’s This help you specified by completing the
following steps:
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a. On the View menu, click Output Directory.

b. Open the ProjectName folder, where ProjectName is the name of your project.

c. Open the whatisthis.txt file and verify that the field-level help you created is associated with the
correct ID you received from your product development team.

d. Open the whatisthis.h file and verify that each new string you added is listed in the file.
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Opening Topics in Custom Windows in Word
You can open topics in custom windows in Microsoft HTML Help and Oracle Help. By default, Microsoft HTML
Help displays content in the standard Microsoft HTML Help tri-pane window. The Stationery designer can
modify the size, position, and other characteristics of the tri-pane window in your Microsoft HTML Help project.
The Stationery designer can also define custom windows for you to use in a Microsoft HTML Help project. If the
Stationery designer defines custom windows in a Microsoft HTML Help project, you can specify which topics
you want to display in the custom window using the WindowType marker.

By default, Oracle Help displays content in the standard Oracle Help viewer. The Stationery designer can modify
the size, position, and other characteristics of Oracle Help windows. The Stationery designer can also define
custom windows for you to use in an Oracle Help project. If the Stationery designer defines custom windows
in an Oracle Help project, you can specify which topics you want to display in the custom window using the
WindowType marker.

For example, if you want your context-sensitive help topics to display in a different type of window than other
content, after you create a context-sensitive help topic you can use the WindowType marker to specify that you
want the context-sensitive help topics to display in a custom window. After you assign a custom window to a
topic using the WindowType marker, the help system displays the topic in your generated output in the custom
window whenever users access the topic from the table of contents, index, a standard hyperlink, a related topics
list, or a See Also link.

To open topics in custom windows, your Stationery and template must have the following items configured:

Custom window styles defined for your Stationery by the Stationery designer

PageStyle marker type

The following procedure provides an example of how to specify topics open in custom Microsoft HTML Help
or Oracle Help windows in Microsoft Word source documents using Microsoft Word 2003. Steps for specifying
topics open in custom Microsoft HTML Help or Oracle Help windows in Microsoft Word may be different in
other versions of Microsoft Word.

To specify topics open in a custom window in a Microsoft Word source document

1. Obtain the names of custom windows configured in the Stationery you use for your ePublisher project from
the Stationery designer.

2. In your Microsoft Word source document, locate the topic that you want to open in a custom window.

3. Insert your cursor into the topic.

4. On the WebWorks menu, click Markers.

5. In the Marker list, select WindowType from the list.

6. In the Value field, type the name of the custom window configured by the Stationery designer that you
want to specify for the topic.

7. Click OK.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.
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10. In Output Explorer, verify the topic displays in the custom window you specified for the topic. For more
information about viewing output files in Output Explorer, see “Viewing Output in Output Explorer”.
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Customizing Table of Contents Icons in Word
By default, the Contents tab in a Microsoft HTML Help, Oracle Help, and WebWorks Help uses book and page
icons to identify entries. By default, the Contents tab in Sun JavaHelp uses folder and page icons to identify
entries. You can also customize the table of contents icons.

For example, if you want to make new topics stand out by using a unique icon specific to new books, pages, or
folders, you can insert a marker into a topic and specify the icon you want to display for the book, page, or folder
in your help system table of contents.

To customize a table of contents icon, your Stationery and template must have the following items configured:

TOCIconHTMLHelp for Microsoft HTML Help

TOCIconOracleHelp for Oracle Help

TOCIconJavaHelp for Sun JavaHelp

TOCIconWWHelp for WebWorks Help

The following procedure provides an example of how to customize table of contents icons for topics in Microsoft
Word source documents using Microsoft Word 2003. Steps for customizing table of contents icons for topics in
Microsoft Word may be different in other versions of Microsoft Word.

To specify a custom table of contents icon in a Microsoft Word source document

1. If you want to specify a custom table of contents icon for Microsoft HTML Help, identify the number of
the image you want to use for the table of contents image for the topic in the .hhp file for your Microsoft
HTML Help project by completing the following steps:

a. On the View menu, click Output Directory.

b. Open the ProjectName folder, where ProjectName is the name of your project.

c. Open the ProjectName.hhp file where ProjectName is the name of your project.

d. On the Contents tab, select a table of contents entry, and then click the Pencil icon.

e. On the Advanced tab, in the Image index field, use the up and down arrows to identify the table of
contents image you want to use for the topic.

f. Note the number of the image you want to use for the table of contents image for the topic.

For example, if you want to use a question mark icon with a red star for the table of contents icon for
new topics, note that the number for this icon is 10.

g. Close HTML Help Workshop.

2. If you want to specify a custom table of contents icon for Oracle Help or Sun JavaHelp, create the
graphic file for the custom table of contents icon in .gif format. The default graphics used as Sun
JavaHelp or Oracle Help table of contents icons are 17 x 17 pixels. The custom graphics you create for Sun
JavaHelp or Oracle Help table of contents icons should also be 17 x 17 pixels. You can assign any name to
the graphic files.

3. If you want to specify a custom table of content icon for WebWorks help, create graphics files containing
the collapsed and expanded versions of the icons you want to use, then save the graphic files in .gif
format. The default graphics used as WebWorks Help table of contents icons are 17 x 17 pixels. The custom
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graphics you create for WebWorks Help table of contents icons should also be 17 x 17 pixels. You can
assign any name to the graphic files.

4. Copy the graphic files you want to use as icons in the table of contents into the following folder:

Note: If the folder does not exist, first create the folder using the specified folder structure and then copy
the graphic files you want to use as icons into the folder. You do not need to perform this step when
specifying custom table of contents icons for Microsoft HTML Help.

If you are generating Oracle Help, copy the graphic files you want to use into the following folder:

ProjectName\Formats\Oracle Help\Files\images folder, where ProjectName is the name of
your project.

If you are generating Sun JavaHelp 1.1.3, copy the graphic files you want to use into the following
folder:

ProjectName\Formats\Sun Java Help 1.1.3\Files\images folder, where ProjectName is the
name of your project.

If you are generating Sun JavaHelp 2.0, copy the graphic files you want to use into the following
folder:

ProjectName\Formats\Sun Java Help 2.0\Files\images folder, where ProjectName is the
name of your project.

If you are generating WebWorks Help, in your ProjectName\Files folder, where ProjectName is
the name of your project, create a wwhelp\images subfolder and copy the graphic files you want to
use into this folder. Your project file structure should be similar to the following structure:

ProjectName\Files\wwhelp\images, where ProjectName is the name of your project.

5. In your Microsoft Word source document, locate the topic where you want to use the custom table of
contents icon.

6. Insert your cursor into the heading for the topic.

7. On the WebWorks menu, click Markers.

8. In the Marker list, select the appropriate TOCIcon marker type from the list.

9. In the Value field, type the following text:

If you are generating Microsoft HTML Help, type the number of the icon that you want to use for
the table of contents image.

For example, if you want to use a question mark icon with a red star for the table of contents icon for
new topics, type 10.

If you are generating Oracle Help or Sun JavaHelp, type the following text:

images/TOCIcon.gif

where TOCIcon.gif is the name of the table of contents icon you want to display for the topic.

If you are generating WebWorks Help, type the following text:

c=”collapsed.gif” e=”expanded.gif”

where collapsed.gif is the name of the icon you want to use when the table of contents entry is
collapsed, and expanded.gif is the name of the icon you want to use when the table of contents
entry is expanded. If the table of contents entry is for a page instead of a book, the entry will never
be expanded, so you can omit the e=”expanded.gif” portion of the entry for pages.
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For example, you might create a special icon to highlight books that are new for a particular
release of your WebWorks Help system. If you named these icons newbookopen.gif and
newbookclosed.gif, you would type the following text into the Value field:

c=”newbookclosed.gif” e=”newbookopen.gif”

10. Click OK.

11. Save your Microsoft Word source document.

12. Generate output for your project. For more information, see “Generating Output”.

13. In Output Explorer, verify ePublisher created the table of contents using the table of contents icon you
specified for the topic. For more information about viewing output files in Output Explorer, see “Viewing
Output in Output Explorer”.
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Specifying Context Plug-ins in Word
You can specify Eclipse Help context plug-ins by using Context Plugin markers in your source documents.
ePublisher places the context plug-ins you specify in your source documents in the plugin.xml file generated for
each source document group you have in Document Manager. You can then have developers use the context plug-
ins defined in plugin.xml files to call your Eclipse Help system as appropriate from Eclipse plug-ins.

For example, assume you have the following three top-level groups in Document Manager for your Eclipse Help
system target:

Component A group - contains the source documents for ComponentA Feature1 and ComponentA Feature2

Component B group - contains the source documents for ComponentB Feature1 and ComponentB Feature
2

Component C group - contains the source documents for ComponentC Feature1 and ComponentC Feature
2

You insert the following Context Plugin markers into the source documents for each group:

ComponentAFeature1 and ComponentAFeature2 Context Plugin markers in source documents contained in
the ComponentA group

ComponentBFeature1 and ComponentBFeature2 Context Plugin markers in source documents contained in
the ComponentB group

ComponentCFeature1 and ComponentCFeature2 Context Plugin markers in source documents contained in
the ComponentC group

When you generate your Eclipse Help system, ePublisher creates the following folder structure in the
ProjectName\Output\TargetName folder, where ProjectName is the name of your ePublisher project, and
TargetName is the name of your target:

ComponentA folder, which contains a plugin.xml file with the following entries:

plugin="ComponentAFeature1ContextPlugin"

plugin="ComponentAFeature2ContextPlugin"

ComponentB folder, which contains a plugin.xml file with the following entries:

plugin="ComponentBFeature1ContextPlugin"

plugin="ComponentBFeature2ContextPlugin"

ComponentC folder, which contains a plugin.xml file with the following entries:

plugin="ComponentCFeature1ContextPlugin"

plugin="ComponentCFeature2ContextPlugin"

You can then provide the context plug-in IDs in your plugin.xml files to the appropriate Eclipse developers to
use. The Eclipse developers use the context plug-ins defined in plugin.xml files to call your Eclipse Help system
as appropriate from Eclipse plug-ins.

To specify a context plug-in in a Microsoft Word source document

1. Identify a topic in a source document where you want to insert the context plug-in.

2. On the WebWorks menu, click Markers.
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3. In the Marker Type field, select Context Plugin from the list of markers.

4. In the Value field, type the appropriate ID for the context plug-in.

Note: If you are responsible for defining the ID, ensure you supply the context plug-in ID to your
developers to use as appropriate for their Eclipse plug-ins. If your developers define the ID, use the
context plug-in ID you obtained from your developers.

5. Click OK.

6. Save your Microsoft Word source document.

7. Generate output for your project. For more information, see “Generating Output”.

8. In Output Explorer, verify ePublisher generated a plugin.xml file that contains the context plug-in IDs you
specified by completing the following steps:

a. On the View menu, click Output Directory.

b. Open the ProjectName folder, where ProjectName is the name of your project.

c. Open the group folder for a group that contains the source documents where you specified your
context plug-in ID.

d. Open the plugin.xml file in Notepad and verify that the context plug-in IDs you specified in your
source documents are listed in the plugin.xml file. Your context plug-in IDs should be listed in the
Contexts area of the file. Following is an example of the how the context plug-in IDs you specified
in your source documents should be displayed in the plugin.xml file:

<!-- Contexts -->

<!-- -->

<extension point="org.eclipse.help.contexts">

<contexts file="contexts.xml" plugin="ComponentAFeature1ContextPlugin" />

</extension>

<extension point="org.eclipse.help.contexts">

<contexts file="contexts.xml" plugin="ComponentAFeature2ContextPlugin" />

</extension>
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Creating Accessible Online Content in Word
Accessible content is content that can be easily accessed by users with certain disabilities. This section explains
how you can prepare your Microsoft Word source documents to ensure your content is accessible to users using
assistive technologies.
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Understanding Accessible Content in Word
Images and tables are helpful ways to convey information to end users. However, users with disabilities often
cannot access the important information provided by images and table layouts in online content. You should
document images and other non-text items such as table layouts so that users using assistive technologies to
access online content can access the information these items provide.

Content that must easily be accessed by people with disabilities must conform to certain guidelines published
by both the W3C and the United States government in order to produce accessible online output, also known as
Section 508 compliant output. These guidelines are intended to help writers produce accessible content.

You can use ePublisher to help you produce online content that conforms to the W3C Web Content Accessibility
Guidelines 1.0 (WCAG), Section 508 of the U.S. Rehabilitation Act of 1998, and the Americans with Disabilities
Act (ADA). If you are required to generate accessible content, typically you provide the following items in your
online content:

Alternate text and descriptions for all images and image maps. For more information, see “Assigning
Alternate Text to Images and Image Maps in Word”.

Long descriptions for all images. For more information, see “Assigning Long Descriptions to Images in
Word”.

Summaries for all tables. For more information, see “Assigning Alternate Text (Summaries) to Tables in
Word”.

You may also choose to provide the following items in your online content:

Alternate text for abbreviations. For more information, see “Assigning Alternate Text to Abbreviations in
Word”.

Alternate text for acronyms. For more information, see “Assigning Alternate Text to Abbreviations in
Word”.

Citations for quotes. For more information, see “Providing Citations for Quotes in Word”.

You must prepare source documents and configure your ePublisher project in order to create accessible content.
You prepare your source documents by inserting markers into your source documents and by applying character
formats and paragraph formats. You configure accessibility settings in the ePublisher project. ePublisher uses the
information in your source documents and your ePublisher project to generate accessible online output.

For more information about producing accessible content and to check your content further for compliance, see
the following Web sites:

For the complete W3C note on the WCAG, visit http://www.w3c.org/TR/WCAG10-CORE-TECHS.

For information about the related Web Accessibility Initiative, visit http://www.w3.org/WAI.

For information about Section 508 of the U.S. Rehabilitation Act of 1998, visit http://www.w3.org/WAI/
Policy/#508.

http://www.w3c.org/TR/WCAG10-CORE-TECH
http://www.w3.org/WAI
http://www.w3.org/WAI/Policy/#508
http://www.w3.org/WAI/Policy/#508


318 | Understanding Accessible Content Navigaon in Word

Understanding Accessible Content Navigation in Word
Users can navigate through the accessible content using keys on the keyboard. The following output formats
support navigation keys:

Dynamic HTML

Microsoft HTML Help

Oracle Help

WebWorks Help

Note: For the Dynamic HTML, navigation key behavior may vary based on the browser the user uses. For
example, in Netscape and Mozilla, users must hold down the Alt key while pressing the navigation keys. In
Internet Explorer, users must first hold down the Alt key while pressing the navigation key, and then press
Enter.

The following table lists the how each output format supports navigation keys.

Navigation Key Function Format

1 Display the TOC Dynamic HTML
WebWorks Help 5.0

2 Display the Index Dynamic HTML
WebWorks Help 5.0

3 Display the Search tab WebWorks Help 5.0

4 Go to the previous page Dynamic HTML
Microsoft HTML Help
Oracle Help
WebWorks Help 5.0

If you are using Microsoft HTML Help,
Alt+4 works only if the topic pane has the
focus. If the topic pane does not have the
focus, you must press Alt+0 and then Alt
+4.
If you are using Oracle Help, you must
press Enter after pressing Alt+4.

5 Go to the next page Dynamic HTML
Microsoft HTML Help 1.x
Oracle Help
WebWorks Help 5.0

If you are using Microsoft HTML Help,
the Alt+5 key works only if the topic pane
has the focus. If the topic pane does not
have the focus, you must press Al+ 0 and
then Alt +5.
If you are using Oracle Help, you must
press Enter after pressing Alt+5.

6 Shift the focus to the related topics list
displayed at the bottom of the current page

WebWorks Help 5.0
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Navigation Key Function Format

After you press the 6 key, you can press
Tab to cycle through the entries in the
related topics list.

7 Display a blank feedback e-mail (equivalent
to clicking the e-mail button in the toolbar
frame)

WebWorks Help 5.0

8 Print the current page (equivalent to clicking
the Print button in the toolbar frame)

WebWorks Help 5.0

9 Bookmark the current page (equivalent to
clicking the Bookmark button in the toolbar
frame)

WebWorks Help 5.0

10 Shift the focus to the topic frame (equivalent
to clicking within the topic frame)

WebWorks Help 5.0



320 | Validang Accessible Content in Word

Validating Accessible Content in Word
After you configure your source documents and configure the appropriate settings, ePublisher uses Accessibility
conformance reports to perform the following checks to verify that the generated output conforms to accessibility
standards:

Alternate text for all images

Alternate text for all clickable regions in all image maps

Long descriptions for all images

Summaries for all tables

Note: ePublisher does not verify that you have provided alternate text for abbreviations or acronyms or verify
that you have included citations for quotes. For more information about understanding and using the
Accessibility conformance reports ePublisher provides, see “Configuring Reports”, and “Generating
Reports”.
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Assigning Alternate Text to Images and Image Maps in Word
This section provides information about how to create accessible images and image maps in your generated output
by assigning alternate text to images.
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Understanding Image and Image Map Alternate Text in Word
One of the largest accessibility challenges with online content today is the lack of alternative text for images and
image maps. Sight-impaired users often use screen readers or refreshable Braille devices to read online content.
However, when these assistive technologies come across images or image maps without alternative text, also
known as alternate text, they are unable to provide users with information about the image or image map and its
meaning.

The Web Content Accessibility Guidelines require that alternate text be provided for all images and image maps
in online content. The alternate text is an image label that describes the image or each area of the image map.
Online content should display alternate text for images and image maps when users perform the following actions:

The user hovers the mouse pointer over an image or section of an image map.

The user browser has been configured to disable display of images and image maps.

The user browser is a text-only browser such as Lynx.

The user uses assistive technology such as a screen reader.

The alternate text you assign to an image or sections of an image map should be as accurate and as succinct as
possible and provide users with a brief description of the image and how the image relates to the page they are
viewing. Make sure that your alternate text conveys all of the important information related to the image or image
map section, but do not burden users with excessively long alternative text. Screen readers or refreshable Braille
devices always read the alternative text, so if your page has several images or complex image maps with long
descriptions, it can take a long time for the assistive devices to read image-heavy pages with long descriptions.
If you need to provide a description of the image or image map section that is more than a few words or a few
short sentences, you should provide a brief alternate text description of the image or image map section and then
assign a longer description the image using either the longdesc attribute or a description. Once you specify a long
description using the longdesc attribute, you can also optionally display a D link next to the image. For more
information about assigning long descriptions to images, see “Assigning Long Descriptions to Images in Word”.



Assigning Alternate Text to Images in Word | 323

Assigning Alternate Text to Images in Word
Use the Web tab on the Format Picture window to assign alternate text to images in Microsoft Word source
documents.

The following procedure provides an example of how to assign alternate text to images in Microsoft Word source
documents using Microsoft Word 2003. Steps for assigning alternate text to images in Microsoft Word may be
different in other versions of Microsoft Word.

To assign alternate text to an image in a Microsoft Word source document

1. In your Microsoft Word source document, locate the image for which you want to specify image scaling.

2. Right-click the image, and then click Format Picture or Format Object.

3. On the Web tab, in the Alternative text field, type the alternate text you want to specify for the image.

4. Click OK.

5. Save your Microsoft Word source document.

6. Generate output for your project. For more information, see “Generating Output”.

7. Verify ePublisher assigned the alternate text you specified to the image when it generated output by
completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the image to which you assigned alternate text in
Notepad, where TargetName is the name of your target.

c. Verify that the alternate text you specified is included in the alt tag for the image.
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Assigning Alternate Text to Image Maps in Word
Use the Web tab on the Format Text Box window to assign alternate text to areas of an image map in Microsoft
Word source documents.

The following procedure provides an example of how to assign alternate text to an image map in Microsoft Word
source documents using Microsoft Word 2003. Steps for assigning alternate text to an image map in Microsoft
Word may be different in other versions of Microsoft Word.

To assign alternate text to an image map in a Microsoft Word source document

1. In your Microsoft Word source document, locate the image map for which you want to specify alternate
text.

2. For each clickable area of the image map, complete the following steps:

a. Right-click the text box that defines a clickable region for the image map.

b. On the Web tab, in the Alternative text field, type the alternate text you want to specify for the
image.

c. Click OK.

3. Save your Microsoft Word source document.

4. Verify ePublisher assigned the alternate text you specified to each area of the image map when it generated
output by completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the image map to which you assigned alternate text
in Notepad, where TargetName is the name of your target.

c. Verify that the alternate text you specified is included in the alt tag for each area of the image map.



Assigning Long Descripons to Images in Word | 325

Assigning Long Descriptions to Images in Word
This section explains how to create accessible images in your generated output by assigning long descriptions to
images.
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Understanding Image Long Descriptions
The Web Content Accessibility Guidelines and Section 508 guidelines require you to include long descriptions
for each image in an HTML document. You can use the longdesc attribute and a long descriptions stored in an
external .txt file to assign a long description to an image. When you use this approach, the long descriptions are
referenced in the HTML <img> tag in the longdesc attribute as shown in the following example:

<img src=“mission.gif” height=“240” width=“386” alt=“The Mission”
longdesc=“mission.txt” />

The longdesc attribute in the <img> tag provides a link to a separate page where a long description is available.
The link is invisible to sighted users, but when a conformant screen reader application reads the longdesc
attribute, it loads the file referenced in the longdesc attribute and reads it. In the previous example, the screen
reader would load and read the mission.txt file.

ePublisher provides the following options for assigning long descriptions to images:

You can use the ImageLongDescText marker to assign a long description to an image. With this method,
you assign a long description to an image using a description you include in a marker you insert into your
source document. For more information, see “Specifying Long Descriptions for Images in Word”.

You can use the ImageLongDescByRef marker to assign a long description to an image by referencing a
long description saved in an external text (.txt) file. With this method, you specify the path to the external
text file in a marker. For more information, see “Using Text in External Files to Assign Long Descriptions
to Images in Word”.

If you assign long descriptions to some, but not all of you images, you can use the ImageLongDescNotReq
marker. Use this marker when you use accessibility reports to verify that all images have long description but you
have certain images in your source document that do not require a long description. For more information, see
“Excluding Images from Accessibility Report Checks in Word”.

Although using the longdesc attribute is recommended in the Web Content Accessibility Guidelines and in 508
guidelines, older screen readers and many current browsers do not support this attribute and few online content
developers use this attribute. As a result, the longdesc attributed benefits a only a small number of users. Only
users who use modern screen readers can access the longdesc attribute easily. Older screen readers did not
support this attribute. In addition, even users who use the latest version of screen reader may be unfamiliar with
the longdesc attribute and may not know how to access long descriptions using their screen reader because the
longdesc attribute is used so infrequently in online content.

If you use the ImageLongDescText marker to assign long descriptions to images, as an interim solution ePublisher
allows you to display a D link immediately after the image. The D link is an upper case letter D link that directs
users to another page that contains the text you specified in the ImageLongDescText marker. Although a D link is
not required for accessible Web pages, it can be used in addition to the longdesc attribute. The D link technique
works in all browsers, but it is less elegant than using the londesc attribute. Some users may be confused when
they see a D link on the page, while other users will ignore the D link.

If you want to use D links in addition to the longdesc attribute when you generate output, your Stationery must
have the D link option enabled. If you have permissions to modify target settings in ePublisher, you can enable
the D link option setting in an project. For more information about enabling the D link option in an project, see
“Specifying Accessibility Settings”. For more information about permissions required to modify target settings
using ePublisher Express, see “Customizing Target Settings”.
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Specifying Long Descriptions for Images in Word

To assign a long description to an image, your Stationery and template must have the ImageLongDescText marker
type configured. Your output format must also support this feature. For more information about output formats
that support this feature, see “Features Available in Each Output Format”.

When you use the ImageLongDescText marker to assign long descriptions to images, ePublisher generates an
external text file that contains the long description you specify. When a conformant screen reader application
reads the generated page, it loads the .txt file referenced in the longdesc attribute on the page and reads the file.

The following procedure provides an example of how to specify long descriptions for images in Microsoft Word
source documents using Microsoft Word 2003. Steps for specify long descriptions for images in Microsoft Word
may be different in other versions of Microsoft Word.

To assign a long description to an image using marker text in a Microsoft Word source document

1. In your Microsoft Word source document, locate the image to which you want to assign a long description.

2. Right-click the image, and then click Format Picture or Format Object.

3. Change the layout setting of the image to Top and Bottom by completing the following steps:

Note: By default when you insert images into Microsoft Word, Microsoft Word inserts the image using
the Inline with text layout setting. In order to specify the image scale for image output files, you
must group the image and the text box that contains the ImageLongDescText marker. However, you
cannot group images using the In line with text layout setting in Microsoft Word. To work around
this known Microsoft Word issue, if you have an image that uses an In line with text layout setting,
use the Top and Bottom layout setting for the image while you insert the ImageLongDescText
marker, and then reapply the In line with text layout setting after you group the image and the
ImageLongDescText marker.

a. On the Layout tab, click Advanced.

b. On the Text Wrapping tab, click Top and Bottom.

c. Click OK, and then click OK again to close the window.

4. Select your image.

5. On the Insert menu, click Text Box, and then click to the right of your image. Microsoft Word inserts a text
box.

6. Insert your cursor into the text box, and then complete the following steps:

a. On the WebWorks menu, click Markers.

b. In the Markers field, select ImageLongDescText from the list of markers.

c. In the Value field, type the long description you want to specify for the image.

d. Click OK. ePublisher inserts the ImageLongDescText marker into the text box.

e. Select the text box.

f. Right-click the selected text box, and then click Format Text Box.

g. On the Colors and Lines tab, in the Fill area, in the Color field, select No Fill.

h. In the Line area, in the Color field, select No Line.
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i. Click OK.

7. Drag and drop the text box onto the image.

8. Select the text box and the image.

9. Right-click the selected text box and image, and then click Grouping  > Group.

Note: When you select Group, the location of the image in your Microsoft Word source document may
change in relation to the text in your source document. For example, the image may move up or
down in your Microsoft Word source document. This is known Microsoft Word behavior. You may
need to scroll up or down in your source document to the new location of the image to find the
image.

10. If your image previously used the In line with text layout setting for the image, reassign this style to your
image by completing the following steps:

a. Right-click only the image, and then click Format Object.

Note: You must ensure you right-click only the image, and not on the text box or the grouped text
box and image. If you right-click on the text box or the grouped text box and image, Microsoft
Word does not display the Format Object menu option on the context menu.

b. On the Layout tab, click In line with text.

c. Click OK, and then click OK again to close the window.

11. Save your Microsoft Word source document.

12. Generate output for your project. For more information, see “Generating Output”.

13. Verify ePublisher assigned the long description to the image by completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName\images folder, verify that ePublisher created a .txt file that contains the long
description you specified in the ImageLongDescText marker, where TargetName is the name of your
target.

For example, if you specified a long description for ImageName.png, verify that ePublisher created
an ImageName.txt file in the images folder, where ImageName is the name of the image to which you
assigned a long description.

c. In the TargetName\ProjectName folder, open the page that contains the image to which you
assigned the long description in Notepad and verify that the longdesc attribute references the
ImageName.txt file ePublisher created for the image, where TargetName is the name of your target,
ProjectName is the name of your project, and ImageName is the name of the image to which you
assigned a long description.

d. If you used the ImageLongDescText marker and the Stationery designer configured your
Stationery to support D links, open the page in a browser, verify that the D link displays in the
browser, and then click the D link and verify that a page opens that displays the long description that
you specified in the ImageLongDescText marker.
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Using Text in External Files to Assign Long Descriptions to Images in Word
Use the ImageLongDescByRef marker to assign long descriptions to images using text in external files. To assign
a long description to an image, your Stationery and template must have the ImageLongDescText marker type
configured. Your output format must also support this feature. For more information about output formats that
support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to use text in external files to assign long descriptions to
images in Microsoft Word source documents using Microsoft Word 2003. Steps for using text in external files to
assign long descriptions to images in Microsoft Word may be different in other versions of Microsoft Word.

To assign a long description to an image using marker text in a Microsoft Word source document

1. Create a .txt file that contains each image long description.

2. Place each image long description text file in a folder in the ProjectName\Formats\TargetName\Files
folder for your project, where ProjectName is the name of your ePublisher project and TargetName is the
name of your target.

For example, place the each image long description in the following location:

ProjectName\Formats\TargetName\Files\longdescriptions\imagelongdescription.txt

where ProjectName is the name of your ePublisher project, TargetName is the name of your target,
longdescriptions is the name of the folder where you placed the image long description, and
imagelongdescription is the name of the .txt file that contains the image long description.

3. In your Microsoft Word source document, locate the image to which you want to assign a long description.

4. Right-click the image, and then click Format Picture or Format Object.

5. Change the layout setting of the image to Top and Bottom by completing the following steps:

Note: By default when you insert images into Microsoft Word, Microsoft Word inserts the image using the
Inline with text layout setting. In order to specify the image scale for image output files, you must
group the image and the text box that contains the ImageLongDescByRef marker. However, you
cannot group images using the In line with text layout setting in Microsoft Word. To work around
this known Microsoft Word issue, if you have an image that uses an In line with text layout setting,
use the Top and Bottom layout setting for the image while you insert the ImageLongDescText
marker, and then reapply the In line with text layout setting after you group the image and the
ImageLongDescText marker.

a. On the Layout tab, click Advanced.

b. On the Text Wrapping tab, click Top and Bottom.

c. Click OK, and then click OK again to close the window.

6. Select your image.

7. On the Insert menu, click Text Box, and then click to the right of your image. Microsoft Word inserts a text
box.

8. Insert your cursor into the text box, and then complete the following steps:

a. On the WebWorks menu, click Markers.

b. In the Markers field, select ImageLongDescByRef from the list of markers.
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c. In the Value field, type the path to the .txt file that contains the long description you want to assign
to the image.

For example, type:

./longdescriptions/imagelongdescription.txt

where longdescriptions is the name of the folder where you placed the image long description,
and imagelongdescription is the name of the .txt file that contains the image long description.

d. Click OK. ePublisher inserts the ImageLongDescText marker into the text box.

e. Select the text box.

f. Right-click the selected text box, and then click Format Text Box.

g. On the Colors and Lines tab, in the Fill area, in the Color field, select No Fill.

h. In the Line area, in the Color field, select No Line.

i. Click OK.

9. Drag and drop the text box onto the image.

10. Select the text box and the image.

11. Right-click the selected text box and image, and then click Grouping  > Group.

Note: When you select Group, the location of the image in your Microsoft Word source document may
change in relation to the text in your source document. For example, the image may move up or
down in your Microsoft Word source document. This is known Microsoft Word behavior. You may
need to scroll up or down in your source document to the new location of the image to find the
image.

12. If your image previously used the In line with text layout setting for the image, reassign this style to your
image by completing the following steps:

a. Right-click only the image, and then click Format Object.

Note: You must ensure you right-click only the image, and not on the text box or the grouped text
box and image. If you right-click on the text box or the grouped text box and image, Microsoft
Word does not display the Format Object menu option on the context menu.

b. On the Layout tab, click In line with text.

c. Click OK, and then click OK again to close the window.

13. Save your Microsoft Word source document.

14. Generate output for your project. For more information, see “Generating Output”.

15. In Output Explorer, verify ePublisher assigned the long description to the image using the long description
in the external file when it generated output by completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName\ProjectName folder, open the page that contains the image to which you
assigned the long description using an external file in Notepad and verify that the longdesc attribute
references the external text file that contains the long description for the image, where TargetName is
the name of your target, and ProjectName is the name of your project.
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Excluding Images from Accessibility Report Checks in Word
In some instances, alternate text is sufficient for an image, and assigning a long description to an image in
addition to alternate text would be redundant. However, you may have configured Accessibility reports to check
for images without long descriptions and notify you when an image does not have a long description.

In this scenario, while you want an Accessibility report to notify you when you have an image without a long
description, you do not want to be notified when you deliberately did not assign a long description to an image
because assigning a both a long description and alternative text would be redundant. To address this issue, you
can use the ImageLongDescNotReq marker to exclude an image that deliberately does not have a long description
from validation when you generate Accessibility reports. For more information about Accessibility reports and
configuring and generating Accessibility reports, see “Understanding Accessibility Reports”, “Configuring
Reports”, and “Generating Reports”.

To exclude images without long descriptions from Accessibility reports, your Stationery and template must have
the ImageLongDescNotReq marker type configured. Your output format must also support this feature. For more
information about output formats that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to exclude images without long descriptions from
Accessibility report checks in Microsoft Word source documents using Microsoft Word 2003. Steps for excluding
images without long descriptions from Accessibility report checks in Microsoft Word may be different in other
versions of Microsoft Word.

To exclude an image without a long description from Accessibility report checks in a Microsoft
Word source document

1. In your Microsoft Word source document, locate the image without a long description that you want to
exclude from an Accessibility report check.

2. Change the layout setting of the image to Top and Bottom by completing the following steps:

Note: By default when you insert images into Microsoft Word, Microsoft Word inserts the image using the
Inline with text layout setting. In order to specify the image scale for image output files, you must
group the image and the text box that contains the ImageLongDescNotReq marker. However, you
cannot group images using the In line with text layout setting in Microsoft Word. To work around
this known Microsoft Word issue, if you have an image that uses an In line with text layout setting,
use the Top and Bottom layout setting for the image while you insert the ImageLongDescNotReq
marker, and then reapply the In line with text layout setting after you group the image and the
ImageLongDescNotReq marker.

a. On the Layout tab, click Advanced.

b. On the Text Wrapping tab, click Top and Bottom.

c. Click OK, and then click OK again to close the window.

3. Select your image.

4. On the Insert menu, click Text Box, and then click to the right of your image. Microsoft Word inserts a text
box.

5. Insert your cursor into the text box, and then complete the following steps:

a. On the WebWorks menu, click Markers.

b. In the Markers field, select ImageLongDescNotReq from the list of markers.
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c. In the Value field, do not enter any text. You do not need to enter any text in this field when you
insert a ImageLongDescNotReq marker.

d. Click OK. ePublisher inserts the ImageLongDescText marker into the text box.

e. Select the text box.

f. Right-click the selected text box, and then click Format Text Box.

g. On the Colors and Lines tab, in the Fill area, in the Color field, select No Fill.

h. In the Line area, in the Color field, select No Line.

i. Click OK.

6. Drag and drop the text box onto the image.

7. Select the text box and the image.

8. Right-click the selected text box and image, and then click Grouping  > Group.

Note: When you select Group, the location of the image in your Microsoft Word source document may
change in relation to the text in your source document. For example, the image may move up or
down in your Microsoft Word source document. This is known Microsoft Word behavior. You may
need to scroll up or down in your source document to the new location of the image to find the
image.

9. If your image previously used the In line with text layout setting for the image, reassign this style to your
image by completing the following steps:

a. Right-click only the image, and then click Format Object.

Note: You must ensure you right-click only the image, and not on the text box or the grouped text
box and image. If you right-click on the text box or the grouped text box and image, Microsoft
Word does not display the Format Object menu option on the context menu.

b. On the Layout tab, click In line with text.

c. Click OK, and then click OK again to close the window.

10. Save your Microsoft Word source document.

11. Generate output for your project. For more information, see “Generating Output”.

12. Generate an Accessibility report and confirm that ePublisher did not generate an Image is missing a
long description message for the image. For more information about generating Accessibility reports
and Accessibility report messages, see “Generating Reports” and “Accessibility Report Messages”.
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Assigning Alternate Text (Summaries) to Tables in Word
Tables, just like images, are a way to visually display information. Although tables typically contain text, the
purpose of the table is often not evident from text alone. The organization and display of the table may contain
information that is not evident to assistive technologies. However, through the use of table summaries, assistive
technologies can convey useful information to users about tables. The Web Content Accessibility Guidelines
recommend that you provide summary text for each table in an HTML document. Table alternate text, or table
summaries, provide users with information about what type of information the table contains.

You can create accessible tables by typing the table summary into a TableSummary marker. When ePublisher
generates content, ePublisher puts the table summary you specify into the table in the summary attribute.

To assign alternate text to tables, your Stationery and template must have the TableSummary marker type
configured. Your output format must also support this feature. For more information about output formats that
support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to assign alternate text to tables in Microsoft Word source
documents using Microsoft Word 2003. Steps for assigning alternate text to tables in Microsoft Word may be
different in other versions of Microsoft Word.

To assign table summaries in a Microsoft Word source document

1. In your Microsoft Word source document, locate the table to which you want to assign a table summary.

2. Insert your cursor in front of the table.

3. On the WebWorks menu, click Markers.

4. In the Markers field, select TableSummary from the list of markers.

5. In the Value field, type the alternate text for the table.

6. Click OK. ePublisher inserts the TableSummary marker into the table.

7. Insert the marker into the table caption by clicking OK.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. Verify ePublisher assigned the table summary you specified to the table when it generated output by
completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the table to which you assigned a table summary in
Notepad, where TargetName is the name of your target.

c. Verify that the table summary you specified is included in the summary attribute for the table.
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Excluding Tables from Accessibility Report Checks in Word
Tables used specifically for layout may not need a table summary. For example, if you use a table for layout, you
probably would not assign a table summary to the table. However, you may have configured Accessibility reports
to check for tables without table summaries and notify you when a table does not have a table summary.

In this scenario, while you want an Accessibility report to notify you when you have a table without a table
summary, you do not want to be notified when you deliberately did not assign a table summary to a table because
a table summary is not required. To address this issue, you can use the TableSummaryNotReq marker to exclude
a table that deliberately does not have a table summary from validation when you generate Accessibility reports.
For more information about Accessibility reports and configuring and generating Accessibility reports, see
“Understanding Accessibility Reports”, “Configuring Reports”, and “Generating Reports”.

To exclude tables from Accessibility report checks, your Stationery must have the TableSummaryNotReq marker
type configured. Your output format must also support this feature. For more information about output formats
that support this feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to exclude tables without table summaries from
Accessibility report checks in Microsoft Word source documents using Microsoft Word 2003. Steps for excluding
tables without table summaries from Accessibility report checks in Microsoft Word may be different in other
versions of Microsoft Word.

To exclude a table with a table summary from Accessibility report checks in a in Microsoft Word
source document

1. In your Microsoft Word source document, locate the table without a table summary that you want to
exclude from an Accessibility report check.

2. Insert your cursor in front of the table.

3. On the WebWorks menu, click Markers.

4. In the Markers field, select TableSummaryNotReq from the list of markers.

5. In the Value field, do not enter any text. You do not need to enter any text in this field when you insert a
TableSummaryNotReq marker.

6. Click OK. ePublisher inserts the TableSummaryNotReq marker into the table.

7. Save your Microsoft Word source document.

8. Generate output for your project. For more information, see “Generating Output”.

9. Generate the Accessibility report and confirm that ePublisher did not generate an Table is missing a
table summary message for the table. For more information about generating Accessibility reports and
Accessibility report messages, see “Generating Reports” and “Accessibility Report Messages”.
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Assigning Alternate Text to Abbreviations in Word
Abbreviations are often used in written communication. Using an Abbreviation character style and an
AbbreviationTitle marker, you can specify alternate text for abbreviations. For example, if your source
document includes an abbreviation such as SS#, you can specify Social Security Number as alternate text for the
abbreviation. When you use an AbbreviationTitle marker and Abbreviation character style to specify alternate text
for an abbreviation, ePublisher adds the abbreviation alternate text you specify to the title attribute of the abbr
tag in the output.

Following is an example of the HTML code produced when you specify Social Security Number as alternate text
for SS#.

<th>First name</th>

<th><abbr title="Social Security Number">SS#</abbr></th>

To assign alternate text to abbreviations, your Stationery and template must have the following items configured:

Abbreviation character style

AbbreviationTitle marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify alternate text for abbreviations in Microsoft Word
source documents using Microsoft Word 2003. Steps for specifying alternate text for abbreviations in Microsoft
Word may be different in other versions of Microsoft Word.

To specify alternate text for an abbreviation in a Microsoft Word source document

1. In your Microsoft Word source document, locate the abbreviation for which you want to specify alternate
text.

2. Apply the AbbreviationTitle character style to the abbreviation text.

3. Insert your cursor anywhere inside the abbreviation.

4. On the WebWorks menu, click Markers.

5. In the Markers field, select AbbreviationTitle from the list of markers.

6. In the Value field, type the abbreviation alternate text.

7. Click OK. ePublisher inserts the AbbreviationTitle marker into the abbreviation.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. Verify ePublisher assigned the abbreviation alternate text you specified when it generated output by
completing the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the abbreviation to which you assigned alternate
text in Notepad, where TargetName is the name of your target.
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c. Verify that the alternate text you specified for the abbreviation is included in the abbr tag in the
title attribute.
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Assigning Alternate Text to Acronyms in Word
Acronyms are often used in written communication. Using an Acronym character style and an AcronymTitle
marker, you can specify alternate text for acronyms. For example, if your document includes an acronym like
NATO you can specify North Atlantic Treaty Organization as alternate text for the acronym. When you use an
AcronymTitle marker and an Acronym character style to specify alternate text for an acronym, ePublisher adds
the acronym alternate text you specify to the title attribute of the acronym tag in the output.

Following is an example of the HTML code produced when you specify North Atlantic Treaty Organization as
alternate text for NATO.

<p><acronym title=”North Atlantic Treaty Organization”>NATO</acronym> is a military
alliance.<p>

 

To assign alternate text to acronyms, your Stationery and template must have the following items configured:

Acronym character style

AcronymTitle marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify alternate text for acronyms in Microsoft Word
source documents using Microsoft Word 2003. Steps for specifying alternate text for acronyms in Microsoft Word
may be different in other versions of Microsoft Word.

To specify alternate text for an acronym in a Microsoft Word source document

1. In your Microsoft Word source document, locate the acronymn for which you want to specify alternate text.

2. Apply the AcronymTitle character style to the abbreviation text.

3. Insert your cursor anywhere inside the abbreviation.

4. On the WebWorks menu, click Markers.

5. In the Markers field, select AcronymTitle from the list of markers.

6. In the Value field, type the acronym alternate text.

7. Click OK. ePublisher inserts the AcronymTitle marker into the abbreviation.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. Verify ePublisher assigned the acronym alternate text you specified when it generated output by completing
the following steps:

a. On the View menu, click Output Directory.

b. In the TargetName folder, open the page that has the acronym to which you assigned alternate text in
Notepad, where TargetName is the name of your target.

c. Verify that the alternate text you specified for the acronym is included in the acronym tag in the
title attribute.
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Providing Citations for Quotes in Word
A citation is a reference or footnote to a book, article, or other material that specifies the source from which a
quotation was borrowed. A citation contains all the information necessary to identify and locate the work. Using
a Citation character style and the Citation marker, you can specify citations for quotes that enable users to go to a
Web site that contains additional information about the quote.

Following is an example of the HTML code produced when you specify a citation for a quote.

<blockquote cite="http://shakespeare.mit.edu/lll/full.html"> <p>Remuneration! O! that's the
Latin word for three farthings.

--- William Shakespeare (Love's Labor Lost).</p> </blockquote>

 

To provide citations for quotes, your Stationery and template must have the following items configured:

Citation character style

Citation marker type

Your output format must also support this feature. For more information about output formats that support this
feature, see “Features Available in Each Output Format”.

The following procedure provides an example of how to specify citations for quotes in Microsoft Word source
documents using Microsoft Word 2003. Steps for specifying citations for quotes in Microsoft Word may be
different in other versions of Microsoft Word.

To specify citations for quotes in a Microsoft Word source document

1. In your Microsoft Word source document, locate the quotation for which you want to specify a citation.

2. If the quotation is a phrase within a paragraph, complete the following steps:

a. Apply the Citation character style to the quotation phrase.

b. Insert your cursor anywhere inside the quotation phrase.

3. If the quotation is a full paragraph, insert your cursor into the paragraph.

c. On the Special menu, click Marker.

4. On the WebWorks menu, click Markers.

5. In the Markers field, select Citation from the list of markers.

6. In the Value field, type the URL for the citation.

7. Click OK. ePublisher inserts the Citation marker into the abbreviation.

8. Save your Microsoft Word source document.

9. Generate output for your project. For more information, see “Generating Output”.

10. Verify ePublisher created the citation you specified when it generated output by completing the following
steps:

a. On the View menu, click Output Directory.
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b. In the TargetName folder, open the page that has the quotation for which you specified a quotation in
Notepad, where TargetName is the name of your target.

c. Verify that the citation you specified for the quotation is included in the cite attribute.
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Troubleshooting Word issues
Occasionally there might be issues with the source documents you are using. Below is a list linking to the wiki
solutions website that will help you troubleshoot each one:

Issue For more information, see to...

If you are seeing hidden text in the
output

Hidden text in output

If you are seeing inconsistent bullets
in output

Inconsistent bullet sizes

If you are seeing an “infinite” number
of transit menus in Word 2003

Transit Menu displays "infinite" menu syndrome

If you are using relative images Relative Images

If you are using master docs Using Microsoft Word Master Docs

If conversions hang and your
documents track changes or
comments

Word warning dialogs that interrupt conversions

 

http://wiki.webworks.com/Permalinks/Solutions/Input/Word/HiddenText
http://wiki.webworks.com/Permalinks/Solutions/Input/Word/InconsistentBulletSize
http://wiki.webworks.com/Permalinks/Solutions/Input/Word/InfiniteMenu
http://wiki.webworks.com/Permalinks/Solutions/Input/Word/RelativeImages
http://wiki.webworks.com/Permalinks/Solutions/Input/Word/UsingMasterDocs
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Word warning dialogs that interrupt conversions
Conversions in ePublisher being stuck because of warning dialogs or just hanging when you are using Word
source documents and you have comments or tracking the changes, might be cause by a configuration in your
Word application.

A warning dialog you might see during a conversion in ePublisher should look similar to the following figure.

The following procedure provides an example of how to disable the “Warn before printing, saving or sending a
file that contains tracked changes or comments” option in Microsoft Word source documents using Microsoft
Word 2016.

To disable the “Warn before printing, saving or sending a file that contains tracked changes or
comments” in a Microsoft Word source document

1. Open a Microsoft Word document, or even a Blank document.

2. On the Word menu, click File and then Options.

3. In the window that pops out in the left side menu click on Trust Center, and on the right side select Trust
Center Settings. You should see a window similar to the following figure.
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4. After selecting Trust Center Settings you’ll see a new window, click on the left side on Privacy Options
and on the right panel uncheck Warn before printing, saving or sending a file that contains tracked
changes or comments. You should see a window similar to the following figure.

5. And finally click OK.
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Preparing DITA Source Documents

Before you can generate output using DITA source documents, you need to prepare your DITA source documents
for output generation. This section explains how to prepare your DITA source files for output generation.
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Checklist: Preparing DITA Source Documents
Use the following checklist to help you prepare your DITA source documents for output generation.
 

 Task For more information, see to...

1. If you want to create Context
Sensitive Help

“Creating Context-Sensitive Help in DITA
Source Documents”

2. If you want to create Popups “Creating Popups in DITA Source
Documents”

3. If you want to create Related Topics, “Creating Related Topics in DITA Source
Documents”

4. If you want to create Wiki Categories “Specifying Wiki Categories or Labels in
DITA”

5. If you want to create See Also links, “Creating See Also Links in DITA Source
Documents”

6. If you want to assign a specific page
style to specific pages,

“Assigning Custom Page Styles to Pages in
DITA Source Documents”

7. If you want to customize the
appearance of table of contents
icons in your generated output,

“Customizing Table of Contents Icons for
Topics in DITA Source Documents”

8. If you want to embed HTML or
Passthrough content in your
generated output,

“Using Passthrough outputclass in DITA”
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DITA 1.2 Support
Starting with version 2011.2, ePublisher includes support for the DITA 1.2 standard. For information on the
complete set of DITA 1.2 topic types, elements, attributes, and other specifications you may want to visit:
http://www.webworks.com/Documentation/DITA_1.2_Specification.

http://www.webworks.com/Documentation/DITA_1.2_Specification/
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Keyref elements
You can use the "keyref" feature in DITA 1.2 as an indirect addressing mechanism. Instead of linking directly to
topics or maps, these can be given a symbolic name (key attribute) that points to a topic file path (href attribute).
References to the topics are made using a key reference (keyref attribute). If the topic is relocated, the path needs
to be updated only in the map where it is defined. All other references will automatically pick up the new location.

For more information, see DITA 1.2 feature article: Keyref overview (http://dita.xml.org/resource/keyref-
overview-dita-12).

http://dita.xml.org/resource/keyref-overview-dita-12
http://dita.xml.org/resource/keyref-overview-dita-12
http://dita.xml.org/resource/keyref-overview-dita-12
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Conref extensions
DITA 1.2 introduces new extensions to the conref element.

Conref Range - Allows a single element to reference a range of elements.

Conref Push - Most commonly used when your component adds to an existing component.

Conkeyref - Allows you to use a key in the conref attribute so you can more easily change the target of the
conref.

For more information, see Understanding DITA 1.2: Keys, conref extensions, and more (http://dita.xml.org/
resource/understanding-dita-12-keys-conref-extensions-and-more).

http://dita.xml.org/resource/understanding-dita-12-keys-conref-extensions-and-more
http://dita.xml.org/resource/understanding-dita-12-keys-conref-extensions-and-more
http://dita.xml.org/resource/understanding-dita-12-keys-conref-extensions-and-more
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New Document Type Definitions
DITA 1.2 introduces new, industry specific specializations:

Classifications - specifically for information taxonomy for audience and relationships

Glossary - support for acronym expansion and also for more information such as parts of speech and usage

Learning - created by learning professionals with instructional design goals in mind

For more information, see What’s Coming in DITA 1.2 (http://dita.xml.org/sites/dita.xml.org/files/DITA12.pdf).

http://dita.xml.org/sites/dita.xml.org/files/DITA12.pdf
http://dita.xml.org/sites/dita.xml.org/files/DITA12.pdf
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Using Ditaval files in DITA
For conditional text, DITA uses filtering to determine the user or audience that will be viewing the help content.
Using a file called a “ditaval” file, you can control the filtering of the content that will be generated as output. You
can place ditaval files within files using the name of the DITA map files that they are to be applied to similar to
this (nested maps use the parentmap's ditaval file):

<ditamap name>.ditaval

With ePublisher you have 3 additional ways to handle ditaval files. The ditaval definitions are looked for in the
following order.

Per Target: Targets\<Target Name>\Adapters\xml\scripts\dita\default.ditaval

Per Format: Formats\<Format Name>\Adapters\xml\scripts\dita\default.ditaval

Entire project: Formats\Adapters\xml\scripts\dita\default.ditaval

The following example shows an example of how filtering works with the ditaval markup:

<val>

<prop att="audience" val="web" action="exclude" />

</val>

 

The attributes within prop determine the action and who sees the material that is defined in the output.

action
include - Includes the content in output. This is the default behavior unless otherwise set.

exclude - Excludes the content from output (if all values in the particular attribute are excluded).

passthrough - Include the content in output, and preserve the attribute value as part of the output stream for
further processing by a runtime engine, for example runtime filtering based on individual user settings

flag - include and flag the content on output (if the content has not been excluded).

att
The attribute to be acted. This must be one of props, audience, platform, product, otherprops, or a
specialization of props. If the att attribute is absent, then the prop element declares a default behavior for
any conditional processing attribute.

val
The value to be acted upon. If the val attribute is absent, then the prop element declares a default behavior
for any value in the specified attribute.

For further explanation of the ditaval file, please refer to the specification: http://docs.oasis-open.org/dita/v1.2/os/
spec/common/about-ditaval.html#ditaval

http://docs.oasis-open.org/dita/v1.2/os/spec/common/about-ditaval.html#ditaval
http://docs.oasis-open.org/dita/v1.2/os/spec/common/about-ditaval.html#ditaval
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Using Passthrough outputclass in DITA
You may want to include some kind of HTML or Javascript in your output that would not be generated as normal
output. For this example we are going to use a passthrough attribtue on a paragraph tag in DITA. This will create
a Passthrough paragraph style that you would switch to Passthrough in the paragraph options tab in ePublisher, for
more information, See “Paragraph Styles Options”.

Below is an example of a Javascript alert in HTML using the CDATA attribute

<p outputclass="Passthrough">

<![CDATA[

<div><a href="alert('Yahoo!'">Click Me!</a></div>

]]>

</p>

Once you have entered in the paragraph that contains the passthrough attirbute, re-scan the documennt and
make sure that this passthrough paragraph has the “Passthrough” option enabled so that the HTML will not be
processed.

Depending on the output, for example, browser-based (Dynamic HTML or WebWorks Help 5.0) versus PDF
output, you may want to use ditaval filtering to ensure that only the web-based output is getting output. For this
instance, you would want to have the following DITA markup

<p outputclass="Passthrough" audience="web">

<![CDATA[

<div><a href="alert('Yahoo!'">Click Me!</a></div>

]]>

</p>

For the PDF output, for example you would want to have the Target override:

Targets\PDF\Adapters\xml\scripts\dita

and the default.ditval information:

<val>

<prop att="audience" val="web" action="exclude" />

</val>

For the Dynamic HTML output you would want to have the Target override:

Targets\Dynamic HTML\Adapters\xml\scripts\dita

and the default.ditval information:

<val>

<prop att="audience" val="web" action="include" />
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</val>

Note: Depending on what your Target name and input is like, the information may be different than what is listed
above. For more information on Target overrides, See “Creating Target Overrides”.
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Creating Context-Sensitive Help in DITA Source Documents
This section explains how you can use ePublisher to create links to context-sensitive help content in DITA source
documents
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Understanding Context-Sensitive Help
Context-sensitive help provides immediate assistance and information to users without requiring users to leave
the context in which they are working. It helps answer questions like "What is this?" and "Why would I use this?",
and provides information for a particular object and its context.

For example, in many applications, user interface controls such as windows and tabs have a help button. When
users click on the help button, the application links users to a help topic specific to the context of the window.
Some applications also embedded context-sensitive help topics into the window itself as an HTML pane. The
application relies on an identifier such as a topic ID or file name to identify the specific help topic to display.

There are several methods for creating context-sensitive help links. In addition, different output formats use
different mechanisms to support context-sensitive help links. For example, some output formats, such as
Microsoft HTML Help, create a map file using topic aliases. Applications then use the topic IDs in the map file
to provide links to context-sensitive help topics from within the application. Other output formats do not have a
mapping mechanism. However, these output formats may support creating links to context-sensitive help topics
using file names.
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Understanding Map Files
Many application support the use of map files to deliver context-sensitive help. The topic IDs and map numbers
are listed in a map file, which is a text file that typically has a .h extension. Applications can use the information
in the map file to link users to the appropriate context-sensitive help topic.

Note: Some developers may use the term header file instead of map file.

There are some variations in the way context-sensitivity works depending on which supported ePublisher output
format you use. For example, Microsoft WinHelp, Microsoft HTML Help, Sun JavaHelp, and Oracle Help output
formats use map files.

Note: WebWorks Help, WebWorks Reverb, Simple HTML Help, Dynamic HTML Help, and XML+XSL
output formats do not use map files.

When an application calls a context-sensitive help topic, it relies on the topic IDs and map numbers to identify
the specific topic to display. Therefore, the topic IDs and map numbers must be embedded both in the application
code and in the help system. If the topic IDs and map numbers do not match, the wrong topic (or no topic)
displays when the user requests Help.

Following is a typical example of a Microsoft HTML Help and Microsoft WinHelp map file:

#define IDH_WDWTYPE 1001

#define IDH_WDWENTER 1002

#define IDH_WDWCANCEL 1003

 

In this example, IDH_WDWTYPE is a topic ID, and 1001 is the corresponding map number. These topic IDs and
map numbers must be embedded in the software application and in your source documents.

Following is a typical example of a Sun JavaHelp and Oracle Help map file:

<mapID target="ch1_htm_999374" url="ch1.htm#999374">

<mapID target="ch2_htm_999640" url="ch2.htm#999640">

<mapID target="ch9_htm_999786" url="ch9.htm#999786">

 

In this example, ch1_htm_99374 is a topic ID, and ch1.htm#99374 is the target URL for the topic ID. These topic
IDs must be embedded in the software application and in your source documents.
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Planning for Context-Sensitive Help
Creating context-sensitive help requires you to collaborate with application developers. Because topic IDs and
map numbers must be embedded in both the software application and in your source documents, you and the
application developers must agree in advance on the values to use.

Before you create context-sensitive help topics, complete the following steps:

1. Confirm with your application developers that the application supports context-sensitive help.

2. Meet with your application developers to identify each context-sensitive help topic you need to create.

3. Determine if you will use topic IDs or file names to create links to context-sensitive help topics.

4. Discuss the process for referencing context-sensitive help topics from the application with your application
developers. Writers and application developers have the following options for creating context-sensitive
help links:

The writer chooses the topic IDs or file names and embeds them in the source documents. If the
generated output supports map files, the writer performs the following steps:

The writer uses topic IDs inserted into source documents and ePublisher to generate a
map file, also known as a header file, that contains the topic IDs defined by the writer and
automatically generated mapping IDs.

The writer supplies the generated map file to the application developers to implement.

Note: The writer must supply the header file along with the help system to the developers each time
the writer updates the help system. This ensures correctly identified context-sensitive help
topics each time.

Application developers choose the topic IDs or file names and then give the topic IDs or filenames
to the writer to embed in the source documents. If the generated output supports map files, the
application developers perform the following steps:

Application developers create the map file, or header file.

Application developers give the writer a copy of the map file, or header file, and the writer
embeds the topic IDs from the map file into the source documents.

Note: The group context must be unique so that if there are the same topic ID’s in a help system, the context
sensitive pointer will go to the correct place in the help.
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Understanding Topic ID and File Name Requirements
If you are creating context-sensitive help topics using topic IDs, topic IDs must follow these guidelines:

Must be unique

Must begin with an alphabetical character

May contain alphanumeric characters

May not contain special characters or spaces, with the exception of underscores ( _ )

Dynamic HTML, Eclipse Help, Microsoft HTML Help, Microsoft WinHelp, Oracle Help, Sun, WebWorks Help,
and WebWorks Reverb support the use of topic IDs to create context-sensitive help.

If you are creating context-sensitive help topics using file names, file names must follow these guidelines:

Must be unique

Must begin with an alphabetical character

May contain alphanumeric characters

May not contain special characters or spaces

Simple HTML, and XML+XSL support the use of file names to create context-sensitive help.
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Output Formats that support Creating Context-Sensitive Help Links In DITA
Source Documents
The following table lists output formats available for creating context-sensitive help links.
 

Output Formats that Support
Context-Sensitive Help Links

You can use ePublisher to create
context-sensitive help links for the
following output formats:

Dynamic HTML
Eclipse Help
Microsoft HTML Help
Microsoft WinHelp
Oracle Help
Sun JavaHelp 1.1.3
Sun JavaHelp 2.0
WebWorks Help
WebWorks Reverb
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Specifying Context-Sensitive Help Links in DITA Source Documents
Before you specify context-sensitive help links, review context-sensitive help link requirements. For more
information about context-sensitive help and context-sensitive help link requirements, see “Understanding
Context-Sensitive Help” and “Output Formats that support Creating Context-Sensitive Help Links In DITA
Source Documents”.

To specify a topic alias for a topic in a DITA source document:

1. In your DITA source document, locate your topic’s meta information container element.

2. For this element, you use the <othermeta> element to define the topic alias, for example: <othermeta
name="TopicAlias" content="helpid"/>

Note: You can also use the <data> element to define topic alias values, for example: <data
name="TopicAlias" value="helpid"/>

3. Save the DITA document

4. Generate output for your target. For more information, see “Generating Output”

Steps for creating context-sensitive help links in DITA may be different in other versions of DITA.
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Creating Hyperlinks in DITA Source Documents
You will have to use DITA elements to create links in your documents so that ePublisher can create links to other
topics or files in the online help output of your choice.

To create an a hyperlink to a topic in the same DITA file or another DITA file, complete the
following steps

1. Identify your link type, as it will determine the markup that is required.

2. For a hyperlink that is going the same file create the following markup:
<xref href="#yourtopicID">Your xref link text</xref>

3. For a hyperlink that is going to a different file create the following markup:
<xref href="file.xml#yourtopicID">Your xref link text</xref>

4. For a hyperlink that is going to a PDF create the following markup:
<xref format="PDF" href="sample.PDF">Your xref link text</xref>
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Creating Popups in DITA Source Documents
This section explains how to create popups in DITA source documents.
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Understanding Popups
A popup window is a window that is smaller than standard windows and typically does not contain some of the
standard window features such as tool bars or status bars. Popup windows display when users hover over or click
on a link. The popup topic closes automatically as soon as the users clicks somewhere else.

A typical use of popups is to display glossary terms. For example, in a printed document, terms and definitions
are typically grouped in a separate glossary document. However, in a help system, you can display glossary
definitions in popups. When you create glossary popups, users can choose whether they want to view the
definition of an unfamiliar term. If they want additional information about the term, they can view the definition
in a click.

You create popups by creating link between the word or phrase in a topic and the content you want to display in
the popup, and then you use <othermeta> elements or paragraph styles to create popups.

Popup and Popup Append paragraph styles
Specifies that content displays both in popup windows and in standard help topics. You apply the Popup
paragraph style to the first paragraph of content you want displayed in the popup window. If you have more
than one paragraph of content you want to display, you apply the Popup Append style to the additional
paragraphs.

For example, if you apply a glossary term and glossary definitions style for a glossary using the Popup and
Popup Append styles, the terms and definitions in your output display in both a popup window and in a
glossary topic that contains the definitions.

Popup Only and Popup Only Append paragraph styles
Specifies that content displays only in popup windows. You apply the Popup Only paragraph style to the
first paragraph of content you want displayed in the popup window. If you have more than one paragraph of
content you want to display, you apply the Popup Only Append style to the additional paragraphs.

For example, if you apply a glossary term and glossary definition style for a glossary using the Popup Only
and Popup Only Append paragraph style, the terms and definitions in your output display in only popup
windows. The content is not displayed in an additional glossary topic that contains the definitions.
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Requirements for Creating Popups in DITA Source Documents
You prepare popups using <othermeta> elements or paragraph formats. Before you create popups in your source
documents, verify that your output formats, templates, and stationery meet popup requirements. The following
table lists requirements for creating popups.
 

 Requirement

Output Format You can use ePublisher to create popups for the following output formats:
Microsoft HTML Help
Oracle Help
Sun JavaHelp
WebWorks Help
WebWorks Reverb
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Creating Popup Links in DITA Source Documents
Steps for creating links in DITA may be different in other versions of DITA.
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Using Paragraph Styles to Create Popups in DITA Source Documents
You can use Popup paragraph formats in your DITA source documents to create popups. To use Popup paragraph
styles to create popup windows, your Stationery and DITA file must have the following items configured:

Popup and Popup Append paragraph style behaviors if you want your content to display both in popup
windows and in standard help topics.

Popup Only and Popup Only Append paragraph style behaviors if you want your content to display only in
popup windows.

The following procedure provides an example of how to use Popup paragraph formats to create popup windows in
DITA source documents.

To create popup windows using Popup paragraph styles in DITA source document

1. In your DITA source document, create a link between a word or phrase in the topic and the content you
want to display in the popup window and ensure that the link resolves in the document.

2. Save your DITA source document.

3. In the ePublisher Style Designer, configure the destination paragraph styles with the appropriate popup
behavior via the Options panel.

4. Generate output for your project.

5. In Output Explorer, go to the page where you created the popup window and verify that ePublisher created
the popup window and that the popup window displays the content you specified.
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Creating Related Topics in DITA Source Documents
This section explains how to create related topics in DITA source documents.
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Understanding Related Topics
Related topics provide a list of other topics that may be of interest to the user viewing the current topic. For
example, you could have a section called Creating Web Pages in your help. You may also have many other topics,
such as HTML Tags and Cascading Style Sheets, that related to creating Web pages. Identifying these related
topics for users can help them find the information they need and identify additional topics to consider. However,
providing these types of links as cross-references within the content itself may not be the most efficient way to
present the information. By utilizing related topics links, you combine the capabilities of cross-references with the
efficiency of a related topics button.

Related topics and See Also links provide similar capabilities, but there are several important differences:

Related topics can link to headings in a Help system that do not start a new page.

Relate topics links are static and defined in the source documents as links. You must have all the source
documents to create the link and generate the output.

If a related topics list contains a broken link in the source document, that link is broken in the generated
output. In a See Also link list, the broken link is not included in the output.

The stationery designer can configure related topics to display in the following ways:

Display in a popup window when the user clicks a button,

Included in a list in the topic itself and then displayed in a popup window when the user clicks a button.
 

Note: If a related topic link is broken in the source document, in most cases that link is broken in the generated
output. WebWorks Help provides an additional feature by removing broken links from related topics lists
that are displayed in a popups window when a user clicks the Related Topics button.
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Requirements for Creating Related Topics Links in DITA Source Documents
You can create related topics using a paragraph format. Before you create related topics links in your DITA source
documents, verify that your output formats, templates, and stationery meet related topics links requirements. The
following table lists requirements for creating related topics links.
 

 Requirement

Output Format You can use ePublisher to create related topics for the following output formats:
Dynamic HTML
Eclipse Help
Microsoft HTML Help
Oracle Help
Simple HTML
Sun Java Help
WebWorks Help
WebWorks Reverb
XML+XSL
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Specifying Related Topics Links in DITA Source Documents
Create related topics links by applying the Related Topics paragraph format to cross-references you create in your
DITA source documents. Before you create related topics in your source documents, review related topics links
requirements. For more information about related topics and related topics links requirements, see “Understanding
Related Topics” and “Requirements for Creating Related Topics Links in DITA Source Documents”.

The following procedure provides an example of how to create related topics links in DITA source documents
using DITA 1.4. Steps for creating related topics links in DITA may be different in other versions of DITA.

To create a related topics list in a DITA source document

1. Identify the topic in which you would like to insert a related topics list.

2. Identify the different topics you want to link to from this topic.

Note: Generally, you should only create one related topics list for each section of your source document
that corresponds to a help topic. For example, if you have specified in your ePublisher project that
there will be a page break at each Heading 1 section, then you should only create one related topics
list for each Heading 1 section within your source document.
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Specifying Wiki Categories or Labels in DITA
On Wikis, categories, which are referred to as labels in some Wiki formats, are used to organize Wiki content.
Categories help group together pages that have similar subjects.

Note: MoinMoin and Media Wiki use the term category to describe page grouping functionality. Confluence uses
the term label to describe page grouping functionality.

Pages are assigned to category groups through the use of category or label tags. When you assign a category or
label tag to a Wiki page, the category to which the Wiki page belongs displays in a box at the bottom of the page.

Category and label tags on Wiki pages allow categorized pages to automatically be added to a list on a category
page on the Wiki. The category page lists all of the Wiki pages tagged for a certain category. For example, if
you tag each page on a Wiki that contains licensing information with a Licensing category tag, then a licensing
category page on the Wiki can display a list of all of the pages tagged as containing licensing information.

The following procedure provides an example of how to specify categories for Wiki pages in DITA Source
Documents:

To specify a Wiki category or label for a topic in a DITA source document:

1. In your DITA source document, locate your topic’s meta information container element.

2. For this element, you use the <othermeta> element to define the WikiCategory, for example: <othermeta
name="WikiCategory" content="categoryname"/>.

Note: You can also use the <data> element, for example: <data name="WikiCategory"
value="categoryname"/>

3. Save the DITA document

4. Generate output for your Wiki target. For more information, see “Generating Output”

5. Deploy the Wiki output files to a Wiki server. For more information, see “Deploying Output to Output
Destinations”.

Note: You must deploy generated Wiki content to a Wiki server before you can view the Wiki content.

6. Verify that your Wiki pages display the categories or labels you specified at the bottom of the page
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Creating See Also Links in DITA Source Documents
This section explains how to create See Also links in DITA source documents.
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Understanding See Also Links
See Also links, also known as ALinks, or associative links, are links that may be of interest to the user viewing
the current topic. These links use internal identifiers to specify the links and the link list is built dynamically based
on the topics available when the user clicks to display the links. See Also links are important to use with larger
help sets and merged help sets.

Related topics and See Also links provide similar capabilities, but there are several important differences:

See Also links must link to styles that start a new topic, such as a heading.

See Also links are dynamic and the lists of links are built at display time instead of during help generation.

Since see Also link lists are dynamically built, they do not include links to topics that are not available
when the user displays the links. If a er list contains a broken link in the source document, that link is
broken in the generated output for most output formats.

See Also links are useful if you plan to merge help systems. For example, if you have a multiple help systems that
you merge into one main help system at run time and if your topics in the merged help systems contain See Also
keywords that are also used in the main help system, links to those topics are included in the See Also lists in the
main project.

You can create See Also links as buttons or as inline text links in Microsoft HTML Help and WebWorks Help.
The following example shows how the two different types of See Also links display in a Microsoft HTML Help
system.

 

To create See Also links in your generated output, use a See Also paragraph format or character format defined by
the stationery designer and through <othermeta> elements.
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Requirements for Creating See Also Links in DITA Source Documents
You create See Also links using a paragraph or character format and through <othermeta> elements. Before you
create See Also links in your DITA source documents, verify that your output formats, templates, and stationery
meet See Also link requirements. The following table lists requirements for creating See Also links.
 

 Requirement

Output Format You can use ePublisher to create See Also links for the following output formats:
Microsoft HTML Help
WebWorks Help
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Specifying See Also Links in DITA Source Documents
Create See Also links by applying the See Also paragraph format or character format to text in your DITA source
documents and through <othermeta> elements into your DITA source documents. Before you create See Also
links in your source documents, review See Also link requirements. For more information about See Also links
and See Also link requirements, see “Understanding See Also Links” and “Requirements for Creating See Also
Links in DITA Source Documents”.

Steps for creating See Also links in DITA may be different in other versions of DITA.
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Assigning Custom Page Styles to Pages in DITA Source
Documents
This section explains how to assign custom page styles to specific pages in DITA source documents.
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Understanding Page Styles
By default, each page generated by ePublisher is associated with the default page style defined in the stationery
used by your ePublisher project. This means that typically you do not need to specify a page style for pages when
you generate output.

For example, you may want to use one page style in your help system for all concept and procedure topic pages,
and another page style for all context-sensitive window description topic pages in your help system. In this
example, you can use the default page style for all of your concept and procedure topic pages, and then you can
use a second custom page style defined in your stationery for all context-sensitive window description topic pages
in your help system.
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Requirements for Specifying Custom Page Styles for Pages in DITA Source
Documents
You specify page styles for pages using <othermeta> elements. Before you specify page styles for pages by using
<othermeta> elements in your DITA source documents, verify that your output formats, templates, and stationery
meet image style requirements. The following table lists requirements for specifying page styles for pages.

 Requirement

Output Format You can use ePublisher to specify page styles for specific images for the following output
formats:

Dynamic HTML
Eclipse Help
eBook - ePub 2.0
Microsoft HTML Help
Microsoft WinHelp
Oracle Help
Simple HTML
Sun JavaHelp 1.1.3
Sun JavaHelp 2.0
WebWorks Help
WebWorks Reverb
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Specifying Custom Page Styles for Pages in DITA Source Documents
For more information about page styles and page style requirements, see “Understanding Page Styles” and
“Requirements for Specifying Custom Page Styles for Pages in DITA Source Documents”.

To specify a Page Style for a topic in a DITA source document:

1. In your DITA source document, locate your topic’s meta information container element.

2. For this element, you use the <othermeta> element to define the Page Style, for example: <othermeta
name="PageStyle" content="stylename"/>

3. Save the DITA document

4. Generate output for your target. For more information, see “Generating Output”

Steps for specifying custom page styles for pages in DITA may be different in other versions of DITA.
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Customizing Table of Contents Icons for Topics in DITA
Source Documents
This section explains how to customize the appearance of table of contents icons for topics in Microsoft HTML
Help, Sun JavaHelp, Oracle Help, and WebWorks help systems.
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Requirements for Specifying Custom Table of Contents Icons in DITA Source
Documents
. .

 Requirement

Output Format You can use ePublisher to specify custom table of contents icons in the following output
formats:

Microsoft HTML Help
Oracle Help
Sun JavaHelp
WebWorks Help
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Specifying Custom Table of Contents Icons in DITA Source Documents
For more information about custom table of contents icons, see “Requirements for Specifying Custom Table of
Contents Icons in DITA Source Documents”.

To specify a Custom Table of Contents Icon for a topic in a DITA source document:

1. In your DITA source document, locate your topic’s meta information container element.

2. For this element, you use the <othermeta> element to define the Page Style, for example: <othermeta
name="TOCIcon" content="blue.png"/>.

Note: You can also use the <data> element, for example: <data name="TOCIcon" value="blue.png"/>.

3. Save the DITA document

4. Generate output for your target. For more information, see “Generating Output”

Steps for customizing table of contents icons for topics in DITA may be different in other versions of DITA.

To specify a custom table of contents icon in a DITA source document

5. If you want to specify a custom table of contents icon for Microsoft HTML Help, identify the number of
the image you want to use for the table of contents image for the topic in the .hhp file for your Microsoft
HTML Help project by completing the following steps:

a. On the View menu, click Output Directory.

b. Open the ProjectName folder, where ProjectName is the name of your project.

c. Open the ProjectName.hhp file where ProjectName is the name of your project.

d. On the Contents tab, select a table of contents entry, and then click the Pencil icon.

e. On the Advanced tab, in the Image index field, use the up and down arrows to identify the table of
contents image you want to use for the topic.

f. Note the number of the image you want to use for the table of contents image for the topic.

For example, if you want to use a question mark icon with a red star for the table of contents icon for
new topics, note that the number for this icon is 10.

g. Close HTML Help Workshop.

6. If you want to specify a custom table of contents icon for Oracle Help or Sun JavaHelp, create the
graphic file for the custom table of contents icon in .gif format. The default graphics used as Sun
JavaHelp or Oracle Help table of contents icons are 17 x 17 pixels. The custom graphics you create for Sun
JavaHelp or Oracle Help table of contents icons should also be 17 x 17 pixels. You can assign any name to
the graphic files.

7. If you want to specify a custom table of content icon for WebWorks help, create graphics files containing
the collapsed and expanded versions of the icons you want to use, then save the graphic files in .gif
format. The default graphics used as WebWorks Help table of contents icons are 17 x 17 pixels. The custom
graphics you create for WebWorks Help table of contents icons should also be 17 x 17 pixels. You can
assign any name to the graphic files.

8. Copy the graphic files you want to use as icons in the table of contents into the following folder:
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Note: If the folder does not exist, first create the folder using the specified folder structure and then copy
the graphic files you want to use as icons into the folder. You do not need to perform this step when
specifying custom table of contents icons for Microsoft HTML Help.

If you are generating Oracle Help, copy the graphic files you want to use into the following folder:

ProjectName\Formats\Oracle Help\Files\images folder, where ProjectName is the name of
your project.

If you are generating Sun JavaHelp 1.1.3, copy the graphic files you want to use into the following
folder:

ProjectName\Formats\Sun Java Help 1.1.3\Files\images folder, where ProjectName is the
name of your project.

If you are generating Sun JavaHelp 2.0, copy the graphic files you want to use into the following
folder:

ProjectName\Formats\Sun Java Help 2.0\Files\images folder, where ProjectName is the
name of your project.

If you are generating WebWorks Help, in your ProjectName\Files folder, where ProjectName is
the name of your project, create a wwhelp\images subfolder and copy the graphic files you want to
use into this folder. Your project file structure should be similar to the following structure:

ProjectName\Files\wwhelp\images



Using markopen and markclose | 383

Using markopen and markclose
This default.wwconfig modification specifies the start and a stop of an element. This is especially useful for
the implementation of the dropdown elements in WebWorks Help 5 or WebWorks Reverb output. ePublisher has
preconfigured items such as the Defintion Term Elements, below is an example of the sample DITA markup:

<?xml version="1.0" encoding="utf-8"?>

<!DOCTYPE concept PUBLIC "-//OASIS//DTD DITA Concept//EN" "concept.dtd">

<concept id="simplelist" xml:lang="en-us">

<title>Definition List</title>

<conbody>

<p>Definition list</p>

<dl>

<dlhead>

<dthd>Image File View Selection</dthd>

<ddhd>Resulting Information</ddhd>

</dlhead>

<dlentry>

<dt>File Type</dt>

<dd>Image's file extension</dd>

</dlentry>

<dlentry>

<dt>Image Class</dt>

<dd>Image is raster, vector, metafile or 3D</dd>

</dlentry>

<dlentry>

<dt>Number of pages</dt>

<dd>Number of pages in the image</dd>

</dlentry>

<dlentry>

<dt>Fonts</dt>

<dd>Names of the fonts contained within a vector image</dd>

</dlentry>

</dl>

<p>Content after the definition list.</p>

</conbody>

</concept>

 

Without the use of the markclose in the default.wwconfig, the last paragraph would be underneath the last
Definition Term element. To make sure that no other elements are inside the dropdown, you can assign
markclosed to it by creating an override to default.wwconfig located in [project directory]\Formats
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\Adapters\xml\scripts\dita. For more information, refer to “Creating Format Overrides” Below is an
example of the modification needed to get the desired output:

<!-- Mark open/close on definition entries -->

<!-- -->

<Style match="//*[contains(@class, ' topic/dlentry ')]">

<xsl:variable name="VarName" select="'Definition List Entry'" />

<wwditaconfig:Head name="{$VarName}" markopen="{$VarName} Open" markclose="{$VarName}
Close" />

</Style>
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Configuring markopen and markclose entries for dropdowns in ePublisher
After you have created the override, you will still need to scan for the newly created paragraph styles in
ePublisher. Using our created override, you would see something like this in the Style Designer:

The output is set to disabled because the markopen just serves as a placeholder text. In the closed entry, we set the
Options to have the Dropdown to Break:
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We do this because that is how the content will emit, below is an example of the sample output’s HTML that
shows the paragraph styles as div classes:

Note that the Content after the definition list is now in a Body paragraph, so that it does not become included in
the dropdown.
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Troubleshooting DITA issues
Occasionally there might be issues with the source documents you are using. Below is a list linking to the wiki
solutions website that will help you troubleshoot each one:

Issue Solution

If you are having issues with
whitespace when authoring with
FrameMaker using DITA

tWhite space in FrameMaker

If you are having issues with
cross references when authoring
with FrameMaker using DITA. In
particular, if you are using the fm-
xref element, generated output will
not properly update the generated
numbering. There is a solution to fix
this behavior in FrameMaker.

DITA Cross References in FrameMaker

If you are receiving a Cannot
Duplicate Document

Cannot duplicate document error message

If you are having issues outputting
cross references from DITA

Cross Reference to same topic not working

If you are having issues using a
custom DTD

DTD Issues

If you are using an older or newer
version of the OTK

Different versions of the OTK

If you are trying to use conditional
text

DITA conditions

If you are trying to localize figure/
table paragraphs

Localization of the word "table" or "figure"

If you are getting a Java error when
generating

Java Error

If you are trying to put a list in a table List in a Table

If you are getting a Resample
WIFerror upon generation

ResampleWIF Pipeline Error Blocks Generation of Output

If your elements are not being
populated in the style designer

DITA styles are not being read in the Style Designer

If your Overview topics are showing
up on the same level as their children

DITA Overview Topics Showing on Same Level as Children Topics

http://wiki.webworks.com/Permalinks/Solutions/Input/DITA/WhitespaceRemoved
http://wiki.webworks.com/Permalinks/Solutions/Input/DITA/DTD%20issues
http://wiki.webworks.com/Permalinks/Solutions/Input/DITA/StylesNotPopulated
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Generang Output Using WebWorks Markdown Standard

WebWorks now has their own standard of Markdown that ePublisher can use as a source for generang output.
This secon outlines the WebWorks Markdown Standard, supported by ePublisher.

 

Headings

Headings are made by starng the line with a hash symbol. The amount of hash symbols that precede the text
declares the level of the heading. WebWorks Markdown Standard supports up to Heading 6.

# Heading 1
## Heading 2
### Heading 3
#### Heading 4
##### Heading 5
###### Heading 6

There are alternave ways to indicate Heading 1 or Heading 2. An author may underline the text with an equals
signs for Heading 1 and hyphens for Heading 2.

Heading 1
=========
Heading 2
---------

 

Emphasis

Currently the WebWorks Markdown Standar supports italic, bold, and strikethrough emphasis. The WebWorks
Markdown Standard also supports combined emphasis.

For italic text, wrap the text that is to be put in italics with a single asterisk or underscore.

I’m *telling* you, what I saw was _real_!

I’m telling you, what I saw was real!

For bold text, wrap the text to be emboldened in double asterisks or double underscores.

To start a **New Line**, press the __Enter Key__.

To start a New Line, press the Enter Key.

For strikethrough text, the text must be wrapped with two ldes.

For lunch today, I had a ~~greasy burger~~ healthy salad.

For lunch today, I had a greasy burger healthy salad.

Mulple emphasis styles can be combined using the proper convenons.

I’m supposed to **be there, _now_**.

I’m supposed to be there, now.

Lists
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In the WebWorks Markdown Standard, numerical and bulleted lists can be created. Lower roman lists are only
supported as sub-lists within a numerical list item if the the sub-list is also numerical.

A list is created by starng the line of text with a number followed by a period for a numbered list, or an asterisk,
hyphen, or plus sign for bulleted lists. To start a sub list within a list item, the syntax is the same with the addion
of an indentaon of three spaces.

Keep in mind that it does not maer that the numeric lists are actually in sequence in the source document, all
that maers is the inial character that starts the list. Aer that, all list items will be formaed to that style.

For example:

1. Spaghetti & meatballs
* One box pasta
- One bottle of tomato & basil sauce
1. 1 lb ground beef
* Fried rice
1. White rice
- Soy sauce
* Mixed veggies

Would format into:

1. Spaghetti & meatballs

• One box pasta

• One bottle of marinara sauce

• 1 lb ground beef

2. Fried rice

i. White rice

ii. Soy sauce

iii. Mixed veggies

In addion to nesng lists within lists, you can also nest plain paragraphs within lists. To do this, a set of three
white spaces is used in a new line aer a list item. For example:

1. Spaghetti & meatballs cooking instructions
Bring water to a rapid boil. Add spaghetti and cook for 10 minutes.
Grill the meatballs first in a separate pan, then add in marinara sauce.

Lists will connue to generate in sequence unl a new style of content is created, if a second list needs to appear
directly aer the first list, separate the lists by two empty lines. A list can be nested within another list up to 4
levels deep.

Links

Links can be created using a few different syntaxes. These are the syntax styles supported by WebWorks
Markdown Standard:

Web links

Inline links

Reference-style links

Web links can be wrien directly into the content, either as-is or inside of angle brackets. The full address is
needed for this convenon.
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You can follow a link to http://www.webworks.com as well as <http://
www.webworks.com> though webworks.com will not work.

Inline links, the most basic syntax, is created by wrapping the readable text of the link in a pair of hard brackets
followed by the path the link should follow in parenthesis.

[Follow me to the WebWorks homepage](http://www.webworks.com)

Inline links can also have tle text by following the path with some text wrapped in quotaons.

[this link](http://www.webworks.com "WebWorks Home Page")

Reference-style links can be used to make your content more readable and easier to create. There are a few
different ways to create reference-style links.

The first way to do this would be to write the link’s readable text (read text) in a pair of hard brackets followed by
the text for the referenced link. This text is not case sensive, but the characters need to match on both ends.

[This link will take you elsewehere][link to webworks]
...
[Link to WebWorks]: http://www.webworks.com

Another way to write a reference-style link would be to use numbers for the reference text.

[This link will take you elsewhere][1]
...
[1]: http://www.webworks.com

And finally, reference style links can also be created simply by matching the link’s read text to a reference item.

Click on the [link].
...
[link]: http://www.webworks.com

Important Note

Absolute and relave file paths can be used to link to another file in the output, though for this to work properly,
the desnaon file needs to either be a source document that is also present in the project, or a file that can be
carried over to the output as a baggage file.

Images

The image syntax in WebWorks Markdown Standard is very similar to the link syntax, with the only real
difference being that image syntax is preceded by an exclamaon mark.

Inline images are wrien just like inline links, with a leading exclamaon mark.

![Alternate Text]( http://webworks.com/assets/web/img/WebWorks-Logo.png "Title
Text")

Images can also be wrien in the reference style just like links:

![Alternate Text][logo]
...
[logo]: http://webworks.com/assets/web/img/WebWorks-Logo.png
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Images can also be nested in a link. To do this, use the image syntax inside of the area of a link where the read
text would be.

[![Alternate Text]( http://webworks.com/assets/web/img/WebWorks-Logo.png "Title
Text")](http://www.webworks.com)

Code

WebWorks Markdown Standard also handles code samples and emphasis on technical items using Markdown. To
achieve this, the back-ck character is used.

To put emphasis on a technical term (generally represented by formang the text to a monospaced font), wrap
the text to be formaed in a pair of back-cks.

In JavaScript, to declare a variable, use the `var` keyword.

To write a code block (code fence) that will be formaed to a monospaced font and have its white space
preserved, wrap the code in two sets of three back-cks.

```
var app = {};
app.start = function () {
var message = "Good morning!";
alert(message);
}();
```

In addion to code fencing, you can also create a code line by beginning the line with at least 4 whitespace
characters. As long as each consecuve code line has 4 leading whitespace characters, the code block will
connue.

var addNumbers = function (nums) {
var total = 0;
for (var i = 0; i < nums.length; i++;) {
total += nums[i];
}
return total;
};

Tables

WebWorks Markdown Standard easily supports the creaon of tables by using pipes. Tables need to be
separated from other content by a blank line in order to render correctly. This will allow for a clear separaon
between text and table. Table cells are separated by the pipe character.

The first line of a table should be the column heading text separated by pipes. The next line should have a
matching amount of cells that serve as the separator of the body and the header of the table, as well as seng
the alignment of the column. These separator cells at the very least need three hyphens separated by pipes. To
change the alignment of the column, use the colon character. A lack of colons will keep the column at it’s default
le alignment. Wrapping the hyphens in a pair of colons will center the text in the column, and a colon only
proceeding the hyphens will right-align the column’s text. Inline Markdown can also be used within table cells.

| Name | Age | City |
| ---------- |:---:| -------------:|
| John Smith | 35 | **Dallas** |
| Jane Doe | 28 | **Ft. Worth** |
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| Earl Grey | 47 | **Austin** |

As you can see in this example, the Name column will be le-aligned, the Age column will be centered, and the
City column will be right-aligned, as well as having the city names emboldened.

Tables do not have to be formaed with extra white space. This is usually done to be more human-readable in
the source document, but it is not required. The outer pipe characters are also not required. The next example
shows a table built with the minimum amount of pipes and hyphens, and that would sll render properly.

Username | Last login
--- | ---
superuser99 | 22:56:40
xx_gamechanger_xx | 03:29:12

Blockquotes

Blockquotes are supported in WebWorks Markdown Standard by beginning the line with a single greater-
than sign. A blockquote can be broken out of by separang it with an empty line from other content. All of the
WebWorks Markdown Standard elements can be used inline inside of a blockquote.

> **Abraham Lincoln** said:
> Four score and seven years ago...

Inline HTML

HTML content can be wrien directly and passed-through to the generated output. The important thing to note
about using inline HTML inside source documentaon is that WebWorks Markdown Standard elements will
not work when contained within a subset of HTML. To emphasize parts of content within the HTML subset, use
standard HTML elements.

<div class="Content_Wrapper">
<p class="Content">
To finish your transaction, click on the <strong>Finish & Pay</strong> button.
</p>
</div>

Horizontal Rule

With the WebWorks Markdown Standard, it is possible to create a horizontal rule to separate one content
secon from another. To do this, simply use three consecuve characters of either hyphens, asterisks, or
underscores.

---

***

___

Line Breaks

To separate content into paragraphs or new secons, a new line can be used to achieve this result. By starng a
new line under the previous content, the new text content will remain intact with the previous line, thus being in
the same paragraph. To separate paragraphs, put at least one new line in between the two sets of content.

This content is the beginning of a paragraph.
Because this sentence is on the next line, it
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will also be rendered in the same paragraph
as the first sentence.
This content begins a new paragraph, breaking
from the previous due to the empty line
between them.

Videos

Videos are currently supported as either inline HTML or by using the nested-image link syntax following the
WebWorks Markdown Standard. Note that by using the nested-image link method, this will redirect the user to
the locaon of the video. To embed a video in your HTML output, use the recommended method in HTML.

<iframe width="420" height="315"
src="https://www.youtube.com/watch?v=yYVRxSS1MwI">
</iframe>

Escaping Reserved Characters

If you want to embed a reserved character so that it appears in the generated output, precede the character with
a backslash. For example, to embed an asterisk so that it does not create emphasized text, you would use the
following syntax.

\*

Footnotes

You can embed footnotes in your markdown content. Footnote syntax works very similar to the other various
reference types, only difference being the number of the footnote is preceded by the circumflex character. The
following markdown content demonstrates how to create footnotes and their corresponding definions.

The quick brown fox[^1] jumped over the lazy dog[^2].
[^1]: Foxes are red.
[^2]: Dogs are usually not red.
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Producing Output Based on
Stationery

This section explains how writers can use their source documents and ePublisher projects and Stationery to
produce output.
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Checklist: Producing Output Based on Stationery
Use the following checklist to help you use your source documents and ePublisher projects and Stationery and to
produce output. For more information about designing Stationery, see the ePublisher Design Guide.

Task

1. Review the conceptual information related to projects, source documents, targets,
and Stationery. For more information, see “Understanding Projects and the Project
Folder Structure”, “Understanding Source Documents”, “Understanding Targets”,
and “Understanding Stationery”.

2. Talk to the Stationery designer to determine what Stationery you should use to
generate output.

3. Identify the source documents you want to use to generate output.

4. Prepare your source documents. For more information, see “Preparing Adobe
FrameMaker Source Documents” and “Preparing Microsoft Word Source
Documents”.

5. Create a project using the Stationery created by the Stationery designer. For more
information, see “Creating Projects Based on Stationery”.

6. Add source documents to your project. For more information, see “Adding Source
Documents to Projects”.

7. If you are generating WebWorks Help output, replace the default WebWorks
Help splash image. For more information, see “Customizing or Removing Splash
Page Images in WebWorks Help”.

8. Generate output. For more information, see “Generating and Regenerating Output”.

9. View your output. For more information, see “Viewing Output”.

10. If you want to use reports to validate your output, review reports. For more
information, see “Validating Output Using Reports”.

11. If you want to merge multiple help systems into one help system, configure
merge settings for your merged help system. For more information, see “Merging
Help Systems (Multivolume Help)”.

12. If you want to customize target settings, customize target settings as needed.
For more information, see “Customizing Target Settings”

13. If you want to customize variable and condition settings, customize variable
and condition settings as needed. For more information, see “Customizing Variable
Settings in Projects” and “Customizing Condition Settings in Projects”.

14. If you want to customize cross reference settings, customize cross reference
settings as needed. For more information, see “Customizing Cross-Reference
Settings in Projects”.

15. Deploy your output. For more information, see “Deploying Output”.
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Understanding Projects and the Project Folder Structure
This section explains what a project is and the folder structure projects use.
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Understanding Projects
An ePublisher project consists of all the necessary pieces needed to convert your source documents into online
output. It contains your source documents, images, project Stationery, and any settings or preferences you specify.
After you create a project, you can modify your project settings and preferences, generate reports, and produce
output.

ePublisher provides powerful single-sourcing capabilities that allow you to generate online output in multiple
formats using a single project and a single set of source documents. For example, you can generate WebWorks
Help, Microsoft HTML Help, Oracle Help, Dynamic HTML Help, and Sun JavaHelp using one project and one
set of source files.
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Understanding the Project Folder Structure
The following figure shows a sample project folder.

To view all of the files for your project, on the View menu, click Project Directory.

The project folder contains the following subfolders:

Files
Contains any custom files you want your project to use. Typically, the Files folder contains logo images,
custom.css files, custom bullet images, and custom background images. To view the files in the Files
folder for your project, on the View menu, click User Files.

You can also place a Files directory in a target’s override folder or within the target’s format override
folder.

Formats\<format name>\Files

Targets\<target name>\Files

These files will be copied for each target’s sub-directory but will not be visible in the user interface to
select, e.g. the company logo image in the Target Settings dialog.

Formats
Contains output format overrides and all of the files required to generate output for an output format. Any
time you want to override an output format file, place the override in the Formats folder. For example,
if you want to override the standard table of contents icons for topics in WebWorks Help by specifying
custom table of contents icons, place the custom table of contents icons you want to use in an images folder
in the Formats folder. For more information about format overrides, see the ePublisher Design Guide. To
view the files in the Formats folder for your project, on the View menu, click Format Override Directory.

Logs
Contains the generate.log file. The generate.log file contains information about the actions ePublisher
performed when generating output, along with any warning or errors that occurred during output
generation.

Output
Contains the files ePublisher creates when generating output and provides a structure for generated output
files. ePublisher creates a folder for each target in the project in the Output folder, and each target folder
contains all topic pages, generated images, entry-point files, and merged help files generated for the target.
The entry-point file is the file that opens the help system.

By default, ePublisher creates the Output folder in the following location:

If you use ePublisher Express, by default ePublisher creates the Output folder in the My Documents
\ePublisher Express Projects\ProjectName folder, where ProjectName is the name of the
project.
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If you use ePublisher Designer, by default ePublisher creates the Output folder in the My
Documents\ePublisher Designer Projects\ProjectName folder, where ProjectName is the
name of the project.

You can view output files in the Output folder using Output Explorer or by clicking on and opening output
files in the Output folder. To view the files in the Output folder for your project, on the View menu, click
Output Directory. For more information about viewing output, see “Viewing Output in Output Explorer”
and “Viewing Output in the Output Folder”.

Reports
Contains all of your configured reports in an XML format that ePublisher can display.

Targets
Contains target overrides. Any time you want to override a file in a target, place the override in the Targets
folder. ePublisher looks for overrides in the Targets folder before it looks for overrides in the Formats
folder. The Targets folder only appears in your project folder if your Stationery is configured to use target
overrides. For more information about target overrides, see the ePublisher Design Guide. To view the files
in the Targets folder for the selected target in your project, on the View menu, click Target Override
Directory.

Your project also uses a Data folder. The Data folder contains information about how files in your project have
been processed. The .wif files, which are located in the Data folder, contain style and content information from
your source documents. ePublisher creates the Data folder in the following temporary folder location:

Documents and Settings\UserName\Local Settings\Temp\WebWorks\ePublisherComponent\Data

where UserName is the name of the ePublisher user, and ePublisherComponent is the name of the ePublisher
component used to generate output, such as ePublisher Express or ePublisher Designer.

To view the files in the Data folder for your project, on the View menu, click Data Directory.
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Understanding Source Documents
Source documents are documents you create your content in using a content authoring tool such as Microsoft
Word, Adobe FrameMaker, or an authoring environment that supports DITA authoring, such as Adobe
FrameMaker, XMetaL, or other XML content authoring tool. After you prepare your source documents, you use
your source documents to generate output. For more information about preparing your source documents, see
“Preparing Adobe FrameMaker Source Documents” and “Preparing Microsoft Word Source Documents”. For
more information about generating output, see “Generating and Regenerating Output”.
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Understanding Baggage Files
Baggage files are PDF, HTML and ZIP files that are not part of the ePublisher source files to be converted.
ePublisher makes this determination by examining the file extension. If the file extension matches one of the
following listed below then it’s considered a baggage file.

.pdf

.html

.htm

.shtml

.shtm

.xhtml

.xhtm

.zip

In order to a file to be processed as a Baggage file ePublisher must know about it. This can be achieved in one of
two ways.

(1) Any link from a source file being converted by ePublisher.

(2) Entry in the baggage file info list. For more information see “Baggage files info list”.

Baggage Files will be packaged within your Output folder.

Note: In Target Settings > Links > Baggage File Target, specify whether you want the link to open in the same
browser window or in a different window. There are several other options, see “Baggage File Target”.

Note: Set Target Settings > File Processing > Insert Mark of the Web (MOTW) = Disabled. Otherwise, the
link will fail in Internet Explorer on the local file system. It will work in other browsers. It will work in IE
on a web server.

Note: Baggage files will only be generated if you have the Client-side Search option ON in WebWorks Reverb,
see “Client-side Search”.
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Understanding Targets
A target is the specific type of output you want to produce using your source files and project settings. Targets are
based the output formats you specify for your project, and include all of the project settings you specify for each
output format included in your project when you configure your project.

For example, assume that you are a writer working at CompanyA, and you have the requirement to create a
web-based help system using your source documents. In this scenario, you create a project using stationery that
supports WebWorks Help output and then create a target called CompanyA WebWorks Help.

Next, assume that your documentation requirements change, and in addition to creating WebWorks Help for
CompanyA, you must now also produce Microsoft HTML Help and PDF files for CompanyA using your same
source documents. In this scenario, you update your project to now include the following targets:

CompanyA WebWorks Help

CompanyA Microsoft HTML Help

CompanyA PDF Files

Finally, assume your documentation requirements change again, and now, based on an Original Equipment
Manufacturer (OEM) agreement your company signed, in addition to creating WebWorks Help, Microsoft HTML
Help, and PDF files for CompanyA, you must use your same set of source documents to create WebWorks Help,
Microsoft HTML Help, and PDF files for CompanyB, using company information and variables and conditions
specific to CompanyB. In this scenario, you update your project to now include the following targets:

CompanyA WebWorks Help

CompanyA Microsoft HTML Help

CompanyA PDF Files

CompanyB WebWorks Help

CompanyB Microsoft HTML Help

CompanyB PDF Files

When you have multiple targets included in a project, you choose an active target and then specify project settings
for the active target. The active target is the target currently selected in your project. When you want to modify
project settings for an target, if you have multiple targets included in your project, ensure you have the correct
target selected in the project when you modify project settings. For more information about specifying an active
target, see “Specifying Active Targets”.
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Understanding Stationery
The Stationery designer creates Stationery with ePublisher Designer using a Stationery design project. Stationery
specifies the settings ePublisher uses to generate output. Stationery designers create Stationery by creating
a Stationery design project in ePublisher Designer and then saving the processing rules, styles, and other
information specified in the Stationery design project as Stationery. ePublisher Express and ePublisher AutoMap
can then use the Stationery to generate output.

When the Stationery designer creates a project in ePublisher Designer and then saves a project using the Save
As Stationery option, ePublisher Designer creates a Stationery file. A Stationery file is a file with the .wxsp file
extension that contains formatting, project settings, project overrides, and style information. Source documents
and document-specific information, such as Document Manager groups, are not saved in Stationery. After the
Stationery designer creates the Stationery, writers use the Stationery provided by the Stationery designer when
they create an ePublisher Express project. Writers use their ePublisher Express project and Stationery to generate
output.

When the Stationery designer saves the Stationery, ePublisher creates the following folders:

StationeryName\Formats\OutputFormat

StationeryName\Formats\OutputFormat.base

where StationeryName is the name the Stationery designer specified for the Stationery, and OutputFormat is the
type of output format the Stationery Designer specified for a target in the Stationery.

The StationeryName\Formats\OutputFormat folder contains any customizations or overrides the Stationery
designer specified when designing the Stationery. ePublisher Express synchronizes with the files in the
OutputFormat folder and uses the information about customizations and overrides contained in files in the
OutputFormat folder to generate output.

Note: The Stationery may have one or more OutputFormat folders, based on the settings the Stationery designer
specified.

The StationeryName\Formats\OutputFormat.base folder contains copies of all the files located in the
\Program Files\WebWorks\ePublisher\2018.1\Formats\OutputFormat folder. These files define the default
output format and transforms and are installed by default when you install ePublisher.

Stationery designers can do a compare, or diff, between the files located in these folders to quickly see any
customizations or overrides specified for the Stationery. Stationery designers can use this information to help
them reapply customizations and overrides as needed when designing a newer version of the Stationery in
ePublisher Designer.

When the styles or features used in the generated output need to change, the Stationery designer uses the
ePublisher Designer Stationery design project to update the styles and features specified in the Stationery, and
then the Stationery designer saves the changes, creates updated Stationery, and deploys the Stationery. Once the
new Stationery is available, writers synchronize their ePublisher Express project with the updated Stationery file
and use the updated Stationery the next time they generate output.

Note: When you synchronize your project with Stationery, the synchronization process overwrites any target
setting customizations you configured for the project.

For more information about synchronizing Stationery, see “Synchronizing Projects with Stationery”. For more
information about designing, creating, and deploying Stationery, see the ePublisher Design Guide.
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Creating Projects Based on Stationery
Writers use ePublisher Express and Stationery created by a Stationery designer to generate output. When you
use ePublisher Express to create a project based on Stationery, you specify the Stationery you want the project to
use and the source documents you want to include in the project. The Stationery file uses a .wxsp file extension
and contains information and settings for the project to use, such as style or format information, variable values,
condition settings, cross-reference definitions, and more. The source documents contain the content for which
you want to generate output. The project uses the settings specified in the Stationery file and the content and
formatting in the source documents to generate output. A project file created with ePublisher Express uses the
.wrp file extension.

Note: You cannot create a project based on Stationery using ePublisher Designer. You can only create projects
based on Stationery using ePublisher Express. Stationery designers use ePublisher Designer to create
Stationery using Stationery design projects. For more information about creating Stationery and Stationery
design projects, see the ePublisher Design Guide.

To create a project based on Stationery

1. In ePublisher Express, on the File menu, click New Project.

2. In the Project Name field, type a name for your project.

3. In the Location field, specify the location where you want to save your ePublisher project by clicking on
the folder icon and browsing to the location where you want to save your project.

Note: Ensure you consider the length of the full path you specify for the project name and location. If you
specify long names and paths for project, Windows may not be able to support the length of the full
path.

By default, ePublisher stores projects in the My Documents\ePublisher Express Projects folder.

4. In the Standalone stationery field, specify the Stationery you want to use to create your project by clicking
on the folder icon and browsing to the location of the Stationery file.

5. Select a Stationery file (.wxsp file), and then click Open.

6. Click Next.

7. Click Add.

8. Browse to the location of the source documents you want to include in your project, select the source
documents, and then click Open.

Note: You can add source documents when you create your project or you can add source documents
after you create your project. For more information about adding source documents to projects, see
“Adding Source Documents to Projects”.

9. Click Finish to create the project. ePublisher creates the project and gathers information about the structure
of your source documents.

After you create your project, add targets to your projects as needed and then generate output. For more
information, see “Adding Targets to Projects Based on Stationery” and “Generating Output”.
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Working with Source Documents
This section explains how to work with source documents in Document Manger.
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Adding Source Documents to Projects
You can add source documents to your project when you create a project. You can also add source documents to
your project after you create a project. When you add source documents to your project, ePublisher automatically
adds the source documents to your project and creates a top-level group in Document Manager that contains your
source document. For more information about top-level groups, see “Understanding Source Documents Groups”.

To add a source document to your project

1. On the Project menu, click Add Document.

2. Browse to the folder that contains the source document you want to add to your project.

3. Select the source document you want to add to your project, and then click Open.

4. If you configured ePublisher to scan source documents when you add source documents to projects,
ePublisher adds the source documents to Document Manager and scans the source documents. For
more information about scanning source documents and setting scanning options, see “Scanning Source
Documents” and “Setting Scanning Options”.

5. If you did not configure ePublisher to scan source documents when you add source documents to
projects, ePublisher adds the source documents to Document Manager but does not scan your documents.
After ePublisher adds your source documents to Document Manager, scan your source documents. For
more information about scanning source documents and setting scanning options, see “Scanning Source
Documents” and “Setting Scanning Options”.

6. If you are adding a FrameMaker book file to your project, ePublisher adds the FrameMaker book file
(.bk or .book files) and the source documents the FrameMaker book file contains (.fm files) to your
project. Consider the following points when you add a FrameMaker book file to your project:

When you add a FrameMaker book to your project, by default ePublisher creates a group for the
FrameMaker book in Document Manager, and any FrameMaker source documents contained within
the FrameMaker book are always contained within the group in your project.

When you make changes to a FrameMaker book, such as adding or removing source documents
from a FrameMaker book file, when you scan the FrameMaker book, ePublisher updates the project
with the changes you made to the FrameMaker book file. If you add or remove FrameMaker source
documents in a FrameMaker book, ensure you scan the FrameMaker book before you generate
output. For more information about scanning source documents and setting scanning options, see
“Scanning Source Documents” and “Setting Scanning Options”.

If your FrameMaker book contains front matter files, table of contents files, or index files,
consider the following points:

If you are generating output for a target that uses any output format other than PDF,
by default ePublisher generates output for source document front matter files included in a
book, but does not generate output using the table of contents files and index files included
in the FrameMaker book. ePublisher instead uses the headings and index entries in the source
documents to generate a table of contents and an index for your online output.

If you are generating output for a target that uses PDF as the output format, by default
ePublisher generates the PDF using the front matter, index, and table of contents files included
in the FrameMaker book.

The Stationery designer may modify these default file processing settings when designing Stationery.
If you have target setting modification permissions, you can also customize these settings as
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needed. For more information about target setting customization permissions and customizing file
processing settings, see “Customizing Target Settings” and “Specifying File Processing Behavior
for Front Matter, Index, and Table of Contents Files”. If you do not have target setting customization
permissions, instead of adding an Adobe FrameMaker .book file that contains front matter, table of
contents, and index files, you can instead add the individual Adobe FrameMaker chapter .fm files,
and then use the individual chapter files to generate output.

After you add source documents to your ePublisher project, ePublisher displays your source documents in
Document Manager. You can organize your source documents in Document Manager and perform the following
tasks:

Open and edit source documents from within Document Manager. For more information, see “Opening
Source Documents from Document Manager”.

Relink source documents. For more information, see “Relinking Source Documents”

Remove source documents from your project. For more information, see “Removing Source Documents
from Projects”.

Create an organizational structure for your online output using groups. For more information, see
“Understanding Source Documents Groups” and “Organizing Source Documents Using Groups”.

Rearrange the source document order in Document Manager. For more information, see “Rearranging
Source Documents in Groups”.
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Opening Source Documents from Document Manager
If you want to edit the content of your source documents while working with a project, you can open the source
documents from Document Manager.

To open a source document from Document Manager

1. In Document Manager, double-click the source document you want to open. ePublisher opens the source
document using the content authoring tool you used to create the source document.

2. If you want to edit the content in your source document, edit the content using the content authoring tool
you used to create the source document.

3. Save the source document.
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Scanning Source Documents
This section explains how scanning works, how to scan source documents, and source document scanning
options.



Understanding Scanning and Scanning Opons | 411

Understanding Scanning and Scanning Options
When ePublisher scans your source documents, it reads the style and formatting information, variables,
conditions, and marker types in your source documents and then imports this information into your ePublisher
project. Once ePublisher imports this information into your project, you can generate output. You can also modify
target settings if you have permissions to modify target settings. For more information, see “Generating and
Regenerating Output” and “Customizing Target Settings”.

The scanning process can be time-consuming. You can reduce the amount of time it takes ePublisher to scan your
documents by scanning only the source documents you select. Scan your source documents when you have made
any of the following changes to your source documents:

Added new content

Added new style information

Modified any existing styles

Added new markers, variables, or conditions

Modified existing markers, variables, or conditions

ePublisher provides the following options for scanning source documents in Document Manager:

Scan Selected
Scans only the selected source document in Document Manager.

Scan All Documents
Scans all of the source documents that you added to your project and that are displayed in Document
Manager.
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Setting Scanning Options
By default, ePublisher will ask whether or not to scan your documents. When adding a source document a dialog
box will appear:

This indicates that files such as FrameMaker .book files will scan for additional .fm files linked from this source.
Clicking Yes will scan the individual documents so that the document set styles, for example can be added to the
Style Designer (the same goes for most of the document set customizations.)

However, you can specify that you want ePublisher to scan source documents when you add them to your project.
For example, you can choose to have ePublisher prompt you to scan the source documents when you add source
documents to your project, or you can choose to always have ePublisher scan source documents when you
add them to a project. The scanning option you specify will become the default selection for all existing and
subsequent projects.

If you choose to never have ePublisher scan source documents, when you add them to a project, you must
remember to scan your source documents before you generate output.

To set scanning options

1. On the Edit menu, click Preferences.

2. On the General tab, in the Scan options area, select the scan setting you want to specify. For more
information about scanning options, click Help.

3. Click OK.
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Scanning Selected Documents
Sometimes you may make a change to content in a single source document. You can scan only the source
document you changed. Scanning the selected document updates your project with the new information you
specified in the selected source document.

To scan a selected source document

1. In Document Manager, select the source document you want to scan.

2. On the Project menu, click Scan Selected. ePublisher scans the document you selected in Document
Manager.
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Scanning All Documents
If you have made multiple changes to content in your source documents, you can scan all of the source documents
included in your project at once. Scanning all source documents ensures that ePublisher includes any changes you
made to any of the source documents in your project.

To scan all source documents in a project

On the Project menu, click Scan All Documents. ePublisher scans all of the source documents displayed in
Document Manager.
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Relinking Source Documents
Sometimes the link between Document Manager and the source document may become broken. For example,
moving the source document to another folder location or deleting the source document from a folder may break
the link between Document Manager and the source document. When ePublisher detects a broken link between
Document Manager and the source document, ePublisher displays a Broken Link icon, or red question mark, next
to the source document in Document Manager.

To relink a source document

1. In Document Manager, double-click the Broken Link icon next to the name of the source document.

2. Browse to the location of the source document.

3. Select the source document, and then click Open. ePublisher recreates the link between the source
document and Document Manager.
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Removing Source Documents from Projects
You can remove source documents from an ePublisher project. Remove source documents from your project when
you no longer want to include the content in the source document in your project or in your generated output.

If you are a Stationery designer using ePublisher Designer to design Stationery, when you remove source
documents from an ePublisher project, any styles or formats associated with the source document remain in
Style Designer. For example, assume that the UserManualTitle style is a style that is specific to only one source
document in your project. If you remove the source document that contains the UserManualTitle style from your
project, ePublisher retains the UserManualTitle style name and style information in Style Designer. If you want
to remove this style from Style Designer, you must manually delete it.

To remove a source document from a project

1. In Document Manager, click the source document you want to remove from your project.

2. On the Edit menu, click Remove.

3. If you want to remove an Adobe FrameMaker source document (.fm file) that is a part of an Adobe
FrameMaker book (.book or .bk file) you have added to a project, you cannot remove the Adobe
FrameMaker source document from the project using ePublisher. You must remove the Adobe FrameMaker
source document from the Adobe FrameMaker book file and then scan the Adobe FrameMaker book file to
remove the Adobe FrameMaker source document from your project. For more information about scanning
source documents, see “Scanning Source Documents”.

4. Click Yes to confirm that you want to remove the source document from your project.
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Understanding Source Documents Groups
Groups are containers in Document Manager that hold your source documents and allow you to create an
organizational structure for your output. When you first create a new project, ePublisher automatically creates a
new group in Document Manager using the project name. You can use ePublisher to create the following types of
groups in Document Manager:

Top-level groups
Contains source documents and subgroups. ePublisher creates an entry-point file for each top-level group
in Document Manager. The entry-point file is the file that opens the generated output. All projects must
contain at least one top-level group. You can create additional top-level groups to further organize your
source documents in Document Manager or if you want to create merged, or multivolume, help. For more
information about merged help systems, see “Merging Help Systems (Multivolume Help)”.

Subgroups
Used to organize source documents within top-level groups. Subgroups do not create entry-point files and
do not represent an actual volume in a merged help system.

The following figure shows top-level groups and subgroups in Document Manager.
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Organizing Source Documents Using Groups
You can perform the following actions with source documents and groups in ePublisher:

Create top-level groups. For more information, see “Creating Top-Level Groups”.

Create subgroups. For more information, see “Creating Subgroups”.

Rename groups. For more information, see “Renaming Groups”.

Rearrange source documents in groups. For more information, see “Rearranging Source Documents in
Groups”.

Remove groups. For more information, see “Removing Groups”.
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Creating Top-Level Groups
By default, ePublisher creates a top-level group based on the name of the project when you add your first source
document to your project. There must always be at least one top-level group in Document Manager in order to
add source documents to a project. You can create additional top-level groups if you want to further organize
your source documents or create merged help systems, or multivolume help. For more information about creating
merged help systems, see “Merging Help Systems (Multivolume Help)”.

To create a top-level group

1. On the Project menu, click New Group. ePublisher creates and displays a new top-level group in
Document Manager.

2. Type a name for the new group.

3. Drag the new top-level group to its appropriate position above, below, or between an existing top-level
group in Document Manager.
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Creating Subgroups
You can create subgroups in Document Manager to organize the source documents in a group. By organizing your
source documents into subgroups, you can organize how you want to display your source documents in Document
Manager and how you want content to display in your generated output.

To create a subgroup

1. In Document Manager, select the group to which you want to add a subgroup. You can add a subgroup to a
top-level group or to an existing subgroup.

2. On the Project menu, click New Group. ePublisher displays the new group in Document Manager.

3. Type a name for the new group.
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Renaming Groups
You can rename existing top-level groups and subgroups in Document Manager. For example, when you create a
new project, by default ePublisher creates a new group based on the project name. However, you can change the
default name of the group in Document Manager.

To rename a group in Document Manager

1. In Document Manager, click twice on the group you want to rename.

2. Type a new name for the group.

3. Press ENTER or click outside of the typing area to change the name.
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Rearranging Source Documents in Groups
Once you have added source documents to your project and placed your source documents into groups within
Document Manager, you can rearrange source documents by moving the source documents within the same group
or by moving source documents to a new location in a new group.

If you have a FrameMaker book (.bk or .book file) in a group, you can move the FrameMaker book to a different
group, but you cannot move an individual FrameMaker document (.fm file) to a group if it is included in the
.book file. .fm files that belong to a .book file must remain in the same group as the .book file. If you want to
move a .fm file to a different group than the .book file is in, first remove the .fm file from the book, scan the
book, and add the .fm file, which is no longer part of the book, to the appropriate book.

To rearrange source documents in groups

1. If you want to change the order of source documents within a group, complete the following steps:

a. In Document Manager, click the source document you want to move.

b. Drag the source document to the desired location within the group.

2. If you want to move a source document to a different group, complete the following steps:

a. In Document Manager, click the document you want to move.

b. Drag the source document to the desired location within the new group.
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Removing Groups
If you no longer want to use a group, you can remove the group from Document Manager. When you remove a
group from Document Manager, ePublisher removes any source documents associated with the group from your
project.

Note: ePublisher does not delete the source documents from your computer. ePublisher only removes the source
documents from the project.

To remove a group

1. In Document Manager, select the group you want to remove.

2. On the Edit menu, click Remove.
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Working with Targets
This section explains how to work with targets. For more information about what targets are, see “Understanding
Targets”.
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Specifying Active Targets
Within a project, you can have multiple targets. The active target is the target currently selected in the project.
ePublisher uses the active target when you make modifications to your target settings or generate output.

To specify the active target

On the Project menu, select the target next to Active Target.
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Adding Targets to Projects Based on Stationery
Every project must contain at least one target. Add targets to projects when you need to produce different kinds
of output using the same source documents. Each target is associated with one output format, such as WebWorks
Help, Microsoft HTML Help, or PDF. If you are generating output based on Stationery using ePublisher Express,
the Stationery you use for your project defines the type of output formats you can specify for a target when you
add a target to your project. You can only use output formats defined in the Stationery by the Stationery designer
when you create targets. If you need to create a target for an output format not included in the Stationery, talk to
the Stationery designer about updating the Stationery to include the output format.

For example, assume that you are a writer working at CompanyA, and you need to create web-based help. You
have Stationery from a Stationery designer configured to support WebWorks Help, Microsoft HTML Help, and
PDF output. In this scenario, you create an ePublisher project based on Stationery from the Stationery designer,
and then you create a target called CompanyA WebWorks Help that specifies WebWorks Help as the output
format for the target.

Next, assume that your documentation requirements change, and in addition to creating WebWorks Help for
CompanyA, you must now also produce Microsoft HTML Help and PDF files for CompanyA using your same
source documents. In this scenario, you update your project by adding Microsoft HTML Help and PDF as targets,
and you project now contains the following targets:

CompanyA WebWorks Help

CompanyA Microsoft HTML Help

CompanyA PDF Files

To add a target to a project based on Stationery

1. On the Project menu, click Manage Targets.

2. Click Add.

3. In the Format Type field, select the output format you want to use for the format target.

4. In the Target Name field, type a name for the format target.

5. Click OK.
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Renaming Targets
You can rename targets. By default, the target name is the same as the output format in ePublisher. However,
in some situations, you may want specify a different name for the target. For example, assume that you are
a writer working at CompanyA, and you have the requirement to create a web-based help system using your
documentation source files. In this scenario, you create an ePublisher project that specifies WebWorks help as
your help system and you configure your project settings to use information and branding for CompanyA to create
an target called WebWorks Help.

Next, assume that your requirements change, and now, based on an OEM agreement your company signed, in
addition to creating WebWorks Help for CompanyA, you must use your source files to create WebWorks Help
for CompanyB. In this scenario you create a new target in your project called CompanyB WebWorks Help and
configure settings for this target. However, after configuring settings for the CompanyB WebWorks Help target,
you now want to go back and rename your original WebWorks Help output format, and change the name of this
output format to CompanyA WebWorks Help.

To rename a target

1. On the Project menu, click Manage Targets.

2. In the Target Name field, click the name of the output format you want to rename.

3. Click Edit.

4. In the Target Name field, type the new name you want to specify.

5. Click OK.
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Deleting Targets
You can delete targets from a project if you no longer need to produce output for the target.

To delete a target

1. On the Project menu, click Manage Targets.

2. In the Target Name field, click the name of the output format you want to delete.

3. Click Delete.

4. Click OK.
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Working with Projects
This section explains how to work with projects.
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Saving Projects
You should periodically save your project to ensure that you do not lose any changes you have made. By saving
your project, you ensure that ePublisher stores the information in your project in the project files and all of your
project information will be available the next time you open your project.

To save a project

On the File menu, click Save. ePublisher automatically saves your ePublisher project in a file in the location you
specified when you first created the project.

If you are saving an ePublisher Express project, by default ePublisher saves the project file in the My
Documents\ePublisher Express Projects\ProjectName folder, where ProjectName is the name of the
project.

If you are saving an ePublisher Designer project, by default ePublisher saves the project file in the My
Documents\ePublisher Designer Projects\ProjectName folder, where ProjectName is the name of
the project.
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Opening Existing Projects
You can open an existing project using one of the following methods:

Open the project from within the ePublisher Express or ePublisher Designer user interface.

Open the project from Windows Explorer by double-clicking the project file in the folder where you saved
the project.

By default ePublisher saves project files in the following locations:

ePublisher saves ePublisher Express project files in the My Documents\ePublisher Express Projects
\ProjectName folder, where ProjectName is the name of the project. ePublisher Express project files use
the .wrp file extension.

ePublisher saves ePublisher Designer project files in the My Documents\ePublisher Designer Projects
\ProjectName folder, where UserName is the name of the user account running ePublisher Express and
ProjectName is the name of the project. ePublisher Designer project files use the .wep file extension.

When you open an existing project, ePublisher opens a separate instance of the ePublisher for each project,
and each project has its own window. For example, if you have ProjectA open, and then you decide to open a
project called ProjectB, ePublisher opens up a new instance of ePublisher for the new project and you have two
ePublisher instances with ProjectA and ProjectB open concurrently on your computer.

To open an existing project

1. If you want to open an existing project from within ePublisher Express or ePublisher Designer, complete
the following actions:

a. In ePublisher, on the File menu, click Open.

b. Browse to the location of the project file you want to open.

c. Select the project file you want to open, and then click Open.

2. If you want to open an existing project using Windows Explorer, complete the following steps:

a. In Windows Explorer, browse to the location of the ePublisher project file you want to open.

b. Double-click the ePublisher project file.
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Closing Projects
When you finish working with a project, you can close it. When you close the project, ePublisher prompts you to
save any changes to your project that you have not already saved.

To close a project

On the File menu, click Exit.
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Synchronizing Projects with Stationery
ePublisher Express projects use Stationery designed in ePublisher Designer by the Stationery designer. From
time to time, the Stationery designer may update the Stationery used by your ePublisher Express project. When
the Stationery designer updates the Stationery, you must synchronize your ePublisher Express project with the
Stationery associated with the project in order to obtain the updates made by the Stationery designer. For more
information about Stationery, see “Understanding Stationery”.

When the Stationery designer updates the Stationery an ePublisher Express project uses, ePublisher detects the
change the next time you open a project that uses the Stationery, notifies you that the Stationery used by the
project has been modified, and prompts you to synchronize your project with the updated Stationery. ePublisher
Express prompts you to synchronize your project with its Stationery file under the following conditions:

ePublisher detects differences between the project manifest file and the Stationery manifest file.

ePublisher detects modifications to the Stationery file used by the project.

When you synchronize your project with Stationery, you update your project file so that the information in your
project file matches the information in the Stationery file and in the Stationery manifest file. Synchronizing the
project file with the Stationery file and the manifest file ensures all of the settings and information in the project
file match all of the settings and information in the Stationery file. For more information about the Stationery file
and the Stationery manifest file, see “Understanding Manifest Files” and “Understanding Stationery Files”.

Based on your ePublisher implementation, after you create an ePublisher Express project using Stationery, you
can customize target settings for the targets available in your project if you have appropriate permissions. You
can only customize target settings in your ePublisher Express project if you have target setting modification
permissions. Any customizations you make to target settings will be overwritten the next time you synchronize
your ePublisher Express project with Stationery. For more information, see “Customizing Target Settings”.

ePublisher Express allows you to synchronize your project with its associated Stationery using one of the
following methods:

Automatically synchronize projects with Stationery. For more information, see “Automatically
Synchronizing ePublisher Express Projects with Stationery”.

Manually synchronize projects with Stationery. For more information, see “Manually Synchronizing
ePublisher Express Projects with Stationery”.
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Understanding Manifest Files
When you create a project based on Stationery in ePublisher Express, ePublisher copies the manifest file used by
the Stationery you specify for the project and places a copy of the Stationery manifest file in the project folder for
the new ePublisher Express project. The manifest file is a record of all of the files associated with the Stationery
file, including all of the files listed in the following project folders:

Formats folder

Targets folder

Files folder

For more information about project folders, see “Understanding the Project Folder Structure”.

Any time the Stationery designer performs one of the following actions in the Stationery Formats, Targets, or
Files folder, ePublisher updates the Stationery manifest file:

Modifies a file in a folder

Adds a file to a folder

Removes a file from a folder

When you open an existing ePublisher Express project, ePublisher compares the ePublisher Express project
manifest file to manifest file of the Stationery associated with the ePublisher Express project and determines if
there are differences between the manifest file.

If the Stationery designer has updated, removed, or added any files to the Formats, Targets, and Files folder in
the Stationery since the last time you opened your ePublisher Express project, ePublisher detects these differences
and prompts you to synchronize your ePublisher Express project with the Stationery file. When you synchronize
your ePublisher Express project with the Stationery file, ePublisher copies the Stationery’s updated manifest file
over to your ePublisher Express project file and adds, removes, and updates files in the Formats, Targets, and
Files folders for your project as appropriate.

For example, assume that the Stationery designer updated the Stationery you use for one of your projects by
adding a new Page.asp file. When the Stationery designer makes this change, ePublisher updates the Stationery
manifest file with the change. After the Stationery designer makes this change, the next time you open up your
ePublisher Express project that uses the changed Stationery, ePublisher Express recognizes that the ePublisher
Express project manifest file is different than the Stationery project file and prompts you to synchronize your
project to your Stationery file. When you synchronize your project, ePublisher adds the new Page.asp file to your
project folders.
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Understanding Stationery Files
When you open an existing ePublisher Express project, ePublisher Express determines if the Stationery used
by the project has been modified by examining the checksum of the Stationery file. A checksum is a value that
depends on the contents of a file. ePublisher uses the checksum to determine if a Stationery the file has changed.
If the checksum of the Stationery file is different than the checksum of the project file, ePublisher Express
prompts you to synchronize your project with the Stationery file associated with your project. Any changes to the
following settings within the Stationery file will affect the checksum:

Style and format information

Conditions

Variables

Cross-reference definitions

Target settings
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When to Synchronize
All ePublisher Express projects should be synchronized with Stationery any time the Stationery designer modifies
the Stationery. ePublisher Express projects must be synchronized with the Stationery in order for ePublisher to
include the changes made by the Stationery designer to the Stationery file in an ePublisher Express project. When
you synchronize an ePublisher Express project (.wrp file) with Stationery (.wxsp file), ePublisher updates the
information in the ePublisher Express project to match the information in the Stationery file. If you choose not
to synchronize, your project will retain its old settings and the information in the project file will not match the
information in the Stationery file until you synchronize.
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Automatically Synchronizing ePublisher Express Projects with Stationery
When you open an existing project, ePublisher Express automatically detects whether any modifications have
been made to the Stationery file. If any changes have been made to the Stationery, ePublisher Express displays
a window notifying you that the Stationery has been modified. When this window displays, you can choose to
synchronize your project to the modified Stationery file. You can also choose to synchronize your project to new
Stationery.

To automatically synchronize an ePublisher Express project with Stationery

1. Open ePublisher Express. If the Stationery designer has modified the Stationery linked to your ePublisher
Express project, ePublisher Express displays a window that tells you that the Stationery the ePublisher
Express project is linked to has been modified. The window ePublisher displays should be similar to the
following window.

2. If you want to synchronize your ePublisher Express project with the specified Stationery, click Yes.

3. If you want to synchronize your ePublisher Express project with different Stationery, complete the
following steps:

a. Click the folder icon, and then browse to the location of the Stationery with which you want to
synchronize your ePublisher Express project.

b. Select the Stationery (.wxsp file), and then click Open.

c. Click OK again.

4. If you do not want to synchronize your ePublisher Express project with Stationery, click Cancel.
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Manually Synchronizing ePublisher Express Projects with Stationery
You can manually synchronize your project file with Stationery at any time. When you manually synchronize
your project file with Stationery, ePublisher Express prompts you to specify the Stationery with which you want
to synchronize your ePublisher Express project. You can synchronize your ePublisher Express project with the
Stationery currently associated with your ePublisher Express project, or you can specify that you want your
ePublisher Express project to synchronize with different Stationery.

To manually synchronize an ePublisher Express project with Stationery

1. In ePublisher Express, on the File menu, click Synchronize with Stationery.

Note: You can only synchronize ePublisher Express projects with Stationery. You cannot synchronize
ePublisher Designer projects with Stationery, because ePublisher Designer projects are not based on
Stationery. ePublisher Designer projects are used to design Stationery.

2. Browse to the location of the Stationery to which you want to synchronize your ePublisher Express project.
By default, ePublisher saves Stationery to the following folder:

My Documents\ePublisher Stationery\ProjectName, where ProjectName is the name of the project
used to create the Stationery.

3. Select the Stationery (.wxsp file), and then click Open. ePublisher synchronizes the ePublisher Express
project with the specified Stationery.
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Deleting Projects
Delete a project when you no longer want to use the project to generate output.

To delete a project

1. Open Windows Explorer.

2. Browse to the location of the project folder for the project you want to delete.

By default ePublisher saves ePublisher Express project files in the My Documents\ePublisher
Express Projects\ProjectName folder, where ProjectName is the name of the project. ePublisher
Express project files use the .wrp file extension

By default ePublisher saves the ePublisher Designer project files in the My Documents\ePublisher
Designer Projects\ProjectName folder, where ProjectName is the name of the project.
ePublisher Designer project files use the .wep file extension.

3. Delete the project folder.

When you delete a project, ePublisher continues to display the project on the Start Page until you close and then
reopen the ePublisher user interface.
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Generating and Regenerating Output
When you generate output in ePublisher, ePublisher creates all of the files specified for the target. ePublisher uses
the information in the project source documents and project settings to generate output files. Output files include
the following types of files:

Individual topic page .html files (or .rtf files if you generate Microsoft WinHelp)

Image files, such as .jpg, .gif, and .png files

The entry-point file, which is used to open the generated output

All files required by the help system if you are generating output for a help system
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Understanding Output Generation and Regeneration
In ePublisher, you generate output using either the generate or regenerate option. The generate and regenerate
option both create output from your project. However, there are some important differences between the options.

As you make changes to your source documents and your project settings, you need to generate output files in
order to see any changes made to the following items:

Content changes in your source documents

Changes to project settings

Changes in the Stationery associated with your ePublisher project

When you generate output for a target for the first time, ePublisher creates the output files for the first time. After
you generate output files for a target the first time, if you generate output for your target again, you update your
output files with the changes you made in your source documents and the changes you made to your project
settings. Generating, or updating, your output creates output files more quickly than regenerating your output
files.

Use the generate option when you have made changes to the following project settings:

Condition settings

Variable values

Cross-reference definitions

Merge settings

Target settings

Project preferences

When you regenerate output, ePublisher deletes the Data folder from the project folder, creates a new Data folder,
and creates new output files each time. Regenerate your output any time you add new information to your source
documents that is not content. Non-content modifications to source documents include adding, removing, or
modifying following items:

Paragraph, character and table styles and formats

Marker types

Cross-reference definitions

Variable values in the source documents

Condition settings in the source documents
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Generating Output
In ePublisher, you can generate output for the following items:

The entire project, which generates output for all the groups and source documents in your project

A single group within your project

An individual source document within your project

Generate output for all of the groups in your project when you are generating the final, completed output or help
system, when you are merging output or help systems, or when you are deploying your output.

Generate output for a single group if you have already generated output for the other groups in your project, but
you have made some slight modifications to one of the groups. Using ePublisher to generate output for a single
group reduces the amount of time it takes ePublisher to generate output for your project. When you generate
output for a single group, ePublisher generates output for all of the source documents within the group. If you
select a top-level group or a group that contains subgroups, ePublisher generates output for all of the source
documents in the group and its subgroups.

Generate output for an individual source document if you have made some slight modifications to a source
document and want to preview what your generated output will look like. Selecting an individual source
document instead of generating output for the entire group or project reduces the amount of time it takes
ePublisher to generate output.

To generate output

1. On the Project menu, select the target next to Active Target for which you want to generate output.

2. If you want to generate output for an entire project, on the Project menu, click Generate All.

3. If you want to generate output for a group in your project, complete the following steps:

a. In Document Manager, select the group for which you want to generate output.

b. On the Project menu, click Generate Selected.

4. If you want to generate output for an individual source document in your project, complete the following
steps:

a. In Document Manager, select the document for which you want to generate output.

b. On the Project menu, click Generate Selected.

Note: Some formats, such as the Wiki-based formats and WebWorks Reverb, must be deployed to a server for
proper viewing. WebWorks Reverb does provide a convenience web server that can be used for quick, non-
production preview purposes. Refer to Deploying Output to Output Destinations for further information.
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Regenerating Output
When you regenerate output, ePublisher deletes the Data folder from the project folder, creates a new Data folder,
and generates new output files.

Regenerate your source document any time you have added new information to your source document that is not
content, including adding, removing, or modifying the following items:

Character styles

Paragraph styles

Table styles

Cross-reference definitions

Variable values within source documents

Conditions settings within source documents

To regenerate output

1. On the Project menu, select the target next to Active Target for which you want to regenerate output.

2. On the Project menu, click Regenerate All.
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Generating Output from FrameMaker or Microsoft Word
In 2011.1, ePublisher adds the ability to generate output and reports with your authoring tool via the Transit menu.
Output and reports generated via this menu are short-lived. They disappear once the project window is closed.
Long lived projects should be created with the classic Express interface.

In your Source Document

1. Go to the WebWorks menu

2. Select ePublisher Express -> Generate Output

3. Select the Stationery file on which you want the project to be based

4. Click OK once you have selected the Stationery and the Target you want to use. Now click Finish to
generate output. ePublisher provides you a window to view the Output Explorer as well as the generated
output
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Modifying Help System Title Bars
The title bar in your generated help system displays the title you assigned to your project. If you want to specify a
different title in the title bar for your generated help system, you can do this in the Merge Settings window if you
are generating output for the following help systems:

Dynamic HTML

Eclipse Help

Microsoft HTML Help

WebWorks Help

WebWorks Reverb

You cannot use merge settings to modify help system title bars for other output formats.

To modify the title bar of a help system

1. On the Project menu, select the target next to Active Target for which you want to modify the title bar of a
help system.

2. On the Target menu, click Merge Settings.

3. In the Merge Title field, type the title you want to display in the title bar for your generated help system,
and then click OK.

4. On the File menu, click Save.

5. Regenerate your output. For more information, see “Regenerating Output”.
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Customizing or Removing Splash Page Images in WebWorks Help
The splash page is the first page that displays in the topic frame when a WebWorks Help system first opens.
By default, WebWorks Help displays a WebWorks image on the splash page. The Stationery designer may also
customize the WebWorks Help splash page in the Stationery used by your project to display a custom image. You
can replace the existing splash page image with a different image or you can configure WebWorks Help to display
the first topic in the help instead of the splash page image.
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Customizing Splash Page Images in WebWorks Help
By default when you generate WebWorks Help, WebWorks Help displays a splash page. The splash page is the
first page that displays in the topic frame when the WebWorks Help opens. You can replace the default splash
page image with a custom image.

For more information about the project folder, see “Understanding Projects and the Project Folder Structure”.

To replace the splash page image

1. If you want to override the image for all WebWorks Help targets, complete the following steps:

a. In your project, on the View menu, click Format Override Directory.

b. Create the WebWorks Help 5.0\Pages\images folder in your ProjectName\Formats folder, where
ProjectName is the name of your ePublisher project.

2. If you want to override the image for one WebWorks Help target, complete the following steps:

a. In your project, on the View menu, click Target Override Directory.

b. Create the WebWorks Help 5.0\Pages\images folder in your ProjectName\Targets folder, where
ProjectName is the name of your ePublisher project.

3. Copy the splash.jpg file from the following folder to the images folder you created within your project
folder:

Program Files\WebWorks\ePublisher\2018.1\Formats\WebWorks Help 5.0\Pages\images

4. Open the splash.jpg file you copied into the images folder and modify it to be the splash page image you
want.

5. Save and close the splash.jpg file.

6. Regenerate your output and then open WebWorks Help in Output Explorer to verify the change to the
splash page image. For more information, see “Regenerating Output” and “Viewing Output in Output
Explorer”.
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Removing Splash Page Images in WebWorks Help
By default when you generate WebWorks Help, WebWorks Help displays a splash page. However, instead of
displaying the splash page, WebWorks Help can display the first topic page instead. If you configure this option,
when users open the WebWorks Help system, it displays the first topic.

To remove the splash page image in WebWorks Help

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings.

3. Set Show first document instead of splash page to Enabled.

4. Click OK.

5. Regenerate you output and then open WebWorks Help in Output Explorer to confirm the first topic page
displays instead of the splash page. For more information, see “Regenerating Output” and “Viewing Output
in Output Explorer”.
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Viewing Output
After you specify project and target settings, generate output for your target to review your changes and verify
that the generated output displays and functions properly. You can generate output for all of the source documents
and groups in your project, or you can generate output for a single group or source document. You can view your
generated output files in one of the following ways:

View output by automatically opening the generated output. For more information, see “Viewing Output by
Automatically Opening Generated Output”.

View output in Output Explorer. For more information, see “Viewing Output in Output Explorer”.

View output in the Output folder. For more information, see “Viewing Output in the Output Folder”.
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Viewing Output by Automatically Opening Generated Output
When you generate or regenerate output for a target, after ePublisher generates output, ePublisher prompts you to
view the generated output by displaying the following window:

To view output by automatically opening the output

1. Generate or regenerate output. For more information, see “Generating Output” or “Regenerating Output”.

2. When ePublisher displays a window asking if you would like to view the generated output, perform one of
the following actions:

If you want to view the generated output, click Yes.

If you do not want to view the generated output, click No.

If you want ePublisher to automatically open the output each time you generate output and you do
not want ePublisher to ask you each time if you want to view the generated output, select the Don’t
ask me about this again check box, and then click Yes.

If you do not want ePublisher to automatically open the output each time you generate output and
you do not want ePublisher to ask you each time if you want to view the generated output, select
the Don’t ask me about this again check box, and then click No.

If you select the Don’t ask me about this again check box and specify that you always want ePublisher to
display the generated output or that you never want ePublisher to display the generated output, ePublisher uses the
options you specify as the default behavior for automatically displaying output when you generate or regenerate
output. If you later want to change the default behavior, you can clear your preferences in the WebWorks
ePublisher Preferences window, and then set new preferences the next time you generate or regenerate output. For
more information about setting ePublisher preferences, see “Specifying General ePublisher Preferences”.
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Viewing Output in Output Explorer
Output Explorer allows you to view output files from within the ePublisher user interface. Each time you generate
output for a group of source documents or for an individual source document, ePublisher displays the generated
output files in Output Explorer. The list of files ePublisher displays in Output Explorer is based on if you have a
group of source documents selected or if you have an individual source document selected.

If you select a top-level group in Document Manager, ePublisher displays a group folder with the same name as
the top-level group in Output Explorer that contains the following items:

Navigation group. The Navigation group displays the generated entry-point file and printable reports. The
entry-point file is the file that opens the generated output.

Reports group. The Reports group displays any reports associated with the target that ePublisher generated.

If you select a source document in Document Manager, ePublisher displays the source document group with the
same name as the source document selected in Document Manager that contains the following items:

Files group. The Files group contains all of the generated content files and printable reports.

Images group. The Images group contains images associated with the source document.

Reports group. The Reports group displays any reports associated with the generated output for the target.

If you select a subgroup in Document Manager, ePublisher does not display any information in the Navigation
and Reports groups in Output Explorer, because subgroups do not create a generated entry-point file and do
not represent an actual table of contents group in generated output. The entry-point file is the file that opens the
generated output.

If you have two or more top-level groups in Document Manager and your output format supports merged help
systems, ePublisher creates a Merge Output group in Output Explorer. The Merge Output group contains the
entry-point file for the merged help system. For more information about merged help systems, see“Merging Help
Systems (Multivolume Help)”.

To view output in Output Explorer

1. If Output Explorer is not displayed in the ePublisher user interface, on the View menu, click Output
Explorer.

2. On the Project menu, select the target next to Active Target for which you want to view output.

3. If you want to view output by opening the entry-point file, complete the following steps:

a. In Output Explorer, select a top-level group.

b. Click on the plus sign next to the top-level group to expand the group.

c. Click on the plus sign next to the Navigation group to expand the group.

d. Double-click on the entry-point file to open the generated output.

Output Type Generated Default Entry-Point File to Double-Click to Open

Dynamic HTML toc.html

Eclipse Help View Eclipse Help

Microsoft HTML Help name.chm
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Output Type Generated Default Entry-Point File to Double-Click to Open

Microsoft WinHelp name.hlp

Oracle Help name.jar

Sun JavaHelp name.jar

WebWorks Help index.html

WebWorks Reverb index.html

Wiki - Confluence You cannot view Confluence generated output by
clicking on an entry-point file in Output Explorer. you
must deploy the Confluence output to a Confluence
server computer before you can view the output. For
more information about deploying Confluence output,
see “Deploying Output”.

Wiki - MediaWiki You cannot view MediaWiki generated output by
clicking on an entry-point file in Output Explorer. You
must deploy the MediaWiki output to a MediaWiki
server computer before you can view the output. For
more information about deploying MediaWiki output,
see “Deploying Output”.

Wiki - MoinMoin You cannot view MoinMoin Wiki generated output by
clicking on an entry-point file in Output Explorer. You
must deploy the MoinMoin Wiki output to a MoinMoin
Wiki server computer before you can view the output.
For more information about deploying MoinMoin Wiki
output, see “Deploying Output”.

XML+XSL toc.xml

4. If you generated output for an HTML-based output format and you want to view the individual HTML
files generated for a specific document, complete the following steps:

Note: By default, ePublisher produces individual HTML files for HTML-based output formats based on
the page breaks settings you specify for your project. For more information about specifying page
break settings, see “Specifying Page Breaks Settings”.

a. In Document Manager, select a source document.

b. In the Output Explorer, click on the plus sign next to the document to expand the group.

c. Click on the plus sign next to the Files group to expand the group.

d. Double-click on the generated output file to open the file.

5. If you generated output for a Wiki-based output format and you want to view the individual .wiki files
generated for a specific document, you must deploy the generated .wiki files to a Wiki server computer
before you can view the individual .wiki files. For more information about deploying Wiki-based output,
see “Deploying Output”.

Note: By default, ePublisher produces individual .wiki files for Wiki-based output formats based on the
page breaks settings you specify for your project. For more information about specifying page break
settings, see “Specifying Page Breaks Settings”.

6. If your output format supports merged help systems and you want to view the entry-point file for a
merged help system, complete the following steps:
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a. In Output Explorer, click on the plus sign next to the Merged Output group in the Output Explorer
to expand the group.

b. Double-click on the entry-point file to open the generated output.
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Viewing Output in the Output Folder
ePublisher stores generated output pages and images in the Output folder. By default, ePublisher creates an
Output folder in the following location:

If you are creating a project using ePublisher Express, by default ePublisher creates the Output folder in
the My Documents\ePublisher Express Projects\ProjectName folder, where ProjectName is the name
of the project.

If you are creating a project using ePublisher Designer, by default ePublisher creates the Output folder
in the My Documents\ePublisher Designer Projects\ProjectName folder, where ProjectName is the
name of the project.

The Output folder contains individual output folders for each one of your targets. For example, if your project
contains targets for WebWorks Help, Microsoft HTML Help, and Dynamic HTML, then there will be three
folders, one for each of these targets, in the Output folder.

You can view output files for all output formats other than Wiki-based output formats by opening them directly
from the Output folder. You can only view output files for Wiki-based output formats by deploying the files
to a Wiki server computer. For more information about deploying output files to a Wiki server computer, see
“Deploying Output”.

You can also view output files for all output formats other than Wiki-based output formats by opening them
from the ePublisher user interface. You cannot open files for Wiki-based output formats from the ePublisher user
interface. When you open output files from the ePublisher user interface, ePublisher opens the Output folder for
the active target you are currently working with in ePublisher. For more information about specifying an active
target and working with targets, see “Specifying Active Targets” and “Working with Targets”.

To view output in the Output Folder

1. On the Project menu, select the target next to Active Target for which you want to view output.

Note: You must generate output before you can view output in the Output folder. For more information
about generating output, see “Generating Output”.

2. On the View menu, click Output Directory. ePublisher opens Windows Explorer and displays a folder
based on the name of your target. This Output folder contains the output files ePublisher generated for the
active target.
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Changing the Location of the Output Folder
When you generate output, ePublisher places the output files into the Output folder. You can modify the location
where ePublisher stores your output files.

To change the default location of the Output folder

1. On the Project menu, select the target next to Active Target for which you want to view output.

2. On the Target menu, click Target Settings.

3. In the Generated output location field, type the path to the folder where you want ePublisher to place the
generated output, or click the folder icon to browse to and select a folder.

4. Click OK.
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Working with Output Log Files
Each time you generate output for a target,ePublisher creates a log file named generate.log and writes the
following information to the log file:

Time when output generation began

Actions and commands ePublisher performed, such as processing, creating and copying files

Pipelines processed by ePublisher

Any messages, warnings, or errors generated by ePublisher when ePublisher generated output for the target

Time when output generation ended

Total amount of time it took ePublisher to generate the output

To work with output log files for a target

1. If you want to view the log file for a target from within the ePublisher user interface, complete the
following steps:

a. On the Project menu, select the target next to Active Target for which you want to view log files.

b. On the View menu, click Log Window.

2. If you want to save the log file as a .txt file, complete the following steps:

a. Click the Save button, located in the upper-right corner of the Log Window.

b. Specify a name for the log file and the location where you want to save the log file, and then click
Save.

3. If you want to view the log file for a target using Windows Explorer, in Windows Explorer browse to one of
the following locations:

If you are using ePublisher Express, browse to the ProjectName\Logs\TargetName folder, where
ProjectName is the name of the project and TargetName is the name of the target for which you
generated output. By default ePublisher saves project files for ePublisher Express projects in the My
Documents\ePublisher Express Projects\ProjectName folder, where ProjectName is the name
of the project.

If you are using ePublisher Designer, browse to the ProjectName\Logs\TargetName folder, where
ProjectName is the name of the project and TargetName is the name of the target for which you
generated output. By default ePublisher saves project files for ePublisher Designer projects in the My
Documents\ePublisher Designer Projects\ProjectName folder, where ProjectName is the name
of the project.
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Validating Output Using Reports
After you generate output, you can validate your output using ePublisher reports. ePublisher reports contain
information about how ePublisher processed items in your source documents when ePublisher generated output.
Reports also allow you to identify any problems that occurred when ePublisher generated output. If reports
display notifications, such as messages, warnings, or errors, you can correct the items in your source documents
that caused the error. You can then generate output again and then review the reports again to verify that any
issues have been addressed as needed.

ePublisher provides the following types of reports:

Accessibility reports. For more information, see “Understanding Accessibility Reports”.

Baggage Files reports. For more informations, see “Understanding Baggage Files Reports”.

Conditions reports. For more information, see “Understanding Conditions Reports”.

Filenames reports. For more information, see “Understanding Filenames Reports”.

Links reports. For more information, see “Understanding Links Reports”.

Styles reports. For more information, see “Understanding Styles Reports”.

Topics reports. For more information, see “Understanding Topics Reports”.

Images reports. For more information, see “Understanding Images Reports”.

Printable reports. For more information, see “Understanding Printable Reports”.

For more information about configuring and generating reports, see “Configuring Reports” and “Generating
Reports”.
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Understanding Accessibility Reports
You can use markers in your source documents to create accessible online content. For more information about
using markers to creating accessible content, see “Creating Accessible Online Content in FrameMaker” and
“Creating Accessible Online Content in Word”.

You can use Accessibility reports to validate that the online content you generate using ePublisher meets your
accessibility requirements. Accessibility reports provide notifications on the following items when ePublisher
generates output:

Images without alternative text

Image maps without alternative text

Images without long descriptions

Tables without summaries

Configure the notifications you want ePublisher to generate for Accessibility report settings before you generate
Accessibility reports. For more information about configuring Accessibility report settings, see “Configuring
Reports”. For more information about generating Accessibility reports, see “Generating Reports”.
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Understanding Baggage Files Reports
You can generate baggage files by adding links to HTML or PDF files in your file system, in your source
documents. For more information about baggage files, see “Understanding Baggage Files” and “Specifying
Baggage Files Settings”.

You can use Baggage Files reports to obtain information about how the baggage files are going to be shown
in your Search Results. Baggage Files reports provide notifications on the following items when ePublisher
generates output:

Baggage files without summary

Baggage files without title

Configure the notifications you want ePublisher to generate for Baggage Files report settings before you generate
Baggage Files reports. For more information about configuring Baggage Files report settings, see “Configuring
Reports”. For more information about generating Baggage Files reports, see “Generating Reports”.
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Understanding Conditions Reports
If you add new conditions after ePublisher already scanned the document, those new conditions won’t be picked
up by ePublisher. To warn you about that, ePublisher has a Conditions Report where you can see all those details,
and re-scan the document so the new conditions can be picked up or add it manually yourself using the UI:
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Understanding Filenames Reports
You can specify names for output files using Filename markers. For more information about specifying output file
names using Filename markers, see “Specifying Output File Names in FrameMaker” and “Specifying Output File
Names in Word”.

You can use Filenames reports to validate that ePublisher named your output files correctly using the Filename
markers you inserted in your source documents. The Filenames report displays the name of the Filename marker
you inserted into your source document and the name of the output file ePublisher generated based on the
Filename marker. The Filenames report also provides notifications on the following items when ePublisher
generates output:

The files ePublisher created that correspond to the Filename markers you inserted into your source
documents

If ePublisher ignored a Filename marker when generating output

If duplicate Filename markers exist in the source documents used by your project to generate output

Configure the notifications you want ePublisher to generate for Filenames report settings before you generate
Filenames reports. For more information about configuring Filename report settings, see “Configuring Reports”.
For more information about generating Filename reports, see “Generating Reports”.
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Understanding Links Reports
You can use Links reports to verify that the links you specify to items in your source documents resolve and that
ePublisher processed links in your source documents to the item referenced by the link correctly. Links reports
provide notifications on the following items:

Baggage files

External URLs

Unresolved links to items in other documents

Unresolved links to missing source document

Unresolved links to missing files

Unresolved link within source documents document

Unsupported baggage files

Unsupported external URLs

Unsupported group to group links

For the definition of a baggage file see “Understanding Baggage Files”.

Configure the notification you want ePublisher to generate for Links report settings before you generate Links
reports. For more information about configuring Links report settings, see “Configuring Reports”. For more
information about generating Links reports, see “Generating Reports”.
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Understanding Styles Reports
Styles reports allow you to verify that your source documents conform to the styles and formatting defined in the
Stationery by the Stationery designer. The Styles report notifies you about the following items when ePublisher
generates reports:

Any non-standard styles used in your source documents

Any style overrides used in your source documents

A non-standard style is any style that exists in your source document but is not defined in the stationery file used
by your project. For example, if you add a new style to your source document called BodyIndent 4, but your
stationery designer has not updated the stationery file to include the BodyIndent 4 style, the Styles report notifies
you that there is a non-standard style used in the source document.

A style override is any modification you made to the original style definition for a particular instance of a style.
For example, if you have applied the Body paragraph style to a paragraph in your source document, and you then
apply the Bold character style to the paragraph, the Body paragraph style has a style override.

If your source document contains any non-standard styles or style overrides, ePublisher will process your source
documents when you generate output using the non-standard styles and style overrides you applied in your source
documents.

Configure the notifications you want ePublisher to generate for Styles report settings before you generate Styles
reports. For more information about configuring Styles report settings, see “Configuring Reports”. For more
information about generating Styles reports, see “Generating Reports”.
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Understanding Topics Reports
Context-sensitive help topics require that you have TopicAlias markers inserted in your source documents.
ePublisher generates context-sensitive help topics based on the topic IDs you specify for each TopicAlias marker
you insert in your source documents. Each time ePublisher detects a TopicAlias marker in a source document,
ePublisher generates a context-sensitive help topic based on the topic ID. For more information about creating
context-sensitive help topics, see “Creating Context-Sensitive Help in FrameMaker” and “Creating Context-
Sensitive Help in Word”.

You can use the Topics Report to verify that context-sensitive help topics have been created for each topic ID
specified in your source document. The Topics Report lists the topic ID and the topic file created for each topic
ID.

Configure the notifications you want ePublisher to generate for Topics report settings before you generate Topics
reports. For more information about configuring Topics report settings, see “Configuring Reports”. For more
information about generating Topics reports, see “Generating Reports”.
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Understanding Images Reports
Image reports enable you to verify the integrity and appearance of ePublisher manage images. Users are notified
any time a source image is missing or when an image occurs in a problematic structure, such a images within
tables in the ePUB format.
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Understanding Printable Reports
With the new ePublisher you can see your reports in two different ways: from the UI and in your browser
(Printable Reports). You can find them right after your usual reports.
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Configuring Reports
When you use reports to validate your output, you must specify the type of notification that you want to display
when ePublisher detects issues or performs actions while generating output using your source documents. When
ePublisher generates output, ePublisher generates notifications under the following conditions:

When ePublisher cannot properly process elements

When ePublisher encounters missing information

For example, ePublisher can generate a notification when it detects a potential error in your source documents
when you generate output, such as an unresolved cross reference. ePublisher can also generate a notification
when it performs a specific action using elements contained in your source documents, such as when ePublisher
generates an output file using a filename you specified using a Filename marker.

You can specify the following values for report options when you generate output:

Ignore
Specify this value if you do not want ePublisher to report any issues it identifies in the report. For example,
specify this value you do not want the Styles report to report any style overrides.

Message
Specify this value if you want to receive a message when ePublisher completes or fails to complete an
action. For example, if you are not concerned if your source document uses non-standard styles, but you
would like to see where non-standard styles are used in your source documents, specify this value.

Warning
Specify this value if you want to receive a warning when ePublisher completes or files to complete an
action. For example, if you want to be warned when ePublisher detects non-standard styles in your source
documents, specify this value.

Error
Specify this value if you want the report to display an error when ePublisher completes or files to complete
an action. For example, if you want to receive an error notification when ePublisher detects unresolved
cross-references in your source documents, specify this value.

To configure report notification settings

1. On the Project menu, select the target next to Active Target for which you want to configure report
notification settings.

2. On the Target menu, click Target Settings.

3. If you want to specify Accessibility report notification settings, in the Accessibility Report area, specify a
value for each Accessibility report notification setting you want to configure. For more information about
each setting, click Help.

4. If you want to specify Baggage Files report notification settings, in the Baggage Files Report area,
specify a value for each Baggage File report notification setting you want to configure. For more
information about each setting, click Help.

5. If you want to specify Conditions report notification settings, in the Conditions Report area, specify a
value for each Condition report notification setting you want to configure. For more information about each
setting, click Help.
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6. If you want to specify Filenames report notification settings, in the Filenames Report area, specify a
value for each Filename report notification setting you want to configure. For more information about each
setting, click Help.

7. If you want to specify Links report notification settings, in the Links Report area, specify a value for each
Link report notification setting you want to configure. For more information about each setting, click Help.

8. If you want to specify Styles report notification settings, in the Styles Report area, specify a value for
each Style report notification setting you want to configure. For more information about each setting, click
Help.

9. If you want to specify Topics report notification settings, in the Topics Report area, specify a value for
each Topic report notification setting you want to configure. For more information about each setting, click
Help.

10. If you want to specify Images report notification settings, in the Images Report area, specify a value for
each Image report notification setting you want to configure. For more information about each setting, click
Help.
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Generating Reports
You can generate reports for source documents and baggage files by selecting the group or source document
that you want to generate reports for in Document Manager. Before you generate reports, configure notification
settings for each report you want to generate. For more information about configuring report notification settings,
see “Configuring Reports”.

To generate a report

1. In Document Manager, select the group or source document for which you want to generate a report.

1. If you want to generate all reports for the selected item, on the Project menu, click Generate Reports >
All.

2. If you want to generate Accessibility reports for the selected item, on the Project menu, click Generate
Reports > Accessibility Report.

3. If you want to generate Baggage Files reports for the selected item, on the Project menu, click Generate
Reports > Baggage Files Report.

4. If you want to generate Conditions reports for the selected item, on the Project menu, click Generate
Reports > Conditions Report.

5. If you want to generate Filename reports for the selected item, on the Project menu, click Generate
Reports > Filenames Report.

6. If you want to generate Links reports for the selected item, on the Project menu, click Generate Reports
> Links Report.

7. If you want to generate Styles reports for the selected item, on the Project menu, click Generate Reports
> Styles Report.

8. If you want to generate Topics reports for the selected item, on the Project menu, click Generate Reports
> Topics Report.

9. If you want to generate Images reports for the selected item, on the Project menu, click Generate
Reports > Images Report.
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Understanding Report Messages
The following tables provide descriptions for report messages.
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Accessibility Report Messages
The following table lists messages in Accessibility reports.

Message Definition

Table is missing a table summary. The table does not contain a table summary. Insert a table summary marker within the
table.

Image link '{0}' is missing alternate
text.

The hotspot does not have alternate text. Insert an image area alternate text marker in a
text frame within the image.

Image is missing alternate text. The image does not have alternate text. Insert an image alternate text marker in a text
frame within the image.

Image is missing a long description The image does not have a long description. Insert an image long description marker in
a text frame within the image.
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Baggage Files Report Messages
The following table lists messages in Baggage Files reports.

Message Definition

Title missing for '{0}'. The baggage file doesn’t have a title defined.
If it’s an HTML baggage file insert a <title> tag in the <head> tag of the HTML. Or add
the @title attribute to that file entry in your baggage list info file.
If it’s a PDF baggage file add the @title attribute to that file entry in your baggage list
info file.

Summary missing for '{0}'. The baggage file doesn’t have a summary defined.
If it’s an HTML baggage file you can do one of these:

insert a <meta> tag in the <head> tag of the HTML with @name=’summary’ and
@content with the summary you want to define,
create any kind of tag inside the <body> tag that accepts the attribute @class
with @class=’summary’ and then place your summary as the content of the
element,
insert a <meta> tag in the <head> tag of the HTML with @name=’description’
and @content with the summary you want to define.

Or add the @summary attribute to that file entry in your baggage list info file.
If it’s a PDF baggage file add the @summary attribute to that file entry in your baggage
list info file.
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Filename Report Messages
The following table lists messages in Filename reports.

Message Definition

File '[NAME]' has been processed
as a baggage file.

Any files not contained within your project are processed as baggage files.

Filename marker '[NAME]' has been
used for generated file '[FILE PATH]'.

A file has been generated using a filename marker. This alerts you that the name of the
file has been changed.

Filename marker '[NAME]' has been
ignored.

The filename marker has been ignored because it is either uses a duplicate name or it
has not been inserted at a heading that splits.

Filename marker '[NAME]' has been
processed as '[NAME]' for generated
file '[NAME]'.

The filename marker has not been used; instead, the file has been renamed to the
filename indicated.
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Links Report Messages
The following table list messages in Links reports.

Message Definition

Unresolved link to target ‘[NAME]’ in
document ‘[NAME]’.

There is an unresolved cross-reference in the document. The destination target either
does not exist or cannot be found.

Unresolved link from document
‘[NAME]’ to target ‘[NAME]’ in
document ‘[NAME]’.

There is an unresolved cross-reference from a document to a location in another
document. The destination target cannot be found.

Unresolved link from document
'[NAME]' to document '[NAME]'.

There is an unresolved link from one document to another document. It cannot find the
referenced document.

Unresolved link from document
'[NAME]' to missing file '[NAME]'.

There is an unresolved link from a document to an external file. A file refers to any
file that is not part of the ePublisher project or is not of the same type as your source
document (for example, .jpeg, .gif, .tif)

Unresolved link from document
'[NAME]' to document '[NAME]'.
Output format does not support
group to group linking.

There is an unresolved cross-reference from one document to another document
because the output format your project is using does not support linking from one top-
level group to another.

Unresolved link from document
'[NAME]' to file '[NAME]'. Output
format does not support baggage
files.

There is an unresolved cross-reference from the document to a file because the output
format your project is using does not support baggage files. Files refer to any file that is
not part of the project.

External URL link '[NAME]' is not
supported.

The output format does not support external links.

Styles Report Messages
The following table lists messages in Styles reports.

Message Definition

Encountered [STYLE TYPE] style
name '[NAME]' in your source file
that is not defined in ePublisher.

The style name is not defined in ePublisher.

Encountered text with [STYLE
TYPE] style name '[NAME]' that has
modified style properties in your
source file.

There is a style override. Style overrides refer to attributes that are defined within the
style.

Encountered style properties not
associated with a named style in
your source file.

There is a style override. For example, the character style bold has been modified in one
instance of its use.
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Topics Report Messages
The following table lists messages in Topics reports.

Message Definition

Topic '[NAME]' resolves to the file
'[FILE PATH]'.

A topic page has been created for the topic alias marker.

Topic ‘[NAME]’ is duplicated in the
file ‘[FILENAME]’

A duplicate topic alias has been created in that file.
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Images Report Messages
The following table lists messages in Images reports.

Message Definition

Missing by-reference source files An image referenced by the source document is missing.

Images in table cells Image occurs inside a table cell (problematic for certain ePUB readers)
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Merging Help Systems (Multivolume Help)
Merged help, which is sometimes also referred to as multivolume help, is a help system with a single set of files
created from output from multiple groups from within a project. Merged help takes the table of contents, index,
and search data from each top-level group entry-point file and combines this information to create a single,
consolidated help system. You can use ePublisher to create merged help systems for the following output formats:

Eclipse Help

Microsoft HTML Help

WebWorks Help

WebWorks Reverb

If you have created several top-level groups in Document Manager for your project, by default ePublisher
generates its own help system with its own entry-point file when you generate output for your project. The entry-
point file is the file that opens the help system. ePublisher places the merged help system in the Merged Output
group in Output Explorer.

You must have at least two top-level groups in Document Manager to create merged help. By default, ePublisher
uses the organizational structure specified in Document Manager to create the merged, or multivolume help
system. If you want to organize and group your top-level groups using a different name than the group name
specified in the Document Manager, or if you want to use a different hierarchy in your merged help system than
the hierarchy you currently have specified for your project in Document Manager, you can do this using merge
settings. The following figure shows the Merge Settings window.

ePublisher names the merged help system based on the name of your target. For example, if you generate output
for a target named CompanyA WebWorks Help, ePublisher creates an entry-point file for the merged help system
named CompanyA WebWorks Help and displays this name in the title bar when users open the merged help
system.

ePublisher also creates individual help systems for each top-level group in Document Manager and names these
individual help systems based on the names of the top-level groups in Document Manager. For example, if
you have three top-level groups in Document Manager named FeatureA, FeatureB, and FeatureC and you are
generating output for a target called CompanyA WebWorks Help, ePublisher creates FeatureA, FeatureB, and
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FeatureC help systems as well as a merged help system named CompanyA WebWorks Help that merges the table
of contents, index, and search data from each top-level group into a single, consolidated help system. These top-
level groups also display in the table of contents in your merged help system.

You can use ePublisher merge settings to perform the following actions:

Specify a different name than the target name for the title displayed in the title bar of the merged help
system

Specify a different name for subgroups in your generated output than the names used in Document Manager

Organize and group your top-level groups in a merged help system into a different hierarchy than the
hierarchy used in Document Manager.

To merge help systems

1. Create the top-level groups you want to use in your merged help system in Document Manager. For more
information about creating top-level groups, see “Creating Top-Level Groups”.

2. On the Project menu, select the target next to Active Target for which you want to create a merged help
system.

3. On the Target menu, click Merge Settings.

4. If you want to specify a name other than your target name for the merged help system, in the Merge
Title field, type in the name you would like to display in the title bar of your merged help system.

5. If you want to specify a different name for each top-level group in the table of contents for your
generated output, complete the following steps for each top-level group you want to rename in your
generated output:

a. In the Hierarchy area, select the name of the top-level group for which you want to specify a
different name in the generated output.

b. In the Table of contents title field, type the name you want to display for the group in the generated
output.

6. If you want to reorganize the table of contents in your merged help system, select and then drag and drop
any of the top-level groups to a new position.

7. If you want to create a new custom group for your merged help system that includes some of your
existing top-level groups from Document Manager, complete the following steps:

a. Click the Add button. The Add button in the Merge Settings window is an icon of a blue page with
a plus (+) character ePublisher adds a new group called Untitled Topic to your table of contents
hierarchy.

b. Click on the Untitled Topic group in the Merge Settings window and rename it.

c. Select and then drag and drop the top-level groups you want to include in the new group into the new
group.

8. If you want to delete a custom group you previously created that contains top-level groups, complete the
following steps:

Note: You can only remove groups that you have manually added to your merged help system hierarchy.
You cannot remove groups ePublisher creates by default based on the top-level groups in Document
Manager.

a. Select the group you want to remove.
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b. Click the Delete button.

9. If you are generating merged, or multivolume WebWorks Help or WebWorks Reverb that includes
context-sensitive help, in the Group context field, specify the help context for each top-level group to use.

Note: In WebWorks Help and WebWorks Reverb, you need to include the context and the TopicAlias value
in the help call to display the correct help topic. For more information, see the ePublisher Design
Guide.

10. Click OK.

11. Generate you output. For more information, see “Generating Output”.

12. Open the merged help system by completing one of the following steps:

Note: ePublisher creates the entry-point file using the name of the selected target. If you want to change the
name of the entry-point file for the merged help system, rename your target. For more information
about renaming your target, see “Renaming Targets”.

a. On the View menu, click Output Explorer.

b. Under the Merge Output group in the Output Explorer, double-click on the entry-point file for the
merged help system to open the merged help system.

Note: Ensure you click under the Merge Output group in Output Explorer. You must click under the
Merge Output group in Output Explorer in order to view the merged output. If you click under
one of the other groups, you will only see the output generated for the specific group selected.

13. Review the merged help system you created based on the merge settings you specified and confirm that
your merged help system displays using the help system name and table of contents group hierarchy that
you want.



480 | Deploying Output

Deploying Output
This section explains how you can use ePublisher to deploy output to multiple locations, such as to folders on a
network, to a Web server, or to a Wiki.
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Understanding Output Deployment
By default ePublisher places output files in the following location on your local computer:

If you are creating a project using ePublisher Express, by default ePublisher creates the Output folder in
the My Documents\ePublisher Express Projects\ProjectName folder, where ProjectName is the name
of the project.

If you are creating a project using ePublisher Designer, by default ePublisher creates the Output folder
in the My Documents\ePublisher Designer Projects\ProjectName folder, where ProjectName is the
name of the project.

If you would like to deploy your output files to another location in addition to this default location after ePublisher
generates output, such as a folder on a network, you can deploy your output to one or more output destinations
using ePublisher. The output destination is the location where you would like to deploy your generated output
files. In ePublisher, the output destination consists of the following components:

Output name

Output destination location

To deploy your output, you must perform the following steps:

1. Create one or more output destinations. For more information, see “Creating Output Destinations”.

2. Specify an output destination for each target. For more information, see “Specifying Output Destinations
for Targets”.

3. Deploy output to output destinations. For more information, see “Deploying Output to Output
Destinations”.
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Creating Output Destinations
Before you can deploy your output, you must create output destinations. You can specify one output destination
or multiple output destinations. Specify multiple output destinations when you want to deploy your output to
multiple locations. For example, assume that you place your generated output to a web server computer or to
a Wiki, and you use both a staging server and a production server. You can create one output destination in
ePublisher for the staging server, and another output destination in ePublisher for the production server.

Output destinations are not project or target specific. When you define output destinations in ePublisher,
ePublisher saves the output destinations you define and allows you to use the output destinations you specify
across multiple ePublisher projects and targets.

When you deploy output to an output destination, ensure you specify a descriptive name for the output
destination. When you work with output destination, you can only see the name of the output destination. You will
not be able to see the actual path you specified to the output destination. Type a descriptive name for the output
destination that allows you to easily identify each output destination you specify.

For example, if you are deploying WebWorks Help output for a product to both a staging server and a production
server, type Production Server ProductA WebWorks Help for the first output destination. When you create
your second output destination, type Staging Server ProductA WebWorks Help for the second output
destination.

If you are deploying Wiki - MediaWiki or Wiki - MoinMoin output, review Wiki output format requirements
before creating an output destination on a Wiki. For more information, see “Wiki - MediaWiki” and
“Wiki - MoinMoin”.

To create an output destination

1. On the Target menu, click Target Settings.

2. Click Add deploy target.

3. If your target is not based on a Wiki output format, complete the following steps:

a. Click Add > Folder.

b. In the Name field, type a descriptive name for the output destination.

c. In the Directory field, type the path to the folder you want to specify as the output destination, or
click the folder icon and then browse to and select the folder where you would like to deploy your
output.

d. Click OK.

4. If your target is based on a Wiki output format, such as Wiki - MediaWiki or Wiki  - MoinMoin, complete
the following steps:

a. Click Add > Wiki - Type

where Type is the Wiki type output format on which your target it based.

For example, click Add > Wiki - MediaWiki or Add > Wiki - MoinMoin

b. In the Name field, type a descriptive name for the output destination.

c. Click Edit.

d. In the Wiki Location field, specify the URL root on the Wiki where you want to deploy the output.
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e. If you want to deploy output for a target that uses the Wiki - MoinMoin output format and you
want to deploy different versions of MoinMoin Wiki content to the same MoinMoin Wiki, specify a
parent page where you want to deploy the MoinMoin Wiki content. The parent page is the URL page
path where you want to deploy the Wiki output.

f. If the Wiki to which you are deploying uses authentication, select the User name and password
check box, and then specify the user name and password for a user account with permissions on the
Wiki. ePublisher encrypts this information before storing it.

g. Click Test. ePublisher checks to see if the user credentials you specify have appropriate permissions
on the Wiki by requesting an authentication token from the Wiki.

h. Click OK.

After you create an output destination, you must specify which target is associated with the output destination
before you can deploy output. For more information, see “Specifying Output Destinations for Targets” and
“Deploying Output to Output Destinations”.
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Specifying Output Destinations for Targets
After you create an output destination, you must associate the output destination with an target before you can
deploy output.

To specify an output destination for a target

1. On the Project menu, select the target next to Active Target for which you want to specify an output
destination.

2. On the Target menu, click Target Settings.

3. In the Deploy to field, select an output destination.

Note: You must create an output destination before you can specify an output destination for a target. For
more information about creating output destinations, see “Creating Output Destinations”.

4. Click OK.

After you specify an output destination for a target, you can generate output and deploy the output to the output
destination.
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Deploying Output to Output Destinations
After you create output destinations, specify output destinations for targets and generate output, you can use
the Deploy command in ePublisher to copy your output files and place them into the locations you specified as
output destinations. When you deploy output, ePublisher copies the target output files and places the output files
in the location you specified as the output destination. For more information about creating output destinations
and specifying output destinations for targets, see “Creating Output Destinations” and “Specifying Output
Destinations for Targets”.

If you are deploying Wiki - MediaWiki or Wiki - MoinMoin output, review Wiki output format requirements
and ensure the output destination you specify has been configured appropriately in order to support deployment
of Wiki - MediaWiki or Wiki - MoinMoin output format. For more information about Wiki output format
requirements, see “Wiki - MediaWiki” and “Wiki - MoinMoin”.

To deploy output to an output destination

1. On the Project menu, select the target next to Active Target for which you want to deploy output.

2. On the Target menu, click Deploy. ePublisher deploys the output files to the specified output location.
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Customizing Target Settings
Based on your ePublisher implementation, after you create a project using Stationery, you can customize target
settings for the targets available in your project if you have appropriate permissions. You can only customize
target settings in a project if you have target setting modification permissions.

If you are using ePublisher Designer, you have target setting modification permissions. If you are using ePublisher
Express, you may or may not have target setting modification permissions. When you install ePublisher
Express, you must select the Allow users to modify Target Settings and Properties check box in order to have
permissions to modify the target settings for the targets available in your project. If you do not select this check
box during installation, you will not be able to customize target settings in projects. However, you can enable
target setting modification permissions after you install ePublisher Express if needed. For more information, see
“Working with Contract IDs”.

If you have permissions to modify the target settings in projects, you can customize the following target settings
for most output formats:

Note: If you are using ePublisher Express, any customizations you make to target settings will be overwritten
the next time you synchronize your ePublisher Express project with Stationery. For more information, see
“Synchronizing Projects with Stationery”.

Accessibility settings. For more information, see “Specifying Accessibility Settings”.

Baggage Files settings. For more information, see “Specifying Baggage Files Settings”

Company information. For more information, see “Specifying Company Information”.

File processing behavior for front matter, index files, and table of contents files. For more information, see
“Specifying File Processing Behavior for Front Matter, Index, and Table of Contents Files”.

When to create new pages. For more information, see “Specifying Page Breaks Settings”.

How you want to name your page files and image files when generating output. For more information, see
“Specifying Page, Image, and Table File Naming Patterns”.

Index settings. For more information, see “Specifying Index Settings”.

How links to files or external URLs display in browser windows. For more information, see “Specifying
How Links to Files or External URLs Display in Browser Windows”.

Character encoding settings for targets. For more information, see “Specifying Character Encoding for
Targets”.

Language used by targets. For more information, see “Specifying the Language Used by Targets”.

PDF generation settings. For more information, see “Specifying PDF Generation Settings”

Table of contents settings. For more information, see “Specifying Table of Contents Settings”.

Report settings. For more information, see “Specifying Report Settings”.

Output format-specific settings, such as settings specific to the WebWorks Help output format or the
Microsoft HTML Help output format. For more information, see “Specifying Output Format-Specific
Settings”.

Variable settings. For more information, see “Customizing Variable Settings in Projects”.
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Condition settings. For more information, see “Customizing Condition Settings in Projects”.

Cross-reference settings. For more information, see “Customizing Cross-Reference Settings in Projects”.

After you make any customizations to the target settings for the targets available in your project, generate output
so that you can review your changes and verify that the generated output displays and functions properly. You can
generate output for all the source documents and groups in your project, or you can generate output for a single
group or source document. For more information about generating output, see “Generating Output”.
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Specifying Accessibility Settings
In ePublisher, accessibility refers to how users with disabilities access electronic information and how writers
and producers of online content produce accessible output that can function with assistive devices used by
individuals with disabilities. Creators of online content, such as writers who product online content and help
systems and others who are responsible for producing accessible help, or Section 508 compliant content, must
follow certain guidelines established by the W3C and the U.S. government. If you are responsible for producing
accessible online content, you must provide alternate text and descriptions for all images and image maps and
summaries for all tables included in the online content. Ensure you specify this information when you prepare
your source documents for output generation. For more information, see “Creating Accessible Online Content in
FrameMaker” and “Creating Accessible Online Content in Word”.

To specify accessibility settings for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Accessibility, specify the appropriate values for the Accessibility settings. For more information
about Accessibility settings and values, click Help.

4. Click OK.
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Specifying Baggage Files Settings
In addition to your source files content inside HTML and PDF files can be indexed by enabling Baggage File
settings. In ePublisher you can access to the Baggage File settings only if your target is WebWorks Reverb (also
Reverb 2). There are several settings that allows you to customize the way Reverb handles the baggage files
which will only take effect when you have ON the Client-side Search option in WebWorks Reverb, see “Client-
side Search”.

You can specify the following settings:

Baggage files info list

Copy baggage file dependents

Create standalone group

Note: If your Output Format is Reverb 2 this setting not supported.

Index baggage files

Index external links

Standalone group name

Note: If your Output Format is Reverb 2 this setting not supported.

We will explain each setting briefly below.
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Baggage files info list
The baggage files info list allows you to specify additional baggage files and external URLs that you want
to be included in the search index results and/or packaged with the output.

Note: Currently, creating baggage files in this way requires that the Create standalone group Target setting be
Enabled.

Note: External URLs cannot be packaged with the help, however, they can be included as part of the search
index. Furthermore, external URLs must enable the Create standalone group Target setting in order to be
indexed.

If your baggage files or external URLs do not have adequate title and summary values defined, then you can also
use the baggage files info list to provide these values. These values are used for displaying search results.

If you have external URL links or baggage files in your source content that you do not want included in the search
index, then use the attribute @noindex.

When specifying the path for baggage files, you can either use an absolute path or a path relative to the baggage
files info list file.

You can specify the location and filename of the baggage files info list using the Target Settings dialog
(explained below). By default the filename is called: baggage_list.xml and is available to override in the
Advanced > Manage Format/Target Customizations menu. In addition to renaming this file, you can also
specify an absolute path or a relative path from the project file directory. Furthermore, you can use a variable for
getting the directory location of the first document in the project. Using this variable called: $FirstDocDir;, you
can locate the baggage files info list file in this directory. This is a useful way to use your stationary with
multiple projects.

To use this variable you need to specify it first in the Target Setting value like this:

$FirstDocDir;/baggage_list.xml.

Note: If you change the path of the baggage files info list target setting, then even if you have overridden
this file, the overridden file will be ignored and the file specified will be used instead. However, if you just
change the base filename, then ePublisher will look for this file as if it were an override.

To get the path of the Baggage Files info list file we follow these steps

1. If you change the default value or just change the name (without specifying a path) Reverb tries to
get the file from the Targets folder first and then from the Formats folder. The file will be located in the
Transforms folder, so you can easily do an override of it if you want to keep the default name, otherwise
you can add the new file there with the name you defined in the Target Settings.

2. If you define an Absolute or Relative path Reverb will calculate the relative path relative to the project file
and will take the absolute path as is.

If you don’t specify a title and/or a summary for a baggage file we will try to do it for you.

In case of an HTML file for getting a title (if you didn’t define one in a baggage list file) we will search for:

1. A <title> tag defined in the <head> section of the HTML.

2. The base name without the extension of the HTML file.

In case of a PDF file for getting a title (if you didn’t define one in a baggage list file) we will get the base name
without the extension of the PDF file.



Baggage files info list | 491

In case of an HTML file for getting a summary (if you didn’t define one in a baggage list file) we will search for:

1. The attribute @content in the <meta> tag defined in the <head> section of the HTML with attribute
@name=”summary”.

2. All the text inside the first tag, contained in the <body> tag, with attribute @class=”summary”.

3. The attribute @content in the <meta> tag defined in the <head> section of the HTML with attribute
@name=”description”.

4. All the text inside the first <p> tag, contained in the <body> tag.

In case of a PDF file for getting a summary (if you didn’t define one in a baggage list file) we will get the first 300
letters from the content of the PDF file.

The attribute @noindex accepts 2 values: true|false, or you can even not define this attribute at all, and it will
take the value false by default. If you define @noindex="true" it means Reverb won’t index that file.

The attribute @path is for specifying the path to the file (relative or absolute) or the external URL. It should be an
existing path to an HTML page or PDF, either local or in the web.

Note: Any text you write in this file, if it contains a reserved character you’ll have to change it to use the entity
corresponding. For example, instead of “&” use “&amp;”.

The following code will show you how to structure a baggage list file, as well as some examples for the entries:

<?xml version="1.0" encoding="UTF-8" ?>

<Files version="1.0" xmlns="urn:WebWorks-Baggage-List-Schema">

<File path="http://example.com/" noindex="true"/>

<File path="https://example.com/myfavoritepage" title="My favorite page" summary="Favorite
pages can make your day better"/>

<File path="Source-Docs\some_pdf.pdf" title="Some PDF title" summary="Some PDF summary"/>

<File path="C:\Documents\another_pdf.pdf" title="Another PDF title" summary="Another PDF
summary"/>

...

</Files>
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Copy baggage file dependents
If you have this setting Enabled in your Target Settings, all the dependents of your HTML baggage files will be
copied to the baggage folder inside the corresponding group in the output folder. These mean the final user will be
able to open the HTML baggage file and it will look pretty similar to the original one. Right now we support the
dependences corresponding to these tags:

<link> tag inside the <head> tag that it’s not an external URL or starts with “javascript:”

<script> tag that it’s not an external URL or starts with “javascript:”

<img> tag that it’s not an external URL or starts with “javascript:”

<input> tag that it’s not an external URL or starts with “javascript:”

<iframe> tag that it’s not an external URL or starts with “javascript:”

<video> tag that it’s not an external URL or starts with “javascript:”

<audio> tag that it’s not an external URL or starts with “javascript:”

<object> tag inside the <body> tag that it’s not an external URL or starts with “javascript:”
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Create standalone group
The behavior by default when you have baggage files linked in your source documents is to copy them to your
Output folder in the corresponding group folder. Reverb creates a baggage folder inside the group folder and it
copies there all your baggage files and its dependents (if you have Copy baggage file dependents -> Enabled),
and also copies creates the corresponding bpair.js files containing the pairs in each baggage file to the pairs
folder inside that group. Additionally, in your group index file (with format NameOfTheGroup_sx.js in the output
target folder), Reverb adds the indexed words for every baggage files with its relevance.

Note: If your Output Format is Reverb 2 Standalone groups are not supported and this section does not apply.

The problem with the default behavior is that if you use the same baggage file across different groups, you’ll have it
duplicated in your Output folder, because it’s going to be copied to every group folder and furthermore you are
going to have duplicate results in your Search Results pointing to the different groups where that file lives.

But if you have the Create standalone group setting Enabled in your Target Settings, Reverb instead of
copying to every group the corresponding baggage files, it will create an “imaginary” parallel group to the
other groups that it will only contain 2 folders: baggage and pairs, containing all related with the baggage
files across all groups. Also it will create an index file, with all the indexed words in each baggage file (named
StandaloneGroupName_sx.js, using as StandaloneGroupName the one defined in Standalone group name) in
the output target folder. Now you will have an independent index for all your baggage files and all the information
related with them in the same place (a common folder).

Note: If you have this setting Enabled and the Index baggage files setting -> Enabled all the entries in the
baggage files info list representing baggage files that are not in your source documents will be
indexed as well. So this is a way to index files not contained in your source. Also, if you have the Index
external links setting Enabled combined with this setting, Reverb will index those external links from the
baggage files info list.
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Index baggage files
If you have this setting Enabled in your Target Settings, Reverb will index all the baggage files allowing them
to show up in Search Results. This as mentioned before requires you have them linked in your source documents
or in your Baggage files info list (this requires Create standalone group -> Enabled). You can override this
behavior on a file by file basis by specifying the attribute @noindex="true" in your Baggage files info list.

In order to handle most any type of HTML file Reverb uses Tidy (tool for cleaning up HTML files) for creating a
well-formed XHTML temporary copy of the files, which are valid XML files that ePublisher can read.
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Index external links
If you have this setting Enabled in your Target Settings, Reverb will index all the external links you have in your
source documents and in your Baggage files info list (if you have Create standalone group -> Enabled). That
means you’ll have in your Search Results links to your external URLs if they match with the searched phrase.

The Reverb format downloads the file to the Data directory and then uses Tidy (tool for cleaning up HTML files)
for creating an XHTML copy of the files, which are valid XML files that ePublisher can read.

Note: If your URL needs to execute some JavaScript code to get the content of the page, Reverb won’t be able to
index the dynamic content of the page. To simulate the actual content that Reverb will index at a particular
URL, temporarily disable JavaScript in your browser and visit that link.
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Standalone group name
If you have the Create standalone group setting Enabled in your Target Settings, this will be the name the
Standalone Group will take, see “Create standalone group”.

Note: If your Output Format is Reverb 2 Standalone groups are not supported and this section does not apply.

To specify baggage files settings for a target (only for Reverb targets):

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Baggage Files, specify the appropriate values for the Baggage Files settings. For more information
about Accessibility settings and values, click Help.

4. Click OK.
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Specifying Company Information
You can add your company’s contact information to each generated output page. By default, ePublisher displays
the company contact information on the bottom and/or top of your output pages. Where the company information
displays depends on what the Stationery designer specified in the Stationery file.

You can specify the following company information:

Company email address

Company fax number

Company logo image

Company name

Company phone number

Company web page

To specify company information for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Company Information, specify the appropriate values for the company information settings. For
more information about the company information settings and values, click Help.

4. Click OK.
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Specifying File Processing Behavior for Front Matter, Index, and Table of
Contents Files
You can specify file processing behavior for front matter, index files, and table of contents files. For example, you
can specify whether or not you want to generate output for front matter included in your source documents.

To specify file processing behavior for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under File Processing, specify the appropriate values for file processing settings. For more information
about the file processing settings and values, click Help.

4. Click OK.
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Specifying Page Breaks Settings
When ePublisher processes source documents, it creates new topic pages based on settings specified by the
Stationery designer in the Stationery. However, you can modify how you would like ePublisher to handle the page
breaks.

To specify page break settings for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Files, in the Page break handling field, select the value you want to specify. For more information
about the values, click Help.

4. Click OK.
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Specifying Page, Image, and Table File Naming Patterns
You can specify page, image, and table file naming patterns that you want ePublisher to use when generating
output.

For example, you can specify if you would like to include the following items in page, image, and table file names
when generating output:

Target name

Name of the group in Document Manager that contains the topic

Page heading text or title

You can use image naming patterns to specify names for embedded image output files. However, if you insert
your images by reference in Adobe FrameMaker or use the Link to File or Insert and Link option in the Insert
Picture window in Microsoft Word, ePublisher preserves the original file names.

You can only specify table file naming patterns for Wiki - MoinMoin output. When ePublisher generates Wiki -
MoinMoin Wiki, it creates a separate file for each table in a topic.

Note: You can also use Filename markers to specify page and image output file names.

For more information about using markers to specify output file names, see “Specifying Output File Names in
FrameMaker” and “Specifying Output File Names in Word”.

To specify page, image, and table file naming patterns for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Files, specify the appropriate values for the page, image, and file naming patterns you want to use.
For more information about file settings and values, click Help.

Note: You can only specify table file naming patters for targets that use the Wiki - MoinMoin output
format.

4. Click OK.
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Specifying Index Settings
In ePublisher, you can specify if you want to generate an index for your help system. If you choose to generate an
index for your help system, you must have index markers in your source documents. For more information about
creating index markers in your source documents, see “Creating Index Entries in FrameMaker” and “Creating
Index Entries in Word”.

To specify index settings for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Index, specify the appropriate value for each index setting. For more information about the index
settings and values, click Help.

4. Click OK.
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Specifying How Links to Files or External URLs Display in Browser Windows
ePublisher allows you to specify how you want links that open baggage files or links that open external URLs
displayed in your output. For the definition of a baggage file see “Understanding Baggage Files”.

To specify link settings for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Links, specify the appropriate value for each links setting. For more information about the links
settings and values, click Help.

4. Click OK.
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Specifying Character Encoding for Targets
In ePublisher, encoding refers to the character encoding method used to convert bytes into characters. Programs
use encoding when they display HTML documents. Documents in English and most other Western European
languages typically use the widely supported character encoding UTF-8. If you are producing output localized for
other languages, such as Japanese, Korean, Simplified Chinese, Traditional Chinese, Greek, Turkish, or Eastern
European, Cyrillic, or Baltic languages, you must specify the correct encoding for each target for which you
generate output.

Ensure the encoding you specify when you generate your output matches the encoding used in the environment
where your output will be posted. For example, if your output will be posted on a web server, the encoding you
specify when you generate your output should match the encoding used on the web server. If your output and the
computer or web server hosting your output do not use the same character encoding method, some characters may
not display correctly when users view your output.

To specify character encoding for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Locale, specify the appropriate value for the Encoding setting. For more information about the
encoding setting values, click Help.

4. Click OK.



504 | Specifying the Language Used by Targets

Specifying the Language Used by Targets
In ePublisher, locale refers to the language used when displaying output for a target. If you produce localized
output, specify the correct language for each target in your ePublisher project.

To specify the language to use for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Locale, specify the appropriate value for the Locale setting. For more information about the locale
setting values, click Help.

4. Click OK.
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Specifying PDF Generation Settings
ePublisher can generate PDFs for each source document, for each top-level group in your project, or for each
source document and each top-level group in your project.

Note: If you are generating WebWorks help and you want to display a PDF button in your WebWorks Help
system, see “Specifying Output Format-Specific Settings”.

To specify PDF generation settings for a target

1. On the Project menu, select the output format next to Active Target for which you want to specify
settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under PDF, specify the appropriate values for the PDF settings. For more information about PDF settings
and values, click Help.

4. Click OK.
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Specifying Table of Contents Settings
ePublisher allows you to specify whether you want to generate a table of contents, the file name you want to
specify for your table of contents file, and how you want your table of contents to display in your generated
output.

ePublisher provides table of contents settings to help you address how you want your table of contents to display.
By default, ePublisher uses the table of contents levels specified in the project or in the Stationery file to create
a table of contents for your help system based on the heading levels in your source documents. However, if you
have source documents where writers skipped heading levels, you can specify how you want ePublisher to display
skipped headings in the table of contents.

For example, assume that you have an ePublisher project that uses a Stationery file that specifies Heading 1,
Heading 2, and Heading 3 as levels in the output table of contents. Then assume that in the source document, you
skipped several Heading 2 levels. ePublisher displays an empty table of contents icon, similar to the following
figure, in the location of the skipped Heading 2 levels unless you specify how you want to manage skipped
heading levels in the generated table of contents.

You can specify the following behavior for table of contents where writers skipped headings:

If you want ePublisher to automatically insert empty table of contents entries for skipped heading levels,
select the Don’t collapse value. The following figure shows a table of contents with this option selected.

If you want ePublisher to automatically insert labeled entries for skipped heading levels, select the Re-
label value. ePublisher displays the heading text from the table of contents entry below the current entry as
the table of contents label. The following figure shows a table of contents with this option selected.

If you want ePublisher to automatically remove empty table of contents entries and move the heading
that follows an empty table of contents entry up a level to replace the skipped table of contents level,
select the Smart collapse value. The following figure shows a table of content with this option selected.



Specifying Table of Contents Sengs | 507

If you want ePublisher to remove all skipped heading levels and table of contents entries and place all
table of contents headings at the same level, regardless of the table of contents level specified in the
Stationery, select the Fully collapse value. The following figure shows a table of contents with this option
selected.

To specify table of contents settings for a target

1. On the Project menu, select the target next to Active Target for which you want to specify settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under Table of contents, specify the appropriate values for the table of contents settings. For more
information about table of contents settings and values, click Help.

4. Click OK.
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Specifying Report Settings
You can use reports to identify problems in your source documents. If an ePublisher report detects problems
in your source document, ePublisher displays a notification alert in the report. You can specify which types of
settings you want to use to validate your generated output and the type of notification you want to receive if
ePublisher detects an issue when validating your output. For more information about using reports to validate your
output and the different types of notifications you can receive, see “Validating Output Using Reports”.
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Specifying Output Format-Specific Settings
You can specify output format-specific settings for the following output formats:

eBook - ePUB 2.0

Eclipse Help

Microsoft HTML Help

Microsoft WinHelp

Oracle Help

PDF

PDF - XSL-FO

Sun JavaHelp

WebWorks Help

WebWorks Reverb

Wiki - Confluence

Wiki - MediaWiki

Wiki - MoinMoin

You must have the target that uses the output format selected in your project before you can see the output
format-specific settings in the window. For example, to see WebWorks Help output format-specific settings in
the window, you must have a target that uses the WebWorks Help output format selected as your active target. If
you have a target that uses the Microsoft HTML Help output format selected as your active target, you will not be
able to see WebWorks Help output format-specific settings in the window. You will only be able to see Microsoft
HTML Help output format-specific settings.

To specify output format-specific settings for a target

1. On the Project menu, select the target next to Active Target for which you want to specify output format-
specific settings.

2. On the Target menu, click Target Settings. You must have target modification permissions to modify
target settings. For more information, see “Customizing Target Settings”.

3. Under the name of the output format, specify the appropriate values for each output format-specific setting.
For more information about output format-specific settings and values, click Help.

4. Click OK.
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Customizing Variable Settings in Projects
In a project, you can use the variable values defined in your source document. You can also change the value of
any variable in your source document in a project. Changing the value of a variable in a project does not change
or affect the value of the variable in your source document. You can use the value of the variable you defined in
your project when you generate output. Before you can work with variables in projects, you must insert variables
in your source documents. For more information about variables and inserting variables and conditions in your
source documents, see “Using Variables in FrameMaker” and “Using Variables in Word”.

To customize a variable in a project

1. On the Project menu, select the target next to Active Target for which you want to customize variable
settings.

2. On the Target menu, click Variables. You must have target modification permissions to modify variable
settings for a target. For more information, see “Customizing Target Settings”.

Note: For Microsoft Word documents only, if you use variables that are built-in DocProperty types such as
Author or Company, then you will need to manually add these variables into the project or stationery
as they are not detected when scanned by ePublisher Designer. However, once added into either the
stationery or project then they will be available for customization from that point forward.

3. In the Name column, find the variable you want to modify.

4. If you want the your ePublisher project to use the variable value defined in your source document, click
in the Value field for the variable, and then select Use document value from the drop-down list.

5. If you want to change the variable value ePublisher uses when generating output, click in the Value field
for the variable, and then type in a new value for the variable.

6. Click OK.

7. Generate your output. For more information, see “Generating Output”.

8. Review your output and confirm that variables display appropriately in your generated output. For more
information, see “Viewing Output”.
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Customizing Condition Settings in Projects
In a project, you can use the conditions defined in your source document to control the visibility of content to
which you have applied conditions. You can also change the visibility specified for any condition in a project.
Changing the visibility specified for any condition in a project does not change the visibility specified for the
condition in your source documents. Before you can work with conditions in projects, you must apply conditions
to content in your source documents. For more information about conditions and applying conditions in your
source documents, see “Using Conditions in FrameMaker” and “Using Conditions in Word”.

To customize a condition in a project

1. On the Project menu, select the target next to Active Target for which you want to customize condition
settings.

2. On the Target menu, click Conditions. You must have target modification permissions to modify condition
settings for a target. For more information, see “Customizing Target Settings”.

3. In the Name column, find the condition for which you want condition to set the value.

4. Specify the appropriate value for the condition. For more information about condition values, click Help.

5. Click OK.

6. Generate your output. For more information, see “Generating Output”.

7. Review your output and confirm that conditionalized content displays appropriately in your generated
output. For more information, see “Viewing Output”.
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Customizing Cross-Reference Settings in Projects
Cross-references help users access related information quickly in printed and online content. When you convert
your source documents to online help, if you have cross-references in your source documents, ePublisher
automatically converts all cross-references to hypertext links. Typically, cross-references used for printed
materials have a different format than cross-references used for online help. For example, cross-references in
printed content typically include page numbers, while cross-references in online help typically do not include
page numbers, because page numbers are out of context in online help.

In ePublisher, you use the Cross-Reference Rules window to add, edit, or delete cross-reference formats for
your project. A cross-reference format is a combination of text and code that defines how you want your cross-
reference to display. For example, your source documents may display the following cross-reference format:
“Modifying Cross-Reference Formats on page xxx”, where xxx is the page number where the topic “Modifying
Cross-Reference Formats” begins. However, you may modify the cross-reference format in ePublisher so that
when you generate online content, the “Modifying Cross-Reference Formats” topic displays as a hyperlink
without a page number, such as Modifying Cross-Reference Formats in Projects.

ePublisher obtains the cross-reference formats and values in the Cross-Reference Rules window from your source
documents. You can modify cross-reference formats in ePublisher. For more information about cross-reference
building blocks or codes, see your content authoring tool documentation.

The following figure shows the Cross-Reference Rules window in ePublisher.
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Modifying Cross-Reference Formats in Projects
Modify cross-reference formats when you want cross-references in your online content to use a different format
than your printed content.

To modify a cross-reference format in a project

1. On the Project menu, select the target next to Active Target for which you want to modify cross-reference
formats.

2. On the Target menu, click Cross Reference Rules. You must have target modification permissions to
modify a cross-reference format for a target. For more information, see “Customizing Target Settings”.

3. Specify the appropriate value for each cross reference. For more information about cross reference values,
click Help.

4. Click OK.

5. Generate your output. For more information, see “Generating Output”.

6. Review your output and confirm that cross-references display appropriately in your generated output. For
more information, see “Viewing Output”.
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Adding Cross-Reference Formats to Projects
ePublisher obtains the cross-reference formats and values in the Cross-Reference Rules window from your source
documents. You can also add cross-reference formats in ePublisher.

For example, if you started to use a new cross-reference format in your source document and the Stationery
designer has not yet added this new cross-reference format to the Stationery associated with your project, you
can add the new cross-reference format to your project and specify the cross-reference format you want to use for
your new cross-reference format. After you add a new cross reference format ePublisher recognizes the new cross
reference formats and applies the cross-reference format you specify.

To add a cross-reference format to a project

1. On the Project menu, select the target next to Active Target for which you want to add a cross-reference
format.

2. On the Target menu, click Cross Reference Rules. You must have target modification permissions to add
a cross-reference format for a target. For more information, see “Customizing Target Settings”.

3. In the Document type field, select the content authoring tool for the cross-reference format you want to
add.

4. Click the Add New Cross Reference icon.

5. In the Name field, type a name for the new cross-reference format you want to add to the project.

6. In the Replacement field, type a combination of text and code or building blocks that define how you want
your new cross-reference to display. For more information about cross-reference building blocks or codes,
see your content authoring tool Help.

7. Click OK.

8. Click OK again to close the window.

9. Generate your output. For more information, see “Generating Output”.

10. Review your output and confirm that cross-references display appropriately in your generated output. For
more information, see “Viewing Output”.
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Deleting Cross-Reference Formats from Projects
ePublisher obtains the cross-reference formats and values in the Cross-Reference Rules window from your source
documents. You can delete cross-reference formats in ePublisher. Delete cross-reference formats when you no
longer want to use the cross-reference format in your source documents.

If you delete the cross-reference format in your ePublisher project, but your source documents continue to use the
cross-reference format, ePublisher will detect the deleted cross-reference format in your source documents and
add it to your project again the next time you scan your source documents or generate output.

To delete a cross-reference format from a project

1. On the Project menu, select the target next to Active Target for which you want to delete a cross-reference
format.

2. On the Target menu, click Cross Reference Rules. You must have target modification permissions to
delete a cross-reference format for a target. For more information, see “Customizing Target Settings”.

3. In the Document type field, select the content authoring tool associated with the cross-reference format
you want to delete.

4. In the Name column, select the cross-reference format you want to delete.

5. Click the Delete Cross Reference icon.

6. Click OK.
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Customizing File Mappings
This section explains how to customize file mappings in a project.
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Understanding File Mappings
In ePublisher, a file mapping is an association between a file extension and an ePublisher adapter. An ePublisher
adapter is an ePublisher component that links the content authoring tool that you used to develop your content
with ePublisher. ePublisher currently provides adapters for the following content authoring tools:

Adobe FrameMaker

Microsoft Word

XML

In ePublisher, you can add any source documents that can be opened with Adobe FrameMaker, Microsoft Word,
DITA-XML to your ePublisher project through the use of file mappings. By default, ePublisher provides a list
of file extensions that are preset to use either Microsoft Word, Adobe FrameMaker, or the built-in XML adapter.
For example, you can add .txt files to your ePublisher project by specifying the adapter ePublisher should use in
order to open the .txt file. You can specify whether you want the Adobe FrameMaker, Microsoft Word, or XML
adapter to open the .txt files you add to your project.

Certain file extensions, such as .book, .fm, and .bk files, are unique to a specific adapter. For example,.book,
.fm, and .bk file can only be opened by Adobe FrameMaker. .rtf, .xml, and .doc are specific to Microsoft
Word. If you try to generate output or an output preview using a file type associated with an ePublisher adapter
and the file type cannot normally be opened with the content authoring tool associated with the ePublisher
adapter, ePublisher displays an error message. The built-in XML adapter ePublisher provides is configured out-
of-the-box to support DITA-XML. You can also configure ePublisher Stationery to support other XML types.
However, XML input formats other than DITA-XML may not be supported by the WebWorks Technical Support
team.

If you have an ePublisher Contract ID that enables only the Microsoft Word, the Adobe FrameMaker, or the built-
in XML adapter, then you can use only that adapter when you use ePublisher. Although the option to choose
another adapter may be available in the ePublisher user interface, you will not be able to generate output or
preview output using the other adapters. You can only use the adapters enabled by your Contract ID.
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Modifying File Mappings
ePublisher provides a default list of file mappings in which file extensions have been preset to use a specific
adapter. However, in some cases you may need to modify file mappings for a project. For file extensions that can
either be opened with Microsoft Word or Adobe FrameMaker, such as .txt files, you can specify the adapter you
want ePublisher to use for the file extension. You can modify file mappings for a specific project or for all of your
ePublisher projects.

To modify a file mapping

1. If you want to modify a file mapping for a specific project, complete the following steps:

a. On the Project menu, click Project Settings.

b. In the File Extension column, click the file extension for which you want to modify the file
mapping.

2. If you want to modify a file mapping for all of your ePublisher projects, complete the following steps:

a. On the Edit menu, click Preferences.

b. On the File Mappings tab, in the File Extension column, click the file extension for which you want
to modify the file mapping.

3. In the Adapter column, select the ePublisher adapter you want to associate with the file extension. The
ePublisher adapter you associate with the file extension will be the ePublisher adapter that opens files with
the specified file extension.

4. Click OK.

5. Click OK again. Each new ePublisher project you create after you modify the file mapping will use the
ePublisher adapter you associated with the file extension.
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Creating New File Mappings
If there is a file extension that you would like to use but the file extension is not available in ePublisher in the
default list of file extensions, you can create a new file mapping. To create a new file mapping, add a new file
extension and associate, or map, the file extension to an ePublisher adapter. You can use the new, or custom, file
mapping to specify that ePublisher open files using the new file extension with Adobe FrameMaker, Microsoft
Word, or the built-in XML adapter. When you create a new file mapping, ePublisher saves information about the
new file mapping you created, and you can apply the new file mapping to all of the subsequent projects that you
open.

When you create a file mapping and specify an ePublisher adapter for the file extension, ensure the file extension
can be opened using the content authoring tool associated with the adapter outside of ePublisher before you create
the new file mapping. If the file extension cannot be normally opened using the content authoring tool, then
ePublisher will also not be able to generate output from the source document using the ePublisher adapter.

For example, assume your Contract ID enables licensing for ePublisher Express for FrameMaker. Next assume
that you add HTML as a file mapping and associate the .html file extension with the Microsoft Word adapter.
When you create the file mapping for the .html file extension with the Microsoft Word adapter, ePublisher allows
you to add the HTML file to your project. However, since you do not have a valid license key for the ePublisher
Express for Microsoft Word, ePublisher displays the following error message.

To create a new file mapping

1. If you want to create a new file mapping for a specific project, complete the following steps:

a. On the Project menu, click Project Settings.

b. Click the Add icon.

2. If you want to create a new file mapping for all of your ePublisher projects, complete the following steps:

a. On the Edit menu, click Preferences.

b. On the File Mappings tab, click the Add icon.

3. In the File extension field, type the file extension you want to use for the file mapping. For example, you
can add .html as a file extension.

4. In the Adapter field, select the ePublisher adapter you want to associate with the file extension. The
ePublisher adapter you associate with the file extension will be the ePublisher adapter that opens files with
the specified file extension. For example, you can select Microsoft Word as the adapter for the .html file
extension.

5. Click OK.

6. Click OK again. Each new ePublisher project you create after you modify the file mapping will use the
ePublisher adapter you associated with the file extension.
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Deleting File Mappings
Delete a file mapping when you no longer want to use the file mapping in your ePublisher project.

To delete a file mapping

1. If you want to delete a file mapping for a specific project, complete the following steps:

a. On the Project menu, click Project Settings.

b. In the File extension field, select the file extension for the file mapping you want to delete.

2. If you want to delete a file mapping for all of your ePublisher projects, complete the following steps:

a. On the Edit menu, click Preferences.

b. On the File Mappings tab, in the File extension field, select the file extension for the file mapping
you want to delete.

3. Click the Delete icon.

4. Click OK.

5. Click OK again. Each new ePublisher project you create after you delete the file mapping will not use the
ePublisher adapter you deleted.
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